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Setup Guide

For safety, please read this manual carefully before you use this product and keep it
handy for future reference.
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Notes to users in the United States of America

Notice:
This equipment has been tested and found to comply with the limits for a Class B digital device, pursu-
ant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equip-
ment does cause harmful interference to radio or television reception, which can be determined by turn-
ing the equipment off and on, the user is encouraged to try to correct the interference by one more of
the following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.
Consult the dealer or an experienced radio/TV technician for help.

Warning
Changes or modifications not expressly approved by the party responsible for compliance could void
the user's authority to operate the equipment.

Caution (in case of 100BaseTX environment):
Properly shielded cables must be used for connections to host computer (and/or peripheral) in order to
meet FCC emission limits.
Network interface cable with ferrite core must be used for RF interference suppression.

Declaration of Conformity
Product Name: Laser Printer
Model Number: RICOH LASER AP2610/RICOH LASER AP2610N
Responsible party: Ricoh Corporation
Address: 5 Dedrick Place, West Caldwell, NJ 07006
Telephone number: 973-882-2000
This device complies with part 15 of FCC Rules.
Operation is subject to the following two conditions:
1. This device may not cause harmful interference, and
2. this device must accept any interference received,
including interference that may cause undesired operation.

Properly shielded cables must be used for connections to host computer (and/or peripheral)
in order to meet FCC emission limits.
Network interface cable with ferrite core must be used for RF interference suppression.

Note to users in Canada

Note:
This Class B digital apparatus complies with Canadian ICES-003.

802.11b Interface Unit TypeA(R-WL11):
This device complies with RSS 210 of Industry Canada.
To prevent radio interference to the licensed service, this device must be operated indoors only and
should be kept away from windows to provide maximum shielding.

Remarque concernant les utilisateurs au Canada

Avertissement:
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.

802.11b Interface Unit TypeA(R-WL11):
Pour empêcher que cet appareil cause du brouillage au service faisant l'objet d'une licence, il doit être
utilisé à l'intérieur et devrait être placé loin des fenêtres afin de fournir un écran de blindage maximal.
Si le matériel (ou son antenne d'émission) est installé à l'extérieur, il doit faire l'objet d'une licence.

In accordance with IEC 60417, this machine uses the following symbols for the main power switch: 
aaaa means POWER ON.
bbbb means POWER OFF.

Introduction

This manual contains detailed instructions on the operation and maintenance of this machine. To get
maximum versatility from this machine all operators should carefully read and follow the instructions in
this manual. Please keep this manual in a handy place near the machine.

Please read “Safety Information” in this manual before using this machine. It contains important infor-
mation related to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Power Source

120 V, 60 Hz, 8.4 A or more

Please be sure to connect the power cable to a power source as shown above.

Operator Safety:

This machine is considered a CDRH class I laser device, safe for office/EDP use. The machine con-
tains 7 milliwatt, 645 - 660 nanometer wavelength, AlGaInp Laser Diode. Direct (or indirect reflected)
eye contact with the laser beam might cause serious eye damage. Safety precautions and interlock
mechanisms have been designed to prevent any possible laser beam exposure to the operator.

Laser Safety:

The Center for Devices and Radiological Health (CDRH) prohibits the repair of laser-based optical unit
in the field. The optical housing unit can only be repaired in a factory or at a location with the requisite
equipment. The laser subsystem is replaceable in the field by a qualified Customer Engineer. The laser
chassis is not repairable in the field. Customer engineers are therefore directed to return all chassis
and laser subsystems to the factory or service depot when replacement or the optical subsystem is re-
quired.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Caution:

Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Do not attempt any maintenance or troubleshooting other than that mentioned in this manual. This
printer contains a laser beam generator and direct exposure to laser beams can cause permanent eye
damage.

Two kinds of size notation are employed in this manual. With this machine refer to the inch version.

For good print quality, the supplier recommends that you use genuine toner from the supplier.

The supplier shall not be responsible for any damage or expense that might result from the use of parts
other than genuine parts from the supplier with your office products. 

Copyright © 2001

Download from Www.Somanuals.com. All Manuals Search And Download.



Download from
Setup Guide
For safety, please read this manual carefully before you use this product and keep it
handy for future reference.
 Www.Somanuals.com. All Manuals Search And Download.



Introduction

This manual contains detailed instructions on the operation and maintenance of this machine. To get
maximum versatility from this machine all operators should carefully read and follow the instructions in
this manual. Please keep this manual in a handy place near the machine.

Please read “Safety Information” in this manual before using this machine. It contains important infor-
mation related to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Power Source

120 V, 60 Hz, 8.4 A or more

Please be sure to connect the power cable to a power source as shown above.

Operator Safety:

This machine is considered a CDRH class I laser device, safe for office/EDP use. The machine con-
tains 7 milliwatt, 645 - 660 nanometer wavelength, AlGaInp Laser Diode. Direct (or indirect reflected)
eye contact with the laser beam might cause serious eye damage. Safety precautions and interlock
mechanisms have been designed to prevent any possible laser beam exposure to the operator.

Laser Safety:

The Center for Devices and Radiological Health (CDRH) prohibits the repair of laser-based optical unit
in the field. The optical housing unit can only be repaired in a factory or at a location with the requisite
equipment. The laser subsystem is replaceable in the field by a qualified Customer Engineer. The laser
chassis is not repairable in the field. Customer engineers are therefore directed to return all chassis
and laser subsystems to the factory or service depot when replacement or the optical subsystem is re-
quired.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Caution:

Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Do not attempt any maintenance or troubleshooting other than that mentioned in this manual. This
printer contains a laser beam generator and direct exposure to laser beams can cause permanent eye
damage.

Two kinds of size notation are employed in this manual. With this machine refer to the inch version.

For good print quality, the supplier recommends that you use genuine toner from the supplier.

The supplier shall not be responsible for any damage or expense that might result from the use of parts
other than genuine parts from the supplier with your office products. 

Download from Www.Somanuals.com. All Manuals Search And Download.



Trademarks

Microsoft, Windows and Windows NT are registered trademarks of Microsoft
Corporation in the United States and/or other countries.
Novell, Netware, NDS are registered trademarks or Novell, Inc.
PostScript is a registered trademark of Adobe Systems, Incorporated.
PCL is a registered trademark of Hewlett-Packard Company.
AppleTalk, Apple, Macintosh, TrueType and LaserWriter are registered trade-
marks of Apple Computer, Incorporated.
IPS-PRINT Printer Language Emulation Copyright© 1999-2000 Oak Technolo-
gy, Inc., All rights reserved.
Ethernet is a registered trademark of Xerox Corporation.
Other product names used herein are for identification purposes only and might
be trademarks of their respective companies. We disclaim any and all rights in
those marks.
• The product name of Windows® 95 is Microsoft® Windows® 95.
• The product name of Windows® 98 is Microsoft® Windows® 98.
• The product name of Windows® Me is Microsoft® Windows® Millennium

Edition (Windows Me).
• The product names of Windows® 2000 are as follows:

Microsoft® Windows® 2000 Advanced Server
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional

• The product names of Windows® XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition

• The product names of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Server 4.0
Microsoft® Windows NT® Workstation 4.0

Notes:

Some illustrations in this manual might be slightly different from the machine.
Certain options might not be available in some countries. For details, please con-
tact your local dealer.
i
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Safety Information

When using your printer, the following safety precautions should always be fol-
lowed.

Safety During Operation

In this manual, the following important symbols are used: 

R WARNING:

 

R WARNING:
Indicates a potentially hazardous situation which, if instructions 
are not followed, could result in death or serious injury.

R CAUTION:
Indicates a potentially hazardous situation which, if instructions are 
not followed, may result in minor or moderate injury or damage to 
property.

• Connect the power cord directly into a wall outlet and never use an ex-
tension cord.

• Disconnect the power plug (by pulling the plug, not the cable) if the 
power cable or plug becomes frayed or otherwise damaged.

• To avoid hazardous electric shock or laser radiation exposure, do not 
remove any covers or screws other than those specified in this manu-
al.

• Turn off the power and disconnect the power plug (by pulling the plug, 
not the cable) if any of the following occurs:

• You spill something into the machine.

• You suspect that your machine needs service or repair.

• The external housing of your machine has been damaged.

• Do not incinerate spilled toner or used toner. Toner dust might ignite 
when exposed to an open flame.

• Disposal can take place at our authorized dealer.

• Dispose of the used toner cartridge in accordance with the local regu-
lations.
Download from Www.Somanuals.com. All Manuals Search And Download.



R CAUTION:

 

Positions of Labels and Hallmarks for RRRRWARNING and RRRRCAUTION

This machine has labels and hallmarks for RWARNING,RCAUTION at the
positions shown below. For safety, please follow the instructions and handle  the
machine as indicated.

• Protect the machine from dampness or wet weather, such as rain and snow.

• Unplug the power cord from the wall outlet before you move the machine. 
While moving the machine, you should take care that the power cord will not 
be damaged under the machine. Unplug the power cord from the wall outlet 
before you move the machine. While moving the machine, you should take 
care that the power cord will not be damaged under the machine.

• When you disconnect the power plug from the wall outlet, always pull the 
plug (not the cable).

• Do not allow paper clips, staples, or other small metallic objects to fall inside 
the machine.

• Keep toner (used or unused) and toner cartridge out of the reach of children.

• For environmental reasons, do not dispose of the machine or expended 
supply waste at household waste collection points. Disposal can take place 
at an authorized dealer.

• The inside of the machine could be very hot. Do not touch the parts with a 
label indicating "v" (means hot surface). Touching "v" (means hot surface) 
could result in a burn.

• Our products are engineered to meet high standards of quality and function-
ality, and we recommend that you use only the expendable supplies availa-
ble at an authorized dealer.

ZGDH250E
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ENERGY STAR Program

• Energy Saver mode
This printer automatically lowers its power consumption 30 minutes after the
last operation has been completed. To exit Energy Saver mode, press any key
on the control panel. To change the setting of the Energy Saver mode, see
“System Menu” in the Printer Reference on the CD-ROM labeled “Printer
Drivers and Utilities”.

❖❖❖❖ Specifications

----Recycled Paper
In accordance with the ENERGY STAR Program, we recommend use of recycled
paper which is environment friendly. Please contact your sales representative
for recommended paper.

As an ENERGY STAR Partner, we have determined 
that this machine model meets the ENERGY STAR 
Guidelines for energy efficiency.

The ENERGY STAR Guidelines intend to establish an international energy-saving system for 
developing and introducing energy-efficient office equipment to deal with environmental is-
sues, such as global warming.

When a product meets the ENERGY STAR Guidelines for energy efficiency, the Partner shall 
place the ENERGY STAR logo onto the machine model.

This product was designed to reduce the environmental impact associated with office equip-
ment by means of energy-saving features, such as Low-power mode.

Energy Saver mode Power Consumption • Basic model:
With Options: 17 W or less
Printer Only: 12 W

• Network standard model:
With Options: 18 W or less
Printer Only: 13 W

Default Time 30 minutes
v
Download from Www.Somanuals.com. All Manuals Search And Download.



vi
Manuals for This Printer

Manuals for This Printer

The following manuals describe the operational procedures and maintenance of
this machine.
To enhance safe and efficient operation of this printer, all users should read and
follow the instructions carefully.

❖❖❖❖ Quick Installation Guide
Describes how to install the printer.

❖❖❖❖ Setup Guide  (this manual)
Provides information about setting up the printer and its options. This man-
ual is provided as a printed manual, and also on the CD-ROM labeled "Oper-
ating Instructions".

❖❖❖❖ Printer Reference
Provides information about using the printer and its options. This manual is
provided on the CD-ROM labeled “Operating Instructions”.

❖❖❖❖ Network Printing Guide
Provides information about setting up and using the printer in a network en-
vironment. This manual is provided on the CD-ROM labeled “Operating In-
structions”.

❖❖❖❖ PostScript 3 Operating Instructions Supplement
Describes the menus and features for the PostScript 3 printer driver. This
manual is provided on the CD-ROM labeled “Operating Instructions”.

Note
❒ There are three CD-ROMs that come with this printer. “Operating Instruc-

tions”, “Printer Drivers and Utilities”, and “Document Management Utility”.
❒ Concerning UNIX information, please visit our Web site or consult your au-

thorized reseller.
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How to Read This Manual

Symbols

In this manual, the following symbols are used:

R WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

R CAUTION:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.
* The statements above are notes for your safety.

Important
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates the prior knowledge or preparations required before op-
erating.

Note
This symbol indicates precautions for operation, or actions to take after misop-
eration.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

[ ]
Keys that appear on the machine's panel display.
Keys and buttons that appear on the computer's display.

{ }
Keys built into the machine's control panel.
Keys on the computer's keyboard.
vii
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1. Getting Started
Features of This Printer

This printer is designed especially for office workgroups, both for shared usage
within a network environment, and for one-to-one usage by being connected di-
rectly to the computer.

❖❖❖❖ Time Saving
Superior features save time on print tasks.
• Continuous Printing Speed : 26 ppm.

A4 L, 81/2" × 11" L, maximum printing speed from a standard paper tray.
• All Front Operation: From the front, you can replace the toner cartridge,

check indicators, and clear a paper misfeed if it occurs.

❖❖❖❖ Compact Body
Its compact body requires minimum space to place it on your desk or desk
side.

❖❖❖❖ Network Connectivity
• Basic model

This is a printer with a standard USB port and parallel port.
• Network standard model

This is a printer with a standard Ethernet port, USB port, and parallel port.

❖❖❖❖ Major Specifications

Note
❒ The “K” symbol means short-edge feed direction.
❒ The ”L” symbol means long-edge feed direction.

Printing Speed 26 pages per minute (A4L, 81/2" × 11"L)

Maximum Print Quality True 1200 × 1200 dpi resolutions (PCL 6, RPCS, PS3)

Printer Language PCL 6 , PCL 5e, RPCS, PostScript 3

Maximum Input Paper Size Paper Tray and Bypass Tray:

A3K, 11" × 17"K

Standard Memory Size 32MB

Maximum Memory Size 
with Optional Memory

96MB
1
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Printer Drivers for This Printer

Printing requires installation of a printer driver for your operating system. The
following drivers are included on the CD-ROM that comes with this printer.

*1 Microsoft Windows 95 operating system
*2 Microsoft Windows 98 operating system
*3 Microsoft Windows Millennium Edition
*4 Microsoft Windows 2000 Advanced Server

Microsoft Windows 2000 professional
Microsoft Windows 2000 Server

*5 Microsoft Windows XP Professional
Microsoft Windows XP Home Edition

*6 Microsoft Windows NT Server operating system version 4.0, Microsoft Windows NT
Workstation operating system version 4.0 in a computer using x86 processors.

*7 Required version is 8.6 or later operating system.
*8 Requires Service Pack 4 or later.
*9 The Adobe PostScript printer drivers and PostScript Printer Description (PPD) files

are included on the CD-ROM labeled “Operating Instructions”.

❖❖❖❖ PCL printer drivers
Printer drivers allow the computer to communicate with the printer via a
printer language. Two kinds of PCL printer drivers, PCL 6 and PCL 5e, are
provided with this printer. We recommend PCL 6 as your first choice. 

Note
❒ Some of your applications might require the installation of the PCL 5e

printer driver. In this case, you can install PCL 5e in addition to PCL 6. See
p.54 “Installing the PCL 6/5e Printer Driver”

❖❖❖❖ RPCS printer driver
This printer driver allows the computer to communicate with the printer via
a printer language. The preset type user interface is provided in addition to
the conventional one.
See p.56 “Installing the RPCS Printer Driver”

Printer Language PCL 6 PCL 5e RPCS PostScript 3

Operating system

Windows 95 *1 √ √ √ √ *9 

Windows 98 *2 √ √ √ √ *9 

Windows Me *3 √ √ √ √ *9 

Windows 2000 *4 √ √ √ √ *9 

Windows XP *5 √ √ √ √ *9 

Windows NT 4.0 *6 √ √ √ √ *8  *9 

Mac OS *7 √ *9 
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Printer Drivers for This Printer
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❖❖❖❖ Adobe PostScript Printer Drivers and PPD files
The Adobe Postscript printer drivers and PPD files are included on the CD-
ROM that comes with this printer. Adobe PostScript printer driver allows the
computer to communicate with the printer via a printer language. The PPD
files allow the printer driver to enable the printer specific functions.
See p.58 “Windows 95/98/Me - Installing the PostScript Printer Driver”
See p.59 “Windows 2000/Windows XP - Installing the PostScript Printer
Driver”
See p.61 “Windows NT 4.0 - Installing the PostScript Printer Driver”
3
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Software and Utilities Included on the CD-
ROM

There are three CD-ROMs that come with this printer. These are labeled "Oper-
ating Instructions", "Printer Drivers and Utilities" and "Document Management
Utility". The following are included on the three separate CD-ROMs.

❖❖❖❖ Agfa Monotype Font Manager 2000
Helps you to install new screen fonts, or organize and manage fonts already
installed on the system. This is included on the CD-ROM labeled “Printer
Drivers and Utilities”.

❖❖❖❖ SmartNetMonitor for Admin
A utility for the system administrator to manage printers on the network. This
is included on the CD-ROM labeled “Printer Drivers and Utilities”.

Reference
See SmartNetMonitor for Admin online Help for more information about
using SmartNetMonitor for Admin.

❖❖❖❖ SmartNetMonitor for Client
A utility for users to manage their own print status on the network. This is in-
cluded on the CD-ROM labeled “Printer Drivers and Utilities”.

Reference
See SmartNetMonitor for Client online Help for more information about
using SmartNetMonitor for Client.

❖❖❖❖ Acrobat Reader
A utility that allows you to read PDF (Portable Document Format). This is in-
cluded on the CD-ROM labeled “Operating Instructions”.

Note
❒ Documentation about using the printer is included on the CD-ROM in PDF

format. See Acrobat Reader online Help for more information about using
Acrobat Reader.

Important
❒ If you upgrade to Windows 2000 from Windows 95/98/Me or Windows NT

4.0, the software and utilities must be uninstalled prior to installing Windows
2000. Then reinstall them in a Windows 2000 environment.
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Viewing the Contents of the CD-ROM

Follow the steps to view the contents of the CD-ROM.

AAAA Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

BBBB Click [Browse This CD-ROM].
Explorer starts and displays the contents of the CD-ROM.
5
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Guide to This Printer

Mainframe

❖❖❖❖ Exterior

1. Paper Size Dial
Adjust this dial to match the size and
feed direction of the paper loaded in
the paper tray.

2. Bypass Tray Extension
Pull out this extension to load paper
into the Bypass Tray when its length is
longer than A4 L or 81/2” x 11”L.

3. Bypass Tray
Use to print onto thick paper, OHP
transparencies, adhesive labels, cus-
tom size paper, envelopes as well as
plain paper. When printing on custom
paper size, printer driver settings are
required.

Up to 100 sheets of plain paper (80
g/m2, 20 lb. bond) can be loaded.
See “Paper and Other Media Supported
by this Printer” and “ Loading Paper in
the Bypass Tray” in the Printer Refer-
ence on the CD-ROM labeled "Operat-
ing Instructions".

4. Output Tray Extension
Pull out this extension when printing
on long paper.

5. Control Panel
Contains keys for the printer opera-
tion and a panel display that shows
the printer status.

ZGDH141N
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Guide to This Printer
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6. Output Tray (Standard Tray)
Printed output is stacked here with
the print side facing down.

7. Upper Cover
Remove to install the optional 1-bin
Shift Sort Tray or the optional Mail-
box.

8. Paper Exit Cover
Open this cover to remove misfed pa-
per.

9. Ventilator
This hole helps to keep components
inside the printer from overheating.

Important
❒ Do not block or obstruct the

ventilator. A malfunction may
occur due to overheating.

10. Front Cover Release Button
Use this button to open the front cov-
er.

11. Power Switch
Use this switch to turn the printer
power on and off.

12. Paper Tray (Tray 1)
Loads up to 250 sheets of plain paper
(80 g/m2, 20 lb. bond) into this tray for
printing. 
See “Paper and Other Media Supported
by this Printer” in the Printer Reference
on the CD-ROM labeled "Operating
Instructions".

Note
❒ Paper Tray is displayed “Tray 1”

on the panel display.

13. Rear Cover
Remove to install the optional Duplex
Unit or to replace the Fusing Unit.

14. Power Cord
Plug this cord into a wall outlet.

15. Ventilators
These holes help to keep components
inside the printer from overheating.

Important
❒ Do not block or obstruct the

ventilators. A malfunction may
occur due to overheating.

16. Controller Board
Slide it out to install some options. At-
tach the interface cable, the network
interface cable or the 1394 interface ca-
ble to the board.
7
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❖❖❖❖ Interior

1. Toner Cartridge
Includes toner and a photoconductor
unit.
When “Replace Toner Cartridge” ap-
pears on the panel display, replace
this unit.

2. Front Cover
Open this cover when accessing the
inside of the printer.

3. Guide Board
Open this board to remove misfed pa-
per.

4. Registration Roller
Feeds the paper. If it becomes dirty,
clean it.
See “Cleaning the Registration Roller” in
the Printer Reference on the CD-ROM
labeled "Operating Instructions".

5. Transfer Roller Cover
Open this cover when replacing a
transfer roller.

6. Transfer Roller
When “Replace Maintenance Kit” ap-
pears on the panel display, replace
this roller.

7. Fusing Unit Lock Levers
Lift these levers when replacing the
fusing unit.

8. Fusing Unit
Fuses the image onto paper. 
When “Replace Maintenance Kit” ap-
pears on the panel display, replace
this unit.

[Front side] [Back side]

ZGDH230J
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Control Panel

1. Panel display
Shows the current status of the printer
and error messages.
See “Error & Status Messages on the Control
Panel” in the Printer Reference on the
CD-ROM labeled "Operating Instruc-
tions".

2. Power indicator
Is on while the printer power is on.
Is off when the power is turned off or
while the printer is in Energy Saver
mode.

3. Error indicator
Blinks or lights up whenever any printer
error occurs. A message describing the
cause of the error also appears on the
panel display.
See “Error & Status Messages on the Control
Panel” in the Printer Reference on the
CD-ROM labeled "Operating Instruc-
tions".

4. Data In indicator
Blinks while the printer is receiving data
from a computer.
Is on if there is data to be printed.

5. {{{{On Line}}}} key
Press this key to switch the printer be-
tween online and offline.

6. {{{{Job Reset}}}} key
When the printer is online, press this key
to cancel any ongoing print job.
See “Canceling a Print job” in the Printer
Reference on the CD-ROM labeled "Op-
erating Instructions".

7. {{{{Form Feed}}}} key
If the printer is offline, press this key to
print all the data left in the printer's input
buffer.

Note
❒ This does not work if the printer is on-

line.

8. {{{{Menu}}}} key
Press this key to make and check the cur-
rent printer settings.
See “Making Printer Settings with the Con-
trol Panel” in the Printer Reference on the
CD-ROM labeled "Operating Instruc-
tions".

EnterForm Feed

Job Reset

On Line

Escape

Menu

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

ZDDS100N
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9. {{{{Escape}}}} key
Press this key to return to the previous
condition on the panel display.

10. {{{{Enter #}}}} key
Press this key to execute menu items se-
lected on the panel display.
Press this key to clear some errors.
See “Troubleshooting” in the Printer Refer-
ence on the CD-ROM labeled "Operating
Instructions".

11. {{{{UUUU}}}} {{{{TTTT}}}} keys
Use these keys to increase or decrease
values on the panel display when making
settings.
Download from Www.Somanuals.com. All Manuals Search And Download.



2. Installing Options
R CAUTION:

Important
❒ The voltage rating of the connector for options is 24V DC or less.
❒ Turn the power off before removing the Paper Feed Unit Type 2600, 1-bin

Shift Sort Tray Type 2600, or Mailbox CS380. Removing any of these units
with the power on may cause the printer to fail.

❖❖❖❖  Option List

Note
❒ See the inside front cover of this manual to confirm which printer (Basic

model or Network standard model) you have.

❍ : Available option
*1 With Basic model, these cannot be installed at the same time.
*2 With Network standard model, these cannot be attached at the same time.

Note
❒ Up to two Paper Feed Units can be attached to the printer at the same time.
❒ The installation of the Paper Feed Unit is necessary to attach the Envelope

Feeder Unit.

• Be sure to turn off the printer and wait for about an hour before installing 
options. Not waiting for the printer to cool down can result in a burn.

• When lifting the printer, use the inset grips on both sides of the printer, oth-
erwise the printer might fall and cause personal injury.

• When you move the printer, unplug the power cord from the wall outlet to 
avoid a fire or an electric shock.

Basic model Printer Network standard 
model Printer

Paper Feed Unit Type 2600 ❍ ❍

Envelope Feeder Type 2600 ❍ ❍

1-bin Shift Sort Tray Type 2600 ❍ ❍

CS380 (Mailbox) ❍ ❍

AD410 (Duplex Unit) ❍ ❍

Memory Unit TypeB 64MB ❍ ❍

Hard Disk Drive Type 2600 ❍ ❍

Network Interface Board Type 2610 *1 ❍

1394 Interface Unit Type 4510 *1  *2 ❍ ❍

802.11b Interface Unit Type A *1  *2 ❍ ❍
11
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❒ Either one of the 1-bin Shift Sort Tray or the Mailbox can be attached to the
printer.

❒ The installation of the Memory Unit is necessary to use the 1394 Interface
Unit.

Available Options

The following options can be attached to the printer.

❖❖❖❖ Exterior

1. Paper Feed Unit Type 2600 (Tray 2
or Tray 3)

You can load up to 500 sheets (60-
105g/m2, 16-28 lb.bond) of plain pa-
per into the tray.

Note
❒ Do not attach more than two Paper

Feed Units to the printer at the
same time.

❒ Top-most optional Paper Feed Unit
is displayed “Tray 2” and bottom-
most is displayed “Tray 3” on the
panel display.

2. Envelope Feeder Type 2600
You can load up to 60 envelopes (72-
90g/m2, 19-24 lb.bond) into the tray.

Note
❒ The Envelope Feeder is a tray that

slides into the optional Paper Feed
Unit. Without the optional Paper
Feed Unit, the Envelope Feeder
cannot be used.

❒ The Printer can have two optional
Paper Feed Units installed at the
same time. However the Envelope
Feeder should be used in the top-
most optional Paper Feed Unit
(Tray 2). It cannot be used in the
bottom-most Paper Feed Unit
(Tray 3).

ZCEH150J
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3. AD410 (Duplex Unit)
You can print on both sides of paper.

4. 1-bin Shift Sort Tray Type 2600
You can shift and sort the printings.

Note
❒ The 1-bin Shift Sort Tray and the

Mailbox cannot be installed to the
printer at the same time.

5. CS380 (Mailbox)
You can sort the printings and also de-
liver them to each tray separately.

Note
❒ The 1-bin Shift Sort Tray and the

Mailbox cannot be installed to the
printer at the same time.

❖❖❖❖ Basic model Printer : Interior

Note
❒ See the inside front cover of this manual to confirm which printer (Basic

model or Network standard model) you have.

1. Network Interface Board Type
2610

You can perform the print job on the
network environment.

Note
❒ The Network Interface Board, the

1394  Interface  Unit ,  and  the
802.11b Interface Unit cannot be in-
stalled in the printer at the same
time.

2. 802.11b Interface Unit Type A
You can perform the print job on the
IEEE 802.11b (Wireless LAN) environ-
ment.

Note
❒ The Network Interface Board , the

1394 Interface  Unit ,  and the
802.11b Interface Unit cannot be in-
stalled in the printer at the same
time.

3. 1394 Interface Unit Type 4510
You can perform the print job on the
IEEE 1394 environment.

Note
❒ The Network Interface Board , the

1394 Interface  Unit ,  and the
802.11b Interface Unit cannot be in-
stalled in the printer at the same
time.

1

3

2

4

5
ZGDX120J
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4. Memory Unit TypeB 64MB
You can increase the amount of mem-
ory up to 96MB.

5. Hard Disk Drive Type 2600
You can use the “Collate”, the “Sam-
ple Print” and the “Locked Print”
functions.

❖❖❖❖ Network standard model Printer : Interior

Note
❒ See the inside front cover of this manual to confirm which printer (Basic

model or Network standard model) you have.

1. 802.11b Interface Unit Type A
You can perform the print job on the
IEEE 802.11b (Wireless LAN) environ-
ment.

Note
❒ The 1394 Interface Unit and the

802.11b Interface Unit cannot be in-
stalled in the printer at the same
time.

2. 1394 Interface Unit Type 4510
You can perform the print job on the
IEEE 1394 environment.

Note
❒ The 1394 Interface Unit and the

802.11b Interface Unit cannot be in-
stalled in the printer at the same
time.

3. Memory Unit TypeB 64MB
You can increase the amount of mem-
ory up to 96MB.

4. Hard Disk Drive Type 2600
You can use the “Collate”, the “Sam-
ple Print” and the “Locked Print”
functions.

2

1

3

4
ZGDX121J
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Paper Feed Unit Type 2600

Important
❒ Do not slide more than one paper

tray out at the same time. Having
more than one paper tray filled
with paper in a fully extended po-
sition could cause the machine to
fall down.

❒ Do not attach more than two Paper
Feed Units in your printer at the
same time.

❒ Check the printer nameplate to
confirm the model code.

AAAA Check the contents of the box for
the following items:
• Paper Feed Unit (including a

paper tray)
• Installation Guide

BBBB Confirm that the followings are
true:
• The power switch is turned off.

• The power cord is unplugged
from the wall outlet.

CCCC Remove the adhesive tape from
the Paper Feed Unit.

Note
❒ If you attach two Paper Feed

Units at the same time, stack
them up in advance.

DDDD There are three pins on the top of
the Paper Feed Unit that point
straight up. On the bottom of the
printer there are three holes.
Align the holes over the pins, and
then lower the printer gently onto
the Paper Feed Unit.

R CAUTION:

EEEE Attach the interface cable to the
printer.ZCEX390J

• When lifting the machine, use 
the inset grips on both sides. 
Otherwise the printer could 
break or cause injury if dropped.

ZGDX400J

ZGDH052N
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FFFF Plug the printer's power cord
back into the wall outlet, and then
turn on the power switch.

Note
❒ After installing the last option that

you want, print the configuration
page to confirm the installation. If
the new device is listed in the col-
umn of configuration options, then
it has been properly installed. For
more information about printing
the configuration page, see "Print-
ing the Configuration Page" in the
Printer Reference on the CD-ROM
labeled "Operating Instructions".

Reference
For information about loading pa-
per, see "Loading Paper in the Op-
tional Paper Tray" in the Printer
Reference on the CD-ROM labeled
"Operating Instructions".
If the printing position is not cor-
rect, adjust the registration of the
trays. For more information about
adjusting the registration of the
trays, see "Adjusting the Registra-
tion of the Trays" in the Printer
Reference.
Download from Www.Somanuals.com. All Manuals Search And Download.
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Envelope Feeder Type 2600

Note
❒ This unit is a tray that slides into

the optional Paper Feed Unit.
Without the optional Paper Feed
Unit, this Envelope Feeder cannot
be used.

❒ Your printer can have two optional
Paper Feed Units. However, the
Envelope Feeder must be used in
the top-most optional Paper Feed
Unit (Tray 2). It cannot be used in
the bottom-most optional Paper
Feed Unit (Tray 3).

Important
❒ Do not slide more than one paper

tray out at the same time. Having
more than one paper tray filled
with paper in a fully extended po-
sition could cause the machine to
fall down.

AAAA Check the contents of the box for
the following items:
• Envelope Feeder

• Installation Guide

BBBB Pull out the second paper tray
(Tray 2) of the optional Paper
Feed Unit until it stops. After that,
lift it slightly, and then pull it out.

Important
❒ The Envelope Feeder must be

used in the top-most optional
Paper Feed Unit (Tray 2).

❒ The tray of the top-most option-
al Paper Feed Unit is beneath
the paper tray.

Note
❒ Keep the paper tray with paper

in a cool dark place.

CCCC While lifting the front side of the
Envelope Feeder, place the feeder
into the printer. Then slide it into
the printer until it stops.

Reference
For information about loading pa-
per, see "Loading Envelopes" in the
Printer Reference on the CD-ROM
labeled "Operating Instructions".

ZDDP330E

ZDDP340E
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Memory Unit TypeB 64MB

Important
❒ Before touching the Memory Unit,

touch something metal to dis-
charge any static electricity. Static
electricity can damage the Memo-
ry Unit.

AAAA Check the contents of the box for
the following items:

• Memory Unit
• Installation Guide

BBBB Confirm that the followings are
true:

• The power switch is turned off.

• The interface cable is un-
plugged from the printer.

Note
❒ If the Duplex Unit is not at-

tached, go to step D.

CCCC If the Duplex Unit is attached,
push down the lever on right side
(AAAA) and pull out the Duplex Unit
until it stops (BBBB).

DDDD Use a coin to remove the two
screws.

Note
❒ The removed screws are re-

quired in step K.

EEEE Pull out the handle of the control-
ler board.

FFFF Pull the handle and slide the con-
troller board out.

ZGDX320J

ZGDX280J

ZGDX370J

ZGDX260J
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GGGG Place the controller board on a flat
surface.

HHHH Insert the Memory unit to the slot
by placing the notch of the unit to
the projection of the slot, and
then push it down until it clicks.

IIII Match the controller board to the
top and bottom rail using the "TTTT"
mark, and then slide it into the
printer slowly until it stops.

JJJJ Push the handle of the controller
board until it clicks.

KKKK Fasten the controller board to the
printer with the two screws.

Note
❒ If the Duplex Unit is not at-

tached, go to step N.

LLLL While aligning the power cord to
the left side groove of the Duplex
Unit, slide the Duplex Unit in un-
til it is connected to the printer.

MMMM Attach the interface cable to the
printer.

ZGDX130J

ZGDX250J

ZGDX380J

ZGDX270J

ZGDX240J
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NNNN Plug the printer's power cord
back into the wall outlet, and then
turn on the power switch.

Important
❒ If you use a Windows operating

system, you should set up the
Memory Unit with the printer
driver to make the printer recog-
nize the installation. See the de-
scription of Windows 95/98/Me,
Windows 2000 and Windows NT
4.0 on p.51 “Installing the Printer
Driver and Software”.

Note
❒ After installing the last option that

you want, print the configuration
page to confirm the installation. If
the new device is listed in the col-
umn of configuration options, then
it has been properly installed. For
more information about printing
the configuration page, see "Print-
ing the Configuration Page" in the
Printer Reference on the CD-ROM
labeled "Operating Instructions".

❒ To remove the Memory Unit, press
the button on the end of the slot.
Download from Www.Somanuals.com. All Manuals Search And Download.
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Network Interface Board Type 2610

Note
❒ Depending on the model you use,

the Network Interface Board , the
1394 Interface  Unit ,  and the
802.11b Interface Unit cannot be
installed to the printer at the same
time. For more information, see
p.11 “Installing Options”.

Important
❒ Before touching the Network In-

terface Board, touch something
metal to discharge any static elec-
tricity. Static electricity can dam-
age the Network Interface Board.

❒ Use the shielded twisted-pair
(STP) network interface cable.

Installing the Network 
Interface Board

AAAA Check the contents of the box for
the following items:
• Network Interface Board

• Ferrite Core

• Installation Guide

BBBB Confirm that the followings are
true:
• The power switch is turned off.

• The interface cable is un-
plugged from the printer.

Note
❒ The interface cable is not includ-

ed in the box. Make sure that the
interface cable you use is appro-
priate for your computer.

❒ If the Duplex Unit is not at-
tached, go to step D.

CCCC If the Duplex Unit is attached,
push down the lever on right side
(AAAA) and pull out the Duplex Unit
until it stops (BBBB). 

DDDD Use a coin to remove the two
screws.

Note
❒ These screws are used again in

step M.

ZGDX320J

ZGDX281J
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EEEE Pull out the handle of the control-
ler board.

FFFF Pull the handle and slide the con-
troller board out.

GGGG Place the controller board on a flat
surface.

HHHH Use a coin to remove the two
screws, and then remove the cover.

Note
❒ These screws are used again in

step J.
❒ The removed cover is not used

when installing the Network In-
terface Board.

IIII Insert the end of the Network In-
terface Board into the opening
(AAAA), and then push down until it
clicks (BBBB).

JJJJ Fasten the Network Interface
Board to the controller board.

ZGDX370J

ZGDX261J

ZGDX410J

ZGDX422J

ZGDX432J

ZGDX441J
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KKKK Match the controller board to the
top and bottom rail using the "TTTT"
mark, and then slide it into the
printer slowly until it stops.

LLLL Push back the handle of the con-
troller board until it clicks.

MMMM Fasten the controller board to the
printer with the two screws.

Note
❒ If the Duplex Unit is not at-

tached, go to step O.

NNNN While aligning the power cord to
the left side groove of the Duplex
Unit, slide the Duplex Unit in un-
til it is connected to the printer. 

OOOO Plug the printer's power cord
back into the wall outlet, and then
turn on the power switch.

ZGDX253J

ZGDX380J

ZGDX271J

ZGDX241J
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Connecting the Network 
Interface Cable to the Network

AAAA Turn off the power switch.

BBBB Loop the network interface cable
and attach the ferrite core.

Note
❒ The network interface cable

loop should be about 15 cm (6")
(A) from the end of the cable
(on the end closet to the print-
er). The ferrite core at the end of
the cable should be a ring type
ferrite core.

CCCC Attach the network interface ca-
ble to the jack on the Network In-
terface Unit.

DDDD Connect the other end of the net-
work interface cable to the net-
work.

EEEE Turn on the power switch.

Note
❒ After installing the last option that

you want, print the configuration
page to confirm the installation. If
the information about network set-
tings (e.g. IP address) is listed in
the configuration page, then it has
been properly installed. For more
information about printing the
configuration page, see "Printing
the Configuration Page" in the
Printer Reference on the CD-ROM
labeled "Operating Instructions".

ZDDP320E

ZGDX291J
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1394 Interface Unit Type 4510

Note
❒ Depending on the model you use,

the 1394 Interface Unit, the Net-
work Interface Board, and the
802.11b Interface Unit cannot be
installed in the printer at the same
time. For more information, see
p.11 “Installing Options”.

Important
❒ Printing using "SCSI print "(Win-

dows 2000) device and "IEEE 1394
and SCSI printers" (Windows XP)
with the optional 1394 Interface
Unit is possible under Windows
2000 and Windows XP. Printing
with IP over 1394 is possible under
Windows XP.

❒ With Windows 2000, the 1394 In-
terface Unit can only be used with
Service Pack 1 or later. If the Serv-
ice Pack is not installed, the con-
nectable SCSI print device in a
1394 bus is only one, and the client
cannot install the printer driver
without using an account with Ad-
ministrators permission.

❒ Before touching the 1394 Interface
Unit, touch something metal to
discharge any static electricity.
Static electricity can damage the
1394 Interface Unit.

❒ Unplug all the interface cables
from the printer before installa-
tion. If you take out the controller
board with cables plugged in, the
1394 Interface Unit might be dam-
aged.

❒ Use the 1394 interface cable that
comes with this printer.

❒ Do not plug or unplug the 1394 in-
terface cable while installing the
printer driver.

Installing the 1394 Interface 
Unit

AAAA Check the contents of the box for
the following items:

• 1394 Interface Unit 

• 1394 Interface Cable (6 pins x 4
pins)

• 1394 Interface Cable (6 pins x 6
pins)

• Installation Guide

BBBB Confirm that the followings are
true:
• The power switch is turned off.

• The interface cable is un-
plugged from the printer.

Note
❒ If the Duplex Unit is not at-

tached, go to step D.

CCCC If the Duplex Unit is attached,
push down the lever on right side
(AAAA) and pull out the Duplex Unit
until it stops (BBBB). 

ZGDX320J
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DDDD Use a coin to remove the two
screws.

Note
❒ These screws are used again in

step M.

EEEE Pull out the handle of the control-
ler board.

FFFF Pull the handle and slide the con-
troller board out.

GGGG Place the controller board on a flat
surface.

HHHH Use a coin to remove the two
screws, and then remove the cov-
er.

Note
❒ These screws are used again in

step J.

IIII Attach the 1394 Interface Unit to
the controller board.

Insert the end of the 1394 Interface
Unit into the opening (A), and
then push down until it clicks (B).

ZGDX280J

ZGDX370J

ZGDX260J

ZGDX410J

ZGDX421J

ZGDX430J
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JJJJ Fasten the 1394 Interface Unit to
the controller board.

KKKK Match the controller board to the
top and bottom rail using the "TTTT"
mark, and then slide it into the
printer slowly until it stops.

LLLL Push back the handle of the con-
troller board until it clicks.

MMMM Fasten the controller board to the
printer with the two screws.

Note
❒ If the Duplex Unit is not at-

tached, go to step O.

NNNN While aligning the power cord to
the left side groove of the Duplex
Unit, slide the Duplex Unit in un-
til it is connected to the printer. 

OOOO Plug the printer's power cord
back into the wall outlet, and then
turn on the power switch.
You need to make settings with the
control panel before using the 1394
Interface Unit.

ZGDX443J

ZGDX252J

ZGDX380J

ZGDX272J

ZGDX242J
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Connecting the 1394 Interface 
Cable to the Printer

AAAA Attach the 1394 interface cable to
the jack on the 1394 Interface
Unit.

Both types of jack are available.

BBBB Connect the other end of the 1394
interface cable to the computer or
the other IEEE 1394 node.

Note
❒ After installing the last option that

you want, print the configuration
page to confirm the installation. If
the new device is listed in the col-
umn of configuration options, then
it has been properly installed. For
more information about printing
the configuration page, see "Print-
ing the Configuration Page" in the
Printer Reference on the CD-ROM
labeled "Operating Instructions".

----1394 Interface Unit 
specifications

❖❖❖❖ Interface Connector:
IEEE 1394 (6 pins × 2)

❖❖❖❖ Required cable:
1394 interface cable (6 pins x 4
pins, 6 pins x 6 pins)

Important
❒ You cannot plug devices togeth-

er to create loops.
❒ Do not use a cable more than 4.5

meters (14.8 feet) long.

❖❖❖❖ Connectable number of devices in a
bus:
Maximum 63

❖❖❖❖ Allowed cable hops in a bus:
Maximum 16

❖❖❖❖ Power supply:
Nonpower supply
Cable Power repeated ( IEEE
1394a-2000 compliant)

ZGDX550J
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802.11b Interface Unit Type A

Note
❒ Depending on the model you use,

the 802.11b Interface Unit, the 1394
Interface Unit, and the Network
Interface Board cannot be installed
to the printer at the same time. For
more information, see p.11 “In-
stalling Options”.

Important
❒ Before touching the 802.11b Inter-

face Unit, touch something metal
to discharge any static electricity.
Static electricity can damage the
802.11b Interface Unit.

AAAA Check the contents of the box for
the following items:

• 802.11b Interface Unit 

• Installation Guide

BBBB Confirm that the followings are
true:
• The power switch is turned off.

• The interface cable is un-
plugged from the printer.

Note
❒ If the Duplex Unit is not at-

tached, go to step D.

CCCC If the Duplex Unit is attached,
push down the lever on right side
(AAAA) and pull out the Duplex Unit
until it stops (BBBB). 

DDDD Use a coin to remove the two
screws.

Note
❒ These screws are used again in

step N.

EEEE Pull out the handle of the control-
ler board.

FFFF Pull the handle and slide the con-
troller board out.

ZGDX320J

ZGDX280J

ZGDX370J

ZGDX260J
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GGGG Place the controller board on a flat
surface.

HHHH Use a coin to remove the two
screws, and then remove the cov-
er.

Note
❒ These screws are used again in

step J.

IIII Attach the 802.11b Interface Unit.
Insert the end of the 802.11b Inter-
face Unit into the opening (A), and
then push down until it clicks (B).

JJJJ Fasten the 802.11b Interface Unit
to the controller board with the
two screws.

KKKK Insert the card slowly into the
802.11b board with the label fac-
ing down and the uneven black
antenna surface facing up until it
stops.

LLLL Match the controller board to the
top and bottom rail using the "TTTT"
mark, and then slide it into the
printer slowly until it stops.

ZGDX410J

ZGDX420J

ZGDX431J

ZGDX442J

ZGDX500J

ZGDX251J
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MMMM Push back the handle of the con-
troller board until it clicks.

NNNN Fasten the controller board to the
printer with the two screws.

Note
❒ If the Duplex Unit is not at-

tached, go to step P.

OOOO While aligning the power cord to
the left side groove of the Duplex
Unit, slide the Duplex Unit in un-
til it is connected to the printer. 

PPPP Plug the printer's power cord
back into the wall outlet, and then
turn on the power switch.
You need to make settings with the
control panel before using the
802.11b Interface Unit.

Note
❒ After installing the last option

that you want, print the config-
uration page to confirm the in-
stallation. If the new device is
listed in the column of configu-
ration options, then it has been
properly installed. For more in-
formation about printing the
configuration page, see "Print-
ing the Configuration Page" in the
Printer Reference on the CD-
ROM labeled "Operating In-
structions".

ZGDX380J

ZGDX273J

ZGDX243J
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Hard Disk Drive Type 2600

Important
❒ Before touching the Hard Disk

Drive, touch something metal to
discharge any static electricity.
Static electricity can damage the
Hard Disk Drive.

AAAA Check the contents of the box for
the following items:

• Hard Disk Drive
• Installation Guide

BBBB Confirm that the followings are
true:

• The power switch is turned off.

• The interface cable is un-
plugged from the printer.

CCCC Use a coin to remove the two
screws, and then remove the cov-
er.

Note
❒ The screws and cover are not

used when installing the Hard
Disk Drive.

DDDD Slowly insert the Hard Disk
Drive while aligning it with the
top and bottom rails in the printer
until it stops.

EEEE Fasten the Hard Disk Drive.

FFFF Attach the interface cable to the
printer.

GGGG Plug the printer's power cord
back into the wall outlet, and then
turn on the power switch.
The following message appears on
the panel display.

ZCEX350J

  HDD Error

  Initialize ?

ZCEX151J

ZCEX360J
Download from Www.Somanuals.com. All Manuals Search And Download.



Hard Disk Drive Type 2600

2

HHHH Press {{{{Enter #}}}} to format the Hard
Disk Drive.

Important
❒ Do not turn off the printer while

formatting the Hard Disk Drive.
Turning off the printer while
formatting the Hard Disk Drive
can damage the Hard Disk
Drive.

If you successfully format the
Hard Disk Drive, the following
message appears on the panel dis-
play.

IIII Press {{{{On Line}}}}.

“Ready” appears on the panel dis-
play.

Important
❒ If you use a Windows operating

system, you should set up the
Hard Disk Drive with the printer
driver to make the printer recog-
nize the installation. See a descrip-
t ion of  Windows 95/98/Me,
Windows 2000 and Windows NT
4.0 on p.51 “Installing the Printer
Driver and Software”.

Note
❒ After installing the last option that

you want, print the configuration
page to confirm the installation. If
the new device is listed in the col-
umn of configuration options, then
it has been properly installed. For
more information about printing
the configuration page, see "Print-
ing the Configuration Page" in the
Printer Reference on the CD-ROM
labeled "Operating Instructions".

  HDD Initialize

  Finish: OK

  Ready

    

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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AD410 (Duplex Unit)

Important
❒ If you attach the Duplex Unit and

the Paper Feed Unit, the Paper
Feed Unit must be attached prior
to attaching the Duplex Unit.

❒ Check the printer nameplate to
confirm the model code.

AAAA Check the contents of the box for
the following items:
• Duplex Unit

• Installation Guide

BBBB Confirm that the followings are
true:

• The power switch is turned off.

CCCC Remove the adhesive tapes.

DDDD Open the rear cover by pushing
the two knobs as shown in the il-
lustration.

EEEE Remove the rear cover in the hor-
izontal direction.

Note
❒ The rear cover of the printer is

not used when attaching the
Duplex Unit.

FFFF While aligning the power cord to
the left side groove of the Duplex
Unit, slide the Duplex Unit in un-
til it is connected to the printer.

ZCEX310J

ZGDX210J

ZGDX220J

ZGDX231E

ZGDX240J
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GGGG Attach the interface cable to the
printer.

HHHH Plug the printer's power cord
back into the wall outlet, and then
turn on the power switch.

Note
❒ After installing the last option that

you want, print the configuration
page to confirm the installation. If
the new device is listed in the col-
umn of configuration options, then
it has been properly installed. For
more information about printing
the configuration page, see "Print-
ing the Configuration Page" in the
Printer Reference on the CD-ROM
labeled "Operating Instructions".

❒ If the printing position is not cor-
rect, adjust the registration of the
trays. For more information about
adjusting the registration of the
trays, see "Adjusting the Registra-
tion of the Trays" in the Printer
Reference.
35
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1-bin Shift Sort Tray Type 2600

Important
❒ If you attach the 1-bin Shift Sort

Tray and the Paper Feed Unit, the
Paper Feed Unit must be attached
prior to attaching the 1-bin Shift
Sort Tray.

❒ The 1-bin Shift Sort Tray and the
Mailbox cannot be attached to the
printer at the same time.

❒ Check the printer nameplate to
confirm the model code.

AAAA Check the contents of the box for
the following items:

• 1-bin Shift Sort Tray

• Upper Tray
• Installation Guide

BBBB Confirm that the followings are
true:

• The power switch is turned off.

• The interface cable is un-
plugged from the printer.

CCCC Remove the adhesive tapes and
the packing material.

DDDD Remove the upper cover of the
printer.

Note
❒ The upper cover that is re-

moved, is not used when in-
stalling the 1-bin Shift Sort Tray.

EEEE Holding the 1-bin Shift Sort Tray
on both sides, align the catches
with the holes on the printer and
insert.

R CAUTION:

ZCEX300J

• When lifting the 1-bin Shift Sort 
Tray, hold it on both sides. Hold-
ing underneath the 1-bin Shift 
Sort Tray may cause injury to the 
hands if caught between the 1-
bin Shift Sort Tray and the print-
er.

ZGDH170J

ZGDX170J
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FFFF Slide the upper tray into the 1-bin
Shift Sort Tray.

GGGG Attach the interface cable to the
printer.

HHHH Plug the printer's power cord
back into the wall outlet, and then
turn on the power switch.

Note
❒ After installing the last option that

you want, print the configuration
page to confirm the installation. If
the new device is listed in the col-
umn of configuration options, then
it has been properly installed. For
more information about printing
the configuration page, see "Print-
ing the Configuration Page" in the
Printer Reference on the CD-ROM
labeled "Operating Instructions".

ZGDX180J
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CS380 (Mailbox)

Important
❒ If you attach the Mailbox and the

Paper Feed Unit, the Paper Feed
Unit must be attached prior to at-
taching the Mailbox.

❒ The Mailbox and the 1-bin Shift
Sort Tray cannot be attached to the
printer at the same time.

❒ Check the printer nameplate to
confirm the model code.

AAAA Check the contents of the box for
the following items:

• Mailbox
• Output Trays (4pcs)

• Output Tray Number Seal

• Installation Guide

BBBB Confirm that the followings are
true:

• The power switch is turned off.

CCCC Remove the adhesive tapes and
the packing materials.

DDDD Remove the upper cover of the
printer.

Note
❒ The upper cover that is re-

moved, is not used when attach-
ing the Mailbox.

EEEE Holding the Mailbox on both
sides, align the catches with the
holes on the printer and insert.

R CAUTION:

ZCEX451J

• When lifting Mailbox, hold it on 
both sides. Holding underneath 
the Mailbox may cause injury to 
the hands if the Mailbox and the 
printer.

ZGDH170J

ZGDX190J
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FFFF Slide the output tray into the low-
er side of the Mailbox first.

GGGG Slide the other output trays into
the Mailbox from the bottom.

HHHH Attach the interface cable to the
printer.

IIII Plug the printer's power cord
back into the wall outlet, and then
turn on the power switch.

Note
❒ After installing the last option that

you want, print the configuration
page to confirm the installation. If
the new device is listed in the col-
umn of configuration options, then
it has been properly installed. For
more information about printing
the configuration page, see "Print-
ing the Configuration Page" in the
Printer Reference on the CD-ROM
labeled "Operating Instructions".

ZGDX200J
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3. Configuring the Printer for
the Network
Make the network settings below depending on the network interface you use.
• Parallel/USB: Making network settings is not necessary. Go to p.51 “Install-

ing the Printer Driver and Software”.
• Ethernet: Make the settings in p.41 “Ethernet Configuration”, and then see

p.51 “Installing the Printer Driver and Software”.
• IEEE 1394: Make the settings in p.45 “IEEE 1394 Configuration”, and then see

p.51 “Installing the Printer Driver and Software”.
• Wireless LAN: Make the settings in p.48 “IEEE 802.11b (Wireless LAN) Con-

figuration”, and then see p.51 “Installing the Printer Driver and Software”.

Note
❒ The optional Network Interface Board is necessary to use Ethernet with Basic

model printer.
❒ The optional 1394 Interface Unit is necessary to use IEEE 1394.
❒ The optional 802.11b Interface Unit is necessary to use the wireless LAN.

Ethernet Configuration

Configure the printer for the network
using the printer's control panel.
The following table shows the control
panel settings and their default val-
ues. These items are included in the
”Host Interface” menu.

Reference
For information about configuring
the computer for the network, see
the Network Printing Guide on the
CD-ROM labeled “Operating In-
structions”.
For information about “Host Inter-
face” menu, see “Host Interface
Menu” in the Printer Reference on
the CD-ROM labeled “Operating
Instructions”. *1 ❍ means that this protocol is active.

*2 Make this setting only when it is nec-
essary.

*3 Appears only when both the Network
Interface Board and the 802.11b Inter-
face Unit are installed.

Setting Name Value

IP Address 011.022.033.044

Subnet Mask 000.000.000.000

Gateway Address 000.000.000.000

Network Boot None

Frame Type (NW)

(Frame type NetWare)
Auto

Active Protocol TCP/IP ❍ *1 

NetWare ❍ *1 

NetBEUI ❍ *1 

AppleTalk ❍ *1 

Ethernet *2 Auto

LAN Type *3 Ethernet
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AAAA Press {{{{Menu}}}}.

“Menu” appears on the panel dis-
play.

BBBB Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “Host
Interface” menu.

CCCC Press {{{{Enter #}}}}.

The following message appears on
the panel display.

DDDD Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “Net-
work Setup”.

EEEE Press {{{{Enter #}}}}.

The following message appears on
the panel display.

FFFF Select the protocol you want to
use.

Note
❒ Do not select protocols that are

not used on your network.
A Press {{{{UUUU}}}} or {{{{TTTT}}}} to display

“Active Protocol”.

B Press {{{{Enter #}}}}.

The current setting appears on
the panel display.

C Press {{{{Enter #}}}}.

D Press {{{{UUUU}}}} or {{{{TTTT}}}} to select "Ac-
tive" or "Not Active", and then
press {{{{Enter #}}}}.

E Set other protocols you need to
set in the same way.

Note
❒ Leave unused protocols "Not

Active".

  Menu:

   Host Interface

  Host Interface:

   I/O Buffer

  Host Interface:

   Network Setup

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
ZFDP020N

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
ZFDP060N

  Network Setup:

   IP Address

  Network Setup:

   Active Protocol

  Active Protocol:

   TCP/IP
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GGGG If you use TCP/IP, assign the IP
address to the printer.

Note
❒ To get the IP address for the

printer, contact your network
administrator.

A Press {{{{UUUU}}}} or {{{{TTTT}}}} until the fol-
lowing message appears.

B Press {{{{Enter #}}}}.

The current IP address appears
on the panel display.

C Press {{{{UUUU}}}} or {{{{TTTT}}}} to enter the
left most entry field of the IP
address.

D Press {{{{Enter #}}}}.

The pointer (k) moves to the
next entry field automatically.

Note
❒ The value moves by 10 if {{{{UUUU}}}}

or {{{{TTTT}}}} is kept pressed.
❒ You can return the pointer

(k) to the previous (left) entry
field by pressing {{{{Escape}}}}.

❒ If you press {{{{Escape}}}} when
the pointer (k) is on the left-
most position, the selected IP
address is reset.

E Repeat steps CCCC and DDDD to enter
the IP address.

Check if the pointer (k) is at the
rightmost position, and press
{{{{Enter #}}}} to register the IP ad-
dress you selected.

HHHH If you use TCP/IP, assign “Subnet
Mask” and “Gateway Address”
following the same procedure for
entering the IP address.

IIII If you use TCP/IP, you can make
settings for “Network Boot”. 

You can select how to assign the
printer's address using the compu-
ter. Select one of the items below if
necessary.
• None (Default)
• DHCP
A Press {{{{UUUU}}}} or {{{{TTTT}}}} to display

“Network Boot”.

B Press {{{{Enter #}}}}.

The current setting appears on
the panel display.

C Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the
method you want to use.

D Press {{{{Enter #}}}}.

  Network Setup:

   IP Address

  IP Address:

   011.022.033.044

  IP Address:

   192.022.033.044

  IP Address:

   192.02k.033.044

  IP Address:

   192.168.000.011

  Network Setup:

   IP Address

  Network Setup:

   Network Boot

  Network Boot:

  *None
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JJJJ If you use NetWare, select the
frame type for NetWare.

Select one of the items below if
necessary.
• Auto (Default)
• Ethernet 802.3
• Ethernet 802.2
• Ethernet II
• Ethernet SNAP

Note
❒ Usually, use the default setting

(“Auto”). When you first select
“Auto”, the frame type detected
by the printer is adopted. If
your network can use more
than two frame types, the print-
er may fail to select the correct
frame type if “Auto” is selected.
In this case, select the appropri-
ate frame type.

A Press {{{{UUUU}}}} or {{{{TTTT}}}} to display
“Frame Type (NW)”.

B Press {{{{Enter #}}}}.
The current setting appears on
the panel display.

C Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the
frame type you want to use.

D Press {{{{Enter #}}}}.

KKKK Select the interface.

Ethernet and IEEE 802.11b appear
only when both the Network Inter-
face Board and the 802.11b Inter-
face Unit are installed.
Select one of the items below.
• Ethernet
• IEEE 802.11b

A Press {{{{UUUU}}}} or {{{{TTTT}}}} to display
"LAN Type".

B Press {{{{Enter #}}}}.

The current setting appears on
the panel display.

C Press {{{{UUUU}}}} or {{{{TTTT}}}} to display
"Ethernet".

D Press {{{{Enter #}}}}.

LLLL Press {{{{On Line}}}}.

"Ready" appears on the panel dis-
play.

MMMM Print a configuration page to con-
firm the settings made.  See
"Printing a Configuration Page" in
the Printer Reference.

The settings are now complete. Go
to p.51 “Installing the Printer Driv-
er and Software”.

  Network Setup:

   Frame Type (NW)

  Frame Type (NW):

  *Auto

  Network Setup:

   LAN Type

  LAN Type:

  *Ethernet

  Ready

  

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
ZFDP010N
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IEEE 1394 Configuration

Use this procedure to configure the
printer for use in the IEEE 1394 envi-
ronment. The following table shows
the control panel settings and their
default values. These items are in-
cluded in the "Host Interface" menu.

Depending on the protocol you use,
procedures vary. See the following ta-
ble.

AAAA Press {{{{Menu}}}}.

“Menu” appears on the panel dis-
play.

BBBB Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “Host
Interface” menu.

CCCC Press {{{{Enter #}}}}.

The following message appears on
the panel display.

DDDD Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “IEEE
1394 Setup”.

EEEE Press {{{{Enter #}}}}.
The following message appears on
the panel display.

FFFF Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “IP
over 1394”.

A Press {{{{Enter #}}}}.
B Press {{{{UUUU}}}} or {{{{TTTT}}}} to select ei-

ther "Active" or "Not Active".
C Press {{{{Enter #}}}}.

The display returns to the previ-
ous menu in a few seconds.

Setting Name Value

IP Address1394 000.000.000.000

Subnet Mask1394 000.000.000.000

IP over 1394 Active

SCSI print Active

Bidi-SCSI print Active

IP over 1394 Steps A-H and then 
go to steps M to N

SCSI print Steps A-D and then 
go to steps I to N

  Menu:

   Host Interface

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
ZFDP020N

  Host Interface:

   I/O Buffer

  Host Interface:

   IEEE 1394 Setup

  IEEE 1394 Setup:

   IP Address1394

  IEEE 1394 Setup:

   IP over 1394

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
ZFDP060N
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GGGG Assign the IP address to the printer.

Do not overlap the IP address in
the same subnet or the same IP ad-
dress in the network setting.

Note
❒ To get the IP address for the

printer, contact your network
administrator.

A Press {{{{UUUU}}}} or {{{{TTTT}}}} until the fol-
lowing message appears.

B Press {{{{Enter #}}}}.

The current IP address appears
on the panel display.

C Press {{{{UUUU}}}} or {{{{TTTT}}}} to enter the
leftmost entry field of the IP
address.

D Press {{{{Enter #}}}}.

The pointer (k) moves to the
next entry field automatically.

Note
❒ The value moves by 10 if {{{{UUUU}}}}

or {{{{TTTT}}}} is kept pressed.
❒ You can return the pointer

(k) to the previous (left) entry
field by pressing {{{{Escape}}}}.

❒ If you press {{{{Escape}}}} when
the pointer (k) is on the left-
most position, the selected IP
address is reset.

E Repeat steps CCCC and DDDD to enter
the IP address.

Check if the pointer (k) is at the
rightmost position, and press
{{{{Enter #}}}} to register the IP ad-
dress you selected.

HHHH Set "Subnet Mask1394" in the
same way.

IIII Set "SCSI print" and "Bidi-SCSI
print" if necessary.

Note
❒ The default setting is "Active".

JJJJ Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "SCSI
print".

KKKK Press {{{{Enter #}}}}.

The following message appears on
the panel display.

LLLL Press {{{{UUUU}}}} or {{{{TTTT}}}} to select either
"Active" or "Not Active", and then
press {{{{Enter #}}}}.

Set " Bidi-SCSI print " in the same
way.

  IEEE 1394 Setup:

   IP Address1394

  IP Address1394:

   000.000.000.000

  IP Address1394:

   192.022.033.044

  IP Address1394:

   192.02k.033.044

  IP Address1394:

   192.168.000.011

  IEEE 1394 Setup:

   IP Address1394

  IEEE 1394 Setup:

   SCSI print

  SCSI print:

  *Active
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MMMM Press {{{{On Line}}}}.

“Ready” appears on the panel dis-
play.

NNNN Print a configuration page to con-
firm the sett ings made.  See
"Printing a Configuration Page"
in the Printer Reference.

The settings are now complete. Go
to p.51 “Installing the Printer Driv-
er and Software”.

  Ready
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IEEE 802.11b (Wireless LAN) Configuration

Configure the printer for using the
wireless LAN. The following table
shows the control panel settings and
their default values. These items are
included in the "Host Interface"
menu.

In order to use the wireless LAN, se-
lect "IEEE 802.11b" for "LAN Type" in
"Network Setup" of the Host Interface
menu, and then set "IP Address",
"Subnet Mask", "Gateway Address",
"Network Boot", "Frame Type (NW)"
and "Active Protocol" in the "Net-
work Setup". For more information
about setting the items in the "Net-
work Setup", see p.41 “Ethernet Con-
figuration”.

AAAA Press {{{{Menu}}}}.

“Menu” appears on the panel dis-
play.

BBBB Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “Host
Interface” menu.

CCCC Press {{{{Enter #}}}}.

The following message appears on
the panel display.

DDDD Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "IEEE
802.11b".

EEEE Press {{{{Enter #}}}}.

Be sure that "Comm. Mode" ap-
pears on the panel display.

Setting Name Value

Comm. Mode Ad hoc

Channel • Inch version
(1-11) 11

• Metric version
(1-13) 11

Trans. Speed Auto

WEP Settings Not Active

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
ZFDP020N

  Menu:

   Host Interface

  Host Interface:

   I/O Buffer

  Host Interface:

   IEEE 802.11b

  IEEE 802.11b:

   Comm. Mode

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
ZFDP060N
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FFFF Press {{{{Enter #}}}}.

The following message appears on
the panel display.

GGGG Press {{{{UUUU}}}} or {{{{TTTT}}}} to select the
transmission mode.

HHHH Press {{{{Enter #}}}}.

The display returns to the previous
menu in a few seconds.

IIII Set "Trans. Speed" and "WEP Set-
tings" in the same way.

For more information about WEP
Settings, see "Using the IEEE
802.11b (Wireless LAN)" in the
Network Printing Guide.

JJJJ If "Ad hoc" is selected for "Comm.
Mode", set the channel to use for
transmission.

Note
❒ Confirm the network adminis-

trator for the channel to use.
A Press {{{{UUUU}}}} or {{{{TTTT}}}} to display

"Channel".

B Press {{{{Enter #}}}}.

The channel currently used ap-
pears on the panel display.

C Press {{{{UUUU}}}} or {{{{TTTT}}}} to enter the
channel.

D Press {{{{Enter #}}}}.

KKKK Press {{{{On Line}}}}.

“Ready” appears on the panel dis-
play.

LLLL Print a configuration page to con-
firm the settings made.  See
"Printing a Configuration Page"
in the Printer Reference.

The settings are now complete. Go
to p.51 “Installing the Printer Driv-
er and Software”.

----Address

❖❖❖❖ Subnet Mask
A number used to mathematically
“mask” or hide an IP address on
the network by eliminating those
parts of the address that are alike
for all the machines on the net-
work.

❖❖❖❖ Gateway Address
A gateway is a connection or inter-
change point that connects two
networks. A gateway address is for
the router or host computer used
as a gateway.

Note
❒ To get the addresses, contact

your network administrator.

  Comm. Mode:

  *Ad hoc

  IEEE 802.11b:

   Channel

  Channel:

  (1-11)    11

  Ready
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4. Installing the Printer Driver
and Software
51
This manual assumes that you are familiar with general Windows procedures
and practices. If you are not, see the documentation that comes with Windows
for details.

Installation Method

The following table shows how to install the printer drivers and software.

*1 Available operating systems are as follows: Windows 95/98/Me, Windows 2000,
Windows XP, Windows NT 4.0

*2 Using custom installation, you can install various software separately.

Reference
When the printer is connected to the computer using USB, see p.66 “Installing
the Printer Driver Using USB”.
When the printer is connected to the computer using IEEE 1394, see p.68 “In-
stalling the Printer Driver Using IEEE 1394”.

Important
❒ Before starting this installation, close all documents and applications. In a net-

work environment, confirm that users who are logged on are disconnected.
Be sure to do this when it will create the least interference with other users.

❒ After installing a printer driver, you must restart the computer.

Note
❒ If the "plug and play" function starts, click [Cancel] in the [New Hardware Found],

[Device Driver Wizard] or [Found New Hardware Wizard] dialog box, and then insert
the CD-ROM. The [New Hardware Found], [Device Driver Wizard] or [Found New
Hardware Wizard] dialog box appears depending on the system version of Win-
dows 95/98/Me, or Windows 2000/Windows XP.

Auto Run *1 

Quick Install Custom 
installation *2 

Network conn
ection with TCP/IP 

Parallel 
connection

PCL 6 printer driver ❍ ❍ ❍

PCL 5e printer driver ❍

RPCS printer driver ❍ ❍ ❍

PostScript printer driver ❍

Agfa Monotype Font Manager 
2000

❍

SmartNetMonitor for Admin ❍

SmartNetMonitor for Client ❍ ❍
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Quick Install

Auto Run will start the installer automatically when you load the CD-ROM in
the CD-ROM drive. By selecting Quick Install, you can install the necessary soft-
ware easily.
TCP/IP requires the following: 
• This machine must be connected to the network through the network inter-

face cable.
• This machine must be turned on.
• The TCP/IP protocol must be configured.
• An IP address must be allocated to this machine and to the computer.

Limitation
❒ If your system is Windows 2000/Windows XP or Windows NT 4.0, installing

a printer driver by Auto Run requires Administrators permission. When you
install a printer driver by Auto Run, log on using an account that has Admin-
istrators permission.

❒ When the printer is connected to the computer using USB or IEEE 1394, Quick
Install cannot be used. See p.66 “Installing the Printer Driver Using USB” or
p.68 “Installing the Printer Driver Using IEEE 1394”.

Note
❒ Auto Run might not automatically work with certain OS settings. In this case,

launch "Setup.exe" located on the CD-ROM root directory.
If you want to cancel Auto Run, hold down the {{{{SHIFT}}}} key (when your system
is Windows 2000/Windows XP, hold down the left {{{{SHIFT}}}} key) while inserting
the CD-ROM. Keep the {{{{SHIFT}}}} key held down until the computer has finished
accessing the CD-ROM.

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish),
Deutsch (German), English (English), Espanol (Spanish), Francais (French),
Italiano (Italian), Magyar (Hungarian), Nederlands (Dutch), Norsk (Norwe-
gian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska
(Swedish)
Default interface language is English.

DDDD Select [Quick Install].
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EEEE The software license agreement appears in the [License Agreement] dialog
box.

After reading through all of the contents, click [I accept the agreement] to agree
with the license agreement, and then click [Next].

FFFF Click to select a model name you want to use when the "Select Printer" di-
alog box appears.

Note
❒ For a network connection with TCP/IP, select the printer whose IP address

is displayed in [Connect To].
❒ For parallel connection, select the printer whose printer port is displayed

in [Connect To].

GGGG Click [Install].

HHHH Follow the instructions on the screen.

Note
❒ During installation in Windows 2000, the [Digital Signature Not Found] dialog

box may appear. In this case, click [Yes] to continue the installation.
❒ During installation in Windows XP, the [Hardware Installation] dialog box

may appear. In this case, click [Continue Anyway] to continue the installa-
tion.

A message prompting you to restart your computer may appear. To complete
the installation, restart your computer.
53
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Installing the PCL 6/5e Printer Driver

Installing the PCL 6/5e Printer Driver

Two kinds of PCL printer drivers, PCL 6 and PCL 5e, are provided with this
printer. We recommend PCL 6 as your first choice.

Limitation
❒ If your system is Windows 2000/Windows XP or Windows NT 4.0, installing

a printer driver by Auto Run requires Administrators permission. When you
install a printer driver by Auto Run, log on using an account that has Admin-
istrators permission.

Important
❒ When updating the printer driver by installing the latest version, you should

uninstall that of former version if any. See “Uninstalling the Printer Driver and
Software” in the Printer Reference.

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

CCCC Select a language to change the interface language, and then click [OK].
The following languages are available: Cestina (Czech), Dansk (Danish),
Deutsch (German), English (English), Espanol (Spanish), Francais (French),
Italiano (Italian), Magyar (Hungarian), Nederlands (Dutch), Norsk (Norwe-
gian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska
(Swedish)
Default interface language is English.

DDDD Select [PCL/RPCS Printer Drivers].

EEEE The software license agreement appears in the [License Agreement] dialog
box.

After reading through all of the contents, click [I accept the agreement] to agree
with the license agreement, and then click [Next].

FFFF Select the printer driver you want to install when the "Select Program" di-
alog box appears.

GGGG Follow the instructions on the screen.

Note
❒ During installation in Windows 2000, the [Digital Signature Not Found] dialog

box may appear. In this case, click [Yes] to continue the installation.
❒ During installation in Windows XP, the [Hardware Installation] dialog box

may appear. In this case, click [Continue Anyway] to continue the installation.
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Setting Up Options

Important
❒ If the printer is equipped with certain options, you should set up the options

with the printer driver.

Limitation
❒ In Windows 2000/Windows XP, changing the printer settings requires Man-

age Printers permission. Members of the Administrators and Power Users
groups have Manage Printers permission by default. When you set up op-
tions, log on using an account that has Manage Printers permission.

❒ In Windows NT 4.0, changing the setting of the printer requires Full Control
permission. Members of the Administrators, Server Operators, Print Opera-
tors, and Power Users groups have Full Control permission by default. When
you set up options, log on using an account that has Full Control permission.

Note
❒ When setting up options, you should access the Printer Properties dialog box

from Windows. You cannot set up options by accessing the Printer Properties
dialog box from an application.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

Note
❒ With Windows XP, access the [Printers and Faxes] window from [Start] on

the taskbar.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties]. 
The Printer Properties appear.

DDDD Click the [Accessories] tab.

EEEE Select options you have installed from the [Options] group.

FFFF Click [OK] .
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Installing the RPCS Printer Driver

Installing the RPCS Printer Driver

Limitation
❒ If your system is Windows 2000/Windows XP or Windows NT 4.0, installing

a printer driver by Auto Run requires Administrators permission. When you
install a printer driver by Auto Run, log on using an account that has Admin-
istrators permission.

Important
❒ When updating the printer driver by installing the latest version, you should

uninstall that of former version if any. See “Uninstalling the Printer Driver and
Software” in the Printer Reference.

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

CCCC Select a language to change the interface language, and then click [OK].
The following languages are available: Cestina (Czech), Dansk (Danish),
Deutsch (German), English (English), Espanol (Spanish), Francais (French),
Italiano (Italian), Magyar (Hungarian), Nederlands (Dutch), Norsk (Norwe-
gian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska
(Swedish)
Default interface language is English.

DDDD Select [PCL/RPCS Printer Drivers].

EEEE The software license agreement appears in the [License Agreement] dialog
box.

After reading through all of the contents, click [I accept the agreement] to agree
with the license agreement, and then click [Next].

FFFF Select the RPCS printer driver when the "Select Program" dialog box ap-
pears.

GGGG Follow the instructions on the screen.

Note
❒ During installation in Windows 2000, the [Digital Signature Not Found] dialog

box may appear. In this case, click [Yes] to continue the installation.
❒ During installation in Windows XP, the [Hardware Installation] dialog box

may appear. In this case, click [Continue Anyway] to continue the installa-
tion.
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Setting Up Options

Important
❒ If the printer is equipped with certain options, you should set up the options

with the printer driver.

Limitation
❒ In Windows 2000/Windows XP, changing the printer settings requires Man-

age Printers permission. Members of the Administrators and Power Users
groups have Manage Printers permission by default. When you set up op-
tions, log on using an account that has Manage Printers permission.

❒ In Windows NT 4.0, changing the setting of the printer requires Full Control
permission. Members of the Administrators, Server Operators, Print Opera-
tors, and Power Users groups have Full Control permission by default. When
you set up options, log on using an account that has Full Control permission.

Note
❒ When setting up options, you should access the Printer Properties dialog box

from Windows. You cannot set up options by accessing the Printer Properties
dialog box from an application.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

Note
❒ With Windows XP, access the [Printers and Faxes] window from [Start] on

the taskbar.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties]. 
The Printer Properties appear.

DDDD Click the [Accessories] tab.

EEEE Select options you have installed from the [Options] group.

FFFF Click [OK] .
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Installing the PostScript Printer Driver

This section describes basic instructions for installing the PostScript printer driv-
er. The actual procedure may differ depending on the operating system. Follow
the appropriate procedures below.

Important
❒ When updating the printer driver by installing the latest version, you should

uninstall that of former version if any. See “Uninstalling the Printer Driver and
Software” in the Printer Reference.

Windows 95/98/Me - Installing the PostScript Printer Driver

Installing the printer driver

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish),
Deutsch (German), English (English), Espanol (Spanish), Francais (French),
Italiano (Italian), Magyar (Hungarian), Nederlands (Dutch), Norsk (Norwe-
gian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska
(Swedish) 
Default interface language is English.

Note
❒ The printer driver with the selected language will be installed.
❒ The printer driver will be installed in English if you select the following

languages: Cestina, Magyar, Polski, Portugues and Suomi.

DDDD Select [PostScript 3 Printer Driver].
[Add Printer Wizard] starts.

EEEE Click [Next].

FFFF Check [Local Printer] and then click [Next].
A dialog box for selecting the printer appears.

GGGG Select the printer you want to use, and then click [Next].

HHHH Follow the instructions on the screen.
Download from Www.Somanuals.com. All Manuals Search And Download.



Installing the PostScript Printer Driver

59

4

Setting up options

Important
❒ If the printer is equipped with certain options, you should set up the options

with the printer driver.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The Printer Properties appear.

DDDD Click the [Accessories] tab.

EEEE Select options you have installed from the [Options] group.

FFFF Click [OK].

Windows 2000/Windows XP - Installing the PostScript Printer Driver

Installing the printer driver

Limitation
❒ Installing a printer driver requires Administrators permission. When you install

a printer driver, log on using an account that has Administrators permission.

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deut-
sch (German), English (English), Espanol (Spanish), Francais (French), Italiano
(Italian), Magyar (Hungarian), Nederlands (Dutch), Norsk (Norwegian), Pol-
ski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska (Swedish) 
Default interface language is English.

Note
❒ The printer driver with the selected language will be installed.
❒ The printer driver will be installed in English if you select the following

languages: Cestina, Magyar, Polski, Portugues and Suomi.

DDDD Select [PostScript 3 Printer Driver].

[Add Printer Wizard] starts.
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EEEE Click [Next].

FFFF Check [Local Printer] and then click [Next].
A dialog box for selecting the printer port appears.

GGGG Select the check box of the port you want to use, and then click [Next].

A dialog box for selecting the printer appears.

HHHH Select the printer you want to use, and then click [Next].

IIII Follow the instructions on the screen.

Note
❒ During installation, the [Digital Signature Not Found] dialog box may appear.

In this case, click [Yes] to continue the installation.
❒ During installation in Windows XP, the [Hardware Installation] dialog box

may appear. In this case, click [Continue Anyway] to continue the installa-
tion.

Setting up options

Important
❒ If the printer is equipped with certain options, you should set up the options

with the printer driver.

Limitation
❒ Changing the printer settings requires Manage Printers permission. Members

of the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you set up options, log on using an account that has
Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

Note
❒ With Windows XP, access the [Printers and Faxes] window from [Start] on

the taskbar.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The Printer Properties appear.

DDDD Click the [Device Settings] tab.

EEEE Select options you have installed from the [Installable Options].

FFFF Click [OK].
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Windows NT 4.0 - Installing the PostScript Printer Driver

Installing the printer driver

Limitation
❒ Installing a printer driver requires Administrators permission. When you install

a printer driver, log on using an account that has Administrators permission.

Important
❒ The CD-ROM containing the Windows NT Server operating system version

4.0, or the Windows NT Workstation operating system is required for install-
ing the printer driver.

❒ We recommend that you upgrade the Windows NT 4.0 operating system to
Service Pack 4 or later before installing the printer driver. Contact your Win-
dows retailer for more information about the latest version available.

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deut-
sch (German), English (English), Espanol (Spanish), Francais (French), Italiano
(Italian), Magyar (Hungarian), Nederlands (Dutch), Norsk (Norwegian), Pol-
ski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska (Swedish) 
Default interface language is English.

Note
❒ The printer driver with the selected language will be installed.
❒ The printer driver will be installed in English if you select the following

languages: Cestina, Magyar, Polski, Portugues and Suomi.

DDDD Select [PostScript 3 Printer Driver].

[Add Printer Wizard] starts.

EEEE Click [Next].

FFFF After confirming that the [My Computer] option is selected, click [Next].

A dialog box for selecting the printer port appears.

GGGG Select the check box of the port you want to use, and then click [Next].

A dialog box for selecting the printer appears.

HHHH Select the printer you want to use, and then click [Next].

IIII Follow the instructions on the screen.
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Setting up options

Limitation
❒ Changing the printer settings requires Manage Printers permission. Members

of the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you set up options, log on using an account that has
Manage Printers permission.

Important
❒ If the printer is equipped with certain options, you should set up the options

with the printer driver.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The Printer Properties appear.

DDDD Click the [Device Settings] tab.

EEEE Select options you have installed from the [Installable Options] group.

FFFF Click [OK].

----Bidirectional transmission
When bidirectional transmission is enabled, information about the paper size
and feed direction settings is automatically sent to the machine by a computer.
You can also check the machine's status from your computer.
• Bidirectional transmissions are supported by Windows 95/98/Me, Windows

2000/Windows XP and Windows NT 4.0.
• When bidirectional transmission is running, the machine status and informa-

tion are obtained by opening the printer driver screen.
To support bidirectional transmission, the following conditions are required:

❖❖❖❖ When connecting with a parallel cable
• The computer must support bidirectional transmission.
• The printer must be set to bidirectional transmission.
• The Interface cable must support bidirectional transmission.
• The machine must be connected to the computer using the standard paral-

lel cable and parallel connector.
• Under Windows 95/98/Me, [Enable bidirectional support for this printer] must

be selected in [Spool Settings…] on the [Details] tab with RPCS printer driver.
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• Under Windows 2000/Windows XP and Windows NT 4.0, [Enable bidirec-
tional support] must be selected and [Enable printer pooling] must not be se-
lected on the [port] tab with RPCS printer driver.

❖❖❖❖ When connecting with the network
• The printer must be set to bidirectional transmission.
• SmartNetMonitor for Client included on the CD-ROM must be installed,

and the TCP/IP protocol must be used.
• Under Windows 95/98/Me, [Enable bidirectional support for this printer] must

be selected in [Spool Settings…] on the [Details] tab with RPCS printer driver.
• Under Windows 2000/Windows XP and Windows NT 4.0, [Enable bidirec-

tional support] must be selected and [Enable printer pooling] must not be se-
lected on the [port] tab with RPCS printer driver.

• Under Windows NT 4.0, specified IP address in the Microsoft TCP/IP
print is used.

❖❖❖❖ When connecting with IEEE 1394
• The printer must be connected to the IEEE 1394 connector of a computer

using the IEEE 1394 interface cable. 
• [Activate] is selected in the SCSI print of IEEE 1394 and [Activate] is selected

in the Bidi-SCSI print.
• Under Windows 2000/Windows XP and Windows NT 4.0, [Enable bidirec-

tional support] must be selected and [Enable printer pooling] must not be se-
lected on the [port] tab with RPCS printer driver.

❖❖❖❖ When connecting with USB
The printer must be connected to the USB connector of a computer using the
USB interface cable.

----Cautions when connecting the USB interface cable and the IEEE 
1394 interface cable

Limitation
❒ Do not unplug the cable while printing. Do not turn off the printer power

while printing or during bidirectional transmission.
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Macintosh - Installing the PostScript 3 Printer Driver

It is necessary to install a printer driver and a PPD file to print from a Macintosh.
Follow these steps to install a printer driver and a PPD file on Macintosh run-
ning the 8.6 operating system or later up to 9.1.

AAAA Insert the CD-ROM into the CD-ROM drive.

BBBB Double-click the CD-ROM icon.

CCCC Double-click the [PS DRIVER] folder.

DDDD Double-click the folder of the language you use.

EEEE Open [DISK1] and double-click the installer icon.

The PostScript 3 printer driver installer window appears.

FFFF Follow the instructions on the screen.

GGGG Double-click [Extensions] in [System Folder].

HHHH Double-click [Printer Descriptions].

IIII Double-click the CD-ROM icon on the desktop.

JJJJ Double-click [DISK1] in the folder of the language you use.

KKKK Drag the PPD file into [Printer Descriptions] in [Extensions] in [System Folder].

LLLL Drag the plugin file into [Printer Descriptions] in [Extensions] in [System Folder].

MMMM Restart the Macintosh.

Setting up the PPD file

Preparation
Make sure that the machine is connected to an AppleTalk network before per-
forming the following procedure.

AAAA On the [Apple] menu, select [Chooser].

BBBB Click the [Adobe PS] icon.

CCCC In the [Select a PostScript Printer:] list, click the name of the machine you want
to use.

DDDD Click [Setup].
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EEEE Click the printer description file you want to use, and then click [Select].

The PPD file is set up, and the [Adobe PS] icon appears at the left of the ma-
chine name in the list. Next, follow the procedure on p.65 “Setting up op-
tions” to make the option settings, or close the [Chooser] dialog box.

Setting up options

AAAA On the [Apple] menu, select [Chooser].

BBBB Click the [Adobe PS] icon.

CCCC In the [Select the PostScript Printer:] list, click the name of the machine you
want to use, and then click [Setup].

DDDD Click [Configure].

A list of options appears.

EEEE Select the option you want to set up and select the appropriate setting for it.

Note
❒ If the option you want to set up is not displayed, the PPD file might not be

set up correctly. Check the name of the PPD file shown in the dialog box.

FFFF Click [OK].
The list of options closes.

GGGG Click [OK].

The [Chooser] dialog box appears.

HHHH Close the [Chooser] dialog box.

Reference
For information about installing the Printer Utility for Mac, see the Post-
Script 3 Operating Instructions Supplement.
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Installing the Printer Driver Using USB

This section describes basic instructions for installing the printer drivers using
USB. The printer drivers can be installed from the provided CD-ROM.

Important
❒ Be sure that all other applications are closed and that the computer is not cur-

rently making prints before installation.

Windows 98/Me - Installing the Printer Driver Using USB

The procedure below takes Windows 98 as an example. The procedure for Win-
dows Me may be slightly different.
When the USB cable is used for the first time, the "plug and play" function starts
and [New Hardware Found], [Device Driver Wizard] or [Found New Hardware Wizard] di-
alog box appears depending on the system used.
If the printer driver is already installed, the "plug and play" is displayed, and the
printer with its port directed to the USB cable is added to the "Printers" folder.

AAAA Click [Next>].

BBBB Select [Search for the best driver for your device. {Recommended}.], and then click
[Next>].

CCCC Check [Specify a location:], and then click [Browse...].

The [Browse for Folder] dialog box appears.

DDDD Insert the CD-ROM provided into the CD-ROM drive.
When Auto Run starts, click [Exit].

Note
❒ If you want to inactivate Auto Run, press {{{{Shift}}}} when inserting the CD-

ROM into the drive and keep it pressed until the computer completes
transmission to the drive.

EEEE Select the drive where the printer driver is located according to the operat-
ing system used, and then click [Next>].

If  the CD-ROM drive is  D, the folder will  be "D:\Drivers\USB-
PRINT\WIN98ME".

FFFF Confirm the printer driver location, and then click [Next>].
"USB Printing Support" will be installed.

GGGG Click [Finish].

HHHH Follow the "plug and play" on the screen to install the printer drivers.
When the installation is complete, the printer with its port directed to "USB00n"
appears on the [Printers] folder. ("n" is the number of printers connected.")

Download from Www.Somanuals.com. All Manuals Search And Download.



Installing the Printer Driver Using USB

67

4

Windows 2000/Windows XP-Installing the Printer Driver Using 
USB

Limitation
❒ Installing a printer driver requires the Administrators permission. When you

install a printer driver, log on using an account that has the Administrators
permission.

When the USB cable is used for the first time, the [Found New Hardware Wizard] di-
alog box appears, and Windows 2000/Windows XP's [USB Printing Support] will
be installed automatically.
If the printer driver is already installed, the "plug and play" is displayed, and the
printer with its port directed to the USB cable is added to the "Printers" *1  folder.
With Windows XP, even if the printer driver has already been installed, [Found
New Hardware Wizard] may start when connecting the printer and the computer
with the USB cable for the first time. In this case, install the printer driver by fol-
lowing the procedure below.

AAAA Install the printer driver by referring to the instructions for installing the
printer driver with Parallel/Ethernet connection.
When installation is complete, the printer with its port directed to "USB00n"
appears on the [Printers] *1  folder. ("n" is the number of printers connected.")
*1 With Windows XP, the folder is [Printers and Faxes].

Macintosh-Creating a Desktop Printer icon

To use a printer connected by USB, create a Desktop Printer icon.

AAAA Install the printer driver. For more information about how to install the
printer driver, see p.58 “Installing the PostScript Printer Driver”.

BBBB Double-click [Desktop Printer Utility] in the [AdobePS Components] folder.

CCCC Select [AdobePS] in [With:] and [Printer (USB)] in [Create Desktop], and then
click [OK].

DDDD Click [Change] in [USB Printer Selection].

EEEE Select the model you are using in [Select a USB Printer:], and then click [OK].

FFFF Click [Auto Setup] in [PostScriptTM Printer Description (PPD) File].

GGGG Click [Create].

HHHH Enter the printer name, and then click [Save].
The printer icon appears on the desktop.

IIII Exit the Desktop Printer Utility.
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Installing the Printer Driver Using IEEE 1394

This section gives basic instructions for installing the printer drivers using IEEE
1394. The printer drivers can be installed from the CD-ROM provided.

Important
❒ Be sure that all other applications are closed and that the computer is not

printing before installation.

Printing with SCSI Print

Printing using a SCSI print device with the optional 1394 Interface Unit is possi-
ble under Windows 2000 and Windows XP.

Important
❒ Do not connect new IEEE 1394 or USB devices to the printer or turn on the

printer while installing the printer driver.
❒ Before uninstalling the printer driver, be sure to disconnect the 1394 interface

cable from the computer.
❒ “SCSI print” must be set active from the control panel. For more information,

see p.45 “IEEE 1394 Configuration”.

Note
❒ This machine cannot receive print data from more than one computer at the

same time. If you send data from your computer when data is being received
from another computer, a message may appear on the computer display.

Installing the Printer Driver

Note
❒ If [Found New Hardware Wizard] appears every time the computer is started or

the cable is connected with Windows 2000/Windows XP, inactivate the de-
vice. See p.71 “Inactivating the Device”. If you want to install another printer
driver after setting the "1394_00n" port, select the "1394_00n" port by follow-
ing the procedures of installing a printer driver.

❒ When the printer connected via the 1394 Interface Unit is installed properly,
the appearance of the icon in the printer folder changes according to whether
the cable is plugged in or not.
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Windows 2000

AAAA Connect the printer and the computer using the IEEE 1394 interface cable.

BBBB In the [Found New Hardware Wizard] dialog box, and then click [Next>].

CCCC When the [This wizard will complete the installation for this Device: Unknown] mes-
sage appears, select [Optional search locations:], and then click [Next>].

DDDD When the [Locate Driver Files] message appears, select the [Optional search loca-
tions.] check box, and then select [Specify a location], and then click [Next>].

EEEE Hold down the left {{{{SHIFT}}}} key and insert the CD-ROM into the CD-ROM
drive.

Keep the left {{{{SHIFT}}}} key held down until the computer has finished access-
ing the CD-ROM.
If the Auto Run program starts, click [Cancel], and then [Exit].

FFFF Click [Browse].

GGGG Select the printer driver that you want to use. The following are locations
where printer drivers are stored:

• RPCS
\DRIVERS\RPCS\WIN2000\DISK1

• PCL6
\DRIVERS\PCL6\WIN2000\DISK1

• PCL5e
\DRIVERS\PCL5e\WIN2000\DISK1

• PostScript 3
\DRIVERS\PS3\WIN2000\DISK1

HHHH Click [Open].

IIII Click [OK].

A printer model selection dialog box appears.

JJJJ Follow the instructions on the screen.

Note
❒ During installation, the [Digital Signature Not Found] dialog box may appear.

In this case, click [Yes] to continue the installation.
❒ If the printer driver is already installed, the printer icon is automatically

added to the [Printer] folder. In such a case, installation of the printer driver
is not necessary.

❒ When the installation is complete, the printer with its port directed to
"1394_00n" appears on the [Printers] folder. ("n" is the number of printers
connected.")
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Windows XP

AAAA Connect the printer and the computer using the IEEE 1394 interface cable.

BBBB In the [Found New Hardware Wizard] dialog box, confirm that [This wizard helps
you install software for: (printer name)] is displayed, and select [Install from a list
on specific location (Advanced)], and then click [Next>].

CCCC When the [Please choose your search and installation option.] messages appears,
select the [Search for the best driver in these locations.] check box, and then select
the [Include this location in the search:] check box, and then select the [Include
this location in the search:] check box.

DDDD Install the printer driver following the same procedures as steps EEEE-JJJJ in
Windows 2000.

Note
❒ During installation in Windows XP, the [Hardware Installation] dialog box

may appear. In this case, click [Continue Anyway] to continue the installa-
tion.

❒ When the installation is complete, the printer with its port directed to
"1394_00n" appears on the [Printers and Faxes] folder. ("n" is the number of
printers connected.")

❒ If the printer driver is already installed, the printer icon is automatically
added to the [Printer] folder. In this case, installation of the printer driver is
not necessary.

❒ Even if the printer driver has already been installed, [Found New Hardware
Wizard] may start when connecting the printer and the computer with the
IEEE 1394 interface cable for the first time. In this case, install the printer
driver by following the procedure.
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Printing with IP over 1394

You can print by setting the IP address for this machine and the computer on
which Windows XP is installed.

Preparation
"IP over 1394" must be set on the control panel and an IP address for the IEEE
1394 must be specified.
For more information about how to make printer settings, see p.45 “IEEE 1394
Configuration”.

Limitation
❒ When using the IEEE 1394 (IP over 1394) interface in a network, the Ethernet

interface cannot be used in the same network.

Note
❒ The maximum number of simultaneous print requests when connecting with

IP over 1394 includes the print requests from the Ethernet interface. For more
information, see the Network Printing Guide.

Installing the Printer Driver

To Print using Standard TCP/IP port. For more information about Standard
TCP/IP port settings, see Network Printing Guide.

----Inactivating the Device

❖❖❖❖ When [Add New Hardware Wizard] starts every time you restart the computer with
an operating system, which does not support SCSI print or plug in or out the cable,
inactivate the device by following procedures.
• Windows Me

A In the [Add New Hardware Wizard] dialog box, confirm that [Windows has
found the following new Hardware: IEEE SBP-2 Device] is displayed, and se-
lect [Recommended search for a better driver [Recommended]], and then click
[Next>].

B When the [Windows was unable to locate the software for this device.] mes-
sage appears, click [Finish].
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❖❖❖❖ If you do not want to install the printer when [Found New Hardware Wizard] starts
with an operating system, which supports SCSI print, inactivate the device by fol-
lowing the procedures.
• Windows XP

A In the [Found New Hardware Wizard] dialog box, confirm that [This wizard
helps you install software for: Unknown] is displayed, and select [Install from
a list on specific location (Advanced)], and then click [Next>].

B When the [Please choose your search and installation option.] message ap-
pears, remove all the selections from [Search for the best driver in these lo-
cations.], and then click [Next>].

C When the [The wizard could not find the software on your computer for..] mes-
sage appears, click [OK].

D When the [Cannot Install this Hardware] message appears, select the [Don't
prompt again to install the software] check box, and then click [Finish].

• Windows 2000
A In [Found New Hardware Wizard] dialog box, and then click [Next>].
B When the [This wizard will complete the installation for this Device: Unknown]

message appears, and select [Search for a suitable driver for my device [rec-
ommended]], and then click [Next>].

C When the [Locate Driver Files] message appears, remove all the selections
from [Optional search locations.], and then click [Next>].

D When the [Driver Files Search Results] message appears, select the [Disable
the device. The Add/Remove Hardware Wizard in the control Panel can be able to
complete the driver installations.] check box, and then click [Finish].

❖❖❖❖ When [Found New Hardware Wizard] appears every time you restart the computer
with an operating system which does not support IP over 1394, plug in or take out
the cable, inactivate the device with the following procedure.
• Windows 2000

A In [Found New Hardware Wizard] dialog box, and then click [Next>].
B When the [This wizard will complete the installation for this Device:] message

appears and "IP over 1394" appears select [Search for a suitable driver for
my device [recommended]], and then click [Next>].

C When the [Locate Driver Files] message appears, remove all the selections
from [Optional search locations.], and then click [Next>].

D When the [Driver Files Search Results] message appears, select the [Disable
the device. The Add/Remove Hardware Wizard in the control Panel can be able to
complete the driver installations.] check box, and then click [Finish].
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Installing the SmartNetMonitor for 
Client/Admin

Limitation
❒ If your system is Windows 2000/Windows XP or Windows NT 4.0, installing

software by Auto Run requires Administrators permission. When you install
a printer driver by Auto Run, log on using an account that has Administrators
permission.

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

CCCC Select a language to change the interface language, and then click [OK].
The following languages are available: Cestina (Czech), Dansk (Danish),
Deutsch (German), English (English), Espanol (Spanish), Francais (French),
Italiano (Italian), Magyar (Hungarian), Nederlands (Dutch), Norsk (Norwe-
gian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska
(Swedish)
Default interface language is English.

DDDD Select [SmartNetMonitor for Client/Admin].

EEEE The software license agreement appears in the [License Agreement] dialog
box.

After reading through all of the contents, click [I accept the agreement] to agree
with the license agreement, and then click [Next].

FFFF Select the program you want to install when the "Select Program" dialog
box appears.

GGGG Follow the instructions on the screen.
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Installing the Agfa Monotype Font 
Manager 2000

Limitation
❒ If your system is Windows 2000/Windows XP or Windows NT 4.0, installing

software by Auto Run requires Administrators permission. When you install
a printer driver by Auto Run, log on using an account that has Administrators
permission.

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

CCCC Select a language to change the interface language, and then click [OK].
The following languages are available: Cestina (Czech), Dansk (Danish),
Deutsch (German), English (English), Espanol (Spanish), Francais (French),
Italiano (Italian), Magyar (Hungarian), Nederlands (Dutch), Norsk (Norwe-
gian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska
(Swedish)
Default interface language is English.

DDDD Select [Agfa Monotype Font Manager 2000].

EEEE Follow the instructions on the screen.
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4

Using Adobe PageMaker Version 6.0 or 6.5

If you use the printer under Windows 95/98/Me, Windows 2000/Windows XP,
Windows NT 4.0 with Adobe PageMaker, you need to copy the PPD file to the
PageMaker folder. 
The PPD file is the file with extension ".ppd". It is in the folder "DRIV-
ERS\PS\WIN9X_ME\(Language)\DISK1\" on the CD-ROM. 
The [WIN9X_ME] folder, inside the [PS] folder is for the Windows 95/98/Me op-
erating system. Use the folder at this level that is appropriate for the operating
system you are using.
The third folder, "(Language)" may be substituted by an appropriate language
name. 
Copy this file to the PageMaker folder.
For PageMaker 6.0 default installation, the folder is "C:\PM6\RSRC\PPD4",
a n d  f o r  P a g e M ak er  6 . 5  d e f a u l t  i ns t a l l a t i o n ,  t he  d i re c t o r y  i s
"C:\PM65\RSRC\USENGLISH\PPD4". "USENGLISH" may differ depending
on your language selection.

Reference
For more information about the language name, see p.52 “Quick Install”.
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Notes to users in the United States of America

Notice:
This equipment has been tested and found to comply with the limits for a Class B digital device, pursu-
ant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equip-
ment does cause harmful interference to radio or television reception, which can be determined by turn-
ing the equipment off and on, the user is encouraged to try to correct the interference by one more of
the following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.
Consult the dealer or an experienced radio/TV technician for help.

Warning
Changes or modifications not expressly approved by the party responsible for compliance could void
the user's authority to operate the equipment.

Caution (in case of 100BaseTX environment):
Properly shielded cables must be used for connections to host computer (and/or peripheral) in order to
meet FCC emission limits.
Network interface cable with ferrite core must be used for RF interference suppression.

Declaration of Conformity
Product Name: Laser Printer
Model Number: RICOH LASER AP2610/RICOH LASER AP2610N
Responsible party: Ricoh Corporation
Address: 5 Dedrick Place, West Caldwell, NJ 07006
Telephone number: 973-882-2000
This device complies with part 15 of FCC Rules.
Operation is subject to the following two conditions:
1. This device may not cause harmful interference, and
2. this device must accept any interference received,
including interference that may cause undesired operation.

Properly shielded cables must be used for connections to host computer (and/or peripheral)
in order to meet FCC emission limits.
Network interface cable with ferrite core must be used for RF interference suppression.

Note to users in Canada

Note:
This Class B digital apparatus complies with Canadian ICES-003.

802.11b Interface Unit TypeA(R-WL11):
This device complies with RSS 210 of Industry Canada.
To prevent radio interference to the licensed service, this device must be operated indoors only and
should be kept away from windows to provide maximum shielding.

Remarque concernant les utilisateurs au Canada

Avertissement:
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.

802.11b Interface Unit TypeA(R-WL11):
Pour empêcher que cet appareil cause du brouillage au service faisant l'objet d'une licence, il doit être
utilisé à l'intérieur et devrait être placé loin des fenêtres afin de fournir un écran de blindage maximal.
Si le matériel (ou son antenne d'émission) est installé à l'extérieur, il doit faire l'objet d'une licence.

In accordance with IEC 60417, this machine uses the following symbols for the main power switch: 
aaaa means POWER ON.
bbbb means POWER OFF.
Copyright © 2001

Download from Www.Somanuals.com. All Manuals Search And Download.



UE USA G074-8637
Download from Www.Somanuals.com. All Manuals Search And Download.



Operating Instructions

Printer Reference

For safety, please read this manual carefully before you use this product and keep it
handy for future reference.
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Introduction

This manual contains detailed instructions on the operation and maintenance of this machine. To get
maximum versatility from this machine all operators should carefully read and follow the instructions in
this manual. Please keep this manual in a handy place near the machine.

Please read “Safety Information” in this manual before using this machine. It contains important infor-
mation related to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Caution:

Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Do not attempt any maintenance or troubleshooting other than that mentioned in this manual. This
printer contains a laser beam generator and direct exposure to laser beams can cause permanent eye
damage.

Two kinds of size notation are employed in this manual. With this machine refer to the inch version.

For good print quality, the supplier recommends that you use genuine toner from the supplier.

The supplier shall not be responsible for any damage or expense that might result from the use of parts
other than genuine parts from the supplier with your office products. 
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Trademarks

Microsoft, Windows and Windows NT are registered trademarks of Microsoft
Corporation in the United States and/or other countries.
Novell, Netware, NDS are registered trademarks or Novell, Inc.
PostScript is a registered trademark of Adobe Systems, Incorporated.
PCL is a registered trademark of Hewlett-Packard Company.
AppleTalk, Apple, Macintosh, TrueType and LaserWriter are registered trade-
marks of Apple Computer, Incorporated.
IPS-PRINT Printer Language Emulation Copyright© 1999-2000 Oak Technolo-
gy, Inc., All rights reserved.
Ethernet is a registered trademark of Xerox Corporation.
Other product names used herein are for identification purposes only and might
be trademarks of their respective companies. We disclaim any and all rights in
those marks.
• The product name of Windows® 95 is Microsoft® Windows® 95.
• The product name of Windows® 98 is Microsoft® Windows® 98.
• The product name of Windows® Me is Microsoft® Windows® Millennium

Edition (Windows Me).
• The product names of Windows® 2000 are as follows:

Microsoft® Windows® 2000 Advanced Server
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional

• The product names of Windows® XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition

• The product names of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Server 4.0
Microsoft® Windows NT® Workstation 4.0

Notes:

Some illustrations in this manual might be slightly different from the machine.
Certain options might not be available in some countries. For details, please con-
tact your local dealer.
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Manuals for This Printer

Manuals for This Printer

The following manuals describe the operational procedures and maintenance of
this machine.
To enhance safe and efficient operation of this printer, all users should read and
follow the instructions carefully.

❖❖❖❖ Quick Installation Guide
Describes how to install the printer.

❖❖❖❖ Setup Guide 
Provides information about setting up the printer and its options. This man-
ual is provided as a printed manual, and also on the CD-ROM labeled "Oper-
ating Instructions".

❖❖❖❖ Printer Reference (this manual)
Provides information about using the printer and its options. This manual
provided on the CD-ROM labeled “Operating Instructions”.

❖❖❖❖ Network Printing Guide
Provides information about setting up and using the printer in a network en-
vironment. This manual provided on the CD-ROM labeled “Operating In-
structions”.

❖❖❖❖ PostScript 3 Operating Instructions Supplement
Describes the menus and features for the PostScript 3 printer driver. This
manual provided on the CD-ROM labeled “Operating Instructions”.

Note
❒ There are three CD-ROMs that come with this printer. “Operating Instruc-

tions”, “Printer Drivers and Utilities”, and “Document Management Utility”.
❒ Concerning UNIX information, please visit our Web site or consult your au-

thorized reseller.
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How to Read This Manual

Symbols

In this manual, the following symbols are used:

R WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

R CAUTION:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.
* The statements above are notes for your safety.

Important
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates the prior knowledge or preparations required before op-
erating.

Note
This symbol indicates precautions for operation, or actions to take after misop-
eration.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

[ ]
Keys that appear on the machine's panel display.
Keys and buttons that appear on the computer's display.

{ }

Keys built into the machine's control panel.
Keys on the computer's keyboard.
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1. Setting Up the Printer Driver
and Canceling a Print Job

PCL 6/5e - Accessing the Printer Properties

Windows 95/98/Me - Accessing the Printer Properties

Changing the default printer settings

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer whose default settings you want to
change.

CCCC On the [File] menu, click [Properties].

The Printer Properties appear.

DDDD Make any settings you require and click [Apply].

Note
❒ With some applications, the printer driver's settings are not used, and the

application's own default settings are applied.

EEEE Click [OK].

Making printer settings from an application

To make the printer settings for a specific application, open the [Printer Properties]
dialog box from that application. The following example describes how to make
settings for the WordPad application that comes with Windows 95/98/Me.

Note
❒ The actual procedure you should follow to open the [Printer Properties] dialog

box may differ depending on the application. For more information, see the
documentation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

AAAA On the [File] menu, click [Print].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Name] list box, and then click [Prop-
erties].

The [Printer Properties] dialog box appears.
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CCCC Make any settings you require and click [OK].

DDDD Click [OK] to start printing.

Windows 2000/Windows XP - Accessing the Printer Properties

Changing the default printer settings - Printer Properties

Limitation
❒ Changing the setting of the printer requires Manage Printers permission.

Members of the Administrators and Power Users groups have Manage Print-
ers permission by default. When you set up options, log on using an account
that has Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

Note
❒ With Windows XP, access the [Printers and Faxes] window from [Start] on

the taskbar.

BBBB Click to select the icon of the printer whose default setting you want to
change.

CCCC On the [File] menu, click [Properties].

The Printer Properties appear.

DDDD Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

EEEE Click [OK].

Changing the default printer settings – Printing Preferences Properties

Limitation
❒ Changing the setting of the printer requires Manage Printers permission.

Members of the Administrators and Power Users groups have Manage Print-
ers permission by default. When you set up options, log on using an account
that has Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.
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BBBB Click to select the icon of the printer whose default settings you want to
change.

CCCC On the [File] menu, click [Printing Preferences...].

The Printing Preferences Properties appears.

DDDD Make any settings you require and click [Apply].

Note
❒ Settings you make here are used as the default settings for all applications.

EEEE Click [OK].

Making printer settings from an application

To make the printer settings for a specific application, open the [Print] dialog box
from that application. The following example describes how to make settings for
the WordPad application that comes with Windows 2000/Windows XP.

Note
❒ The actual procedures you should follow to open the [Print] dialog box may

differ depending on the application. For more information, see the documen-
tation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

AAAA On the [File] menu, click [Print...].
The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Select Printer] box.

Click the tab that you want to change its print setting.

Note
❒ With Windows XP, click [Preference] to open the Printer Preference win-

dow.

CCCC Make any settings you require and click [Apply].

Note
❒ With Windows XP, make any settings you require and click [OK].

DDDD Click [Print] to start printing.
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Windows NT 4.0 - Accessing the Printer Properties

Changing the default printer settings - Printer Properties

Limitation
❒ Changing the setting of the printer requires Full Control access permission.

Members of Administrators, Server Operators, Print Operators, and Power
Users groups have Full Control permission by default. When you set up op-
tions, log on using an account that has Full Control permission. 

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer whose default settings you want to
change.

CCCC On the [File] menu, click [Properties].

The Printer Properties appears.

DDDD Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Changing the default printer settings – Default Document Properties

Limitation
❒ Changing the setting of the printer requires Full Control access permission.

Members of the Administrators, Server Operators, Print Operators, and Pow-
er Users groups have Full Control permission by default. When you set up
options, log on using an account that has Full Control permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer whose default settings you want to
change.

CCCC On the [File] menu, click [Document Defaults].
The Default Document Properties appear.

DDDD Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
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Making printer settings from an application

To make the printer settings for a specific application, open the [Printer Properties]
dialog box from that application. The following example describes how to make
settings for the WordPad application that comes with Windows NT 4.0.

Note
❒ The actual procedure you should follow to open the [Printer Properties] dialog

box may differ depending on the application. For more information, see the
documentation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

AAAA On the [File] menu, click [Print].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Name] list box, and then click [Prop-
erties].
The Printer Properties appears.

CCCC Make any settings you require and click [OK].

Click [OK] to start printing.
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RPCS - Accessing the Printer Properties

Windows 95/98/Me - Accessing the Printer Properties

Changing the default printer settings

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer whose default settings you want to
change.

CCCC On the [File] menu, click [Properties].
The printer properties appear.

DDDD Make any settings you require and click [Apply].

Note
❒ With some applications, the printer driver's settings are not used, and the

application's own default settings are applied.

EEEE Click [OK].

Making printer settings from an application

To make the printer settings for a specific application, open the [Printer Properties]
dialog box from that application. The following example describes how to make
settings for the WordPad application that comes with Windows 95/98/Me.

Note
❒ The actual procedure you should follow to open the [Printer Properties] dialog

box may differ depending on the application. For more information, see the
documentation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

AAAA On the [File] menu, click [Print].
The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Name] list box, and then click [Prop-
erties].

The [Printer Properties] dialog box appears.

CCCC Make any settings you require and click [OK].

DDDD Click [OK] to start printing.
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Windows 2000/Windows XP - Accessing the Printer Properties

Changing the default printer settings - Printer Properties

Limitation
❒ Changing the setting of the printer requires Manage Printers permission.

Members of the Administrators and Power Users groups have Manage Print-
ers permission by default. When you set up options, log on using an account
that has Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

Note
❒ With Windows XP, access the [Printers and Faxes] window from [Start] on

the taskbar.

BBBB Click to select the icon of the printer whose default settings you want to
change.

CCCC On the [File] menu, click [Properties].
The Printer Properties appears.

DDDD Make any settings you require and click [Apply].

Note
❒ Settings you make here are used as the default settings for all applications.

EEEE Click [OK].

Changing the default printer settings – Printing Preferences Properties

Limitation
❒ Changing the setting of the printer requires Manage Printers permission.

Members of the Administrators and Power Users groups have Manage Print-
ers permission by default. When you set up options, log on using an account
that has Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer whose default settings you want to
change.

CCCC On the [File] menu, click [Printing Preferences...].
The Printing Preferences Properties appear.

Download from Www.Somanuals.com. All Manuals Search And Download.



Setting Up the Printer Driver and Canceling a Print Job

8

1

DDDD Make any settings you require and click [Apply].

Note
❒ Settings you make here are used as the default settings for all applications.

EEEE Click [OK].

Making printer settings from an application

To make the printer settings for a specific application, open the [Print] dialog box
from that application. The following example describes how to make settings for
the WordPad application that comes with Windows 2000.

Note
❒ The actual procedures you should follow to open the [Print] dialog box may

differ depending on the application. For more information, see the documen-
tation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

AAAA On the [File] menu, click [Print...].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Select Printer] box.
Click the tab that you want to change its print setting.

Note
❒ With Windows XP, click [Preference] to open the Printer Preference win-

dow.

CCCC Make any settings you require and click [Apply].

Note
❒ With Windows XP, make any settings you require and click [OK].

DDDD Click [Print] to start printing.
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Windows NT 4.0 - Accessing the Printer Properties

Changing the default printer settings - Printer Properties

Limitation
❒ Changing the setting of the printer requires Full Control access permission.

Members of Administrators, Server Operators, Print Operators, and Power
Users groups have Full Control permission by default. When you set up op-
tions, log on using an account that has Full Control permission. 

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

DDDD Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Changing the default printer settings – Default Document Properties

Limitation
❒ Changing the setting of the printer requires Full Control access permission.

Members of the Administrators, Server Operators, Print Operators, and Pow-
er Users groups have Full Control permission by default. When you set up
options, log on using an account that has Full Control permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Document Defaults].

The Default Document Properties appear.

DDDD Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
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Making printer settings from an application

To make the printer settings for a specific application, open the [Printer Properties]
dialog box from that application. The following example describes how to make
settings for the WordPad application that comes with Windows NT 4.0.

Note
❒ The actual procedure you should follow to open the [Printer Properties] dialog

box may differ depending on the application. For more information, see the
documentation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

AAAA On the [File] menu, click [Print].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Name] list box, and then click [Prop-
erties].
The [Printer Properties] dialog box appears.

CCCC Make any settings you require and click [OK].

DDDD Click [OK] to start printing.
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PostScript - Setting Up for Printing

Windows 95/98/Me - Accessing the Printer Properties

Changing the default printer settings

Note
❒ With some applications, the printer driver's settings are not used, and the ap-

plication's own default settings are applied.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

BBBB Click to select the icon of the printer whose default settings you want to
change.

CCCC On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

DDDD Make any settings you require and click [Apply].

EEEE Click [OK].

Making printer settings from an application

To make the printer settings for a specific application, open the [Printer Properties]
dialog box from that application. The following example describes how to make
settings for the WordPad application that comes with Windows 95/98/Me.

Note
❒ The actual procedure you should follow to open the [Printer Properties] dialog

box may differ depending on the application. For more information, see the
documentation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

AAAA On the [File] menu, click [Print].
The [Print] dialog box appears.

BBBB Select the printer you want to use in the Name list box, and then click [Prop-
erties].

The [Printer Properties] dialog box appears.

CCCC Make any settings you require and click [Apply].

DDDD Click [OK] to start printing.
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Windows 2000/Windows XP - Accessing the Printer Properties

Changing the default printer settings - Printer Properties

Limitation
❒ Changing the setting of the printer requires Manage Printers permission.

Members of the Administrators and Power Users groups have Manage Print-
ers permission by default. When you set up options, log on using an account
that has Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

Note
❒ With Windows XP, access the [Printers and Faxes] window from [Start] on

the taskbar.

BBBB Click to select the icon of the printer whose default settings you want to
change.

CCCC On the [File] menu, click [Properties].
The Printer Properties appear.

DDDD Make any settings you require and click [Apply].

Note
❒ Settings you make here are used as the default settings for all applications.

EEEE Click [OK].

Changing the default printer settings – Printing Preferences Properties

Limitation
❒ Changing the setting of the printer requires Manage Printers permission.

Members of the Administrators and Power Users groups have Manage Print-
ers permission by default. When you set up options, log on using an account
that has Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer whose default settings you want to
change.

CCCC On the [File] menu, click [Printing Preferences...].
The Printing Preferences Properties appears.
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DDDD Make any settings you require and click [Apply].

Note
❒ Settings you make here are used as the default settings for all applications.

EEEE Click [OK].

Making printer settings from an application

To make the printer settings for a specific application, open the [Print] dialog box
from that application. The following example describes how to make settings for
the WordPad application that comes with Windows 2000/Windows XP.

Note
❒ The actual procedures you should follow to open the [Print] dialog box may

differ depending on the application. For more information, see the documen-
tation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

AAAA On the [File] menu, click [Print...].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Select Printer] box.
Click the tab that you want to change its print setting.

Note
❒ With Windows XP, click [Preference] to open the Printer Preference win-

dow.

CCCC Make any settings you require and click [Apply].

DDDD Click [OK] to start printing.
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Windows NT 4.0 - Accessing the Printer Properties

Changing the default printer settings - Printer Properties

Limitation
❒ Changing the setting of the printer requires Full Control access permission.

Members of Administrators, Server Operators, Print Operators, and Power
Users groups have Full Control permission by default. When you set up op-
tions, log on using an account that has Full Control permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears .

BBBB Click to select the icon of the printer whose default settings you want to
change.

CCCC On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

DDDD Make any settings you require and click [OK].

Note
❒ Setting you make here are used as the default settings for all applications.

Changing the default printer settings - Default Document Properties

Limitation
❒ Changing the setting of the printer requires Full Control access permission.

Members of the Administrators, Server Operators, Print Operators, and Pow-
er Users groups have Full Control permission by default. When you set up
options, log on using an account that has Full Control permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Document Defaults].

The Default Document Properties appear.

DDDD Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
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Making printer settings from an application

To make the printer settings for a specific application, open the [Printer Properties]
dialog box from that application. The following example describes how to make
settings for the WordPad application that comes with Windows NT 4.0.

Note
❒ The actual procedure you should follow to open the [Printer Properties] dialog

box may differ depending on the application. For more information, see the
documentation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

AAAA On the [File] menu, click [Print].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Name] list box, and then click [Prop-
erties].
The [Printer Properties] dialog box appears.

CCCC Make any settings you require and click [OK].

DDDD Click [OK] to start printing.
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Macintosh - Setting Up for Printing

Making paper settings from an application

AAAA Open the file you want to print.

BBBB On the [File] menu, click [Page Setup].
The [AdobePS Page Setup] dialog box appears.

CCCC Confirm that the printer you want to use is shown in the [Format for:] box.

Note
❒ If the printer is not shown in the [Format for:] box, use the pop-up menu to

display a list of available printers.

Reference
The actual appearance of the Page Setup depends on the application you
are using. See the documentation that comes with the Macintosh for more
information.

DDDD From the [Paper:] box, select the paper size.

EEEE Make any settings you require and then click [OK].

Setting up for printing from an application

AAAA Open the file you want to print.

BBBB On the [File] menu, click [Print].

The Printer Settings appears.

CCCC Confirm that the printer is selected in the [Printer :] box.

DDDD Make any settings you require and click [Print] to start printing.
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Canceling a Print Job

Windows 95/98/Me, Windows 2000, Windows XP, Windows NT 4.0 
- Canceling a Print Job 

AAAA Double-click the printer icon on the Windows taskbar.

A window appears, showing all the print jobs that are currently queuing to
be printed. Check the current status of the job you want to cancel.

BBBB Select the name of the job you want to cancel.

CCCC On the [Document] menu, click [Cancel Printing]. 

Note
❒ You can also open the print job queue window by double-clicking the

printer icon in the [Printer] window.

DDDD Press {{{{Job Reset}}}} on the control panel.

The message appears on the panel display indicating that the print job is be-
ing canceled. 

Important
❒ When the printer is being shared by multiple computers, be careful not to

accidentally cancel someone else's print job.

Note
❒ This procedure cancels the print job that is being processed by the printer.

In some cases, the printer may already be processing data for the next se-
ries of print jobs following the one currently being output. In this case, the
next print jobs are also canceled when you press {{{{Job Reset}}}}.

❒ A print job that contains a large volume of data may take considerable time
to stop.
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Macintosh - Canceling a Print Job

AAAA Double-click the printer's icon on the desktop.
A window appears, showing all the print jobs that are currently queuing to
be printed. Check the current status of the job you want to cancel.

BBBB Select the name of the job you want to cancel.

CCCC Click the pause icon, and then click the trash icon.

DDDD Press {{{{Job Reset}}}} on the control panel.
The message appears on the panel display indicating that the print job is be-
ing canceled.

Important
❒ When the printer is being shared by multiple computers, be careful not to

accidentally cancel someone else's print job.

Note
❒ This procedure cancels the print job that is being processed by the printer.

In some cases, the printer may already be processing data for the next se-
ries of print jobs following the one currently being output. In this case, the
next print jobs are also canceled when you press {{{{Job Reset}}}}.

❒ A print job that contains a large volume of data may take considerable time
to stop.
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2. Uninstalling the Printer
Driver and Software

Uninstalling the PCL 6/5e Printer Driver

This section describes how to uninstall the printer driver. The actual procedure
may differ depending on the operating system.
Follow one of the appropriate procedures below.

Windows 95/98/Me - Uninstalling the PCL 6/5e Printer Driver

AAAA Close all applications that are currently running.

BBBB Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

CCCC Click to select the icon of the printer you want to remove.

DDDD On the [File] menu, click [Delete]. 

A confirmation dialog box appears.

EEEE Click [Yes] to uninstall the printer driver.

Windows 2000/Windows XP - Uninstalling the PCL 6/5e Printer 
Driver

Limitation
❒ Uninstalling a printer driver requires Manage Printers permission. Members

of the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you uninstall a printer driver, log on using an account
that has Manage Printers permission.

AAAA Close all applications that are currently running.

BBBB Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

Note
❒ With Windows XP, access the [Printers and Faxes] window from [Start] on

the taskbar.

CCCC Click to select the icon of the printer you want to remove.

DDDD On the [File] menu, click [Delete].
A confirmation dialog box appears. 
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EEEE Click [Yes] to uninstall the printer driver.

Note
❒ Before upgrading the printer driver, restart your computer after uninstall-

ing the old version of the printer driver.

Windows NT 4.0 - Uninstalling the PCL 6/5e Printer Driver

Limitation
❒ Uninstalling a printer driver requires Full Control access permission. Mem-

bers of the Administrators, Server Operators, Print Operators, and Power Us-
ers groups have Full Control Permission by default. When you install a
printer driver, log on using an account that has Full Control permission.

AAAA Close all applications that are currently running.

BBBB Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

CCCC Click to select the icon of the printer you want to remove.

DDDD On the [File] menu, click [Delete]. 

A confirmation dialog box appears.

EEEE Click [Yes] to uninstall the printer driver.

Note
❒ Before upgrading the printer driver, restart your computer after uninstall-

ing the old version of the printer driver.
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Uninstalling the RPCS Printer Driver

This section describes how to uninstall the printer driver. The actual procedure
may differ depending on the operating system.
Follow one of the appropriate procedures below.

Windows 95/98/Me - Uninstalling the RPCS Printer Driver

AAAA Close all applications that are currently running.

BBBB Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

CCCC Click to select the icon of the printer you want to remove.

DDDD On the [File] menu, click [Delete]. 

A confirmation dialog box appears.

EEEE Click [Yes] to uninstall the printer driver.

Windows 2000/Windows XP - Uninstalling the RPCS Printer Driver

Limitation
❒ Uninstalling a printer driver requires Manage Printers permission. Members

of the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you uninstall a printer driver, log on using an account
that has Manage Printers permission.

AAAA Close all applications that are currently running.

BBBB Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

Note
❒ With Windows XP, access the [Printers and Faxes] window from [Start] on

the taskbar.

CCCC Click to select the icon of the printer you want to remove.

DDDD On the [File] menu, click [Delete].

A confirmation dialog box appears. 

EEEE Click [Yes] to uninstall the printer driver.

Note
❒ Before upgrading the printer driver, restart your computer after uninstall-

ing the old version of the printer driver.
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Windows NT 4.0 - Uninstalling the RPCS Printer Driver

Limitation
❒ Uninstalling a printer driver requires Full Control access permission. Mem-

bers of the Administrators, Server Operators, Print Operators, and Power Us-
ers groups have Full Control Permission by default. When you install a
printer driver, log on using an account that has Full Control permission.

AAAA Close all applications that are currently running.

BBBB Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

CCCC Click to select the icon of the printer you want to remove.

DDDD On the [File] menu, click [Delete]. 

A confirmation dialog box appears.

EEEE Click [Yes] to uninstall the printer driver.

Note
❒ Before upgrading the printer driver, restart your computer after uninstall-

ing the old version of the printer driver.
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Uninstalling the PostScript Printer Driver

This section describes how to uninstall the PostScript printer driver.
The actual procedure may differ depending on the operating system.
Follow one of the appropriate procedures below.

Windows 95/98/Me - Uninstalling the PostScript Printer Driver

AAAA Close all applications that are currently running. 

BBBB Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

CCCC Click to select the icon of the printer you want to remove. 

DDDD On the [File] menu, click [Delete].
A confirmation dialog box appears.

EEEE Click [Yes] to uninstall the printer driver.

Windows 2000/Windows XP - Uninstalling the PostScript Printer Driver

Limitation
❒ Uninstalling a printer driver requires Manage Printers permission. Members

of the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you uninstall a printer driver, log on using an account
that has Manage Printers permission.

AAAA Close all applications that are currently running.

BBBB Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

Note
❒ With Windows XP, access the [Printers and Faxes] window from [Start] on

the taskbar.

CCCC Click to select the icon of the printer you want to remove.

DDDD On the [File] menu, click [Delete].

A confirmation dialog box appears. 

EEEE Click [Yes] to uninstall the printer driver.

Note
❒ Before upgrading the printer driver, restart your computer after uninstall-

ing the old version of the printer driver.
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Windows NT 4.0 - Uninstalling the PostScript Printer Driver

Limitation
❒ Uninstalling a printer driver requires Full Control access permission. Mem-

bers of the Administrators, Server Operators, Print Operators, and Power Us-
ers groups have Full Control Permission by default. When you uninstall a
printer driver, log on using an account that has Full Control permission.

AAAA Close all applications that are currently running. 

BBBB Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

CCCC Click to select the icon of the printer you want to remove. 

DDDD On the [File] menu, click [Delete].

A confirmation dialog box appears.

EEEE Click [Yes] to uninstall the printer driver.

Note
❒ Before upgrading the printer driver, restart your computer after uninstall-

ing the old version of the printer driver.

Macintosh - Uninstalling the PostScript Printer Driver

AAAA Drag the “AdobePS” file from the [Extensions] folder in [System Folder] to
[Trash].

BBBB Drag the PPD file and plug-in file from the [Printer Descriptions] folder in the
[Extensions] folder in [System Folder] to [Trash].
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3. Paper and Other Media

Paper and Other Media Supported by This 
Printer

Paper Types and Sizes

This section describes the type, size, feed direction, and maximum amount of pa-
per that can be loaded into each paper tray in this printer.

Important
❒ If you use damp or curled paper, a misfeed might occur. In this case, try turn-

ing over the paper stack in the paper tray. If there is no improvement, change
to paper with less curl.

Note
❒ The following symbols and terminology are used to represent the feed direc-

tion.

❒ It is recommended that you load paper of the size and direction you frequent-
ly use in the tray selected with “Tray Priority”. For more information about
Tray Priority, see p.106 “Paper Input Menu”.

❒ When loading paper of the same size in more than one tray, it is recommend-
ed that you load paper in the same direction in each tray.

Reference
For more information about loading each type of paper, see p.37 “Loading Pa-
per and Other Media”.

Important
❒ Be sure to set the paper size dial to match the actual paper size loaded in the

tray. When the actual paper size is not shown on the dial, set the dial to “p”
and select the paper size using the control panel.

❒ For Tray 1, 2 and 3, the dial setting overrides the setting made with the control
panel. 

❒ The optional Envelope Feeder Unit requires the installation of the optional
Paper Feed Unit. Up to two Paper Feed Units can be installed to the printer at
the same time. The Envelope Feeder Unit must be used in the top-most Paper
Feed Unit (Tray2).

In this manual On the panel display Paper feed direction

K ↑ (Feed direction)
A4 (210 × 297)

Letter (81/2×11)
Short-edge feed direction

L ↑ (Feed direction)
A4 (297 × 210)

Letter (11 × 81/2)
Long-edge feed direction
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Note
❒ The printable paper size depends on the memory size of the printer and print

data, see p.153 “Memory Capacity and Paper Size”.
❒ For more information about the meanings of the abbreviations, see the notes

at the bottom of each table.

❖❖❖❖ Input Paper Sizes (Metric version)
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A3 K 297 × 420 ❍ ✩ ✩ X

B4 JIS K 257 × 364 ❍ � � X

A4 K 210 × 297 ❍ ✩ ✩ X

L 297 × 210 ❍ ✩ ✩ X

B5 JIS K 182 × 257 ❍ � � X

L 257 × 182 ❍ � � X

A5 K 148 × 210 ❍ X X X

L 210 × 148 ❍ ✩ � X

A6 K 105 × 148 ❍ X X X

11 × 17 K 279 × 432 ❍ � ✩ X

Legal (LG, 81/2 × 14) K 216 × 356 ❍ � ✩ X

Letter (LT, 81/2 × 11) K 216 × 279 ❍ ✩ ✩ X

L 279 × 216 ❍ ✩ ✩ X

51/2 × 81/2 K 140 × 216 ❍ X X X

Executive (Exec., 71/4 × 101/2) K 184 × 276 ❍ X � X

L 276 × 184 ❍ � � X

Folio (81/4 × 13) K 210 × 330 ❍ � � X

Foolscap (F4, 81/2 × 13) K 216 × 330 ❍ � � X

F/GL (8 × 13) K 203 × 330 ❍ � � X

Com#10 Env (41/8 × 91/2) K 104.8 × 241.3 ❍ X X ❍

C5 Env (6.38 × 9.02) K 162 ×229 ❍ X X ❍

C6 Env (4.49 × 6.38) K 114 ×162 ❍ X X ❍

DL Env (4.33 × 8.66) K 110 × 220 ❍ X X ❍

Monarch Env (37/8 × 71/2) K 98.4 × 190.5 ❍ X X ❍
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• ❍

Means that the size is supported but the paper size should be set with the con-
trol panel. There is no dial on the tray.
See p.40 “Loading Paper in the Bypass Tray”
See p.47 “Loading envelopes into the Envelope Feeder Unit”

• ✩
Means that the size is supported and indicated on the tray dial. Be sure to set
the paper size dial to match the actual paper size loaded in the tray.

• �
Means that the size is supported but not indicated on the tray dial. You
should set the tray dial to “p”, and select the paper size with the control pan-
el.

• ❍*
Means that the supported size is approximately 90 - 305 mm in width, and ap-
proximately 148 - 432 mm in length. The supported size may differ depending
on the printer language you use. Use the printer driver to set custom sizes. Set
custom sizes with the control panel.

• �**
Means that the supported size is approximately 182-297 mm in width, and ap-
proximately 148-432 mm in length. The supported size may differ depending
on the printer language you use. Use the printer driver to set custom sizes. Set
custom sizes with the control panel.

• X
Means that the size is not supported.

❖❖❖❖ Input Paper Sizes (Inch version)

Custom Size — — ❍* X �** X

8K (101/2 × 15.35) K 267 × 390 ❍ � � X

16K (7.68 × 101/2) K 195 × 267 ❍ � � X

L 267 × 195 ❍ � � X
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11 × 17 K 11 × 17 ❍ ✩ ✩ X
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Legal (LG) K 81/2 × 14 ❍ ✩ ✩ X

Letter (LT) K 81/2 × 11 ❍ ✩ ✩ X

L 11 × 81/2 ❍ ✩ ✩ X

51/2 × 81/2 K 51/2 × 81/2 ❍ X X X

Executive (Exec.) K 71/4 × 101/2 ❍ X � X

L 101/2 × 71/4 ❍ � � X

A3 K 11.26 × 16.54 ❍ � ✩ X

B4 JIS K 10.12 × 14.33 ❍ � � X

A4 K 8.26 × 5.83 ❍ � ✩ X

L 5.83 × 8.26 ❍ ✩ ✩ X

B5 JIS K 7.17 × 10.12 ❍ � � X

L 10.12 × 7.17 ❍ � � X

A5 K 5.83 × 8.26 ❍ X X X

L 8.26 × 5.83 ❍ � � X

A6 K 4.13 × 5.63 ❍ X X X

Folio K 81/4 × 13 ❍ � � X

Foolscap F4 K 81/2 × 13 ❍ ✩ � X

F/GL K 8 × 13 ❍ � � X

Com#10 Env K 41/8 × 91/2 ❍ X X ❍

C5 Env K 6.38 × 9.02 ❍ X X ❍

C6 Env K 4.49 × 6.38 ❍ X X ❍

DL Env K 4.33 × 8.66 ❍ X X ❍

Monarch Env K 37/8 × 71/2 ❍ X X ❍

Custom Size — — ❍* X �** X

8K K 101/2 × 15.35 ❍ � � X

16K K 7.68 × 101/2 ❍ � � X

L 101/2 × 7.68 ❍ � � X
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• ❍
Means that the size is supported but the paper size should be set with the con-
trol panel. There is no dial on the tray.
See p.40 “Loading Paper in the Bypass Tray”
See p.47 “Loading envelopes into the Envelope Feeder Unit”

• ✩
Means that the size is supported and indicated on the tray dial. Be sure to set
the paper size dial to match the actual paper size loaded in the tray.

• �
Means that the size is supported but not indicated on the tray dial. You
should set the tray dial to “p”, and select the paper size with the control pan-
el.

• ❍*
Means that the supported size is approximately 3.55 - 12.00 inches in width,
and approximately 5.83 - 17.00 inches in length. The supported size may dif-
fer depending on the printer language you use. Use the printer driver to set
custom sizes. Set custom sizes with the control panel.

• �**
Means that the supported size is approximately 7.16 - 11.7 inches in width,
and approximately 5.8 - 17 inches in length. The supported size may differ de-
pending on the printer language you use. Use the printer driver to set custom
sizes. Set custom sizes with the control panel.

• X
means that the size is not supported.

❖❖❖❖ Paper weight and number of sheets to be set

*1 Confirm that the top of the stack is not higher than the limit mark indicated on the
side fence of the tray.

*2 The Envelope Feeder Unit requires the installation of the optional Paper Feed Unit.

Supported paper weight
Maximum number of 
sheets (plain paper) *1 

Paper Tray 60 - 105 g/m2 
(16 - 28 lb. bond)

250 (80 g/m2, 20 lb. bond)

Paper Feed Unit Type 2600 (option) 60 - 105 g/m2 
(16 - 28 lb. bond)

500 (80 g/m2, 20 lb. bond)

Bypass Tray 52 - 162 g/m2 
(14 - 43 lb. bond)

100 (80 g/m2, 20 lb. bond)

For other kind of papers, 
see p.33 “Types of Paper 
and Other Media”.

Envelope Feeder Type 2600 *2 p.33 “Types of Paper and Other Media”.
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❖❖❖❖ Output Paper Sizes (Metric version)

• ❍
Means that the size is supported.

• X
Means that the size is not supported.
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A3 K 297 × 420 ❍ ❍ ❍ ❍

B4 JIS K 257 × 364 ❍ ❍ ❍ ❍

A4 K 210 × 297 ❍ ❍ ❍ ❍

L 297 × 210 ❍ ❍ ❍ ❍

B5 JIS K 182 × 257 ❍ ❍ ❍ ❍

L 257 × 182 ❍ ❍ ❍ ❍

A5 K 148 × 210 ❍ X X X

L 210 × 148 ❍ ❍ ❍ ❍

A6 K 105 × 148 ❍ X X X

11 × 17 K 279 × 432 ❍ ❍ ❍ ❍

Legal (LG, 81/2 × 14) K 216 × 356 ❍ ❍ ❍ ❍

Letter (LT, 81/2 × 11) K 216 × 279 ❍ ❍ ❍ ❍

L 279 × 216 ❍ ❍ ❍ ❍

51/2 × 81/2 K 140 × 216 ❍ X X X

Executive (Exec., 71/4 × 101/2) K 184 × 276 ❍ ❍ ❍ X

L 276 × 184 ❍ ❍ ❍ ❍

Folio (81/4 × 13) K 210 × 330 ❍ ❍ ❍ ❍

Foolscap (F4, 81/2 × 13) K 216 × 330 ❍ ❍ ❍ ❍

F/GL (8 × 13) K 203 × 330 ❍ ❍ ❍ ❍

Com#10 Env (41/8 × 91/2) K 104.8 × 241.3 ❍ X X X

CA Env (6.38 × 9.02) K 162 ×229 ❍ X X X

C6 Env (4.49 × 6.38) K 114 ×162 ❍ X X X

DL Env (4.33 × 8.66) K 110 × 220 ❍ X X X

Monarch Env (37/8 × 71/2) K 98.4 × 190.5 ❍ X X X

Custom Size — — ❍ X X X

8K (101/2 × 15.35) K 267 × 390 ❍ ❍ ❍ ❍

16K (7.68 × 101/2) K 195 × 267 ❍ ❍ ❍ ❍

L 267 × 195 ❍ ❍ ❍ ❍
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❖❖❖❖ Output Paper Sizes (Inch version)
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11 × 17 K 11 × 17 ❍ ❍ ❍ ❍

Legal (LG) K 81/2 × 14 ❍ ❍ ❍ ❍

Letter (LT) K 81/2 × 11 ❍ ❍ ❍ ❍

L 11 × 81/2 ❍ ❍ ❍ ❍

51/2 × 81/2 K 51/2 × 81/2 ❍ X X X

Executive (Exec.) K 71/4 × 101/2 ❍ ❍ ❍ X

L 101/2 × 71/4 ❍ ❍ ❍ ❍

A3 K 11.26 × 16.54 ❍ ❍ ❍ ❍

B4 JIS K 10.12 × 14.33 ❍ ❍ ❍ ❍

A4 K 8.26 × 5.83 ❍ ❍ ❍ ❍

L 5.83 × 8.26 ❍ ❍ ❍ ❍

B5 JIS K 7.17 × 10.12 ❍ ❍ ❍ ❍

L 10.12” × 7.17 ❍ ❍ ❍ ❍

A5 K 5.83 × 8.26 ❍ X X X

L 8.26 × 5.83 ❍ ❍ ❍ ❍

A6 K 4.13 × 5.63 ❍ X X X

Folio K 81/4 × 13 ❍ ❍ ❍ ❍

Foolscap F4 K 81/2 × 13 ❍ ❍ ❍ ❍

F/GL K 8 × 13 ❍ ❍ ❍ ❍

Com#10 Env K 41/8 × 91/2 ❍ X X X

C6 Env K 4.49 × 6.38 ❍ X X X

C5 Env K 6.38 × 9.02 ❍ X X X

DL Env K 4.33 × 8.66 ❍ X X X

Monarch Env K 37/8 × 71/2 ❍ X X X

Custom Size — — ❍ X X X

8K K 101/2 × 15.35 ❍ ❍ ❍ ❍
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• ❍

Means that the size is supported and that the paper size should be set with
the control panel. There is no dial on the tray.

• X
Means that the size is not supported.

16K K 7.68 × 101/2 ❍ ❍ ❍ ❍

L 101/2 × 7.68 ❍ ❍ ❍ ❍
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Paper Recommendations

Note the following suggestions when handling or selecting paper used with this
printer.

Loading Paper

• Confirm the paper types of the printer. For more information, see p.33 “Types
of Paper and Other Media”. Print quality cannot be guaranteed if other paper
types are used.

• Do not use paper that is already printed on. 
• If you load paper into the paper tray, be sure not to stack over the limit mark.
• If you load paper onto the Bypass Tray, be sure that paper fits under the side

guide.
• If you load paper into the paper tray, confirm that the print side is facing

down.
• If you load paper onto the Bypass Tray, confirm that the print side is facing

up.

Storing Paper

Paper should always be stored properly. Improperly stored paper might result
in poor print quality, paper misfeeds or printer damage.
Recommendations are as follows:
• Avoid storing paper in humid areas.
• Avoid exposing paper to direct sunlight.
• Store on a flat surface.
• Keep open reams of paper in the package in which the paper came.

Types of Paper and Other Media

❖❖❖❖ Plain paper
• If you print on paper heavier than 105 g/m2 (28 lb. bond), use the Bypass

Tray. The Bypass Tray can hold paper up to 162 g/m2 (43 lb. bond) in
weight.

• If you load paper heavier than 155 g/m2 (41 lb. bond) onto the Bypass
Tray, set the printer to Thick Paper mode using the control panel. 

• If paper is curled or bent, correct it before loading.
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❖❖❖❖ OHP transparencies
• Load only one OHP transparency at the same time onto the Bypass Tray.
• When loading an OHP transparency onto the Bypass Tray, set the printer

to Transparency mode with the control panel. 
• Be careful not to touch the print side of the OHP transparencies, otherwise

the print side gets dirty or damaged, and results in poor print quality.
• When printing on an OHP transparency that has a print side, load it facing

down onto the Bypass Tray.

❖❖❖❖ Adhesive labels
• Load only one adhesive label at the same time onto the Bypass Tray.
• Use adhesive labels in which the whole side can be printed on.
• Do not use adhesive labels having exposed glue.
• If the print side is coated, print quality might be reduced, as the toner

might not fuse well.

❖❖❖❖ Envelopes
• When printing on envelopes, use the Bypass Tray or the Envelope Feeder

Unit.
• Even when the optional Envelope Feeder Unit is not installed, you can se-

lect the sizes for the Envelopes for Tray 2 using the control panel. Howev-
er, you cannot load the envelopes until optional Envelop Feeder Unit is
installed.
To use the Envelope Feeder Unit, installation of the optional Paper Feed
Unit is required. See “Envelope Feeder Type 2600” in the Setup Guide.

• Specifications of envelopes are as follows:

• You can load up to 10 envelopes (72 – 90 g/m2, 19 – 24 lb. bond) onto the
Bypass Tray at the same time, without forcibly pressing them. Confirm
that the envelopes are not damp, and that the top of the stack is not higher
than the limit mark on the side guide. See p.45 “Loading envelopes onto
the Bypass Tray”.

• You can load up to 60 envelopes (72 – 90 g/m2, 19 – 24 lb. bond) into op-
tional Envelope Feeder Unit at the same time, without forcibly pressing
them. Confirm that the envelopes are not damp, and that the top of the
stack is not higher than the limit mark on the side guide. See p.47 “Loading
envelopes into the Envelope Feeder Unit”.

• Confirm that the print side is facing up when loading onto the Bypass
Tray, and facing down when loading into the optional Envelope Feeder
Unit.

Metric version Inch version

Weight 72 – 90 g/m2 19 – 24 lb. bond

Recommended weight 
and size

72 g/m2, 114 × 162 mm

(C6 Env)

24 lb. bond, 37/8 × 71/2 inches

(Monarch)
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• Load the envelopes with the flaps aligned to the left side fence. The flaps
should be securely folded up. 

• Confirm that there is no air in the envelopes before loading.
• To get better print quality, it is recommended that you set the right, left,

top, and bottom print margin, to at least 15 mm (0.6 inches) each.
• Do not print on both sides of envelopes.
• Load only one size and type of envelopes at the same time.
• Before loading envelopes, flatten the leading edges (the side being fed into

the printer) of them by running a pencil or ruler across them.
• Before loading envelopes, confirm that they are rectangular in shape.
• Do not use the non-supported envelopes listed on p.29 “Paper weight and

number of sheets to be set”.

Paper not supported by this printer

Avoid using the following types of paper that are not supported by this printer:
• Paper whose weight is heavier or lighter than the limitation. See p.25 “Paper

Types and Sizes”.
• Bent, folded or creased paper
• Curled or twisted paper
• Torn paper
• Wrinkled paper
• Damp paper
• Paper stuck together
• Paper that is dry enough to emit static electricity
• Paper that has already been printed on, with the exception of preprinted let-

terhead

Note
❒ Ink on paper from an earlier print job, another copier, an inkjet printer or

other device could damage the fusing unit of this printer due to a differ-
ence in fusing temperatures.

• Coated paper
• Special paper like thermal paper, aluminum foil, carbon paper and conduc-

tive paper
• Heavily textured paper
• Glued paper
• Label paper on which glue or base paper is exposed
• Paper with clips or stapled
• Paper with tape or ribbons attached
• Envelopes in the following conditions:
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• damp
• excessively curled or twisted
• stuck together
• damaged in any way
• with stamps attached
• with windows, holes, perforations, cutouts or embossing
• with metal clasps, string ties or metal folding bars
• designed to be interlocked
• with nicked edges or bent corners
• with rough, wrinkled or laid finishes
• with any exposed adhesive, when the flap is in the sealed or closed posi-

tion

Printable Area

The following shows the printable area for this printer. Be sure to set the print
margins correctly by the application.

A : printable area

Important
❒ The maximum printable length is 432 mm (17 inches) in the paper feed direc-

tion.

Note
❒ The printable area may vary depending on the paper size, printer language

and printer driver settings.

4.2mm(1/6 inches)

4.2mm
(1/6 inches)

1

4.2mm(1/6 inches)

4.2mm
(1/6 inches)

4.2mm(1/6 inches)4.2mm(1/6 inches)
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Loading Paper and Other Media

Loading Paper in the Paper 
Tray

Load paper in the optional Paper
Feed Unit by following the proce-
dures below.

Reference
With the paper tray, you can load
up to 250 pages and with the op-
tional Paper Feed Unit, you can
load up to 500 pages at the same
time. For more information about
the type, size and feed direction of
paper that can be loaded in the
tray, see p.25 “Paper Types and
Sizes”.
When you change the paper size
see p.38 “Changing the paper
size”.

AAAA Lift the paper tray slightly then
pull it out until it stops.

BBBB While lifting the front side of the
tray, pull it out of the printer.

CCCC Load paper into the tray with the
print side down.

Important
❒ Confirm that the top of the stack

is not higher than the limit mark
inside the tray.

❒ Confirm that paper fits under
the rear guide.

ZCEY430J

ZCEY140J

ZCEY130J
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DDDD Carefully slide the paper tray into
the printer until it stops.

Important
❒ Do not slide the paper tray in

with force. If you do, the front
and side guides might move.

Changing the paper size

Important
❒ Confirm that the setting of the pa-

per size dial matches the paper size
and feed direction of the paper in
the tray, otherwise the printer
might be damaged, or printing
problems might occur.

AAAA Lift the paper tray slightly then
pull it out until it stops. Adjust
the paper size dial to match the
size and feed direction of paper in
the paper tray.

Important
❒ If you want to use the paper size

and feed direction that are not
indicated on the paper size dial,
set the dial to “p”. In this case,
you should set the paper size
using the control panel. See
p.106 “Paper Input Menu”.

BBBB While lifting the front side of the
tray, pull it out of the printer.

CCCC If you load paper larger than A4
KKKK or 81/2 ×××× 11 KKKK, you should ex-
tend the tray as follows:

Note
❒ You cannot load paper smaller

than A4 K or 81/2 × 11 K, if the
tray is extended. In this case, re-
turn the tray to its standard
length.

A Slide the catches inwards to
unlock the tray.

ZCEY150J

ZCEY110J

ZCEY140J

ZCEY160J
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B Slide the tray until it stops.

C Return the catches to their orig-
inal positions.

Important
❒ Confirm that the catches re-

turn to their original posi-
tions securely. If they are not
locked securely, paper mis-
feeds might occur.

DDDD Adjust the rear and side guides to
the paper size you want to load.

EEEE Load paper into the tray with the
print side down.

Important
❒ Confirm that the top of the stack

is not higher than the limit mark
inside the tray. 

❒ Confirm that paper fits under
the rear guide.

FFFF Carefully slide the paper tray into
the printer until it stops.

Important
❒ Do not slide the paper tray in

with force. If you do, the front
and side guides might move.

ZCEY170J

ZCEY180J

ZGDY120J

ZCEY130J

ZCEY150J
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Loading Paper in the Bypass 
Tray

Reference
With the Bypass Tray, you can
load up to 100 pages at the same
time. For more information about
the type, size and feed direction of
paper that can be loaded in the
tray, see p.25 “Paper Types and
Sizes”.

Note
❒ If you set custom size paper, you

should set the paper size using the
printer driver. Also, use the con-
trol panel to set the custom size set-
ting.

AAAA Open the Bypass Tray.

BBBB Slide the side guides outward,
and load paper until it stops with
the print side up.

Note
❒ If you load A4K or lager, or

81/2 × 11 Kor larger, slide out
the Bypass Tray extension (A)
and then flip it open (B).

CCCC Adjust the side guides to the pa-
per width.

Important
❒ Confirm that paper fits under

the side guides.

ZGDY190J

ZGDY200J

ZGDY210J

ZGDY220J
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DDDD Set the paper size and feed direc-
tion using the control panel as fol-
lows:
A Press {{{{Menu}}}}.

“Menu” appears on the panel
display.

B Press {{{{TTTT}}}} or {{{{UUUU}}}} to “Paper In-
put” menu.

C Press {{{{Enter #}}}}.

The following message appears
on the panel display.

D Press {{{{Enter #}}}}.

E Press {{{{TTTT}}}} or {{{{UUUU}}}} to select the
paper size you want to use. 

F Press {{{{Enter #}}}} to apply the set-
ting. Wait for a while.

The screen returns to step C in
a few seconds.

G After the panel display chang-
es, press {{{{On Line}}}}.

"Ready" appears on the panel
display.

EEEE Start printing with the computer.

  Menu

   Paper Input

  Paper Input:

   Bypass Size

  Bypass Size:

  *11 x 17

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Bypass Size:

   8 1/2 x 11

  Bypass Size:

  *8 1/2 x 11

  Ready

    

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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Loading custom sized paper in the 
Bypass Tray

Important
❒ The settings of custom sized paper

that take effect are not the settings
made on the control panel but the
settings made in the printer driver.
There is no need to change the set-
tings on the control panel. Howev-
er, when using a printer driver
other than RPCS, you will need to
change the settings on the control
panel.

❒ Applications that do not allow a
custom paper size to be set cannot
print on custom sized paper.

Note
❒ If you print on A3 or longer sheets,

prints may become blurred.

AAAA Press {{{{Menu}}}}.

"Menu" appears on the panel dis-
play.

BBBB Press {{{{TTTT}}}} or {{{{UUUU}}}} to display "Pa-
per Input" menu.

CCCC Press {{{{Enter #}}}}.

The following message appears on
the panel display.

DDDD Press {{{{TTTT}}}} or {{{{UUUU}}}} to display "Cus-
tom Size".

EEEE Press {{{{Enter #}}}}.

The following message appears on
the panel display.

FFFF Press {{{{TTTT}}}} or {{{{UUUU}}}} to display the
length in the feed direction, and
then press {{{{Enter #}}}}.

The screen to enter the size along
the length appears.

GGGG Press {{{{TTTT}}}} or {{{{UUUU}}}} to display the
size along the length of the feed
direction, and then press {{{{Enter
#}}}}.

The screen returns to step D in a
few seconds.

HHHH Press {{{{On Line}}}}.

"Ready" appears on the panel dis-
play.

  Menu

   Paper Input

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Paper Input:

   Bypass Size

  Bypass Size:

   Custom Size

  Custom Size:

   Horiz.    11.69 "

  Custom Size:

   Vert.     8.27 "

  Ready
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Setting the Bypass Tray Paper Type

To make sure printing is done correct-
ly, you must specify one of the follow-
ing for the type of sheets loaded in the
tray:
• Plain paper, Recycled paper, Spe-

cial paper, Color paper, Letter-
head, Preprinted, Labels, Bond
paper, Cardstock, Transparencies,
Thick paper

Important
❒ When you load thick paper or

transparencies in the Bypass Tray,
always specify the type of paper.
Duplex printing is not possible on
paper in a tray for which Thick pa-
per or Transparency has been set.

AAAA Press {{{{Menu}}}}.

"Menu" appears on the panel dis-
play.

BBBB Press {{{{TTTT}}}} or {{{{UUUU}}}} to display "Pa-
per Input" menu.

CCCC Press {{{{Enter #}}}}.

The following message appears on
the panel display.

DDDD Press {{{{TTTT}}}} or {{{{UUUU}}}} to display "Pa-
per Type".

EEEE Press {{{{Enter #}}}}.

The following message appears on
the panel display.

FFFF Press {{{{TTTT}}}} or {{{{UUUU}}}} to display "By-
pass Tray", and then press {{{{Enter
#}}}}.

The screen to select the paper type
appears.

GGGG Press {{{{TTTT}}}} or {{{{UUUU}}}} to display the
type of paper you have loaded,
and then press {{{{Enter #}}}}.

The screen returns to step F in a
few seconds.

HHHH Press {{{{On Line}}}}.

"Ready" appears on the panel dis-
play.

  Menu

   Paper Input

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Paper Input:

   Paper Type

  Paper Type:

   Bypass Tray

  Bypass Tray:

   Thick Paper

  Ready
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Loading Paper in the Optional 
Paper Tray

Reference
With the Paper Feed Unit, you can
load up to 500 pages at the same
time.
For more information about the
type, size and feed direction of pa-
per that can be loaded in the tray,
see p.25 “Paper Types and Sizes”.

Important
❒ If the printer is equipped with the

optional tray(s), do not slide out
more than one tray at the same
time. If you do, the printer might
fall down.

❒ Confirm that the setting of the pa-
per size dial matches the paper size
and feed direction of the paper in
the tray. If different, the printer
might be damaged, or printing
problems might occur.

AAAA Lift the paper tray slightly then
pull it out until it stops. Adjust
the paper size dial to match the
size and feed direction of paper in
the Paper Feed Unit.

Important
❒ If you want to use paper sizes or

feed directions that are not list-
ed on the paper size dial, adjust
the dial to “p”. In this case, you
should set the paper size using
the control panel. See p.106 “Pa-
per Input Menu”.

BBBB While lifting the front side of the
tray, pull it out of the printer.

CCCC Adjust the rear and side guides to
the paper size you want to load.

ZCEY230J

ZDDP330E

ZGDY250E
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DDDD Load paper into the paper tray
with the print side down.

Important
❒ Confirm that the top of the stack

is not higher than the limit mark
inside the tray.

❒ Confirm that paper fits under
the rear guide. 

EEEE While lifting the front of the tray,
place the tray into the printer.
Then slide it inside until it stops.

Important
❒ Do not slide the paper tray in

with force. If you do, the front
and side guides might move.

Loading Envelopes

As there are many kinds of envelopes,
be sure to check if those to be used are
supported by this printer.

Reference
For more information about enve-
lopes, see p.33 “Types of Paper and
Other Media”.

Important
❒ Even when the optional Envelope

Feeder Unit is not installed, you
can select the sizes for the enve-
lopes for Tray 2 using the control
panel. However, you cannot load
the envelopes until the optional
Envelope Feeder Unit is installed.

❒ To install the Envelope Feeder
Unit, the optional Paper Feed Unit
must be installed. See “Envelope
Feeder Type 2600” in the Setup
Guide.

Loading envelopes onto the Bypass Tray

Reference
With the Bypass Tray, you can
load up to 10 envelopes at the same
time. For more information about
envelopes, see p.33 “Types of Pa-
per and Other Media”.

AAAA Open the Bypass Tray.

ZCEY260J

ZDDP340E

ZGDY190J
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BBBB Load envelopes until they stop,
with the print side up and the
sides of the flaps on the left as
shown below.

Important
❒ Confirm that the envelope flaps

are securely folded down, and
that there is no air inside the en-
velopes.

Note
❒ Confirm that the top of the stack

is not higher than the limit mark
on the side guides.

❒ Do not push the stack of enve-
lopes with too much force.

CCCC Slide the side guides against the
edge of the envelope stack.

Note
❒ Confirm that the edges of enve-

lopes fit under the side guides.

DDDD Set the envelope size and feed di-
rection using the control panel as
follows:
A Press {{{{Menu}}}}.

“Menu” appears on the panel
display.

B Press {{{{UUUU}}}} or {{{{TTTT}}}} to display
“Paper Input” menu.

C Press {{{{Enter #}}}}. 

The following message appears.

D Press {{{{Enter #}}}}. 

ZGDY411J

  Menu:

   Paper Input

  Paper Input:

   Bypass Size

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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E Press {{{{UUUU}}}} or {{{{TTTT}}}} to select the
envelope type you want to use.

Reference
For information about types
of envelopes you can select,
see p.25 “Paper and Other
Media Supported by This
Printer”.

F Press {{{{Enter #}}}} to apply the set-
tings. Wait for a while.

G After the panel display chang-
es, press {{{{On Line}}}}.

"Ready" appears on the panel
display.

EEEE Start printing with the computer.

Loading envelopes into the Envelope 
Feeder Unit

Important
❒ With the optional Envelope Feeder

Unit, you can load up to 60 enve-
lopes at the same time. For more
information about envelopes, see
p.33 “Types of Paper and Other
Media”.

AAAA Slide the optional Paper Feed
Unit (Tray 2) out until it stops.
Next, lift it slightly, then slide it
out.

Note
❒ Keep the paper tray with paper

in a cool and dry place.

BBBB Prepare the Envelope Feeder
Unit.

CCCC While pinching the side guides,
slide them outward until they
stop. While pinching the rear
guide, slide it toward the back.

  Ready

   

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

ZDDP330E

ZGDY260E
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DDDD Push the bottom plate down until
it locks into place.

EEEE Load envelopes into the Envelope
Feeder Unit, with the print side
down and the flap on the left as
shown in the illustration.

Important
❒ Confirm that the envelope flaps

are securely folded down, and
that there is no air inside the en-
velopes.

Note
❒ Confirm that the top of the stack

is not higher than the limit mark
on the side guides.

❒ Confirm that the envelopes fit
under the side guides.

❒ Do not push the stack of enve-
lopes with too much force.

FFFF While pinching the side guides,
slide them along the edge of the
envelope stack.

GGGG While pinching the rear guide,
slide it along the edge of the enve-
lope stack.

HHHH While lifting the front of the tray,
place it into the printer. Then
slide it until it stops.

Important
❒ Do not slide the paper tray in

with force. If you do, the front
and side guides might move.

ZDDP360E

ZDDP380E

ZGDY370E

ZGDY390E
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IIII Set the envelope size and feed di-
rection using the control panel as
follows:
A Press {{{{Menu}}}}.

“Menu” appears on the panel
display.

B Press {{{{UUUU}}}} or {{{{TTTT}}}} to display
“Paper Input” menu.

C Press {{{{Enter #}}}}. 

The following message appears
on the panel display.

D Press {{{{UUUU}}}} or {{{{TTTT}}}} to display
“Tray Paper Size”.

E Press {{{{Enter #}}}}. 

The following message appears
on the panel display.

F Press {{{{UUUU}}}} or {{{{TTTT}}}} to display
“Tray 2”.

G Press {{{{Enter #}}}}.

H Press {{{{UUUU}}}} or {{{{TTTT}}}} to select the
envelope type you want to use.

Reference
For more information about
types of envelopes you can
select, see p.25 “Paper and
Other Media Supported by
This Printer”.

I Press {{{{Enter #}}}}. Wait for a
while.

  Menu:

   Paper Input

  Paper Input

   Bypass Size

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Paper Input:

   Tray Paper Size

  Tray Paper Size:

   Tray 1

  Tray Paper Size:

   Tray 2
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J After the panel display chang-
es, press {{{{On Line}}}}.

"Ready" message appears on
the control panel.

JJJJ Start printing with the computer. 

  Ready

   

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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4. Sample Print/Locked Print

Sample Print

Use this function to print only the first
set of a multiple-set print jobs. The re-
maining sets are saved on the option-
al Hard Disk Drive in the printer. The
saved job can be printed or canceled
from the printer's control panel.

Important
❒ Turning the printer off deletes any

documents or error logs stored on
the optional hard disk drive.

Limitation
❒ To use this function, the optional

Hard Disk Drive must be installed
on the printer.

Note
❒ If the application has a collate op-

tion, confirm that it is not selected
before sending a print job. By de-
fault, sample print jobs are auto-
matically collated by the printer
driver. If the collate option is se-
lected from the application print
dialog box, more pages than in-
tended may be printed.

❒ You can identify the file you want
to print by the User ID and the
time when the job was stored.

❒ The actual number of pages the
printer can save depends on the
contents of the print images. For
example, the printer can save up to
30 jobs or 1,000 pages. It depends
on the data volume.

❒ If the first set of the sample print
file is not as you expected and you
do not want to print the remaining
sets, delete the sample print file us-
ing the control panel. If you print
the remaining sets of the sample
print file, the job in the printer is
deleted automatically.

Printing a Sample Print File

The following procedure describes
how to print a sample print file with
the PCL printer driver. For informa-
tion about how to print a sample print
file with the PostScript printer driver,
see the PostScript 3 Operating In-
structions Supplement included on
the CD-ROM. For more information
about RPCS printer driver, see Help.

AAAA From an application, select the
menu command to print.

The print dialog box appears.

BBBB Open the Printer Properties.

CCCC From the [Job Type:] box on the
[Setup] tab, select [Sample Print].

DDDD Click the [Details...] button.

EEEE In the [User ID:] box, type a User ID
of up to eight alphanumeric char-
acters.

Note
❒ This is used to identify the user

associated with a job.
❒ The User ID can consist of up to

eight alphanumeric (a-z, A-Z, 0-
9) characters.
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FFFF Click [OK].

GGGG After making all desired settings,
click [OK].

HHHH Start printing from the applica-
tion's print dialog box.

The sample print job is sent to the
printer and the first set is printed.

IIII Check the print job to confirm
whether the settings are accepta-
ble.

If the settings are fine, go to step J
to print the rest of the print job.
If not, you can delete the saved job.
See p.53 “Deleting a Sample Print
File”

JJJJ On the printer's control panel,
press {{{{Menu}}}}.

“Menu” appears on the panel dis-
play.

KKKK Press {{{{TTTT}}}} or {{{{UUUU}}}} to display the
“Sample Print“ menu.

LLLL Press {{{{Enter #}}}}.

The following message appears on
the panel display.

MMMM Press {{{{TTTT}}}} or {{{{UUUU}}}} to display the
file you want to print, and then
press {{{{Enter #}}}}.

Note
❒ If you want to cancel the sample

print file, press {{{{Escape}}}}.

NNNN Press {{{{Enter #}}}}.

The following message appears on
the panel display.

OOOO Press {{{{UUUU}}}} or {{{{TTTT}}}} to enter the
number of sets.

Note
❒ You can enter up to 999 sets.

  Menu:  

   Sample Print

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Sample Print:

   08:56 ABCD1234

  Select Action: 

  Print File

  Qty:  1(1-999)

  Press # to Print

  Qty:  6(1-999)

  Press # to Print

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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PPPP Press {{{{Enter #}}}} to print the file.

The following message appears on
the panel display.

Note
❒ If you are not satisfied with the

first printout of the sample print
file and do not want to print the re-
mainder, the job in the printer is
deleted automatically.

Deleting a Sample Print File

If you are not satisfied with the print-
out, delete the sample print file. Then
revise it and print again until the set-
tings are fine.

AAAA Press {{{{Menu}}}}.

"Menu" appears on the panel dis-
play.

BBBB Press {{{{TTTT}}}} or {{{{UUUU}}}} to display the
"Sample Print" menu .

CCCC Press {{{{Enter #}}}}.

The following message appears on
the panel display.

DDDD Press {{{{TTTT}}}} or {{{{UUUU}}}} to display the
file you want to delete, and then
press {{{{Enter #}}}}.
The following message appears on
the panel display.

Note
❒ If you want to cancel the dele-

tion of a sample print file, press
{{{{Escape}}}}.

EEEE Press {{{{TTTT}}}} or {{{{UUUU}}}} to display "De-
lete File", and then press {{{{Enter #}}}}.

FFFF Press {{{{Enter #}}}} to delete the file.
The following message appears on
the panel display.

  Processing...

   

  Menu:  

   Sample Print

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Sample Print:

   08:56 ABCD1234

  Select Action:

  Print File 

  08:56  ABCD1234

  Press# to Delete

  Deleted

    

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

Download from Www.Somanuals.com. All Manuals Search And Download.



Sample Print/Locked Print

54

4

GGGG Press {{{{On Line}}}}.

"Ready" appears on the panel dis-
play.

Checking the Error Log

Limitation
❒ You can view only the latest 20 er-

ror logs of all.

AAAA Press {{{{Menu}}}}.

"Menu" appears on the panel dis-
play.

BBBB Press {{{{TTTT}}}} or {{{{UUUU}}}} to display the
"Sample Print" menu.

CCCC Press {{{{Enter #}}}}.

The following message appears on
the panel display.

DDDD Press {{{{TTTT}}}} or {{{{UUUU}}}} to display “Error
File(s)”.

EEEE Press {{{{Enter #}}}}.

The following message appears on
the panel display.

Note
❒ You can check the other error

logs by using {{{{TTTT}}}} or {{{{UUUU}}}}.

FFFF Press {{{{TTTT}}}} or {{{{UUUU}}}} to check "Error
File(s)", and then press {{{{Enter #}}}}.

The following message appears on
the panel display.

  Ready

   

  Menu:

   Sample Print

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Sample Print:

   08:56 ABCD1234

  Sample Print:

   Error File(s)

  Error File(s):

   06:52  ABCD1234

  Sample Print:

   Error File(s)

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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GGGG Press {{{{On Line}}}}.

"Ready" appears on the panel dis-
play.

  Ready

   

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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Locked Print

Use this function to maintain privacy
when printing confidential docu-
ments. Documents will not be printed
out automatically, unless a password
is entered, using the control panel af-
ter sending the print job.

Important
❒ Turning the printer off deletes any

documents or error logs stored on
the optional hard disk drive.

Limitation
❒ To use this function, the optional

Hard Disk Drive must be installed
on the printer.

Note
❒ If the application has a collate op-

tion, confirm that it is not selected
before sending a print job. By de-
fault, locked print jobs are auto-
matically collated by the printer
driver. If the collate option is se-
lected from the application print
dialog box, more pages than in-
tended may be printed.

❒ You can identify the file you want
to print by the User ID and the
time when the job was stored.

❒ The actual number of pages the
printer can save depends on the
contents of the print images. For
example, the printer can save up to
30 jobs or 1,000 pages. It depends
on the data volume.

❒ After the locked print file is print-
ed, the job in the printer is deleted
automatically.

Printing a Locked Print File

The following procedure describes
how to print a locked print file with
the PCL printer driver. For informa-
tion about how to print a locked print
file with the PostScript printer driver,
see the PostScript 3 Operating In-
structions Supplement included on
the CD-ROM. For more information
about RPCS printer driver, see Help.

AAAA From an application, select the
menu command to print.
The print dialog box appears.

BBBB Open the Printer Properties.

CCCC From the [Job Type:] box on the
[Setup] tab, select [Locked Print].

DDDD Click the [Details:] button.

EEEE In the [User ID:] box, type a User ID
of up to eight alphanumeric char-
acters.

Note
❒ This is used to identify the user

associated with a job.
❒ The User ID can consist of up to

eight alphanumeric (a-z, A-Z, 0-
9) characters.

FFFF In the [Password:] box, type a pass-
word of four digits.

Note
❒ The password must be four dig-

its (0-9).

GGGG Click [OK].

HHHH After making all desired settings,
click [OK].
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IIII Start printing from the applica-
tion's print dialog box.

The locked print job is sent to the
printer.

JJJJ On the printer's control panel,
press {{{{Menu}}}}.

"Menu" appears on the panel dis-
play.

KKKK Press {{{{TTTT}}}} or {{{{UUUU}}}} to display
"Locked Print" menu.

LLLL Press {{{{Enter #}}}}.

The following message appears on
the panel display.

MMMM Press {{{{TTTT}}}} or {{{{UUUU}}}} to display a file
you want to print, and then press
{{{{Enter #}}}}.
The following message appears on
the panel display.

NNNN Enter the password you entered
in step FFFF.

A Press {{{{UUUU}}}} or {{{{TTTT}}}} to enter the
leftmost digit of the password.

B Press {{{{Enter #}}}}.
The next digit appears.

Note
❒ If you want to change the

locked print file, press {{{{Es-
cape}}}}.

C Repeat steps AAAA and BBBB to enter
the remaining digit of the pass-
word, and the press {{{{Enter #}}}}.
If the password is not correct,
the following message appears
and the panel display returns to
the password menu. Reset or
reenter the password.

OOOO Press {{{{TTTT}}}} or {{{{UUUU}}}} to display "Print
File", and then press {{{{Enter #}}}}.

Note
❒ If you want to change the

locked print file, press {{{{Escape}}}}.

  Menu:

   Locked Print

  Locked Print

   08:56 ABCD1234

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Password:

  [0---]   

  Password:

  [1---]   

  Password:

  [*2--]

  Invalid Password

  Try Again
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PPPP Press {{{{Enter #}}}}.

The following message appears on
the panel display.

QQQQ Press {{{{Enter #}}}} to print the file.

Deleting the Locked Print File

AAAA Press {{{{Menu}}}}.

"Menu" appears on the panel dis-
play.

BBBB Press {{{{TTTT}}}} or {{{{UUUU}}}} to display the
"Locked Print" menu.

CCCC Press {{{{Enter #}}}}.

DDDD Press {{{{TTTT}}}} or {{{{UUUU}}}} to display the
file you want delete, and then
press {{{{Enter #}}}}.

EEEE Enter the password of the locked
print file.

A Press {{{{UUUU}}}} or {{{{TTTT}}}} to enter the
leftmost digit of the password.

B Press {{{{Enter #}}}}.

The next digit appears.

Note
❒ If you want to change the

locked print file, press {{{{Es-
cape}}}}.

  08:56 ABCD1234

  Press # to Print

  Processing...

   

  Menu:

   Locked Print

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Locked Print:  

   08:56 ABCD1234

  Password:

  [0---]   

  Password:

  [1---]   

  Password:

  [*2--]

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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C Repeat steps AAAA and BBBB to enter
the remaining password digits,
and then press {{{{Enter #}}}}.
If the password is not correct,
the following message appears
and the panel display returns to
the password menu. Reenter
the password.

FFFF Press {{{{TTTT}}}} or {{{{UUUU}}}} to display “De-
lete File”.

GGGG Press {{{{Enter #}}}}.
The following message appears on
the panel display.

Note
❒ If you want to change the

locked print file, press {{{{Escape}}}}.

HHHH Press {{{{Enter #}}}}.

The following message appears on
the panel display.

IIII Press {{{{On Line}}}}.

"Ready" appears on the panel dis-
play.

Checking the Error Log

Limitation
❒ You can view only the latest 20 er-

ror logs of all.

AAAA Press {{{{Menu}}}}.

"Menu" appears on the panel dis-
play.

BBBB Press {{{{TTTT}}}} or {{{{UUUU}}}} to display the
"Locked Print" menu.

  Invalid Password

  Try Again

  Select Action:

  Delete File

  08:56 ABCD1234

  Press# to Delete

  Deleted

   

  Ready

   

  Menu:  

   Locked Print

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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CCCC Press {{{{Enter #}}}}.

The following message appears on
the panel display.

DDDD Press {{{{TTTT}}}} or {{{{UUUU}}}} to display “Error
File(s)”.

EEEE Press {{{{Enter #}}}}.

The following message appears on
the panel display.

FFFF Press {{{{TTTT}}}} or {{{{UUUU}}}} to check "Error
File(s)", and then press {{{{Escape}}}}.

The following message appears on
the panel display.

Note
❒ Press {{{{Escape}}}} to return to the

previous menu.

GGGG Press {{{{On Line}}}}.

"Ready" appears on the panel dis-
play.

  Locked Print:

   08:56 ABCD1234

  Locked Print:

   Error File(s)

  Error File(s):

  06:52 ABCD1234

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Locked Print:

   Error File(s)

  Ready

   

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
ZDDS024N

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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5. Troubleshooting

Error & Status Messages on the Control 
Panel

Messages/Second messages Description Solution

Call Service: EC

Power Off On

/If Error Reoccur

Call Service

An error has occurred in the 
printer.

First, turn the power switch 
off and then on. If the message 
appears again, call your sales 
or service representative.

Change Setting 

Tray #

/Paper Size:

Paper Type:

The paper type and size set-
ting on the tray differs from 
the setting on the driver.

Load { paper size and type } 
paper with the selected feed 
direction into tray. Printing 
will not automatically resume 
if the paper type, size and di-
rection setting is incorrect. 
Make sure that the paper size, 
feed directions and paper type 
set in the printer driver and on 
the control panel are the same. 
There are two methods to 
resume printing.

A Use the control panel to set 
the correct paper type, size 
and direction of the paper 
in tray.

B Press {{{{Form Feed}}}} and se-
lect the tray with the con-
trol panel.

You can make to setting to 
print disregarding the error 
message.

Reference
See “Ppr.Size Error” in 
p.115 “Maintenance Menu 
Parameters”.

Cannot Check

Signal in Ad hoc

The signal strength for the 
wireless LAN cannot be 
checked because "Ad hoc" is 
selected in "Comm.Mode" for 
"IEEE 802.11b" in the Host In-
terface menu.

Change the Transmission 
mode to [Infrastructure] in the 
Host Interface settings.

Close Duplex

Unit Cover

The cover of the optional Du-
plex Unit is open.

Close the cover of the optional 
Duplex Unit.
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Close

Front Cover

The front cover is open. Close the front cover.

Close Rear/Paper 

Exit Cover

The paper exit cover or the 
rear cover is open.

Close the paper exit cover or 
the rear cover.

Close

Mailbox Cover

The cover of the Mailbox is 
open.

Close the cover of the Mail-
box.

Close Upper

Tray Cover

The cover of the output 1-bin 
Tray is open.

Close the cover of the output 
1-bin Tray.

Energy Save Mode The printer is in Energy Saver 
mode.

Wait for a while.

Hardware Problem DIM An error has occurred in the 
printer.

First, turn the power switch 
off and then on. If the message 
appears again, call your sales 
or service representative.

Hardware Problem

Ethernet

An error has occurred in the 
optional Network Interface 
Board.

First, turn off the power 
switch and then on. If the mes-
sage appears again, call your 
sales or service representative.

Turn off the power switch . 
Replace the Network Interface 
Board and turn on the power 
switch. See “Network Interface 
Board Type 2610” in the Setup 
Guide.

Turn off the power switch, re-
move the Network Interface 
Board and turn on the power 
switch.

Note
❒ If you remove the Net-

work Interface Board, you 
cannot print over the net-
work. You can send a print 
jobs to the printer only via 
a parallel cable connection.

Messages/Second messages Description Solution
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Hardware Problem

HDD

An error has occurred in the 
optional Hard Disk Drive.

First, turn the power switch 
off and then on, If the message 
appears again, call your sales 
or service representative.

Turn off the power switch. Re-
place the Hard Disk Drive and 
turn on the power switch. See 
“Hard Disk Drive Type 2600” in 
the Setup Guide.

Turn off the power switch. Re-
move the Hard Disk Drive 
and turn on the power switch.

Note
❒ If the Hard Disk Drive is 

not installed, you cannot 
send the sample print job, 
locked print job and 
download the font to Hard 
Disk Drive using the PS 
Utility for Mac.

Hardware Problem

IEEE1394

An error has occurred in the 
optional 1394 Interface Unit.

First, turn the power switch 
off and then on, If the message 
appears again, call your sales 
or service representative.

Turn off the power switch. Re-
place the 1394 Interface Unit 
and turn on the power switch. 
See “1394 Interface Unit Type 
4510” in the Setup Guide.

Turn off the power switch, re-
move the 1394 Interface Unit 
and turn on the power switch.

Note
❒ If you remove the 1394 In-

terface Unit, you cannot 
send print jobs via the 1394 
Interface Unit. You can 
only send print jobs to the 
printer via the parallel ca-
ble connection.

Hardware Problem

IEEE 802.11b

An error has occurred in the 
optional 802.11b Interface 
Unit.

Replace the IEEE 802.11b 
board.

Messages/Second messages Description Solution
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Hardware Problem

NV-RAM

An error has occurred in the 
printer.

First, turn the power switch 
off and then on. If the message 
appears again, call your sales 
or service representative.

Hardware Problem

Option RAM

An error has occurred in the 
optional Memory Unit.

First, turn the power switch 
off and then on. If the message 
appears again, call your sales 
or service representative.

Turn off the power switch, Re-
place the Memory Unit, and 
then turn on the power 
switch. See "Memory Unit 
TypeB 64MB" in the Setup 
Guide.

Turn off the power switch, re-
move the Memory Unit, and 
then turn on the power 
switch.

Note
❒ If you remove the Memory 

Unit, you must set up the 
option with the printer 
driver. If you are using 
Windows 95/98/Me, Win-
dows 2000/Windows XP 
and Windows NT 4.0, see 
"Installing the Printer Driver 
and Software" in the Setup 
Guide.

❒ In this case, you might not 
be able to print complex 
print jobs.

Hardware Problem

Shift Tray

An error has occurred in the 
shift motor of the shift tray.

First, turn the power switch 
off and then on. If the message 
appears again, call your sales 
or service representative.

Hardware Problem

Parallel I/F

An error has occurred in the 
parallel I/F.

If you use the parallel I/F, re-
place the interface cable that 
caused the error. If the mes-
sage appears again, contact 
your sales or service repre-
sentative.

Hardware Problem

USB

There is a problem related to 
the Universal Serial Bus Con-
nection and Hardware.

First, turn the power switch 
off and then on, If the message 
appears again, call your sales 
or service representative.

Messages/Second messages Description Solution
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HDD Full The maximum HDD area size 
for form/font has been ex-
ceeded.

Delete the disused form/font 
types.

HDD Full The optional Hard Disk Drive 
is full. The sample print job or 
locked print job to be sent 
from the computer is too large 
to store.

Delete any unnecessary stored 
files.

HDD Not Installed You cannot print the sample 
print and the locked print 
jobs, because the optional 
Hard Disk Drive is not in-
stalled.

Install the Hard Disk Drive. 
See “Hard Disk Drive Type 
2600” in the Setup Guide.

Hex Dump Mode The printer is in Hex Dump 
Mode.

Wait for a while. If the "Hex 
Dump Mode" message does 
not change, on the panel dis-
play press {{{{On Line}}}} to return 
to the "Ready" condition.

I/O Buffer Overflow There is too much data for the 
I/O buffer to handle.

Make sure the interface cable 
is inserted into the printer and 
your computer securely.

Make sure the interface cable 
is not damaged or broken.

Increase the size of the I/O 
buffer.

Invalid Password

Try Again

The password was not en-
tered correctly.

Wait for two seconds until the 
previous display appears. 
Then enter the password cor-
rectly.

Load Correct

Size Paper

/Press #

to Continue

The paper size setting on the 
tray differs from that of actual 
paper size in the tray.

Load { paper size } paper of 
the selected feed direction and 
paper size into the tray. Print-
ing will not automatically 
resume if the paper size and 
direction setting is incorrect. 
Make sure that the paper feed 
directions set in the printer 
driver and on the control pan-
el are the same. There are two 
methods to resume printing.

A Use the control panel to set 
the correct paper size and 
direction of the paper in 
tray. Then press {{{{Enter #}}}}.

B Press {{{{Form Feed}}}} and se-
lect the tray with the con-
trol panel.

Messages/Second messages Description Solution
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Load Paper

/Paper Size:

Paper Type:

The paper type and size set-
tings for this tray do not 
match the size and type of pa-
per actually loaded.

Load paper into the tray indi-
cated, then press {{{{Enter #}}}} to 
resume printing. Or press 
{{{{Form Feed}}}} and select the tray 
that holds a different type of 
paper. To cancel printing, 
press {{{{Job Reset}}}}. Then press 
{{{{Enter #}}}}.

Load Paper Tray #

/Paper Size:

Paper Type:

There is no paper left in this 
tray.

Load paper into the tray indi-
cated.

Menu Protected

Cannot Change

The menu is protected and the 
settings cannot be changed.

Wait for two seconds until the 
previous display appears.

No Files Exist There are no files available for 
the sample print job or the 
locked print job.

Wait for two seconds until the 
previous display appears.

Offline The printer is offline. If you want to bring the print-
er online. Press {{{{On Line}}}}.

Output Tray Changed The output tray has been 
changed. The tray in the paper 
feed path is not set correctly 
when the printer receives the 
print job.

Select the output tray correct-
ly.

Paper Invalid for Duplex:Tray 
#

/Change Setting

or Form Feed

A paper setting for the select-
ed tray is not supported for 
duplex printing.

#: tray number

Change the paper setting with 
the control panel. Or press 
{{{{Form Feed}}}} several times un-
til a tray with supported pa-
per settings appears on the 
panel display.

Or press {{{{Job Reset}}}} to cancel 
the print job.

P= XX I= XXXXXXXX

Power Off On

/If Error Reoccur

Call Service

A controller error. The SC 
number indicates the prob-
lem.

First, turn the power switch 
off and then on. If the message 
appears again, call your sales 
or service representative.

Print Overrun A Print overrun occurred on a 
file being printed. Only a part 
of the data on the page will be 
printed, and the print job is 
suspended, or the current 
print job has been canceled.

To print the image correctly, 
add memory to the printer or 
reduce the resolution of the 
image.

Printing... ——— Wait for a while.

Processing... The printer is processing in-
ternally.

Wait for a while.

Messages/Second messages Description Solution
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Ready The printer is online and 
ready to make prints.

If you want to take the printer 
offline, press {{{{On Line}}}}.

Remove Misfeed

Duplex Unit

/Open Duplex

Unit Cover

There is misfeed in the Duplex 
Unit.

Remove the misfed paper.

Remove Misfeed

Internal Path

/Open Front Cover

There is a misfeed in the print-
er.

Remove the misfed paper. See 
p.82 “Removing Misfed Pa-
per”.

Remove Misfeed

Mailbox

/Open

Mailbox Cover

There is a misfeed in the Mail-
box.

Remove the misfed paper.

Remove Misfeed

Paper Exit Cover

/Open Paper

Exit Cover

There is a misfeed in the paper 
exit cover.

Remove the misfed paper.

Remove Misfeed

Paper Tray

/Remove Misfeed

Paper Tray

There is a misfeed in the print-
er.

Remove the misfed paper. See 
p.82 “Removing Misfed Pa-
per”.

Remove Misfeed

Upper Tray Unit

/Open Upper

Tray Cover

There is a misfeed in the up-
per tray unit.

Remove the misfed paper.

Remove Paper

All Output Trays

All output trays are full, and 
the print job is suspended.

Remove paper from all output 
trays, and the print job will be 
resumed automatically.

Remove Paper

from Upper Tray

The upper tray is full, and the 
print job is suspended.

Remove paper from the upper 
tray, and the print job will be 
resumed automatically.

Remove Paper

Mailbox Tray #

The Mailbox is full, and the 
print job is suspended.

Remove paper from the Mail-
box, and the print job will be 
resumed automatically.

Remove Paper

Standard Tray

The standard tray is full, and 
the print job is suspended.

Remove paper from the stand-
ard tray, and the print job will 
be resumed automatically.

Replace

Maintenance Kit

It is time to replace parts in-
cluded in the Maintenance 
Kit. 

Replace parts. See p.144 
“MAINTENANCE KIT Type 
2600”.

Messages/Second messages Description Solution
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Replace

Toner Cartridge

The toner cartridge is not set 
correctly or toner is almost 
run out.

Set the toner cartridge correct-
ly. See p.90 “Replacing the 
Toner Cartridge”.

The toner dust is full. Prepare a new toner cartridge. 
If the image density gets too 
light, replace the toner car-
tridge with a new one. See 
p.90 “Replacing the Toner 
Cartridge”.

Reset Fusing

Unit Correctly

The fusing unit is not set cor-
rectly.

Set the fusing unit correctly, 
or set the proper fusing unit.

Reset Toner

Cartridge

The toner cartridge is not set 
correctly.

Set the toner cartridge correct-
ly. See p.90 “Replacing the 
Toner Cartridge”.

The toner cartridge is not set 
installed.

If the cartridge is installed, 
close the front cover and turn 
the off power switch and then 
on. If the message appears 
again, contact your sales or 
service representative.

Reset Tray #

Correctly

The input paper tray is not set 
correctly.

Set the input paper tray cor-
rectly.

Resetting Job... The print job is being reset. Wait for a while.

SC XXX-X

Power Off On

If Error Reoccur

Call Service

An error has occurred. First, turn the power switch 
off and then on. If the message 
appears again, call your sales 
or service representative.

SC2001 An error has occurred in the 
resident font RAM.

First, turn the power switch 
off and then on. If the message 
appears again, call your sales 
or service representative.

Toner Is Almost

Empty

The toner is almost run out. Prepare a new toner cartridge. 
If the image density gets too 
light, replace the toner car-
tridge with a new one. See 
p.90 “Replacing the Toner 
Cartridge”.

Waiting... The printer is waiting for the 
next print job.

Wait for a while.

Warming Up... The printer is warming up or 
toner is being supplied.

Wait until the panel display 
change the "Ready".

Messages/Second messages Description Solution
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Getting Printer Information over the Network

Printer current status

You can check the printer's status using the telnet command.

❖❖❖❖ telnet
Use the status command.

❖❖❖❖ UNIX
Use the lpq or lpstat command or stat parameter of rsh, rcp, or ftp.

Reference
For more information, see “Remote Maintenance by Telnet (mshell)” in the
Network Printing Guide is provided on the CD-ROM labeled “Operating
Instructions”.

Messages Description Comments

Call Service Center There is a malfunction in the 
printer.

Turn the printer off and on.

Cover Open: Duplex Unit The cover of the optional Du-
plex Unit is open.

Close the cover of the optional 
Duplex Unit.

Cover Open: Front Cover Close the front cover. Close the front cover.

Cover Open: Mailbox The cover of the Mailbox is 
open.

Close the cover of the Mailbox 
cover.

Cover Open: Paper Exit/Rear The paper exit cover or the 
rear cover is open.

Close the paper exit cover or 
the rear cover.

Cover Open: Upper Tray The upper tray cover is open. Close the upper tray cover.

Empty: Toner The toner cartridge is empty. Replace the new toner car-
tridge.

Energy Saver Mode The printer is in Energy Save 
Mode.

Wait for a while.

Energy Saver Mode 1

Error: HDD Board An error has occurred in the 
optional Hard Disk Drive.

First, turn the power switch 
off and then on. If the message 
appears again, call your sales 
or service representative.

IEEE 802.11b Card Error The optional IEEE 802.11b 
board or the optional IEEE 
802.11b card is not installed.

Install the optional IEEE 
802.11b board or the optional 
IEEE 802.11b card.

IEEE 802.11b Card or Board 
Error

An error has occurred in the 
optional IEEE 802.11b board 
or the optional IEEE 802.11b 
card

First, turn the power switch 
off and then on. If the message 
appears again, set the optional 
IEEE 802.11b board. If the 
message still appears, call 
your sales or service repre-
sentative.

Download from Www.Somanuals.com. All Manuals Search And Download.



Troubleshooting

70

5

NVRAM Error An error has occurred in the 
printer.

First, turn the power switch 
off and then on. If the message 
appears again, call your sales 
or service representative.

Error: IEEE 1394 Board An error has occurred in the 
optional 1394 Interface Unit.

First, turn the power switch 
off and then on. If the message 
appears again, call your sales 
or service representative.

Error: Memory Switch An error has occurred in 
printer.

First, turn the power switch 
off and then on. If the message 
appears again, call your sales 
or service representative.

Error: Optional RAM An error has occurred in the 
optional Memory Unit.

First, turn the power switch 
off and then on. If the message 
appears again, call your sales 
or service representative.

Error: Parallel I/F Board An error has occurred in the 
parallel interface board.

First, turn the power switch 
off and then on. If the message 
appears again, call your sales 
or service representative.

Full: Mailbox Tray 1 The output tray 1 of the op-
tional Mailbox is full.

Remove paper from the out-
put tray 1 of the optional Mail-
box.

Full: Mailbox Tray 2 The output Tray 2 of the op-
tional Mailbox is full.

Remove paper from the out-
put Tray 2 of the optional 
Mailbox.

Full: Mailbox Tray 3 The output Tray 3 of the op-
tional Mailbox is full.

Remove paper from the out-
put Tray 3 of the optional 
Mailbox.

Full: Mailbox Tray 4 The output tray 4 of the op-
tional Mailbox is full.

Remove paper from the out-
put tray 4 of the optional Mail-
box.

Full: Output Tray(s) All output trays are full. Remove paper from all output 
trays.

Full: Standard Output Tray The output tray is full. Remove paper from output 
trays.

Full: Waste Toner The toner is almost run out. Prepare a new toner cartridge.

Low: Toner The toner cartridge is not set 
correctly or toner is almost 
running out.

Set the toner cartridge correct-
ly. 

Mismatch: Paper Size The paper size setting of the 
tray differs from that of actual 
paper size in the tray.

Load paper of the indicated 
paper size into the paper tray 
being used. See p.25 “Paper 
and Other Media Supported 
by This Printer”.

Messages Description Comments
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Mismatch: Paper Size and 
Type 

The paper type setting of the 
tray differs from that of actual 
paper type in the tray.

Load paper of the indicated 
paper size and type into the 
paper tray being used. See 
p.25 “Paper and Other Media 
Supported by This Printer”.

Mismatch: Paper Type The paper type setting of the 
tray differs from that of actual 
paper type in the tray.

Load paper of the indicated 
paper type into the paper tray 
being used. See p.25 “Paper 
and Other Media Supported 
by This Printer”.

No Paper: Input Tray(s) There is no paper of the indi-
cated paper size in the paper 
tray.

Load paper into the paper 
tray. See p.37 “Loading Paper 
in the Paper Tray”.

Not Detected: Fusing Unit The fusing unit is not set cor-
rectly.

Set the fusing unit correctly. If 
the message appears again, 
call your sales or service rep-
resentative.

Not Detected: Input Tray(s) The input tray is not set cor-
rectly.

Set the input tray correctly. If 
the message appears again, 
call your sales or service rep-
resentative.

Not Detected: Toner Car-
tridge

The toner cartridge is not set 
correctly.

Set the toner cartridge correct-
ly. If the message appears 
again, call your sales or serv-
ice representative.

Paper Misfeed: Duplex Unit There is misfeed in the Duplex 
Unit.

Remove the misfed paper. See 
p.87 “When "Remove Misfeed 
Duplex Unit" Appears”.

Paper Misfeed: Front Cover There is misfeed in the printer. Remove the misfed paper. See 
p.83 “When "Remove Misfeed 
Internal Path/Open Front 
Cover" Appears”.

Paper Misfeed: Input Tray There is misfeed in the printer. Remove the misfed paper. See 
p.82 “When “Remove Misfeed 
Paper Tray” Appears”.

Paper Misfeed: Mailbox There is misfeed in the Mail-
box.

Remove the misfed paper. See 
p.89 “When "Remove Misfeed 
Mailbox" Appears”.

Paper Misfeed: Output Tray There is misfeed in output 
tray.

Remove the misfed paper. See 
p.84 “When "Remove Misfeed 
Paper Exit Cover" Appears”.

Ready The printer is on line and 
ready to make prints.

———

Messages Description Comments
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Replace Maintenance Kit It is time to replace parts in-
cluded in the Maintenance 
Kit. 

Replace parts. See p.144 
“MAINTENANCE KIT Type 
2600”.

Shift Tray Error An error has occurred in the 1-
bin Shift Sort Tray.

First, turn the power switch 
off and then on. If the message 
appears again, call your sales 
or service representative.

Size Media Mismatch The paper size setting of the 
tray differs from that of actual 
paper type in the tray.

Load paper of the indicated 
paper size and type into the 
paper tray being used. See 
p.25 “Paper and Other Media 
Supported by This Printer”.

Size Mismatch The paper size setting of the 
tray differs from that of actual 
paper type in the tray.

Load paper of the indicated 
paper size and type into the 
paper tray being used. See 
p.25 “Paper and Other Media 
Supported by This Printer”.

USB I/F Error An error has occurred in the 
USB interface. 

First, turn the power switch 
off and then on. If the message 
appears again, call your sales 
or service representative.

Warming Up/Adjusting... The printer is warming up or 
toner is being supplied.

Wait until the panel display 
change the "Ready".

Messages Description Comments
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Printer configuration

You can check the printer configuration using telnet.

❖❖❖❖ telnet
Use the info command.

❖❖❖❖ UNIX
Use the info parameter of rsh, rcp, or ftp.

Reference
For more information, see “Remote Maintenance by Telnet (mshell)” in the
Network Printing Guide is provided on the CD-ROM labeled “Operating
Instructions”.

Note
❒ “*” (asterisk) is displayed with the current setting.
❒ Regarding *1–*6, see below table.

❖❖❖❖ *1 Input Tray: Name

Item Description

Printer System Version of the printer

Network Board Version of the network board

Input Tray

No.

Name

PaperSize

Status

ID number of the paper tray

Name of the paper tray*1

Paper size loaded in the paper tray*2

Current status of the paper tray*3

Output Tray

No.

Name

Status

ID number of the output tray

Name of the output tray*4

Current status of the output tray*5

Emulation

No.

Name

Version

ID number of the emulation used by the print-
er

Name of the emulation used in the printer

Version of the emulation

Program

No.

Name

ID number of the program

Name of the program

Name Description

Tray X Name of installed paper tray. (X is the number 
of tray.)

Bypass Tray Bypass Tray
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❖❖❖❖ *2 Input Tray: Paper Size

Paper Size Description

A3 (297 × 420) A3 K

B4JIS (257 × 364) B4K

A4 (297 × 210) A4L

A4 (210 × 297) A4K

B5JIS (257 × 182) B5L

B5JIS (182 × 257) B5K

A5 (210 × 148) A5L

A5 (148 × 210) A5K

A6 (105 × 148) A6K

11 × 17 279 × 432K

81/2 × 14 LG/216 × 356K

11 × 81/2 LT/279 × 216L

81/2 × 11 LT/216 × 279K

51/2 × 81/2 140 × 216K

FRI Custom Size

101/2 × 71/4 101/2 × 71/4L

71/4 × 101/2 71/4 × 101/2K

81/4 × 13 81/4 × 13K

81/2 × 13 81/2 × 13K

41/8 × 91/2 41/8 × 91/2K

37/8 × 71/2 37/8 × 71/2K

110 × 220 41/3 × 83/4K

C5 Env(162 × 229) C5 EnvK

8 × 13 203 × 330K

C6 Env(114 × 162) C6 EnvK

8K (267 × 390) 8KK

16K (267 × 195) 16KL

16K (195 × 267) 16KK

NCS There is no tray.

** The paper size is not selected.
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❖❖❖❖ *3 Input Tray: Status

❖❖❖❖ *4 Output Tray: Name

❖❖❖❖ *5 Output Tray: Status

Status Description

Normal 

NoTray There is no paper tray

PaperEnd There is no paper in the paper tray

Name Description

Standard Tray Output Tray

1-bin Shift Tray 1-bin Shift Sort Tray

Mailbox Tray 1-4 Mailbox output tray 1-4

Status Description

Normal ----

PaperExist There is paper in the output tray

OverFlow Output tray is full of paper

Error Other error
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Printer Does Not Print

Possible Cause Solutions

Is the power on? Confirm that the cable is securely plugged into the power outlet 
and the printer. 

Turn on the power switch.

Does the On Line indica-
tor stay on?

Press {{{{On Line}}}} so the indicator lights.

Does the Error indicator 
stay red?

Check the error message on the panel display and take the re-
quired action.

Is paper loaded? Load paper into the paper tray or on the Bypass Tray. 

See p.37 “Loading Paper and Other Media”.

Can you print a configura-
tion page?

If you cannot print a test page, it probably indicates a printer mal-
function. You should contact your sales or service representative. 
See p.110 “List/Test Print Menu”.

If you can print a test page but cannot get the printer to print when 
you issue a print command from the computer, it probably means 
there is a problem with the computer.

Note that large or complex data might take a long time to be print-
ed.

Is the interface cable con-
necting the printer to the 
computer connected se-
curely?

Connect the interface cable properly. If there are any connectors or 
screws, confirm that they are fastened securely.

Are you using the correct 
interface cable?

The type of interface cable you should use depends on the compu-
ter. Be sure to use the correct one. 

If the cable is damaged or worn, replace it with a new one.

Is the paper feed roller 
clean?

Clean the paper feed roller if it is dirty. See p.94 “Cleaning the Pa-
per Feed Roller”.
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Possible Cause Solutions

Is the Data In indicator 
blinking or lit after starting 
the print job?

If not blinking or lit, the data is not being sent to the printer. 

❖❖❖❖ If the printer is connected to the computer using the in-
terface cable
Make sure the following printer port settings are correct:

• For a parallel port connection, port LPT1 or LPT2 should be 
set.

• For a USB port connection, port USB00 (n) *1  should be set.

• For a IEEE 1394 (SCSI print) port connection, port 
1394_00(n) *1  should be set.

*1 (n) is the number of printers connected.

• Windows 95/98/Me

A Click [Start], point to [Settings] and then click [Printers].

B Click to select the icon of the printer. Next, on the [File] 
menu, click [Properties].

C Click the [Details] tab.

D Check the [Print to the following port] box to confirm that 
the correct port is selected.

• Windows 2000

A Click [Start], point to [Settings] and then click [Printers].

B Click to select the icon of the printer. Next, on the [File] 
menu, click [Properties].

C Click the [Port] tab.

D Check the [Print to the following port] box to confirm that 
the correct port is selected.

• Windows XP

A Access the [Printers and Faxes] window from [Start] on 
the taskbar.

B Click to select the icon of the printer. Next, on the [File] 
menu, click [Properties].

C Click the [Port] tab.

D Check the [Print to the following port(s).] box to confirm 
that the correct port is selected.

• Windows NT 4.0

A Click [Start], point to [Settings] and then click [Printers].

B Click to select the icon of the printer. Next, on the [File] 
menu, click [Properties].

C Click the [Port] tab.

D Check the [Print to the following port] box to confirm that 
the correct port is selected.

❖❖❖❖ Network Connection
Contact your network administrator.
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Note
❒ If you cannot solve the problem by taking the preceding actions, contact your

sales or service representative.

Do you print via a net-
work?

Confirm that the "Ethernet" setting is correct from the control pan-
el. See p.130 “Host Interface Menu”.

The setting governs the data transfer speed used by the Network 
Interface Board. Three options are available: 

• Auto (default)

• 100 Mbps

• 10 Mbps

Note
❒ For more information about the appropriate setting to use on 

your network, contact your network administrator.

If you use IEEE 1394, check 
for the followings.

A Make sure the 1394 Interface Unit is installed properly.

B Make sure the IEEE 1394 cable is connected properly.

C Restart the computer.
If the problem still exists when SCSI print is used with Win-
dows 2000 and Windows XP, go to step D.

D Disconnect all the IEEE 1394 cables from the computer.

E If you uninstall the printer driver when the printer is connect-
ed to a computer with "SCSI print", the printer driver may not 
be uninstalled properly. To uninstall the driver properly, use 
the IEEE 1394 Printer Removal Utility on the CD-ROM that 
comes with the printer.
Stored in: CD-ROM labeled "Operating Instructions"\DRIV-
ERS\ UTILITY\1394\

Note
❒ For more information about the IEEE 1394 Printer Removal 

Utility, see the README file in the same folder as the pro-
gram.

F Restart the computer.

How is the signal strength 
when using the wireless 
LAN?

Check the signal strength from the Maintenance menu. If the sig-
nal is weak, move to a place with better signal strength or remove 
objects that are possibly interfering with data transmission.

The signal strength appears only in infrastructure mode. If you are 
using the ad hoc mode, the signal strength does not appear on the 
control panel. For more information about displaying the signal 
strength, see p.120 “Displaying the Signal Strength”.

Possible Cause Solutions
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Other Printing Problems

Status Possible Causes, Descriptions, and Solutions

The print side of the page is a 
hazy gray.

Adjust the image density.

See p.101 “Making Printer Settings with the Control Panel”.

If paper is curled, correct it.

If you continuously print data that contains extremely small 
amount of words or images in the printable area, the printed 
side of the page could be a hazy gray. Adjust the image den-
sity. See p.101 “Making Printer Settings with the Control 
Panel”.

Shaking the toner cartridge after pulling out the toner seal 
can cause dirt on paper surfaces, toner spillage, or printer 
failure. If you have accidentally shaken the toner cartridge, 
print some pages (about 50 pages) until the dirt disappear.

Image quality varies when 
printing on thick paper or on 
OHP transparencies.

Switch to Thick Paper mode. 

• When toner is not fused enough, set it to “On”. 

• When the image is blurred, set it to “----”.

See p.101 “Making Printer Settings with the Control Panel”.

Some parts of the print image 
are not clear.

Make the image density darker.

See p.101 “Making Printer Settings with the Control Panel”.

If Toner Saving mode is selected using the control panel, the 
whole image gets lighter. 

The print image is not clear. Due to a sudden change in temperature, condensation might 
appear inside the printer, reducing print quality. If this oc-
curs, when you move the printer from a cold room to a 
warmer room, do not use the printer until it acclimatizes to 
the temperature. 

Nothing is printed on the paper. Check if the tape of the toner cartridge is completely re-
moved. Be sure to remove the tape completely when replac-
ing the toner cartridge. See p.90 “Replacing the Toner 
Cartridge”.

Note
❒ If the power switch is turned on with the tape still at-

tached to the toner cartridge, the printer might be dam-
aged.

Multiple pages are fed through 
the printer at once.

Clean the friction pad if it is dirty. See p.93 “Cleaning the 
Friction Pad”.

Remove all paper from the tray and fan it gently to get air be-
tween the sheets. After that, load it back into the tray.

The image is printed on the re-
verse side of the paper.

Set the paper the other way up.
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Paper misfeeds occur frequent-
ly.

Check the paper size settings. The size set with the paper size 
dial might be different from the actual paper size. Make the 
correct dial setting. 

See p.37 “Loading Paper and Other Media”.

Use the recommended paper. Avoid using curled, folded, 
wrinkled, perforated or glossy paper. See p.35 “Paper not 
supported by this printer”.

Clean the paper feed roller, friction pad and/or registration 
roller, if they are dirty. See p.94 “Cleaning the Paper Feed 
Roller”.

Thin paper, if printed on both sides, may curl up at the cor-
ners and get wrinkled and clogged. Select [Curl Prevention] 
[ON] from the [Maintenance] menu.

The control panel error message 
stays on after removing the mis-
fed paper.

Open the front cover of the printer and then close it. See p.82 
“Removing Misfed Paper”.

Output are not delivered to the 
selected tray you require.

Check the paper size settings. The size selected with the pa-
per size dial might be different from the actual paper size. 
Make the correct dial setting.

See p.37 “Loading Paper and Other Media”.

When using the Bypass Tray, set the paper size using the 
control panel.

See p.37 “Loading Paper and Other Media”.

When you are using a Windows operating system, the print-
er driver settings override those set using the control panel. 
Set the desired output tray using the printer driver. See the 
driver's online Help file.

The printed image is different 
from the image on the compu-
ter.

When you use some functions, such as enlargement and re-
duction, the layout of the image might be different from that 
shown in the computer display.

It takes too much time to resume 
printing.

The data is so large or complex that it takes time to process 
it. If the Data In indicator is blinking, the data processing is 
being done. Just wait until it resumes.

Changing the paper feed direction may sometimes reduce 
the time to resume printing.

The image is printed in the 
wrong orientation.

Set the correct orientation under the “PCL Menu” with the 
control panel. See p.137 “PCL Menu”.

Confirm that the setting of orientation has been set in the ap-
plication you use.

Set the correct paper size and feed direction that matches 
tray settings on the RPCS printer driver.

Part of the image cannot be 
printed.

A paper size which is smaller than that selected in the appli-
cation is used for printing. Load the correct size of paper.

Status Possible Causes, Descriptions, and Solutions
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Note
❒ If the problem cannot be solved, contact your sales or service representative.

Network configurations you 
have made do not become effec-
tive.

Print a configuration page and check the network settings.

Printing from a Macintosh with 
the network standard model is 
slow.

Set the Ethernet speed of the machine to 10Mbps. If you want 
to use the machine with Macintosh at the Ethernet speed of 
100Mbps, call your sales or service representative.

See "Ethernet" in the Network Setup menu.

Status Possible Causes, Descriptions, and Solutions
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Removing Misfed Paper

When a paper misfeed occurs, an error message appears on the panel display.
The procedure you should follow to remove misfed paper depends on the loca-
tion of the misfeed, which is indicated on the panel display.

R CAUTION:

Important
❒ Check the following points if paper continues to misfeed.

• Confirm that the setting of the paper size dial matches the size and feed di-
rection of the paper loaded in the paper tray.

• If the friction pad or the paper feed roller is dirty, clean it. For more infor-
mation, see p.93 “Cleaning the Friction Pad”.

• Confirm that the toner cartridge is set correctly.
❒ If a paper misfeed still occurs, contact your sales or service representative.
❒ Forcefully removing misfed paper may cause paper to tear and leave scraps

of paper in the printer.
❒ Do not leave any scraps of paper in the printer.

When “Remove Misfeed Paper 
Tray” Appears

Important
❒ Forcefully removing misfed paper

may cause paper to tear and leave
scraps of paper in the printer. This
might cause a misfeed and damage
the printer.

AAAA Lift the paper tray slightly. Pull it
out until it stops, and then re-
move the misfed paper.

BBBB Carefully slide the paper tray into
the printer until it stops.

Important
❒ Do not slide the paper tray in

with force. If you do, the front
and side guides might move.

• When removing misfed paper, do not touch the fusing section because it 
becomes very hot. 

ZCEY280J

ZGDY290J
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CCCC Open the front cover by pushing
the front cover release button,
and then close it to reset the mis-
feed condition.

Note
❒ You can apply this procedure

for both the paper tray and the
optional Paper Feed Unit.

❒ To reset the misfeed condition,
open and close the front cover,
then the indicator will be off.

When "Remove Misfeed 
Internal Path/Open Front 
Cover" Appears

Important
❒ Forcefully removing misfed paper

may cause paper to tear and leave
scraps of paper in the printer. This
might cause a misfeed and damage
the printer.

AAAA Open the front cover by pushing
the front cover release button.

BBBB While lifting the front side of the
toner cartridge, pull it out of the
printer.

Important
❒ Be sure to put the toner car-

tridge on a stable, flat surface.
❒ Do not hold the toner cartridge

upside down or stand it verti-
cally.

CCCC Pull out the misfed paper by
holding both sides of paper. Be
careful not to get toner dust on
your hands or clothes.

ZGDY300J

ZCEH120J

ZGDT110J

ZGDY520J
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DDDD Holding the grips of the toner car-
tridge, insert it into the printer
until it stops.

EEEE Push down the toner cartridge to
settle it in appropriate position.

FFFF Close the front cover.

Important
❒ If paper is fed from the Bypass

Tray, be sure to remove all the
paper from the Bypass Tray and
close it before opening the front
cover.

When "Remove Misfeed Paper 
Exit Cover" Appears

R CAUTION:

Important
❒ Forcefully removing misfed paper

may cause paper to tear and leave
scraps of paper in the printer. This
might cause a misfeed and damage
the printer.

AAAA If you installed the 1-bin Shift
Sort Tray, slide the upper tray out
from it. If you installed the Mail-
box, slide the output tray into
lower slide out from it.
The following procedures are ex-
ample of Mailbox.

ZGDT120J

ZGDT140J

ZGDH130J

• When removing misfed paper, 
do not touch the fusing section 
because it becomes very hot.

• The fusing unit becomes very 
hot. When installing the new fus-
ing unit, turn off the printer and 
wait about an hour. After that, in-
stall the new fusing unit. Not 
waiting for the unit to cool down 
can result in a burn.

ZGDY370J
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BBBB Open the paper exit cover.

CCCC Remove the misfed paper.

DDDD Close the paper exit cover until it
clicks.

EEEE If the misfed paper is in the fus-
ing unit, remove it.

A Open the rear cover by push-
ing the two knobs.

B Remove the rear cover in a hor-
izontal direction.

FFFF Lift the lock levers of the fusing
unit as shown in the illustration.

ZGDY390J

ZGDY380J

ZGDY400J

ZGDX210J

ZGDX220J

ZGDX222N
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GGGG Pull the fusing unit out.

HHHH While holding the tab, remove
the misfed paper.

Important
❒ Do not touch the metal part of

the fusing unit. It becomes very
hot. Touching it could result in a
burn.

IIII Insert the fusing unit until it
stops.

JJJJ Push the lock levers of the fusing
unit down until it clicks.

KKKK Insert the rear cover to the inside
grooves on both sides of the print-
er in a horizontal direction.

LLLL Close the rear cover.

ZGDX223N

ZGDY410J

ZGDX224N

ZGDX225N

ZGDX221J

ZGDX211N
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When "Remove Misfeed 
Duplex Unit" Appears

R CAUTION:

Important
❒ Forcefully removing misfed paper

may cause paper to tear and leave
scraps of paper in the Dupelx Unit.
This might cause a misfeed and
damage the printer.

AAAA  Remove the misfed paper inside
of the cover.
A Open the rear cover of the Du-

plex Unit.

B Remove the misfed paper.

C Close the rear cover of the Du-
plex Unit.

D While lifting the lever (AAAA),
open the cover of the Duplex
Unit (BBBB).

E Remove the misfed paper.

• When removing misfed paper, 
do not touch the fusing section 
because it becomes very hot.

ZGDY310J

ZGDY320J

ZGDY330J

ZGDY340J

ZGDY350J
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F Close the cover of the Duplex
Unit.

If the error message appears
again, go to step B.

BBBB Pull the Duplex Unit out of the
printer until it stops, and remove
the misfed paper.
A Push down the lever on the

right side of the Duplex Unit
(AAAA) and pull it out until it stops
(BBBB).

B Lift the guide board inside the
Duplex Unit, and remove the
misfed paper.

Important
❒ When A5L paper misfeeds,

you might not be able to re-
move it by pulling the Du-
plex Unit out. In this case,
pull the paper tray out and
remove the paper.

C While aligning the power cord
with the groove of the left slide
of the Duplex Unit, insert the
Duplex Unit into back of the
printer aligning the rails inside
of the printer until it is con-
nected.
If the error message appears
again, the misfed paper might
be left in the printer. Confirm
that any torn paper scraps are
not in the inside of the printer.
For more information, see p.83
“When "Remove Misfeed Inter-
nal Path/Open Front Cover"
Appears”.

ZGDY360J

ZGDX320J

ZGDY440J

ZGDX240J
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When "Remove Misfeed 
Mailbox" Appears

Important
❒ Forcefully removing misfed paper

may cause paper to tear and leave
scraps of paper in the Mailbox.
This might cause a misfeed and
damage the printer.

AAAA Open the cover of the Mailbox.

BBBB Remove the misfed paper.

CCCC Close the cover of the Mailbox.

When "Remove Misfeed Upper 
Tray Unit" Appears

Important
❒ Forcefully removing misfed paper

may cause paper to tear and leave
scraps of paper in the 1-bin Shift
Sort Tray. This might cause a mis-
feed and damage the printer.

AAAA Open the upper tray cover.

BBBB Remove the misfed paper.

CCCC Close the upper tray cover.

ZCEY460J

ZCEY470J

ZCEY480J

ZCEY490J

ZCEY500J

ZCEY510J
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Replacing the Toner Cartridge

R WARNING:

R CAUTION:

When “Replace Toner Cartridge” ap-
pears on the panel display, the toner
is almost empty. Prepare a new toner
cartridge. If the image density gets
too light, replace the toner cartridge
with a new one.

Important
❒ Do not expose the toner cartridge

to light for a long time. Do not
leave the front cover open for a
long time. If the toner cartridge is
exposed to a light for a long time,
the toner cartridge might be dam-
aged and print quality might be re-
duced.

Note
❒ Do not stand or place the toner car-

tridge upside-down.
❒ The actual number of printed pag-

es you get from a particular toner
cartridge depends on the type and
size of paper you are using, the
contents of the print images, and
printing environment conditions.
All this means that a toner car-
tridge might require replacement
sooner than the normal life de-
scribed on p.164 “Consumables”.

AAAA Open the front cover by pushing
the front cover release button.

• Do not incinerate spilled toner 
or used toner. Toner dust 
might ignite when exposed to 
an open flame.

• Disposal can take place at our 
authorized dealer or at appro-
priate collection sites.

• If you dispose the used toner 
cartridges yourself, dispose 
of them according to your lo-
cal regulations.

• The inside of the machine could 
be very hot. Do not touch the 
parts with a label indicating "v" 
(means hot surface). Touching 
"v" (means hot surface) could 
result in a burn.

• Do not eat or swallow toner.

• Keep toner (used or unused) and 
toner cartridges out of reach of 
children.

• Our products are engineered to 
meet the highest standards of 
quality and functionality. When 
purchasing expendable sup-
plies, we recommend using only 
those specified by an authorized 
dealer.

ZCEH120J

Download from Www.Somanuals.com. All Manuals Search And Download.



Replacing the Toner Cartridge

91

5

BBBB Be sure to put the toner cartridge
on a stable, flat surface.

Note
❒ Do not put the toner cartridge

on an unstable or tilted surface.

CCCC Wipe around the metallic regis-
tration roller by turning with a
soft damp cloth.

Important
❒ Do not use chemical cleaner or

organic solvent such as thinner
or benzene.

DDDD Take the new toner cartridge from
the box.

EEEE Place the toner cartridge on a flat
surface. Pull out the tape inside
the unit horizontally while hold-
ing the cartridge with one hand as
shown in the illustration.

Note
❒ Be sure to remove the tape com-

pletely before installing the new
toner cartridge, otherwise the
printer might be damaged.

❒ Keep the toner cartridge hori-
zontal when pulling out the ton-
er seal. Pulling out the toner seal
with the cartridge upright or
tilted can cause printer failure.

❒ Be careful not to get toner dust
on your hands or clothes.

❒ Do not shake or shock the toner
cartridge after pulling out the
toner seal to avoid dirt on paper
surfaces, toner spillage, or
printer failure.

FFFF Holding the grips of the cartridge,
insert it into the printer until it
stops.

ZGDT110J

ZCEX461J

ZCET151J

ZGDT120J
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GGGG Push down the toner cartridge to
settle it in appropriate position.

HHHH Close the front cover.

Important
❒ Do not close the front cover

with force. If you cannot close
the cover easily, pull out the
toner cartridge from the printer
and insert it again. After that,
close the front cover again.

ZGDT140J

ZGDH130J
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Cleaning and Adjusting the Printer

Cleaning the Friction Pad

If the friction pad is dirty, a multi-
feed or a misfeed might occur. In this
case, clean the pad as follows:

AAAA Lift the paper tray slightly then
pull it out until it stops, and while
lifting the front side of the tray,
pull it out of the printer.

BBBB Place the tray on a flat surface.
When there is paper in the tray,
remove paper.

CCCC Wipe the brown part of the fric-
tion pad with a soft damp cloth.
After that, wipe it with a dry cloth
to remove the water.

Important
❒ Do not use chemical cleaner or

organic solvent such as thinner
or benzene.

DDDD Load paper into the paper tray
with the print side up. Carefully
slide the paper tray into the print-
er until it stops.

Important
❒ Do not slide the paper tray in

with force. If you do, the front
and side guides might move.

Note
❒ If misfeeds or multi-feeds of pa-

per occur after cleaning the fric-
tion pad, contact your sales or
service representative.

❒ Follow the same procedure to
clean the friction pad of the op-
tional Paper Feed Unit and the
Envelope Feeder Unit.

ZCEY140J

TS3Y250E

ZCEY150J
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Cleaning the Paper Feed 
Roller

If the paper feed roller is dirty, a mis-
feed might occur. In this case, clean
the roller as follows:

R CAUTION:

Important
❒ The following are examples of

cleaning the paper feed roller on
the paper tray.

❒  You can clean the paper feed roller
on the optional Paper Feed Unit by
following the procedures below.
The paper feed roller on the op-
tional Paper Feed Unit differs from
the one on the paper tray. Confirm
the type of paper feed roller you
are installing.

AAAA Turn off the power switch.

BBBB Pull out the plug from the socket.
Remove all the cables from the
printer.

CCCC Lift the paper tray slightly then
pull it out until it stops, and while
lifting the front side of the tray,
pull it out of the printer.

DDDD Move the printer to the edge of a
stable table or desk.

Important
❒ Do not put the printer on an un-

stable or tilted surface.
❒ If the printer is equipped with

the optional Paper Feed Unit,
do not move the printer and
unit together as they are not se-
curely attached.

❒ When lifting the printer, con-
firm that the optional Paper
Feed Unit is not attached to the
printer.

• When lifting the printer, use the 
grips on both sides of the printer, 
otherwise the printer might fall 
and cause personal injury.

• When you move the printer, un-
plug the power cord from the wall 
outlet to avoid a fire or an electric 
shock.

• When you pull out the plug from 
the socket, grip the plug to avoid 
damaging the cord and causing 
a fire or an electric shock.

ZCEM200E

For  the paper tray For  the Paper  Feed Unit

ZCEY140J

ZGDM110J
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EEEE Slide the green lock lever to the
left (AAAA), so that the paper feed
roller can be released (BBBB).

FFFF Wipe the rubber part of the roller
with a soft damp cloth. After that,
wipe it with a dry cloth to remove
the water.

Important
❒ Do not use chemical cleaner or

organic solvent such as thinner
or benzene.

GGGG While sliding the green lock lever
to the left (AAAA), set the paper feed
roller to its original position (BBBB).
After that, return the green lock
lever to its original position (CCCC).

Note
❒ Confirm that the green lock le-

ver secures the roller correctly
by confirming that the roller ro-
tates smoothly.

HHHH Move the printer to the place
where it was placed. Carefully
slide the paper tray into the print-
er until it stops.

Important
❒ Do not slide the paper tray in

with force. If you do, the front
and side guides might move.

IIII Insert the plug of the power cord
into the wall socket securely.
Connect all the cables that were
removed in step BBBB.

JJJJ Turn on the power switch.

Note
❒ Follow the same procedure to

clean the paper feed roller of the
optional Paper Feed Unit.

ZGDM120J

ZCEM130J

ZCEY150J
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Cleaning the Registration 
Roller

If the registration roller is dirty, a mis-
feed might occur. In this case, clean
the roller as follows:

R WARNING:

R CAUTION:

AAAA Turn off the power switch.

BBBB Open the front cover by pushing
the front cover release button. 

CCCC Pull the toner cartridge out of the
printer by holding the grips of the
cartridge.

Note
❒ Do not hold the toner cartridge

upside down or stand it verti-
cally.

❒ Do not put the toner cartridge
on an unstable or tilted surface.

DDDD Wipe around the metallic regis-
tration roller by turning with a
soft damp cloth.

Important
❒ Do not use chemical cleaner or

organic solvent such as thinner
or benzene.

• Be sure to turn off the power 
switch and wait for about 30 
minutes before cleaning the 
registration roller. Not waiting 
for the printer to cool down 
can result in a burn.

• The inside of the machine could 
be very hot. Do not touch the 
parts with a label indicating "v" 
(means hot surface). Touching 
"v" (means hot surface) could 
result in a burn.

ZCEH120J

ZGDT110J

ZCEX461J
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EEEE Holding the grips of the toner car-
tridge, insert it into the printer
until it stops.

FFFF Push down the toner cartridge to
settle it in appropriate position.

GGGG Close the front cover.

Important
❒ Carefully close the front cover.

If you cannot close the cover
easily, pull the toner cartridge
out of the printer and insert it
again. After that, close the front
cover again.

HHHH Turn on the power switch.

Adjusting the Image Density

You can adjust the image density
when the print side of the page is a
shaded or print image is too light.

Important
❒ Extreme settings may create print-

outs that appear dirty.
❒ Image density settings should be

made from the application or the
printer driver whenever possible.

AAAA Press {{{{Menu}}}}.

"Menu" appears on the panel dis-
play.

BBBB Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the
"Maintenance" menu, and then
press {{{{Enter #}}}}.

The following message appears on
the panel display.

ZGDT120J

ZGDT140J

ZGDH130J

  Maintenance:

   Image Density

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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CCCC Press {{{{Enter #}}}}.

DDDD Press {{{{UUUU}}}} or {{{{TTTT}}}} to set the image
density value.

Note
❒ To maintain a darker image un-

der high volume printing condi-
tions, we highly recommended
that you select 3 from the con-
trol panel.

❒ You can adjust the image densi-
ty in seven steps from -3 to +3.
Increasing the value makes the
printouts darker and decreasing
the value makes the printouts
lighter.

EEEE Press {{{{Enter #}}}}.

FFFF Press {{{{On Line}}}}.

"Ready" appears on the panel dis-
play.

Adjusting the Registration of 
the Trays

You can adjust the registration of
each tray. The vertical adjustment is
used for all trays. Normally, you need
not update the registration. But when
the optional Paper Feed Unit or the
Duplex Unit is installed, updating the
registration is useful in some case.
The following procedure describes
how to adjust Tray 1. You can use the
same procedure to adjust the other
tray as well.

AAAA Press {{{{Menu}}}}.

"Menu" appears on the panel dis-
play.

  Image Density:

  (-3 +3)       0

  Ready

   

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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BBBB Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the
"Maintenance" menu, and then
press {{{{Enter #}}}}.

CCCC Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "Reg-
istration", and then press {{{{Enter
#}}}}.

The following message appears on
the panel display.

DDDD Print the test sheet to preview the
settings you have made.

A After confirming that "Prt. Test
Sheet" is on the panel display,
press {{{{Enter #}}}}.
The following message appears
on the panel display.

B Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the
tray you want to adjust, and
then press {{{{Enter #}}}} to print the
test sheet. Wait for a few sec-
onds.

The following message appears
on the panel display.

EEEE Adjust the registration by con-
firming the position of the print-
ed image of the test sheet.

The following is an example of ad-
justing the margin on the test sheet
equally.
A Press {{{{UUUU}}}} or {{{{TTTT}}}} to display

"Adjustment", and then press
{{{{Enter #}}}}.

The following message appears
on the panel display.

B Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the
tray you want to adjust, and
then press {{{{Enter #}}}}.
The following message appears
on the panel display.

  Maintenance:

   Image Density

  Registration:

   Prt. Test Sheet

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

ZCEX480J

  Prt. Test Sheet

   Tray 1

  Printing...

   

  Adjustment:

   Horiz.: Tray 1

  Horiz.: Tray:

  (-4.0 +4.0)   0
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C Press {{{{UUUU}}}} or {{{{TTTT}}}} to set the dig-
it of the registration value
(mm).

Note
❒ Increase the value to shift the

print area to the positive di-
rection, and decrease to shift
to the negative direction.

❒ Pressing {{{{UUUU}}}} or {{{{TTTT}}}} makes
the value increase or de-
crease by 0.5 mm step.

D Press {{{{OK}}}}.

FFFF Print the test sheet to check the
settings you have made.

GGGG Repeat steps CCCC and DDDD to adjust the
registration if necessary.

HHHH Press {{{{On Line}}}}.

“Ready” appears on the panel dis-
play.

  Ready

   

TS3X001N

Printable area

The vertical

Fe
ed

 d
ire

ct
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The
horizonal

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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6. Making Printer Settings with
the Control Panel

Menu Chart

This section describes how to change the default settings of the printer and pro-
vides information on the parameters included in each menu. Some items in the
menu appear only when certain options are installed.

Category Function menu

Sample Print *1  ⇒ p.51 Select Action / Error File(s)

Locked Print *1  ⇒ p.56 Select Action / Error File(s)

Paper Input⇒ p.106 Bypass Size

Tray Paper Size

Paper Type

Tray Locking

Tray Priority

List/Test Print⇒ p.110 Config. Page

Menu List

PS Font List

PCL Config.Page

Hex Dump

Maintenance⇒ p.114 Image Density

Registration

Curl Prevention

ROM Update *2 

HDD Format

WL.LAN Signal *3 

WL.LAN Defaults

Key Repeat

Menu Protect *4 

Series Prnt.Job *4 

Ppr.Size Error *4 
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*1 The “Sample Print” menu and the “Locked Print” menu appear only when the op-
tional Hard Disk Drive is installed.

*2 ROM Update is not currently used.

System⇒ p.124 MisfeedRecovery

Prt. Err Report

Auto Continue

Memory Overflow

Sub Paper Size

Page Size

Edge-Edge Print

Duplex *5 

Output Tray

Job Separation

Energy Saver

Memory Usage

Unit Of Measure

Edge Smoothing

Resolution

Toner Saving

Spool Printing

Host Interface⇒ p.130 I/O Buffer

I/O Timeout

Network Setup

IEEE 1394 Setup *6 

IEEE 802.11b *7 

USB Setting *4 

PCL Menu⇒ p.137 Orientation

Form Lines

Font Source

Font Number

Point Size

Font Pitch

Symbol Set

Ext. A4 Width

Language⇒ p.141

Category Function menu
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*3 The "WL.LAN Signal" menu appears only when "IEEE 802.11b" is selected in "LAN
Type" in the Host Interface menu.

*4 While the printer is On Line, press {{{{Enter #}}}}, and then press {{{{Escape}}}}. Finally, press
{{{{Menu}}}}. You can access the "Menu Protect", "Series Prnt.Job", "Ppr.Size Error", and
"USB Setting" on the panel display.

*5 The “Duplex” menu appears only when the optional Duplex Unit is installed.
*6 The “IEEE 1394 Setup” menu appears only when the optional 1394 Interface Unit is

installed.
*7 The “IEEE 802.11b Setup” menu appears only when the optional 802.11b Interface

Unit is installed.
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Accessing the Main Menu

Press {{{{Menu}}}}, and “Menu” appears on the panel display.

This menu shows the following nine items which can be displayed one by one
pressing {{{{UUUU}}}} or {{{{TTTT}}}}.
• Sample Print
• Locked Print
• Paper Input
• List/Test Print
• Maintenance
• System
• Host Interface
• PCL Menu
• Language

Note
❒ "Sample Print" and "Locked Print" appear only when the optional Hard Disk

Drive is installed.
❒ {{{{TTTT}}}}: Press to go to the next page.
❒ {{{{UUUU}}}}: Press to go back to the previous page.

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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❒ After making the printer settings, be sure to return to the previous menu by
pressing {{{{Escape}}}}.

❒ After making the printer settings, press {{{{On Line}}}} to return to the “Ready”
condition.

❒ The revised settings are not canceled even if the power switch is turned off.

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
ZDDS024N

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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Paper Input Menu

There are five menu items in the “Paper Input” menu.
• Bypass size
• Tray Paper Size
• Paper type
• Tray Locking
• Tray Priority

Reference
For more information about loading paper in the tray, see p.37 “Loading Pa-
per and Other Media”.

Paper Input Parameters

Menu Description

Bypass Size The paper size for the Bypass Tray.

For more information about paper sizes that can be set in the By-
pass Tray, see p.25 “Paper and Other Media Supported by This 
Printer”.

Tray Paper Size The paper size for each tray.

When you select sizes that are not indicated on the paper size dial 
of Tray 1, Tray 2 or Tray 3, you should set the dial to “p” and 
then select the paper size here.

❖❖❖❖ Tray 1
For more information about paper sizes that can be set in the 
Tray 1, see p.25 “Paper and Other Media Supported by This 
Printer”.

❖❖❖❖ Tray 2
For more information about paper sizes that can be set in the 
Tray 2, see p.25 “Paper and Other Media Supported by This 
Printer”.

❖❖❖❖ Tray 3
For more information about paper sizes that can be set in the 
Tray 3, see p.25 “Paper and Other Media Supported by This 
Printer”.

Note
❒ Only the installed trays appear on the panel display.
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Paper Type If you use different kinds of paper, you set the paper type for Tray 
1, Tray 2, Tray 3 or Bypass Tray.

❖❖❖❖ Tray 1, Tray 2, Tray 3
Plain Paper, Recycled Paper, Special Paper, Color Paper, Let-
terhead, Preprinted, Prepunched, Bond paper, Cardstock

❖❖❖❖ Bypass Tray
Plain Paper, Recycled Paper, Special Paper, Color Paper, Let-
terhead, Preprinted, Prepunched, Labels, Bond paper, Card-
stock, Transparency, Thick Paper

Note
❒ Default : Plain Paper

❒ Only the installed trays appear on the panel display.

Tray Locking If you use different kinds of paper, you can lock a tray to prevent 
printing on wrong paper such as letterhead or colored paper. 
When "Auto Select" is selected in the Paper Source selections from 
the printer driver, the locked tray will not be used.

Tray 1, Tray 2, Tray 3, Bypass Tray

Note
❒ Only the installed trays appear on the panel display.

❒ You can lock multiple trays.

❒ If you want to use the locked tray, you must select the tray 
from the printer driver.

❒ When a locked tray is selected from the printer driver, the 
printer does not search for another tray.

Tray Priority You can set priority tray for paper feed when "Auto tray Selected" 
is selected in the Paper Source selections from the printer driver. 
When printing from DOS, the tray selected here is used when no 
tray is selected for a print job.

Tray 1, Tray 2, Tray 3, Bypass Tray

Note
❒ Default : Tray 1

❒ Only the installed trays appear on the panel display.

❒ It is recommended that you load paper of the size and direc-
tion you most frequently use in the tray selected with "Tray 
Priority".

Menu Description
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Changing the Paper Input Menu

AAAA Press {{{{Menu}}}}.

“Menu” appears on the panel display.

BBBB Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the “Paper Input” menu.

CCCC Press {{{{Enter #}}}}.

DDDD Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “Tray Priority”.

EEEE Press {{{{Enter #}}}}.

The following message appears on the panel display.

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Menu:

   Paper Input

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Paper Input:

   Tray Priority

  Tray Priority:

  *Tray 1
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FFFF Press {{{{UUUU}}}} or {{{{TTTT}}}} to select the tray type you want to use.

GGGG Press {{{{Enter #}}}}. Wait for a few seconds.

HHHH Press {{{{On Line}}}}.

 “Ready” appears on the panel display.

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Ready
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List/Test Print Menu

There are five menu items in the “List/Test Print” menu.
• Config. Page
• Menu List
• PS Font List
• PCL Config.Page
• Hex Dump

List/Test Print Parameters

Printing a Configuration Page

Reference
For more information, see p.112 “Interpreting the Configuration Page”.

AAAA Press {{{{Menu}}}}.

“Menu” appears on the panel display.

Menu Description

Config. Page You can print the current configuration of the printer. See p.110 
“Printing a Configuration Page”. 

Menu List You can print the Menu List which shows the function menus of 
this printer.

PS Font List You can print the current configuration and installed PS font list 
of PostScript.

PCL Config.Page You can print the current configuration of PCL.

Hex Dump You can print the data sent by the computer using the Hex Dump 
mode.

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
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BBBB Press {{{{TTTT}}}} or {{{{UUUU}}}} to display the “List/Test Print” menu.

CCCC Press {{{{Enter #}}}}.

The following message appears on the panel display.

DDDD Press {{{{Enter #}}}}.

The following message appears on the panel display.

The configuration page will be printed in a short time.

Important
❒ If you cannot print a configuration page correctly, check for an error mes-

sage on the panel display. For more information about error messages, see
p.61 “Error & Status Messages on the Control Panel”.

  Menu:

   List/Test Print

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  List/Test Print:

   Config. Page

  Printing...
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EEEE Press {{{{On Line}}}}.

“Ready” appears on the panel display.

Interpreting the Configuration Page

System Reference

❖❖❖❖ Printer ID
Shows the serial number assigned to the board by its manufacturer.

❖❖❖❖ Firmware Version
• Firmware

Shows the version number of the printer firmware.
• Engine

Shows the version number of the printer engine.
• NCS

Shows the version number of the Network interface.

❖❖❖❖ Pages Printed
Shows the total number of pages printed by the printer to date.

❖❖❖❖ Total Memory
Shows the total amount of memory (SDRAM) installed on the printer.

❖❖❖❖ Printer Language
Shows the version number of the printer driver language.

❖❖❖❖ Controller Option
The item(s) appears when the controller option(s) is installed.

❖❖❖❖ Options
Shows the optional trays that you installed.

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Ready
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Paper Input

Shows the settings made under the “Paper Input” menu.

Reference
For more information, see p.106 “Paper Input Menu”.

Maintenance

Shows the settings made under the “Maintenance” menu.

Reference
For more information, see p.114 “Maintenance Menu”.

System

Shows the settings made under the “System” menu. 

Reference
For more information, see p.124 “System Menu”.

PCL Menu

Shows the settings you made under the “PCL Menu”. 

Reference
For more information, see p.137 “PCL Menu”.

Host Interface

Shows the settings you made under the “Host Interface” menu. 
When DHCP is active on the network, the actual IP Address, Subnet Mask and
Gateway Address appear in parentheses on the configuration page.

Reference
For more information about “Host Interface” menu, see p.130 “Host Interface
Menu”.

Interface Information

Shows the interface information.

Error Log

Shows the log of printer errors.
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Maintenance Menu

There are 11 menu items in the “Maintenance” menu.
• Image Density
• Registration
• ROM Update
• Curl Prevention
• HDD Format
• WL.LAN Signal
• WL.LAN Defaults
• Key Repeat
• Menu Protect
• Series Prnt.Job
• Ppr.Size Error

Note
❒ “HDD Format” appears only when the optional Hard Disk Drive is installed.

For more information, see “Hard Disk Drive Type 2600” in the Setup Guide.
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Maintenance Menu Parameters 

Menu Description

Image Density You can select the print image density.

-3 to 3

Reference
For more information, see p.97 “Adjusting the Image Densi-
ty”.

Registration ❖❖❖❖ Prt. Test Sheet
You can print the registration test sheet.
Tray 1, Tray 2, Tray 3, Bypass Tray, Duplex backside

Note
❒ Default : Tray 1

❒ Only the installed trays appear on the panel display.

❖❖❖❖ Adjustment
You can select the start position for printing on a page.
Horiz.: Tray 1, Horiz.: Tray 2, Horiz.: Tray 3, Horiz.: Bypass, 
Horiz.: Dup.Back, Vert.: All Trays, Vert.: Dup.Back
-4 to 4

Note
❒ Default : Horiz.: Tray 1

❒ The registration value is not a default.

❒ Only the installed trays appear on the panel display.

Reference
For more information, see p.98 “Adjusting the Registration 
of the Trays”.

Curl Prevention You can control the fuser temperature to prevent paper from curl-
ing.

Note
❒ Default: Off

❒ Use this mode only when paper misfeed occurs frequently 
during duplex printing.

ROM Update This menu is not currently used.

HDD Format After installing the Hard Disk Drive, format it.

Note
❒ This menu appears only when the optional Hard Disk Drive is 

installed.

Reference
For more information about formatting the Hard Disk Drive, 
see p.119 “Formatting Hard Disk Drive Type 2600”.
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*1 While the printer is Online, press {{{{Enter #}}}}, and then press {{{{Escape}}}}. Finally, press
{{{{Menu}}}}. You can access the "Menu Protect", “Series Prnt.Job” and “Ppr. Size Error”
menu on the panel display.

WL. LAN Signal You can check the signal strength when using the wireless LAN. 

Reference
For more information about displaying the signal strength, see 
p.120 “Displaying the Signal Strength”.

WL. LAN Defaults You can reset the wireless LAN settings to the default.

Key Repeat You can scroll through the menu by holding this key down.

Note
❒ Default: On

Menu Protect *1 This procedure lets you protect menu settings against accidental 
changes. It makes it impossible to change the menu settings you 
make with the normal procedure unless you perform the required 
key operation. In a network environment, protecting settings re-
stricts who can change menu settings to network administrators.

• Level 1

• Level 2

• Off

Series Prnt.Job *1 You can print series of print jobs without time intervals between 
them when jobs are sent from the same computer, PDL, and inter-
face.

Note
❒ Default: On

❒ When the Job Reset key is pressed, all jobs sent to the machine 
will be canceled.

Ppr.Size Error *1 You can select whether to have an error report printed when the 
paper size setting for the tray differs from the actual size of the pa-
per in the tray. You can also select whether to have an error mes-
sage displayed when feeding paper from the tray.

Note
❒ Default: Do not detect

❒ When it is "Detect", it prints with the paper size that was set 
when the error message appeared.

Menu Description
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Changing the Maintenance Menu

Protecting the menus

AAAA Check if the On Line indicator is on. If not, press {{{{On Line}}}} to enter the
"Ready" condition.

BBBB Press {{{{Enter #}}}}, then {{{{Escape}}}}, and then {{{{Menu}}}}.

"Menu" appears on the panel display.

CCCC Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the “Maintenance” menu, and then press {{{{Enter
#}}}}.

The following message appears on the panel display.

DDDD Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “Menu Protect”.

EEEE Press {{{{Enter #}}}}.

The following message appears on the panel display.

FFFF Press {{{{UUUU}}}} or {{{{TTTT}}}} to select the levels desired, and then press {{{{Enter #}}}}. Wait
for a few seconds.

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In
ZDDS025N

  Maintenance:

   Image Density

  Maintenance:

   Menu Protect

  Menu Protect:

  *Off

Download from Www.Somanuals.com. All Manuals Search And Download.



Making Printer Settings with the Control Panel

118

6

GGGG Press {{{{On Line}}}}.

"Ready" appears on the panel display.

Canceling the protection

AAAA Check if the On Line indicator is on. If not, press {{{{On Line}}}} to enter the
"Ready" condition.

BBBB Press {{{{Enter #}}}}, then {{{{Escape}}}}, and then {{{{Menu}}}}.
“Menu” appears on the panel display.

CCCC Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “Maintenance” menu, and then press {{{{Enter #}}}}.

The following message appears on the panel display.

DDDD Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “Menu Protect”, and then press {{{{Enter #}}}}.

EEEE Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “Off”, and then press {{{{Enter #}}}}. Wait for a few
seconds.

FFFF Press {{{{On Line}}}}.

“Ready” appears on the panel display.

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Ready

   

  Maintenance:

   Image Density
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Formatting Hard Disk Drive Type 2600

If you are formatting the Hard Disk Drive for the first time, follow the proce-
dures below using the control panel.

AAAA Press {{{{Menu}}}}.
 “Menu” appears on the panel display.

BBBB Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “Maintenance” menu.

CCCC Press {{{{Enter #}}}}.

The following message appears on the panel display.

DDDD Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “HDD Format”.

EEEE Press {{{{Enter #}}}}.

The following message appears on the panel display.

FFFF Press {{{{Enter #}}}}.

Important
❒ Do not turn off the printer while formatting the Hard Disk Drive. Turning

off the printer while formatting the Hard Disk Drive can damage the Hard
Disk Drive.

If you successfully format the Hard Disk Drive, the following message ap-
pears on the panel display.

GGGG Turn off the power switch, and then turn it back on.

  Menu:

   Maintenance

  Maintenance:

   Image Density

  Maintenance:

   HDD Format

  HDD Format:

  Press# to Start

  Completed

  Restart Printer
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Displaying the Signal Strength

If you need to check the IEEE 802.11b (Wireless LAN) signal, select "WL.LAN
Signal" in the "Maintenance" menu.

AAAA Press {{{{Menu}}}}.

“Menu” appears on the panel display.

BBBB Press {{{{TTTT}}}} or {{{{UUUU}}}} to display the “Maintenance” menu.

CCCC Press {{{{Enter #}}}}.

The following message appears on the panel display.

DDDD 4 Press {{{{TTTT}}}} or {{{{UUUU}}}} to display "WL.LAN Signal".

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Menu:

   Maintenance

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Maintenance:

   Image Density

  Maintenance:

   WL.LAN Signal
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EEEE Press {{{{Enter #}}}}.

One of the following messages appears on the panel display.

Note
❒ If "WL.LAN Signal" is not displayed, "IEEE 802.11b" has not been selected

for "LAN Type" in "Network Setup" of the Host Interface menu. Select
"IEEE 802.11b" for "LAN Type", and then check the "WL.LAN Signal" in
the Maintenance menu again.

❒ If "Ad hoc" in "Comm. Mode" of "IEEE 802.11b" in the Host Interface menu
is selected, you cannot check the signal. Select "Infrastructure" and then
check it again.

❒ Every time you press {{{{Enter #}}}}, the signal is updated.
❒ The signal is indicated as "Good" if the signal strength is 76-100%, "Fair" if

the strength is 41-75%, "Poor" if the strength is 21-40%, and "Unavailable"
if the strength is 0-20%. If the signal is unstable or unavailable, remove ob-
stacles or move the printer to a place where the signal can be received.

❒ Using wireless devices or microwave sources near the printer might affect
the signal.

FFFF Press {{{{Escape}}}}.

  WL.LAN Signal

  Good        100%

  WL.LAN Signal

  Fair         50%

  WL.LAN Signal

  Poor         30%

  WL.LAN Signal

  Unavailable  18%
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GGGG Press {{{{On Line}}}}.

“Ready” appears on the panel display.

Resetting the IEEE 802.11b (Wireless LAN) Settings

If you need to reset the wireless LAN setting, select "WL.LAN Defaults" in the
Maintenance menu.

Note
❒ The four items that can be reset in "IEEE 802.11b" of the Host Interface menu

are "Comm.Mode", "Channel", "Trans. Speed", and "WEP Settings". Other
items that can be reset are the SSID settings, the WEP key settings, and the
wireless LAN settings that can be made with telnet.

AAAA Press {{{{Menu}}}}.

“Menu” appears on the panel display.

BBBB Press {{{{TTTT}}}} or {{{{UUUU}}}} to display the “Maintenance” menu.

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Ready

   

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Menu:

   Maintenance
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CCCC Press {{{{Enter #}}}}.

The following message appears on the panel display.

DDDD Press {{{{TTTT}}}} or {{{{UUUU}}}} to display "WL.LAN Defaults".

EEEE Press {{{{Enter #}}}}.

FFFF Press {{{{Enter #}}}}.

The following message appears on the panel display.

The wireless LAN setting value is reset.
“Ready” appears on the panel display.

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Maintenance:

   Image Density

  Maintenance:

   WL.LAN Defaults

  WL.LAN Defaults

  Reset->Defaults?

  Defaults reset

  

  Ready
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System Menu

There are 17 menu items in the “System” menu.
• MisfeedRecovery
• Prt. Err Report
• Auto Continue
• Memory Overflow
• Sub Paper Size
• Page Size
• Edge-Edge Print
• Duplex
• Output Tray
• Job Separation
• Energy Saver
• Memory Usage
• Unit Of Measure
• Edge Smoothing
• Resolution
• Toner Saving
• Spool Printing

System Parameters

Menu Description

MisfeedRecovery You can select whether Misfeed Recovery is enabled. When it is 
on, printing restarts after the misfed paper has been cleared.

• On

• Off

Note
❒ Default: On

Prt. Err Report You can select whether or not to have an error report printed 
when a printer error or memory error occurs.

• On

• Off

Note
❒ Default: Off

Download from Www.Somanuals.com. All Manuals Search And Download.



System Menu

125

6

Auto Continue You can set whether Auto Continue is enabled. When it is on, 
printing continues after a system error occurs.

• Off

• 0 minute

• 1 minute

• 5 minutes

• 10 minutes

• 15 minutes

Note
❒ Default: Off

❒ When it is on and certain types of error occur, the current job 
might be canceled, and the next job started automatically.

Memory Overflow You can select whether the memory overflow error report is print-
ed when the data is too large and cannot be processed.

• Not Print

• Error List

Note
❒ Default: Not Print

Sub Paper Size You can select whether the printer automatically selects the paper 
tray containing paper of the specified size.

• Off

• Auto

Note
❒ Default: Off

Page Size You can specify the default paper size.

11 x 17, 8 1/2 x 14, 11 x 8 1/2, 5 1/2 x 8 1/2, 7 1/4 x 10 1/2, 8 x 13, 
8 1/2 x 13, 8 1/4 x 13, A3, B4, A4, B5, A5, A6, 8K, 16K, 4 1/8 x 9 
1/2, 3 7/8 x 7 1/2, C5 Env, C6 Env, DL Env, Custom Size

Note
❒ Default: 11 x 8 1/2

Edge-Edge Print You can print on the complete area of an A4 sheet leaving no bor-
der on any edge.

Note
❒ Default: Off

Duplex You can select whether you want to print on both sides of each page.

• Off

• Short Edge Bind

• Long Edge Bind

Note
❒ Default: Off

❒ This menu appears only when the optional Duplex Unit is in-
stalled.

Menu Description
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Output Tray You can select the default output tray. When you select "Auto 
Tray Sw.", the printer automatically changes to another output 
tray if an output tray becomes full. This function is available only 
when the Mailbox or the 1-bin Shift Sort Tray is installed.

Standard Tray, Mailbox Tray 1, Mailbox Tray 2, Mailbox Tray 3, 
Mailbox Tray 4, Upper Tray, Auto Tray Sw.

Note
❒ Default: Standard Tray

❒ Only the installed trays appear on the panel display.

Job Separation You can enable Job Separation.

• On

• Off

Note
❒ Default: Off

❒ This menu appears only when the optional 1-bin Shift Sort 
Tray is installed.

Energy Saver You can set how many minutes the printer waits before switching 
to Energy Saver mode. Energy Saver mode reduces electric power 
consumption.

On, Off

1 minute, 5 minutes, 15 minutes, 30 minutes, 45 minutes, 60 min-
utes

Note
❒ Default: On

❒ Default: 30 minutes

❒ If there is an error with the printer, the printer will not switch 
to Energy Saver mode.

❒ When the printer switches to Energy Saver mode, the Power 
indicator turns off while the On Line indicator stays on.

Memory Usage You can select memory to be used from "Font Priority" or "Frame 
Priority" according to the paper size, resolution or printer lan-
guage.

• Font Priority
This setting uses memory for registering fonts.

• Frame Priority
This setting uses memory for high speed printing.

Note
❒ Default: Frame Priority

Reference
For more information, see p.153 “Memory Capacity and Paper 
Size”.

Unit Of Measure You can select "mm" or "inch" for the custom paper sizes.

Menu Description
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Edge Smoothing You can set whether Edge Smoothing is enabled. When it is on, 
jagged lines appear more smoothly. Set it to off when the print im-
age contains fine gradation in tone.

• On

• Off

Note
❒ Default: On

❒ If "Toner Saving" is "On", "Edge Smoothing" is ignored even if 
it is "On".

Resolution You can set the print resolution in dots per inch.

❖❖❖❖ PCL
300 dpi, 600 dpi

❖❖❖❖ PS
300 dpi, 600 dpi, 1200 dpi

❖❖❖❖ TIFF
200 dpi, 300 dpi, 400 dpi, 600 dpi, 1200 dpi

Note
❒ Default: 600 dpi

Toner Saving You can select whether or not Toner Saving is enabled.

• On

• Off

Note
❒ Default: Off

❒ If "Toner Saving" is "On", "Edge Smoothing" is ignored even if 
it is "On".

Spool Printing You can select whether all of the print data is spooled to the Hard 
Disk Drive before printing.

• On

• Off

Note
❒ Default: Off

❒ Spooling stores the print job sent by a computer temporarily in 
the printer, transfers the print job, and then prints it.

❒ This menu appears only when the optional Hard Disk Drive is 
installed.

Menu Description
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Changing the System Menu

AAAA Press {{{{Menu}}}}.

“Menu” appears on the panel display.

BBBB Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the “System” menu.

CCCC Press {{{{Enter #}}}}.

The following message appears on the panel display.

DDDD Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “Energy Saver”.

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Menu:

   System

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  System:

   MisfeedRecovery

  System:

   Energy Saver
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EEEE Press {{{{Enter #}}}}.

The following message appears on the panel display.

FFFF Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "E. Saver Timer".

GGGG Press {{{{Enter #}}}}.

The following message appears on the panel display.

HHHH Press {{{{UUUU}}}} or {{{{TTTT}}}} to select how many minutes the printer waits before
switching to Energy Saver mode.

IIII Press {{{{Enter #}}}}.

The screen returns to step F in a few seconds.

JJJJ Press {{{{On Line}}}}.

“Ready” appears on the panel display.

  Energy Saver:

   E.Saver On/Off

  Energy Saver:

   E. Saver Timer

  Energy Saver:

  *30 minutes

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Ready
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Host Interface Menu

There are six menu items in the “Host Interface” menu.
• I/O Buffer
• I/O Timeout
• Network Setup
• IEEE 1394 Setup
• IEEE 802.11b
• USB Setting

Host Interface Parameters 

Menu Description

I/O Buffer You can set the size of the I/O Buffer. Normally it is not necessary 
to change this setting.

16 KB, 32 KB, 64 KB, 128 KB, 256 KB, 512 KB

Note
❒ Default: 128 KB

I/O Timeout You can set how many seconds the printer waits before ending a 
print job if more data is not received when using parallel interface 
and USB. If data from another port often appears in the middle of 
a print job, you should increase the timeout value.

10 seconds, 15 seconds, 20 seconds, 25 seconds, 60 seconds

Note
❒ Default: 15 seconds
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Network Setup Note
❒ Items only appear in the Network Setup when the related op-

tions are installed. "IEEE 1394 Setup" appears only when the 
optional IEEE 1394 board is installed. "IEEE 802.11b" appears 
only when the optional IEEE 802.11b board is installed.

Reference
For more information about the "Network Setup", see "Config-
uring the Printer for the Network" in the Setup Guide.

For more information about the "IEEE 1394 Setup", see "Con-
figuring the Printer for the Network" in the Setup Guide.

For more information about the "IEEE 802.11b", see "Configur-
ing the Printer for the Network" in the Setup Guide.

❖❖❖❖ IP Address
You can set the IP Address.

Note
❒ Default: 011.022.033.044

❖❖❖❖ Subnet Mask
You can set the Subnet Mask.

Note
❒ Default: All zero

❖❖❖❖ Gateway Address
You can set the Gateway Address.

Note
❒ Default: All zero

Menu Description
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Network Setup ❖❖❖❖ Network Boot
You can set how the Network Interface Board acquires 
TCP/IP settings.

Note
❒ Default: None

❖❖❖❖ Frame Type (NW)
You can set the Frame Type for NetWare.

Note
❒ Default: Auto

❖❖❖❖ Active Protocol
You can set the active protocol.
TCP/IP, NetWare, NetBEUI, AppleTalk

Note
❒ Default: All Active

❖❖❖❖ Ethernet
You can select the speed of the network to which the printer is 
connected.
Auto, 10 Mbps, 100Mbps

Note
❒ Default: Auto

❖❖❖❖ LAN Type
You can select Ethernet or IEEE 802.11b for the LAN type.

Note
❒ Default: Ethernet

❒ Appears only when the optional 802.11b Interface Unit is 
installed in the Network standard model.

Reference
For more information about Network Setup, see "Config-
uring the Printer for the Network" in the Setup Guide.

Menu Description
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IEEE 1394 Setup *1 You can make settings for using IEEE 1394. This menu appears 
only when the optional IEEE 1394 board is installed. 

❖❖❖❖ IP Address1394
You can set the IP address for IEEE 1394 (IP over 1394).

Note
❒ Default: All zero

❖❖❖❖ Subnet Mask1394
You can set the Subnet Mask for IEEE 1394 (IP over 1394).

Note
❒ Default: All zero

❖❖❖❖ IP over 1394
You can activate IP over 1394.

Note
❒ Default: Active

❖❖❖❖ SCSI print
You can activate SCSI print.

Note
❒ Default: Activate

❖❖❖❖ Bidi-SCSI print
You can activate bidirectional transmission for SCSI print.

Note
❒ Default: Activate

Menu Description
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*1 Appears only when the 1394 Interface Unit board is installed.
*2 Appears only when the 802.11b Interface Unit board is installed.
*3 While the printer is Online, press {{{{Enter #}}}}, and then press {{{{Escape}}}}. Finally, press

{{{{Menu}}}} . You can access the "USB Setting" menu on the panel display.

IEEE 802.11b *2 You can make settings for using the wireless LAN. This menu ap-
pears only when the optional IEEE 802.11b board is installed.

❖❖❖❖ Comm.Mode
You can set the transmission mode for IEEE 802.11b.

Note
❒ Default: Ad hoc

❖❖❖❖ Channel
The selectable channels are 1-11 (Inch version) and 1-13 (Met-
ric version).

Note
❒ Default: 11

❖❖❖❖ Trans. Speed
You can set the transmission speed for IEEE 802.11b.

Note
❒ Default: Auto

❖❖❖❖ WEP Settings
You can set the code for IEEE 802.11b.

Note
❒ Default: Not Active

❒ You need to set the WEP code key from the network before 
making this setting. Without the key, transmission cannot 
be performed.

❒ Be sure to set the key before setting the code to "Active".

USB Setting *3 You can set the transmission speed for USB.

Note
❒ Default: Auto

Menu Description
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Changing the Host Interface Menu

AAAA Press {{{{Menu}}}}.

“Menu” appears on the panel display.

BBBB Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the “Host Interface” menu.

CCCC Press {{{{Enter #}}}}.

The following message appears on the panel display.

DDDD Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “I/O Timeout”.

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Menu:

   Host Interface

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Host Interface:

   I/O Buffer

  Host Interface:

   I/O Timeout
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EEEE Press {{{{Enter #}}}}.

The following message appears on the panel display.

FFFF Press {{{{UUUU}}}} or {{{{TTTT}}}} to select how many minutes the printer waits before end-
ing a print job.

GGGG Press {{{{Enter #}}}}.

The screen returns to step D in a few seconds.

HHHH Press {{{{On Line}}}}.

“Ready” appears on the panel display.

  I/O Timeout:

  *15 seconds

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Ready
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PCL Menu

There are eight menu items in the “PCL Menu” .
• Orientation
• Form Lines
• Font Source
• Font Number
• Point Size
• Font Pitch
• Symbol Set
• Ext. A4 Width

PCL Parameters

Menu Description

Orientation You can set the page orientation.

• Portrait

• Landscape

Note
❒ Default: Portrait

Form Lines You can set the number of lines per page.

5-128

Note
❒ Default: 64 (Metric version), 60 (Inch version)

Font Source You can set the location of the default font.

• Internal

• Download

• HDD

Note
❒ Default: Internal

❒ When you select "Download", you can select only fonts down-
loaded to printer RAM.

Font Number You can set the ID of the default font you want to use.

• 0 to 50 (for Internal)

• 1 to downloaded number

Note
❒ Default: Internal

❒ Default: 0
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Point Size You can set the point size you want to use for the default font.

4 to 999.75 by 0.25

Note
❒ Default: 12.00

❒ This setting is effective only for a variable-space font.

Font Pitch You can set the number of characters per inch you want to use for 
the default font.

0.44 to 99.99 by 0.01

Note
❒ Default: 10.00

❒ This setting is effective only for a fixed-space font.

Symbol Set You can specify the set of print characters for the default font. The 
available options are as follows.

Roman-8, ISO L1, ISO L2, ISO L5, PC-8, PC-8 D/N, PC-850, PC-
852, PC8-TK, Win L1, Win L2, Win L5, Desktop, PS Text, VN Intl, 
VN US, MS Publ, Math-8, PS Math, VN Math, Pifont, Legal, ISO 4, 
ISO 6, ISO 11, ISO 15, ISO 17, ISO 21, ISO 60, ISO 69, Win 3.0

Note
❒ Default: Roman-8

Ext. A4 Width You can extend the width of the printable area for an A4 sheet 
leaving a narrow margin on the sides.

Note
❒ Default: Off

Menu Description
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Changing the PCL Menu

AAAA Press {{{{Menu}}}}.

"Menu" appears on the panel display.

BBBB Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "PCL Menu", and then press {{{{Enter #}}}}.

The following message appears on the panel display.

CCCC Press {{{{Enter #}}}}.

DDDD Press {{{{UUUU}}}} or {{{{TTTT}}}} to select the orientation desired, and then press {{{{Enter #}}}}.
Wait for a few seconds.
The screen returns to step B in a few seconds.

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  PCL Menu:

   Orientation

  Orientation:

  *Portrait
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EEEE Press {{{{On Line}}}}.

"Ready" appears on the panel display.

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Ready
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Language Menu

You can select the language you use. Available language as are follows:
English, French, German, Italian, Spanish, Dutch, Swedish, Norwegian, Danish,
Finnish, Portuguese, Czech, Polish, Hungarian

Note
❒ Default: English

Changing the Language Menu

You can change the language by the following procedures below.

AAAA Press {{{{Menu}}}}.

”Menu” appears on the panel display.

BBBB Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “Language” menu.

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Menu:

   Language
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CCCC Press {{{{Enter #}}}}.

The following message appears on the panel display.

DDDD Press {{{{UUUU}}}} or {{{{TTTT}}}} until the language you want to select appears on the panel
display.

EEEE Press {{{{Enter #}}}}. Wait for a few seconds.

The screen returns to step B in a few seconds.

FFFF Press {{{{On Line}}}}.

"Ready" appears on the panel display.

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Language:

  *English

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

  Ready
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Replacing Parts

The maintenance kit contains parts necessary for maintaining the printer. When
“Replace Maintenance Kit” appears on the panel display, install the replacement
parts included in the maintenance kit.

R WARNING:

R CAUTION:

Note
❒ If you dispose of the used parts yourself, dispose of them according to local

regulations.

• It is dangerous to handle the plug with wet hands. An electric shock 
might occur.

• The inside of the machine could be very hot. Do not touch the parts with a 
label indicating "v" (means hot surface). Touching "v" (means hot sur-
face) could result in a burn.

• When you pull the plug out of the socket, grip the plug to avoid damaging 
the cord and causing a fire or an electric shock.

• Be sure to turn off the printer and wait for about an hour before replacing 
parts. Not waiting for the printer to cool down can result in a burn.
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MAINTENANCE KIT Type 2600

Checking the contents of the box

Check the contents of the box according to the following list. If one or more items
are missing, contact your sales or service representative.

Description Quantity

Friction pad for 
the paper tray 
(Tray 1)

1 pc See p.145 “Replacing the Fric-
tion Pad”.

Friction pad for 
the Paper Feed 
Unit (Tray 2, 3)

2 pcs

Paper feed roller 
for the paper 
tray (Tray 1)

1 pc See p.146 “Replacing the Pa-
per Feed Rollers”.

Paper feed roller 
for the Paper 
Feed Unit (Tray 
2, 3)

2 pcs

Transfer roller 1 pc See p.147 “Replacing the 
Transfer Roller”.

Gloves 1 pair

Fusing Unit 1 pc See p.149 “Replacing the Fus-
ing Unit”.
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Preparing to replace the parts

You should replace all the parts included in Maintenance Kit at the same time.
Be sure to replace them in the following order:

AAAA Check the contents of the box for the following items:
• Friction pad for the paper tray (Tray 1)
• Friction pad for the Paper Feed Unit (Tray 2, 3)
• Paper feed roller for the paper tray (Tray 1)
• Paper feed roller for the Paper Feed Unit (Tray 2, 3)
• Transfer roller
• Fusing Unit
• Gloves

BBBB Confirm that the followings are true:

• The power switch is turned off.
• The power cord is unplugged from the wall outlet.
• The interface cable is unplugged from the printer.

Replacing the Friction Pad

Replace all friction pad of the tray.
There are two kinds of friction pads.
One is for the paper tray (Tray 1), and
the other are for the Paper Feed
Unit(s) (Tray 2, 3). The following pro-
cedure shows how to replacing fric-
tion pad of the paper tray (Tray1).

AAAA If the optional Duplex Unit, the
Mailbox or the 1–bin Shift Sort
Tray are installed, uninstall them
from the printer.

BBBB Lift the paper tray slightly then
pull it out until it stops.

CCCC While lifting the front side of the
tray, pull it out of the printer.

DDDD Remove paper from the paper
tray. Place the tray upside down
on a flat surface.

ZCEY430J

ZCEY140J

ZCEM160J
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EEEE Use a sharp-pointed item like a
ball-point pen, to release the two
catches that lock the friction pad.

FFFF Return the paper tray to its origi-
nal position, and remove the fric-
tion pad from the tray.

GGGG Insert the new friction pad in the
paper tray.

Attach the center projection of the
new friction pad to the spring and
align the projection of both sides of
the friction pad to the holes of the
paper tray. Then push the friction
pad as shown in the illustration
until it clicks.

HHHH Push the friction pad until it locks
securely.

IIII If your printer is equipped with
the optional Paper Feed Unit(s),
follow the same procedure when
replacing the friction pad.

Replacing the Paper Feed 
Rollers

Replace all feed rollers including the
printer and the optional Paper Feed
Unit(s). The following procedure
shows how to replacing the paper
feed rollers of the printer.

R CAUTION:

AAAA Move the printer to the edge of a
sturdy and stable table or desk.

Important
❒ Be sure to move the printer hor-

izontally. Moving the printer
facing up on down may cause
the toner to scatter.

❒ Do not put the printer on an un-
stable or tilted surface.

ZCEM170J

ZCEM180J

ZCEM190J

• When lifting the machine, use 
the inset grips on both sides. 
Otherwise the printer could 
break or cause injury if dropped.

ZGDM110J
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Note
❒ If the printer is equipped with

the optional Paper Feed Unit,
do not move the printer and the
unit together, they are not se-
curely attached.

BBBB Slide the green lock lever to the
right (AAAA), remove the paper feed
roller (BBBB).

CCCC While sliding the green lock lever
to the right (AAAA), set the new roller
(BBBB). After that, return the green
lock lever to its original position
(CCCC).

Note
❒ Confirm that the green lock le-

ver secures the roller correctly
by checking if the new roller ro-
tates smoothly.

DDDD If the printer is equipped with the
optional Paper Feed Unit(s), fol-
low the same procedure when re-
placing the paper feed roller.

If you installed two Paper Feed
Units, also replace both paper feed
rollers.

EEEE Leave the paper tray pulled out
and go to p.147 “Replacing the
Transfer Roller”.

Replacing the Transfer Roller

AAAA Open the front cover by pushing
the front cover release button.

BBBB Pull the toner cartridge out of the
printer, while lifting the front
side.

Note
❒ Be sure to place the used car-

tridge on the level place.

ZGDM120J

ZCEM130J

ZCEH120J

ZGDT110J
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CCCC To avoid making your hands
dirty with toner from the transfer
roller, wear the gloves included
in the maintenance kit.

DDDD Hold the lock levers (“$$$$” parts),
and pull them.

EEEE Hold the green parts of the roller
on both sides, and remove the
roller from the printer as shown
in the illustration.

FFFF Insert the new transfer roller on
the socket with the gear of the
roller positioned on the left.

Important
❒ Do not insert the roller on the

back of the socket, or the printer
might be damaged.

❒ Insert the metallic part of the
roller on the socket. If you insert
the sponge part of the roller, the
roller might be damaged.

GGGG Push down the green parts of
both sides of the printer until it
clicks as shown in the illustration.

Note
❒ When the transfer roller is set,

the transfer roller cover will re-
turn to its original position au-
tomatically.

HHHH Holding the grips of the toner car-
tridge, insert it into the printer
until it stops.

ZCEM200J

ZCEM210J

ZCEM220J

ZCEM221J

ZGDT120J
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IIII Push down the toner cartridge to
insert it in its appropriate posi-
tion.

JJJJ Close the front cover.

KKKK Take the gloves off and go to
p.149 “Replacing the Fusing
Unit”.

Replacing the Fusing Unit

R CAUTION:

AAAA If the rear cover is attached to the
printer, remove it.

A Open the rear cover by push-
ing the two knobs.

B Remove the rear cover in a hor-
izontal direction.

BBBB Lift the lock levers of the fusing
unit as shown in the illustration.

• The fusing unit becomes very 
hot. When installing the new fus-
ing unit, turn off the printer and 
wait about an hour. After that, in-
stall the new fusing unit. Not 
waiting for the unit to cool down 
can result in a burn.

ZGDT140J

ZGDH130J

ZGDX210J

ZGDX220J

ZGDX222N
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CCCC Pull the fusing unit out.

DDDD Replace the new fusing unit into
the printer.

EEEE Push the lock levers of the fusing
unit down until it clicks.

FFFF Insert the rear cover to the inside
grooves on both sides of the print-
er in a horizontal direction.

GGGG Close the rear cover.

HHHH Print a configuration page to con-
firm that the printer works prop-
erly.

Reference
For more information about
printing the configuration page,
see “List/Test Print Menu” in the
Printer Reference provided as a
PDF file on the CD-ROM la-
beled “Operating Instructions”.

ZGDX223N

ZGDX224N

ZGDX225N

ZGDX221J

ZGDX211N
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Collate and Shift Collate

Reference
For more information about collate and shift collate, see the printer driver's
Help file.

❖❖❖❖ Collate
Outputs can be assembled as sets in sequential order.

❖❖❖❖ Shift Collate
The shift tray moves backward or forward each time the copies of one set or
those of each job are delivered, and makes the next copy to shift when deliv-
ered to differentiate each set or jobs.

Limitation
❒ To use these functions, the optional Memory Unit of at least 96 MB or the op-

tional Hard Disk Drive must be installed on the printer.
❒ Up to 200 pages can be sorted using RAM. If the optional Hard Disk Drive is

installed, up to 1000 pages can be sorted. The maximum number of pages to
be sorted is 200 pages.

❒ Shift Collate requires the optional 1-bin Shift Sort Tray to be installed on the
printer.

Note
❒ When using PostScript 3, if you select Upper Tray as an output tray, it is shift

collated automatically. When using RPCS, you can select collate function.

2
1

3 2
1

3 2
1

3 2
1

3

2
1

3

32
1

32
1

32
1
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Spool Printing

With spool printing, the whole data of a print job is saved in the Printer Hard
Disk before printing. To use this function, set it from the menu. See p.124 “Sys-
tem Menu”. 

Important
❒ Do not turn off the printer or the computer when a print job is being spooled

and the Data In indicator is blinking. If you do, the print job will remain in
the Printer Hard Disk and be printed when the printer is turned on.

Limitation
❒ Spool printing does not appear unless the optional Hard Disk Drive is in-

stalled.
❒ Data that has been received in the protocol other than LPD or IPP cannot be

spooled.
❒ Up to 50 jobs (approximately 500 MB) can be spooled at a time.
❒ When spool printing is on, the size of a single print job cannot exceed 500 MB.
❒ When sending spooled print jobs from more than one computer at the same

time, up to five LPR jobs and one IPP job can be spooled. Jobs exceeding the
maximum number cannot be spooled. Wait until the number of spooled print
jobs falls below the maximum.

Note
❒ When "On" is selected, the first print will take time.

❖❖❖❖ Confirm or delete the spooled job from a Web browser.
The spooled job can be seen or deleted from a Web browser. Start a Web
browser, and then input the IP address of the printer for URL to show the top
page. Click [Admin Info.], and then click [Spool Printing]. Select the file, check for
delete, input the password, and then click the delete button. (The default
password is "password".)
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Memory Capacity and Paper Size

The following tables show the typical memory requirements of the RPCS printer
language. Memory requirements depend on your print data and printing envi-
ronment, such as the "Memory Priority" setting or total memory size that the
printer has available. The print mode also effects whether the print job will
equally completed.

Setting of the “Frame Priority”

❍ 
Means that the print job is supported by simplex and duplex printing.
❍* 
Means it might be impossible to print images complex data with duplex print-
ing. Even with simple date, the number of pages printed with duplex printing
might be limited.

Paper Size
Memory 

Capacity

Resolution (dpi)

600 x 600 1200 x 1200

B5
32MB ❍ ❍

96MB ❍ ❍

A4 (210 × 297)

Letter (81/2×11)

32MB ❍ ❍

96MB ❍ ❍

B4
32MB ❍ ❍

96MB ❍ ❍

A3

(11 × 17)

32MB ❍ ❍*

96MB ❍ ❍
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Setting of the “Font Priority”

❍ 
Means that the print job is supported by simplex and duplex printing.
❍* 
Means it might be impossible to print images complex data with duplex print-
ing. Even with simple date, the number of pages printed with duplex printing
might be limited.
$*
Means it might be impossible to print images complex data with printing. Even
with simple data, the number of pages printed with printing might be limited.

Paper Size
Memory 

Capacity

Resolution (dpi)

600 x 600 1200 x 1200

B5
32MB ❍ ❍

96MB ❍ ❍

A4 (210 × 297)

Letter (81/2×11)

32MB ❍ ❍*

96MB ❍ ❍

B4
32MB ❍ ❍*

96MB ❍ ❍

A3

(11 × 17)

32MB ❍ $*

96MB ❍ ❍
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Moving and Transporting the Printer

R CAUTION:

Repack the printer in its original
packing materials for transporting.

Important
❒ Be sure to disconnect all cables

from the printer before transport-
ing it.

❒ The printer is a precision piece of
machinery. Take care to avoid
damage during shipment.

Moving the Printer

R CAUTION:

Moving the printer in the short distance

AAAA Confirm that the followings are
true:

• The power switch is turned off.
• The power cord is unplugged

from the wall outlet.
• The interface cable is un-

plugged from the printer.

BBBB If you installed external options,
remove them.

Removing the Mailbox or the 1-
bin Shift Sort Tray

The following procedure shows
how to remove the Mailbox as an
example.
A Pull all the upper trays out.

B While pushing the lock buttons
(AAAA), pull the Mailbox out (BBBB).

• When lifting the machine, use 
the inset grips on both sides. 
Otherwise the printer could 
break or cause injury if dropped.

• When you move the printer, re-
member to unplug the power 
cord from the wall outlet to avoid 
a fire or an electric shock.

• When you pull out the plug from 
the socket, grip the plug to avoid 
damaging the cord and causing 
a fire or an electric shock.

• The machine weight is approxi-
mately 18 kg (39.7 lb. bond).

• When lifting the machine, use 
the inset grips on both sides. 
Otherwise the printer could 
break or cause injury if dropped.

• Before moving the machine, un-
plug the power cord from the out-
let. If the cord is unplugged 
abruptly, it could become dam-
aged. Damaged plugs or cords 
can cause an electrical or fire 
hazard.

ZGDY370J

ZCEX470J
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Removing the Duplex Unit

A Push down the lever on right
side of the Duplex Unit (AAAA)
and pull it out until it stops
(BBBB).

B Push the under board levers
(AAAA) and pull the Duplex Unit
out of the printer (BBBB).

CCCC Be sure to close the Bypass Tray
and the front cover.

DDDD Lift the printer and move it to the
place where you want to install it.

R CAUTION:

Important
❒ Be sure to move the printer hori-

zontally. Moving the printer facing
up on down may cause the toner to
scatter.

❒ If the Paper Feed Unit(s) is in-
stalled, detach and move the print-
er separately. Never move the
printer with the Paper Feed Unit(s)
attached.

ZGDX320J

ZCEY450J

• When lifting the machine, use 
the inset grips on both sides. 
Otherwise the printer could 
break or cause injury if dropped.

ZGDH221J
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Specifications

Mainframe

❖❖❖❖ Configuration:
Desktop

❖❖❖❖ Print Process:
Laser beam scanning & Electrophotographic printing
Dual component toner development

❖❖❖❖ Printing Speed:
Maximum 26 pages per minute (A4L, 81/2 × 11L)

Note
❒ Continuous printing on sheets with a width of 230 mm or smaller may de-

crease the printing speed depending on the temperature control of the fus-
ing unit.

❖❖❖❖ Interface: 
Standard 36–pin printer cable and a parallel port on the host computer
IEEE 1284 I/F (Compatible, ECP, Nibble)
• Do not use a cable more than 2.5 meters (8.2 feet) long.
• USB1.1
• USB2.0
• Bidirectional IEEE1284
• 10/100Base-TX(std.for AP2610N)

❖❖❖❖ Resolution:
1,200 × 1,200 dpi (PCL 6, RPCS, PS)
600 × 600 dpi (PCL 6, PCL 5e, RPCS, PS)
300 × 300 dpi(PCL5e)

❖❖❖❖ Printer Language:
PCL 6 (XL) , PCL 5e, RPCS, Adobe PostScript 3

❖❖❖❖ Fonts:
PCL 6, PCL 5e
Agfa Font Manager 35 Intellifonts, 10 TrueType fonts, and 1 bitmap font
Font Manager available, plus 31 additional fonts.
PostScript
136 fonts(Type 2:24, Type 14:112)

❖❖❖❖ Paper size:
See p.25 “Paper and Other Media Supported by This Printer”

Download from Www.Somanuals.com. All Manuals Search And Download.



Appendix

158

7

❖❖❖❖ Paper Weight:
See p.25 “Paper and Other Media Supported by This Printer”

❖❖❖❖ Power Source:
120V, 60 Hz, 8.4A or more

❖❖❖❖ Power Consumption:

❖❖❖❖ Noise Emission *1 :
Sound Power Level

Sound Pressure level *2 

*1 The following measurements are actual values made in accordance with ISO7779.
*2 Measured at the position of a bystander.

❖❖❖❖ Dimensions: *1 

*1 Measurement conditions: With paper tray, Bypass Tray and output tray extension
closed.

❖❖❖❖ Weight:
Approximately 18 kg (39.7 lb. bond) (toner cartridge and power cord includ-
ed)

Maximum 870 W or less

Printing 610 W or less

Energy Saver

• Basic model:
12 W

• Network standard model:
13 W

Mainframe only

During Printing 63 dB (A)

Stand-by 40 dB (A) 

Mainframe only

During Printing 52 dB (A)

Width Depth Height

Printer only (tray not 
extended)

478 mm (18.4 inches) 437 mm (17.2 inches) 305 mm (12.0 inches)

Printer only (tray ex-
tended)

478 mm (18.4 inches) 555 mm (21.9 inches) 305 mm (12.0 inches)

With one optional 
feed unit

478 mm (18.4 inches) 555 mm (21.9 inches) 434 mm (17.1 inches)

With two optional 
feed units

478 mm (18.4 inches) 555 mm (21.9 inches) 562 mm (22.1 inches)
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❖❖❖❖ Warm-up Time:
Less than 19 seconds (23°C, 73F)

❖❖❖❖ Paper Capacity:

*1 Paper weight: 60 – 105 g/m2 (16 – 28 lb. bond)
*2 You can load up to 10 envelopes (55 – 157 g/m2, 14 – 42 lb. bond) at the same time.
*3 To use the Envelope Feeder Unit, the optional Paper Feed Unit is required. The

paper tray of the feed unit can be replaced with the Envelope Feeder Unit.
*4 For more information about envelopes, see p.33 “Types of Paper and Other Me-

dia”.

❖❖❖❖ Paper Output Capacity:
250 sheets (80 g/m2, 20 lb. bond)

❖❖❖❖ Memory:
Standard 32MB, up to 96MB (with the optional Memory Unit)

❖❖❖❖ Network (Basic model printer requires the optional Network Interface Board):
Topology: Ethernet (10BaseT/100BaseTX)
Protocol: TCP/IP, NetBEUI, IPX/SPX, AppleTalk

❖❖❖❖ Optional Equipment:
Common for the Basic model printer and the Network standard model
printer 
• Paper Feed Unit Type 2600
• Envelope Feeder Type 2600
• 1-bin Shift Sort Tray Type 2600
• CS380 (Mailbox)
• AD410 (Duplex Unit)
• Memory Unit TypeB 64MB
• Hard Disk Drive Type 2600
• 1394 Interface Unit Type 4510
• 802.11b Interface Unit Type A
Unique for the Basic model printer
• Network Interface Board Type 2610

Standard paper tray 250 sheets *1  (80g/m2, 20 lb.bond)

Bypass Tray *2 100 sheets *1  (80g/m2, 20 lb.bond)

Optional Paper Feed Unit × 2 500 sheets × 2 *1  (80g/m2, 20 lb.bond)

Optional Envelope Feeder *3 60 envelopes *4 
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Options

Paper Feed Unit Type 2600

❖❖❖❖ Dimensions (W××××D××××H):
468 × 545 × 130 mm (18.4 × 19.7 × 5.1 inches)
(without pins on the unit)

❖❖❖❖ Paper Weight:
60 – 105 g/m2 (16 – 28 lb. bond)

❖❖❖❖ Paper Size:
See p.25 “Paper and Other Media Supported by This Printer”.

Envelope Feeder Type 2600

❖❖❖❖ Dimensions (W××××D××××H):
468 × 410 × 130 mm (18.4 × 16.1 × 5.1 inches)

❖❖❖❖ Paper Weight:
72 – 90 g/m2 (19 – 24 lb. bond)

❖❖❖❖ Paper Size:
See p.25 “Paper and Other Media Supported by This Printer”.

AD410 (Duplex Unit)

❖❖❖❖ Dimensions (W××××D××××H):
380 × 150 × 220 mm (15.0 × 5.9 × 8.7 inches)

❖❖❖❖ Paper Size:
See p.25 “Paper and Other Media Supported by This Printer”.

❖❖❖❖ Paper Weight:
60 – 105 g/m2 (17 – 28 lb. bond)

❖❖❖❖ Weight: 
5 kg (11.0 lb. bond)
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1-bin Shift Sort Tray Type 2600

❖❖❖❖ Dimensions (W ×××× D ×××× H): 
465 × 395 × 160 mm (18.3 × 15.6 × 6.3 inches) 

❖❖❖❖ Paper Size: 
See p.25 “Paper and Other Media Supported by This Printer”.

❖❖❖❖ Paper Weight:
60 – 105 g/m2 (16 – 28 lb. bond)

❖❖❖❖ Stack Capacity:
250 sheets / bin (80 g/m2, 20 lb. bond)

❖❖❖❖ Weight: 
3.5 kg (7.7 lb. bond)

CS380 (Mailbox)

❖❖❖❖ Dimensions (W ×××× D ×××× H): 
465 × 395 × 285 mm (18.3 × 15.6 × 11.2 inches) 

❖❖❖❖ Paper Size: 
See p.25 “Paper and Other Media Supported by This Printer”.

❖❖❖❖ Paper Weight:
60 – 105 g/m2 (16 – 28 lb. bond)

❖❖❖❖ Stack Capacity:
50 sheets / bin (80 g/m2, 20 lb. bond)

❖❖❖❖ Weight: 
5.5 kg (12.1 lb. bond)

Hard Disk Drive Type 2600

❖❖❖❖ Storage Capacity (Formatted):
6 GB
You can install PostScript fonts with this optional Hard Disk Drive. With a
Macintosh, types of fonts supported are PostScript Type 1 and PostScript
Type 2. To download them, use PS Utility for Mac.
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Memory Unit TypeB 64MB

❖❖❖❖ Module Type:
SO-DIMM (Small Outline Dual-in-line Memory Module)

❖❖❖❖ Memory Type:
SDRAM (Synchronous Dynamic RAM)

❖❖❖❖ Number of Pins:
144 pins

Network Interface Board Type 2610

❖❖❖❖ Topology:
Ethernet (10BaseT/100BaseTX)

❖❖❖❖ Protocols:
TCP/IP, NetBEUI, IPX/SPX, AppleTalk

❖❖❖❖ Interface Connector:
RJ45

❖❖❖❖ Required Cable:
STP (Shielded Twisted-Pair) cable
Category / Type5 or better

1394 Interface Unit Type 4510

❖❖❖❖ Transmission Spec.:
IEEE 1394

❖❖❖❖ Device Class:
SCSI print, IP over 1394

❖❖❖❖ Interface Connector:
IEEE 1394 (6 pins × 2)

❖❖❖❖ Required cable:
1394 interface cable (6 pins x 4 pins, 6 pins x 6 pins)

Important
❒ You cannot plug devices together to create loops.
❒ Do not use a cable more than 4.5 meters (14.8 feet) long.

❖❖❖❖ Connectable number of device in a bus:
Maximum 63
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❖❖❖❖ Allowed cable hops in a bus:
Maximum 16

❖❖❖❖ Power supply:
Nonpower supply
Cable Power repeated (IEEE 1394a-2000 compliant)

802.11b Interface Unit TypeA (R-WL11)

❖❖❖❖ Transmission Spec.:
Based on IEEE 802.11b (Wireless LAN)

❖❖❖❖ Protocol:
TCP/IP, NetBEUI, IPX/SPX, AppleTalk

Note
❒ SmartNetMonitor and WebStatusMonitor are supported.

❖❖❖❖ Data Transfer Speed:
Auto select from below speed
1Mbps, 2Mbps, 5.5Mbps, 11Mbps

❖❖❖❖ Frequency Range:
• Inch version:

2412-2464 Mhz (1-11 channels)
• Metric version:

2412-2472 Mhz (1-13 channels)

❖❖❖❖ Transmittable Distance:
1Mbps 400m *1 

2Mbps 270m *1 

5.5Mbps 200m *1 

11Mbps 140m *1 

*1 These figures are a guideline for outdoor use. In general, the transmittable dis-
tance indoors is 10-100 m, depending on the environment.

❖❖❖❖ Transmission Mode:
ad hoc mode and infrastructure mode
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Consumables

R CAUTION:

❖❖❖❖ Toner Cartridge

*1 A4, 5% test chart

Note
❒ The actual number of printed pages you get from a particular toner car-

tridge depends on the type and size of paper you are using, the contents of
your print images, and printing environment conditions. All this means
that a toner cartridge might require replacement sooner than the normal
life described above.

❒ The number of printable pages that can be expected from the starter toner
cartridge included in the printer is about 6,000 pages (A4, 5% chart).

❖❖❖❖ Maintenance Kit
MAINTENANCE KIT Type 2600
It is required to change the maintenance kit after every 90,000 pages have
been printed. However, it may be necessary to change the parts earlier de-
pending on their operating period.

• Our products are engineered to meet the highest standards of quality and 
functionality. When purchasing expendable supplies, we recommend using 
only those specified by an authorized dealer.

Printable number of pages per cartridge *1 

Toner Cartridge 20,000 pages
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Information about Installed Software

expat

Expat(Version 1.1). Copyright 1998, 1999 James Clark. All rights reserved.
• The software installed on this product includes the expat application soft-

ware Version 1.1 (hereinafter "expat 1.1").
• The product manufacturer has not made any modification to the source code

of the expat 1.1.
• The product manufacturer provides warranty and support to the software of

the product including the expat 1.1 and the product manufacturer makes Mr.
James Clark, the initial developer of the expat 1.1, free from these obligations.

• The expat 1.1 is made available under Mozilla Public License Version 1.1
(hereinafter "MPL 1.1"), and controller software of the product equals the
Larger Work as defined in MPL 1.1. The software of this product except the
expat 1.1 is licensed to the product manufacturer under separate agree-
ment(s).

• The source code of the expat 1.1 is available at:
ftp://ftp.jclark.com/pub/xml/expat1_1.zip

• MPL 1.1 is also available at:
http://www.mozilla.org/MPL/MPL-1.1.html

• Information relating to the expat 1.1 is available at:
http://www.jclark.com/xml/expat.html

JPEG LIBRARY

• The software installed on this product is based in part on the work of the In-
dependent JPEG Group.
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NetBSD

Copyright Notice of NetBSD
For all users to use this product:
This product contains NetBSD operating system:
For the most part, the software constituting the NetBSD operating system is not
in the public domain; its authors retain their copyright.
The following text shows the copyright notice used for many of the NetBSD
source code. For exact copyright notice applicable for each of the files/binaries,
the source code tree must be consulted.
A full source code can be found at http://www.netbsd.org/.
Copyright © 1999, 2000 The NetBSD Foundation, Inc.
All rights reserved.
Redistribution and use in source and binary forms, with or without modifica-
tion, are permitted provided that the following conditions are met:
A Redistributions of source code must retain the above copyright notice, this list

of conditions and the following disclaimer.
B Redistributions in binary form must reproduce the above copyright notice,

this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

C All advertising materials mentioning features or use of this software must
display the following acknowledgment:
This product includes software developed by the NetBSD Foundation, Inc.
and its contributors.

D Neither the name of The NetBSD Foundation nor the names of its contribu-
tors may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND
CONTRIBUTORS ''AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MER-
CHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DIS-
CLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEM-
PLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMIT-
ED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CON-
TRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTH-
ERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Authors Name List

All product names mentioned herein are trademarks of their respective owners.
The following notices are required to satisfy the license terms of the software
that we have mentioned in this document:
• This product includes software developed by the University of California,

Berkeley and its contributors.
• This product includes software developed by Jonathan R. Stone for the NetB-

SD Project.
• This product includes software developed by the NetBSD Foundation, Inc.

and its contributors.
• This product includes software developed by Manuel Bouyer.
• This product includes software developed by Charles Hannum.
• This product includes software developed by Charles M. Hannum.
• This product includes software developed by Christopher G. Demetriou.
• This product includes software developed by TooLs GmbH.
• This product includes software developed by Terrence R. Lambert.
• This product includes software developed by Adam Glass and Charles Hannum.
• This product includes software developed by Theo de Raadt.
• This product includes software developed by Jonathan Stone and Jason R.

Thorpe for the NetBSD Project.
• This product includes software developed by the University of California,

Lawrence Berkeley Laboratory and its contributors.
• This product includes software developed by Christos Zoulas.
• This product includes software developed by Christopher G. Demetriou for

the NetBSD Project.
• This product includes software developed by Paul Kranenburg.
• This product includes software developed by Adam Glass.
• This product includes software developed by Jonathan Stone.
• This product includes software developed by Jonathan Stone for the NetBSD

Project.
• This product includes software developed by Winning Strategies, Inc.
• This product includes software developed by Frank van der Linden for the

NetBSD Project.
• This product includes software developed for the NetBSD Project by Frank

van der Linden
• This product includes software developed for the NetBSD Project by Jason R.

Thorpe.
• The software was developed by the University of California, Berkeley.
• This product includes software developed by Chris Provenzano, the Univer-

sity of California, Berkeley, and contributors.
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1394 interface cable,   162
1394 Interface Unit Type 4510,   162
1-bin Shift Sort Tray Type 2600,   161

A

AD410,   160
adhesive labels,   34
Adjusting the image density,   97
Adjusting the Registration,   98
Auto Continue,   124

B

Bypass size,   106

C

Collate,   151
Config. Page,   110
CS380,   161
Curl Prevention,   114

D

Data In indicator,   77
Duplex,   124

E

Edge-Edge Print,   124
Edge Smoothing,   124
Energy Saver,   124
Envelope Feeder Type 2600,   160
envelopes,   34
envelopes, loading,   45
error,   61
Error indicator,   76
Escape key,   105
Ethernet cable,   162
Ext. A4 Width,   137

F

Font Number,   137
Font Pitch,   137
fonts,   157
Font Source,   137
Form Lines,   137
friction pad,   145
friction pad, cleaning,   93
fusing unit,   149

H

Hard Disk Drive Type 2600,   161
HDD Format,   114
Hex Dump,   110
Host Interface,   104, 130

I

IEEE 1394 Setup,   130
IEEE 802.11b,   130
Image density,   114
I/O Buffer,   130
I/O Timeout,   130

J

Job Separation,   124

K

Key Repeat,   114

L

Language,   104, 141
List/Test Print,   104, 110
List/Test Print Parameters,   110
Locked Print,   56, 104

M

Macintosh
uninstall, PostScript,   24

Maintenance,   104, 114, 115
MAINTENANCE KIT Type 2600,   144
media,   25
memory,   153, 159
Memory Overflow,   124
Memory Unit TypeB 64MB,   162
Memory Usage,   124
menu, accessing,   104
menu, changing,   141
Menu Chart,   101
Menu key,   104
Menu List,   110
Menu Protect,   114
messages,   61
misfeed,   82
MisfeedRecovery,   124
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N

Network Interface Board,   159, 162
Network Printing Guide,   ii
Network Setup,   130
NIB,   159

O

OHP transparencies,   34
On Line indicator,   76
On Line key,   76, 105
options,   159, 160
Orientation,   137
Output Tray,   124

P

Page Size,   124
panel display, messages,   61
paper,   25
paper feed roller,   146
paper feed roller, cleaning,   94
Paper Feed Unit Type 2600,   160
Paper Input,   104, 106
paper, loading,   37
paper, sizes, types,   25
Paper type,   106
Parallel cable,   157
PCL,   137
PCL 5e

Windows 2000, uninstalling,   19
Windows 95/98/Me, uninstalling,   19
Windows NT 4.0, uninstalling,   20
Windows XP, uninstalling,   19

PCL 6
Windows 2000, uninstalling,   19
Windows 95/98/Me, uninstalling,   19
Windows NT 4.0, uninstalling,   20
Windows XP, uninstalling,   19

PCL Config.Page,   110
PCL Menu,   104
plain paper,   33
Point Size,   137
PostScript

Macintosh, uninstall,   24
Windows 2000, uninstalling,   23
Windows 95/98/Me, uninstalling,   23
Windows NT 4.0, uninstalling,   24
Windows XP, uninstalling,   23

Ppr.Size Error,   114
Printer Reference,   ii
Prt. Err Report,   124
PS Font List,   110

Q

Quick Installation Guide,   ii

R

Registration,   114
registration roller, cleaning,   96
Resolution,   124
ROM Update,   114
RPCS

Windows 2000, uninstalling,   21
Windows 95/98/Me, uninstalling,   21
Windows NT 4.0, uninstalling,   22
Windows XP, uninstalling,   21

S

Sample Print,   51, 104
SDRAM,   159, 162
Series Prnt.Job,   114
Setup Guide,   ii
Shift Collate,   151
specifications,   157
Spool Printing,   124
Sub Paper Size,   124
Symbol Set,   137
System,   104, 124

T

toner cartridge, replacing,   90
Toner Saving,   124
transfer roller,   147
Tray Locking,   106
Tray Paper Size,   106
Tray Priority,   106
troubleshooting,   61

U

Unit Of Measure,   124
USB Setting,   130
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Windows 2000
PCL 5e, uninstalling,   19
PCL 6, uninstalling,   19
PostScript, uninstalling,   23
printer properties, PCL,   2
printer properties, PostScript,   12
printer properties, RPCS,   7
RPCS, uninstalling,   21

Windows 95/98/Me
PCL 5e, uninstalling,   19
PCL 6, uninstalling,   19
PostScript, uninstalling,   23
printer properties, PCL,   1
printer properties, PostScript,   11
printer properties, RPCS,   6
RPCS, uninstalling,   21

Windows 95/98/Me, Windows 2000, 
Windows XP, Windows NT 4.0

canceling a job,   17
Windows NT 4.0

PCL 5e, uninstalling,   20
PCL 6, uninstalling,   20
PostScript, uninstalling,   24
printer properties, PCL,   4
printer properties, PostScript,   14
printer properties, RPCS,   9
RPCS, uninstalling,   22

Windows XP
PCL 5e, uninstalling,   19
PCL 6, uninstalling,   19
PostScript, uninstalling,   23
printer properties, PCL,   2
printer properties, PostScript,   12
printer properties, RPCS,   7
RPCS, uninstalling,   21

WL.LAN Defaults,   114
WL.LAN Signal,   114
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Network Printing Guide

For safety, please read this manual carefully before you use this product and keep it
handy for future reference.
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Introduction

To get maximum versatility from this machine all operators should carefully read and follow the instruc-
tions in this manual. Please keep this manual in a handy place near the machine.

Please read the Safety Information before using this machine. It contains important information related
to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Software Version Conventions Used in this Manual

• NetWare 3.x means NetWare 3.12 and 3.2.

• NetWare 4.x means NetWare 4.1, 4.11 and IntranetWare.

Trademarks

Apple, AppleTalk, EtherTalk, LaserWriter, Macintosh and Mac are registered trademarks of Apple
Computer, Inc.

Ethernet is a registered trademark of Xerox Corporation.

Microsoft, Windows and Windows NT are registered trademarks of Microsoft Corporation in the United
States and/or other countries.

Netscape and Netscape Navigator are registered trademarks of Netscape Communications Corpora-
tion.

Novell, NetWare and NDS are registered trademarks of Novell, Inc.

PostScript is a registered trademark of Adobe Systems, Incorporated.

Sun is a registered trademark of Sun Microsystems, Inc.

SunOS is a trademark of Sun Microsystems, Inc.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

The proper names of the Windows operating systems are as follows:

• The product name of Windows® 95 is Microsoft® Windows 95.

• The product name of  Windows® 98 is Microsoft® Windows 98.

• The product name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).

• The product names of Windows® XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition

• The product names of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Advanced Server
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional

• The product names of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Server 4.0

• Microsoft® Windows NT® Workstation 4.0
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Manuals for This Machine

The following manuals describe the operational procedures and maintenance of
this machine.
To enhance safe and efficient operation of this machine, all users should read
and follow the instructions carefully.

❖❖❖❖ Quick Installation Guide
Describes how to install the printer.

❖❖❖❖ Setup Guide
Provides information about setting up the printer and its options. This man-
ual is provided as a printed manual, and also as a PDF file on the CD-ROM
labeled "Operating Instructions".

❖❖❖❖ Printer Reference
Describes the procedures and provides necessary information about using
this machine. This manual is included as a PDF file on the CD-ROM labeled
“Operating Instructions”.

❖❖❖❖ Network Printing Guide
Describes the procedures and provides necessary information about setting
up and using the printer under the network environment. We recommend
this manual as your first choice to read, and it is included as a PDF file on the
CD-ROM labeled “Operating Instructions” (this manual).

❖❖❖❖ PostScript 3 Operating Instructions Supplement
Describes the menus and features you can set using the PostScript 3 printer
driver. This manual is provided as a PDF file on the CD-ROM labeled “Oper-
ating Instructions”.

Note
❒ There are three CD-ROMs that come with this printer. "Operating Instruc-

tions", "Printer Drivers and Utilities", and "Document Management Utility".
❒ Concerning UNIX information, please visit our web site or consult your au-

thorized reseller.
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How to Read This Manual

Symbols

In this manual, the following symbols are used:

R WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

R CAUTION:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.
* The statements above are notes for your safety.

Important
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates the prior knowledge or preparations required before op-
erating.

Note
This symbol indicates precautions for operation, or actions to take after misop-
eration.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

[ ]
Keys that appear on the machine's panel display.
Keys and buttons that appear on the computer's display.

{ }
Keys built into the machine's control panel.
Keys on the computer's keyboard.
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This manual contains detailed instructions on configuring the machine as a net-
work printer. Read the section appropriate to your network environment on
how to configure the machine correctly.

Important
❒ The procedures written in this manual assume that you are a network admin-

istrator. If you are not, be sure to consult your network administrator before
configuration.

Reference
For more information about configuring the Network Interface Board with
the control panel, see the Setup Guide.

❖❖❖❖ Features
• Support for 100BASE-TX, 10BASE-T, IP over 1394 and IEEE 802.11b.
• The Network Interface Board is compatible with NetWare *1  (IPX/SPX,

TCP/IP), Windows NT 4.0 (TCP/IP, NetBEUI *2 , IPP *3 ), Windows 2000
(TCP/IP, NetBEUI *2 , IPP *3 ), Windows XP (TCP/IP, IPP *3 ), Windows
95/98/Me (TCP/IP, NetBEUI *2 , IPP *3 ), UNIX (TCP/IP) and Macintosh
(AppleTalk) protocols. This allows you to use the machine in a network
that uses different protocols and operating systems.

• A computer used as a dedicated print server is not required because the
Network Interface Board can be configured as a NetWare print server.

• The Network Interface Board can connect the machine to the network
without requiring its own power supply because the Network Interface
Board is installed inside the machine.

NetWare (Server)

Windows NT (Server)
Windows 2000, Windows XP,

Windows 95/98/Me

Macintosh

Windows NT

         NetWare
          (Client)

Windows XP

Windows 2000

UNIX
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*1 If the optional 802.11b Interface Unit has been installed, you cannot use the ad hoc
mode.

*2 To use NetBEUI, use the SmartNetMonitor for Client port.
*3 IPP (Internet Printing Protocol) is a protocol for printing via the Internet.

❖❖❖❖ Interface supported protocols

❍ means that the protocol is supported.
× means that the protocol is not supported.
*1 If the optional 802.11b Interface Unit has been installed, you cannot use the ad hoc

mode.

Interface

Ethernet IEEE 802.11b IEEE 1394
 (IP over 1394)

Protocol TCP/IP ❍ ❍ ❍

NetBEUI ❍ ❍ ×

NetWare ❍ ❍ *1 ×

AppleTalk ❍ ❍ ×
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Setting Up the Machine on a Network

Windows 95/98/Me, Windows 2000/Windows XP, Windows NT 4.0

For setting up the machine as a network printer in Windows 95/98/Me, Win-
dows 2000/Windows XP and Windows NT 4.0 environment.
See p.1 “Windows 95/98/Me Configuration”.
See p.13 “Windows 2000 Configuration”.
See p.25 “Windows XP Configuration”.
See p.37 “Windows NT 4.0 Configuration”.

TCP/IP
NetBEUI
IPP

TCP/IP
NetBEUI
IPP
LPR

❖ Printing Without a Print Server

Windows 95/98/Me Windows 2000

TCP/IP
IPP
LPR

TCP/IP
NetBEUI
IPP
LPR

Windows XP Windows NT 4.0

Windows 2000, Windows XP or
Windows NT Server (or Workstation)
Print Server

Windows 95/98/Me Windows 2000 Windows XP Windows NT 4.0

❖ Printing With a Windows 2000, Windows XP or Windows NT Print Server

Download from Www.Somanuals.com. All Manuals Search And Download.



vi

NetWare

For setting up the machine as a network printer in a NetWare environment, see
p.49 “NetWare Configuration”. The Network Interface Board allows you to use
the machine as either a print server or a remote printer.
For more information about setting up the clients, see the following pages.
• See p.68 “Windows 95/98/Me” .
• See p.69 “Windows 2000” .
• See p.70 “Windows NT 4.0” .

Configuring the machine as a print server

A dedicated NetWare print server is not required because the machine can be
configured as a print server.

The actual procedures for configuring the machine depend on the NetWare ver-
sion.
• NetWare 3.x 

See p.55 “Setting Up as a Print Server”.
• NetWare 4.x, 5/5.1

See p.61 “Setting Up as a Print Server”.

NetWare
File Server

Print Server

Windows 95/98/Me Windows 2000 Windows NT 4.0
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Configuring the machine as a remote printer

If a dedicated NetWare print server is being used, the machine should be config-
ured as a remote printer.

The actual procedures for configuring the machine depend on the NetWare ver-
sion.
• NetWare 3.x

See p.57 “Setting Up as a Remote Printer”.
• NetWare 4.x, 5/5.1

See p.65 “Setting Up as a Remote Printer”.

Macintosh

For setting up the machine as a network printer in a Macintosh environment, see
p.71 “Macintosh Configuration”.

NetWare
Print Server

NetWare
File Server

Remote Printer

Windows 95/98/Me Windows 2000 Windows NT 4.0

AppleTalk

Macintosh
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UNIX

Concerning UNIX printing information, please visit our Web site or consult your
authorized reseller.

Printing using the IEEE 802.11b Interface

This section describes how to print after installing the optional 802.11b Interface
Unit.
There are two methods of using this machine as a network printer with IEEE
802.11b.

❖❖❖❖ ad hoc mode
This is the mode for transmitting between each wireless LAN client. You
must make the channels the same for each wireless LAN client to transmit us-
ing this basic transmitting method which does not require an access point. See
p.87 “Using the IEEE 802.11b (Wireless LAN)”.

TCP/IP

UNIX
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❖❖❖❖ infrastructure mode
This is the mode for transmitting via an access point. If an SSID *1  and WEP
*2  are set in the access point, you must set the same values for the access point
and IEEE 802.11b. By connecting the access point to Ethernet, you can trans-
mit the current network environment. See p.87 “Using the IEEE 802.11b
(Wireless LAN)”.
*1 This is called a Service Set ID and is used in the connection between the wireless

LAN client and the access point. Only a wireless LAN client and an access point
that have the same SSID can transmit to each other. (The character strings to be set
are in the range ASCII 0x20-0x7e and the SSID is case-sensitive to 32 bytes.)

*2 This is used to protect coded wireless data transmission. To transmit between
wireless LAN clients and the coded access point, you must set the same WEP key
as the printer. (You can set only 10 hexadecimal characters.)

❖ad hoc mode

access point

❖infrastructure mode
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Printing using the IEEE 1394 Interface

This section describes how to print via the IEEE 1394 interface after installing the
1394 Interface Unit Type 4510.
There are two methods of using the machine as a network printer with IEEE
1394.

❖❖❖❖ SCSI print
You can print using the SCSI print device provided by Windows 2000 and
Windows XP. For more information, see ”IEEE 1394 Configuration” in the
Setup Guide.

❖❖❖❖ IP over 1394
You can print by setting the IP address for this machine and the computer on
which Windows XP is installed. For more information, see “IEEE 1394 Con-
figuration” in the Setup Guide and p.25 “Printing with a Standard TCP/IP
Port” in the Windows XP Configuration.

SCSI print
IP over 1394
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1. Windows 95/98/Me
Configuration

Configuring Windows 95/98/Me

Printing without a Print Server

The following procedure describes how to configure Windows 95/98/Me to use
the machine on a network without a Windows 2000 Server, Windows 2000 Pro-
fessional, Windows NT Server, Windows NT Workstation, or NetWare based
print server.

AAAA Specify the protocol to use

Consult your network administrator about which of the three protocols is ap-
propriate.
• TCP/IP
• IPP
• NetBEUI

BBBB Configure the chosen protocol.

• See p.2 “Configuring TCP/IP and IPP for Printing”.
• See p.3 “Configuring NetBEUI for Printing”.

CCCC Install the software and set the printer driver port

• Install SmartNetMonitor for Client from the CD-ROM labeled "Printer
Drivers and Utilities". For more information about how to install the soft-
ware and how to specify the printer driver port, see the Setup Guide.

Printing with a Windows 2000 or Windows NT Print Server

See p.10 “Setting Up a Client Computer” for configuring Windows 95/98/Me
with a Windows 2000 or Windows NT print server.
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Configuring Protocols

Configuring TCP/IP and IPP for Printing

These instructions are for configuring the Network Interface Board and Win-
dows 95/98/Me to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
• Make sure that the TCP/IP protocol is set to active. (The default is active.)
• Assign an IP address and make other settings required for using the TCP/IP

protocol.

Reference
For more information about how to make the above settings, see the Setup
Guide.
If DHCP is used to assign IP addresses, see p.121 “Using DHCP”.

Note
❒ After setting the IP address, use the ping command to make sure that it has

been set correctly.
A Enable the use of the command prompt as follows:

• On Windows 95 or Windows 98
Click [Start], point to [Programs], and then click [Command Prompt].

• On Windows Me
Click [Start], point to [Programs], point to [Accessories], and then click
[Command Prompt].

B Type the following: (Example IP address is 192.168.15.16)
C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.
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Configuring a Windows 95/98/Me computer

These steps are for configuring a Windows 95/98/Me computer to use the
TCP/IP protocol.

AAAA Open [Control Panel] and then double-click the [Network] icon. Make sure that
“TCP/IP” is listed in the [The following network components are installed:] box on
the [Configuration] tab.

Note
❒ If the TCP/IP protocol is not installed, click [Add] on the [Configuration] tab

to install it. For more information about installing the TCP/IP protocol, see
Windows 95/98/Me Help.

BBBB Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.

Configuring NetBEUI for Printing

These instructions are for configuring the Network Interface Board and Win-
dows 95/98/Me to use the NetBEUI protocol.

Preparation
To use NetBEUI, use the SmartNetMonitor for Client port.

Configuring the machine

Configure the machine to use the NetBEUI protocol.
• Make sure that the NetBEUI protocol is set to active. (The default is active.)

Reference
For more information about how to make the above settings, see the Setup
Guide.
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Configuring a Windows 95/98/Me computer

Install the NetBEUI protocol on the Windows 95/98/Me computer and set it as
the default protocol.

AAAA Open [Control Panel], and then double-click the [Network] icon. Make sure
that “NetBEUI” is listed in the [The following network components are installed:]
box on the [Configuration] tab.

Note
❒ If the NetBEUI protocol is not installed, click [Add] on the [Configuration] tab

to install it. For more information about installing the NetBEUI protocol,
see Windows 95/98/Me Help.

❒ If “NetBEUI →Dial-Up Adaptor” is listed in the [The following network com-
ponents are installed:] box, select it and click [Remove] to remove the binding.

BBBB Set the NetBEUI protocol as the default protocol. Click the [Configuration]
tab, select “NetBEUI” in the [The following network components are installed:]
box, and then click [Properties].

CCCC Click the [Advanced] tab, select [Set this protocol to be the default protocol], and
then click [OK].

DDDD Click [OK] to close the [Network] dialog box.

EEEE When the message to restart appears, click [Yes].
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Using SmartNetMonitor for Client 

SmartNetMonitor for Client is a utility that helps you to use network printers ef-
fectively. It is useful in environments where two or more network printers are
used. It is recommended that you install SmartNetMonitor for Client to use Par-
allel Printing and Recovery Printing. For more information about SmartNet-
Monitor for Client, see SmartNetMonitor for Client Help.

❖❖❖❖  SmartNetMonitor for Client features
• Sends a print job directly to the network printers without using a print

server.
• Notifies when a printing error occurs.
• Prints documents using other printers in the printer group when the spec-

ified printer is busy (Recovery Printing).
• Equally divides the number of copies to be printed among the selected

printers in the printer group (Parallel Printing).

Important
❒ The following must be the same for the specified printer and the print-

ers selected for Recovery Printing or Parallel Printing.
• Printer models (for Parallel Printing only)
• Installed options (e.g. Paper tray unit)
• Size and orientation of paper in each paper tray unit
• Total memory
• Installed fonts (including the downloaded fonts)

Note
❒ Failure to meet any of the conditions above may result in unexpected

print results.
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Installing SmartNetMonitor for Client 

Install SmartNetMonitor for Client from the CD-ROM labeled “Printer Drivers
and Utilities”. For more information about how to install, see the Setup Guide.
After the installation is complete, configure the printer port with SmartNetMon-
itor for Client. See p.7 “Setting Up the Printer Driver”.

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, and then delete it. For more information about SmartNetMonitor for
Client, see SmartNetMonitor for Client Help.

AAAA From the [Printers] window, click the icon of the printer which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

BBBB Click the [Details] tab, and then make sure that the SmartNetMonitor for
Client port is shown in the [Print to the following port] box.

Remember the port name because this port should be deleted later.

CCCC From the [Print to the following port] box, select [FILE].

DDDD Click [Delete Port].

EEEE Click the SmartNetMonitor for Client port name as in step BBBB, and then click
[OK]. 

The port is deleted.

FFFF Click [OK] to close the printer properties.

Uninstalling SmartNetMonitor for Client 

Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:
• The SmartNetMonitor for Client settings dialog box is closed.
• No printer is using the SmartNetMonitor for Client port as a printer port.

AAAA Open [Control Panel], and then double-click the [Add/Remove Programs] icon.

BBBB On the [Install/Uninstall] tab, click [SmartNetMonitor for Client], and then click
[Add/Remove].

CCCC After the confirmation message appears, click [Yes].

UninstallShield removes all of the components of SmartNetMonitor for Cli-
ent.
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DDDD After the confirmation message, click [Yes].

EEEE Acknowledge the [Question] dialog box.

FFFF When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

Preparation
The target printer must be turned on before starting the installation process.

AAAA Install the printer driver of the printer you want to use.

BBBB From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

CCCC Click the [Details] tab and click [Add Port].

DDDD Click [Other], click [SmartNetMonitor] from the list, and then click [OK].

The [Select Printer] dialog box appears .
The displayed items are as follows:
Model Name: The model name of the printer. 
Name: The name of the Network Interface Board.
Comment: Additional information about the Network Interface Board.
Address: The IP address of the printer.

EEEE Select the printer.

TCP/IP

A Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an IP broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.

❒ You cannot add an address partially similar to that already used. For ex-
ample, when “192.168.0.2” is already used, “192.168.0.2xx” cannot be
used. Similarly, when “192.168.0.20” is already used, “192.168.0.2” can-
not be used. 
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NetBEUI

A Click [NetBEUI].
A list of printers that can be printed to by the NetBEUI protocol appears.

B Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to a broadcast from the computer will be displayed.

To print to a printer not listed here, click [Specify Address], and then type
the NetBEUI address. Make sure that the NetBEUI address is on the con-
figuration page. For more information about the printing of the configu-
ration page, see “Printing a Configuration Page” in the Setup Guide. The
NetBEUI address appears as “\\RNPxxxx\xxx” on the configuration
page. Type the printer's network path name in the form of "%%Computer
name\Share name". Do not type "\\" as head characters but "%%".

❒ You cannot print to printers beyond routers.

IPP

A Click [IPP].
The IPP setting dialog box appears.

B To specify the IP address of the printer, type "http://printer's-ip-ad-
dress/printer" or "ipp://printer's-ip-address/printer" in the [Printer URL]
field.
(Example IP address is 192.168.15.16)
http://192.168.15.16/printer

ipp://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name differing from those of any existing port names.
If you omit this, the address typed in [Printer URL] will be set as the IPP port
name.

D If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

Note
❒ For more information about these settings, see SmartNetMonitor for

Client Help.

FFFF Click [OK].

GGGG Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port] box, and then click [OK].
This completes the settings.
To print, select the specified printer. SmartNetMonitor for Client will now di-
rect print data to the printer automatically.
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Changing Port Settings

Follow these steps to change SmartNetMonitor for Client settings, such as Par-
allel Printing, Recovery Printing, TCP/IP, the proxy server and IPP URL.

Note
❒ There are no settings for the NetBEUI protocol.
❒ You can configure Timeout Settings for the TCP/IP protocol.

AAAA From the [Printers] window, click the printer icon. On the [File] menu, click
[Properties].

BBBB Click the [Details] tab, and then click [Port Settings].

The [Port Settings] dialog box appears.
• For IPP, you can configure User Settings, Proxy Settings and Timeout Set-

tings.

Note
❒ For more information about these settings, see SmartNetMonitor for Client

Help.
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Setting Up a Client Computer

This section describes the procedures for setting up a client on a network that
uses Windows 2000, Windows XP, Windows NT Server or Windows NT Work-
station as a print server.
When using a Windows 2000, Windows XP or Windows NT print server, select
a shared printer on Windows 2000, Windows XP or Windows NT.

Limitation
❒ When using a print server connected to the printer with SmartNetMonitor for

Client, you cannot use Recovery Printing and Parallel Printing.

Note
❒ This section assumes that the client has already been configured to communi-

cate with a Windows 2000, Windows XP or Windows NT print server. Do not
begin the following procedure until the client has been set up and configured
correctly.

AAAA Install the printer driver as a local printer.

Reference
For more information about installing the printer driver, see the Setup
Guide.

Note
❒ Any port can be selected during the installation, however, LPT1 is recom-

mended.

BBBB Click [Start], point to [Settings], and then click [Printers].

CCCC Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

Windows 2000, Windows XP or 
Windows NT Print Server

Windows 95/98/Me
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DDDD Click the [Details] tab, and then click [Add Port].

EEEE Click [Network], and then click [Browse].

FFFF On the network tree, double-click the name of the computer used as the
print server.
The printers connected to the network are displayed.

GGGG Click the name of the printer you want to use, and then click [OK].

HHHH Click [OK].

IIII Make sure that the port name is displayed in the [Print to the following port]
box, and then click [OK].
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2. Windows 2000
Configuration

Configuring Windows 2000

Printing without a Print Server

The following procedure describes how to configure Windows 2000 to use the
machine on a network without a Windows 2000, Windows NT Server, Windows
NT Workstation or NetWare based print server.

AAAA Specify the protocol to use

Consult your network administrator about which of the three protocols is ap-
propriate.
• TCP/IP
• IPP
• NetBEUI

BBBB Configure the chosen protocol.
• See p.15 “Configuring TCP/IP and IPP for Printing”.
• See p.16 “Configuring NetBEUI for Printing”.

CCCC Install the software and set the printer driver port
• Install SmartNetMonitor for Client from the CD-ROM labeled "Printer

Drivers and Utilities". For more information about how to install the soft-
ware and how to specify the printer driver port, see the Setup Guide.

Printing with a Standard TCP/IP Port

Standard TCP/IP port is a standard port of Windows 2000 to enable Peer-to-
Peer printing in a network environment.
For more information about Standard TCP/IP port settings, see Windows 2000
Help.

Note
❒ If a device model selection dialog box appears during the procedure to add

the standard TCP/IP port, select "RICOH Network Printer C Model".
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Printing with a LPR Port

See p.22 “Configuring LPR Port Printing” for configuring a LPR port in Win-
dows 2000.

Printing with a Windows 2000 or Windows NT Print Server

See p.23 “Setting Up a Client Computer” for configuring Windows 2000 with a
Windows 2000 or Windows NT print server.
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Configuring the Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 2000 to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
• Make sure that the TCP/IP protocol is set to active. (The default is active.)
• Assign an IP address and make other settings required for using the TCP/IP

protocol.

Reference
For more information about how to make the above settings, see the Setup
Guide.
If DHCP is used to assign IP addresses, see p.121 “Using DHCP”.

Note
❒ After setting the IP address, use the ping command to make sure that it has

been set correctly.
A Click [Start], point to [Programs], point to [Accessories], and then click [Com-

mand Prompt].
B Type the following: (Example IP address is 192.168.15.16)

C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.

Configuring a Windows 2000 computer

Follow these steps to configure a Windows 2000 computer to use the TCP/IP
protocol.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

BBBB Click [Local Area Connection]. On the [General] tab, click [Properties].
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CCCC Make sure that the“Internet Protocol (TCP/IP)” is selected in the [Compo-
nents checked are used by this connection:] box on the [General] tab.

Note
❒ Select the TCP/IP protocol box if it is not already selected.
❒ If the TCP/IP protocol is not installed, click [Install] on the [General] tab to

install it. For more information about installing the TCP/IP protocol, see
Windows 2000 Help.

DDDD Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.
Check with the network administrator that the settings are correct.

Configuring NetBEUI for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 2000 to use the NetBEUI protocol.

Preparation
To use NetBEUI, use the SmartNetMonitor for Client port.

Configuring the machine

Configure the machine to use the NetBEUI protocol.
• Make sure that the NetBEUI protocol is set to active. (The default is active.)

Reference
For more information about how to make the above settings, see the Setup
Guide.

Configuring a Windows 2000 computer

Follow these steps to configure a Windows 2000 computer to use the NetBEUI
protocol.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

BBBB Click [Local Area Connection]. On the [General] tab, click [Properties].

CCCC Make sure that the“NetBEUI Protocol” is selected in the [Components
checked are used by this connection:] box on the [General] tab.

Note
❒ Select the NetBEUI protocol box if it is not already selected.
❒ If the NetBEUI protocol is not installed, click [Install] on the [General] tab

and install it. For more information about installing the NetBEUI protocol,
see Windows 2000 Help.
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Using SmartNetMonitor for Client 

SmartNetMonitor for Client is a utility that helps you to use network printers ef-
fectively. It is useful in environments where two or more network printers are
used. It is recommended that you install SmartNetMonitor for Client to use Par-
allel Printing and Recovery Printing. For more information about SmartNet-
Monitor for Client, see SmartNetMonitor for Client Help.

❖❖❖❖  SmartNetMonitor for Client features
• Sends a print job directly to the network printers without using a print

server.
• Notifies when a printing error occurs.
• Prints documents using other printers in the printer group when the spec-

ified printer is busy (Recovery Printing).
• Equally divides the number of copies to be printed among the selected

printers in the printer group (Parallel Printing).

Important
❒ The following must be the same for the specified printer and the print-

ers selected for Recovery Printing or Parallel Printing.
• Printer models (for Parallel Printing only)
• Installed options (e.g. Paper tray unit)
• Size and orientation of paper in each paper tray unit
• Total memory
• Installed fonts (including the downloaded fonts)

Note
❒ Failure to meet any of the conditions above may result in unexpected

print results.
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Installing SmartNetMonitor for Client 

Install SmartNetMonitor for Client from the CD-ROM labeled “Printer Drivers
and Utilities”. For more information about how to install, see the Setup Guide.
After the installation is complete, configure the printer port with SmartNetMon-
itor for Client. See p.19 “Setting Up the Printer Driver”.

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it. For more information about SmartNetMonitor for Cli-
ent, see SmartNetMonitor for Client Help.

AAAA From the [Printers] window, click the icon of the printer which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

BBBB Click the [Ports] tab, and then make sure that the SmartNetMonitor for Cli-
ent port is shown in the [Print to the following port(s)] box.

Remember the port name because this port should be deleted later.

CCCC Select the [FILE] check box in the [Port] column.

DDDD Click [OK] to close the Printer Properties.

The port which is currently in use is changed.

EEEE Open the Printer Properties of the same printer.

FFFF Select the [Ports] tab.

GGGG At the [Port] column in the [Print to the following port(s)] dialog box, click to se-
lect the SmartNetMonitor for Client port name as in step BBBB. 

HHHH Click [Delete Port].

IIII When the confirmation message appears, click [Yes].
The port is deleted.

JJJJ Click [Close] to close the Printer Properties.
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Uninstalling SmartNetMonitor for Client 

Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:
• The port settings dialog box is closed.
• No printer is using the SmartNetMonitor for Client port as a printer port.
• You have performed login with the same user authority as that used to in-

stall SmartNetMonitor for Client.

AAAA Open [Control Panel], and then double-click the [Add/Remove Programs] icon.

BBBB Click the [Change or Remove Programs] tab, click [SmartNetMonitor for Client],
and then click [Change/Remove].

CCCC After the confirmation message appears, click [Yes].

UninstallShield removes all of the components of SmartNetMonitor for Client.

DDDD After the confirmation message appears, click [Yes].

EEEE Acknowledge the [Remove Shared File?] dialog box.

FFFF When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

Preparation
The target printer must be turned on before starting the installation process.

AAAA Install the printer driver for the printer you want to use.

BBBB From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

CCCC Click the [Ports] tab and click [Add Port].

DDDD Click [SmartNetMonitor for Client] in the [Available port types:] box, and then
click [New Port].

The [Select Printer] dialog box appears and printers on the network are browsed. 
The displayed items are as follows: 
Model Name: The model name of the printer.
Name: The name of Network Interface Board.
Comment: Additional information about Network Interface Board.
Address: The IP address of the printer.
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EEEE Select the printer.

TCP/IP

A Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an IP broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address] and
then type the IP address or host name.

NetBEUI

A Click [NetBEUI].
A list of printers that can be printed by the NetBEUI protocol appears.

B Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to a broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address] and
then type the NetBEUI address. Make sure that the NetBEUI address is
on the configuration page. For information about the printing of the
configuration page, see "Printing a Configuration Page" in the Setup
Guide. The NetBEUI address appears as "\\RNPxxxx\xxx" on the con-
figuration page. Type the printer's network path name in the form of
"%%Computer name\Share name". Do not type "\\" as head characters
but "%%".

❒ You cannot print to printers beyond routers.

IPP

A Click [IPP].
The IPP setting dialog box appears.

B To specify the IP address of the printer, type "http://printer's-ip-ad-
dress/printer" or "ipp://printer's-ip-address/printer" in the [Printer URL]
field.
(Example IP address is 192.168.15.16)
http://192.168.15.16/printer

ipp://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name different from those of any existing port names.
If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.
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D If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

Note
❒ For more information about these setting, see SmartNetMonitor for Cli-

ent Help.

FFFF Click [OK].

GGGG Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port(s)] box, and then click [Close].

This completes the settings.
To print, select the specified printer. SmartNetMonitor for Client will now di-
rect print data to the printer automatically.

Changing Port Settings

Follow the steps to change SmartNetMonitor for Client settings, such as Parallel
Printing, Recovery Printing, TCP/IP, the proxy server and IPP URL.

Note
❒ There are no settings for the NetBEUI protocol.

AAAA From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

BBBB Click the [Ports] tab, and then click [Configure Port].

The [Port Settings] dialog box appears
• For TCP/IP protocol, you can configure Parallel Printing, Recovery Print-

ing and Timeout Settings.
• For IPP, you can configure User Settings, Proxy Settings and Timeout Set-

tings.

Note
❒ For more information about these settings, see SmartNetMonitor for Client

Help.
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Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
2000.

Note
❒ The TCP/IP protocols must be installed and configured correctly. For more

information about configuring the protocols, see p.15 “Configuring TCP/IP
and IPP for Printing”.

AAAA Click [Start], point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

CCCC Click the [Ports] tab and click [Add Port].

DDDD In the [Available port types:] box, click “LPR Port”, and then click [New Port].

Note
❒ If “LPR Port” does not appear, “Print Services for Unix” has not been in-

stalled. For more information about how to install "Print Services for Un-
ix", see Windows 2000 Help.

EEEE Type the IP address of the Network Interface Board into the [Name or address
of server providing lpd:] box.

FFFF Type “lp” into the [Name of printer or print queue on that server box:], and then
click [OK].

GGGG Click [Close].

HHHH Make sure that the port name is displayed in the [Print to the following port(s)]
box and that the check box is selected, and then click [OK].

Download from Www.Somanuals.com. All Manuals Search And Download.



Setting Up a Client Computer

23

2

Setting Up a Client Computer

This section describes the procedures for setting up a client in a network that
uses Windows 2000, Windows XP, Windows NT Server or Windows NT Work-
station as a print server.
When using a Windows 2000, Windows XP or Windows NT print server, select
a shared printer on Windows 2000, Windows XP or Windows NT.

Limitation
❒ When using a print server connected to the printer with SmartNetMonitor for

Client, you cannot use Recovery Printing and Parallel Printing.

Note
❒ This section assumes that the client has already been configured to communi-

cate with a Windows 2000, Windows XP or Windows NT print server. Do not
begin the following procedure until the client has been set up and configured
correctly.

Use the [Printers] window to set up the printer.

AAAA Click [Start], point to [Settings] and then click [Printers].

BBBB Double-click the [Add Printer] icon.
This launches the Add Printer Wizard.

CCCC Click [Next >].

DDDD Click [Network printer], and then click [Next >].

EEEE Click [Next >].

FFFF In the [Shared printers:] box, double-click the name of the computer used as
a print server.

The printers attached to the network are displayed.

Windows 2000

Windows 2000, Windows XP or 
Windows NT Print Server

Download from Www.Somanuals.com. All Manuals Search And Download.



Windows 2000 Configuration

24

2

GGGG Click the printer you want to use, and then click [Next >].

Note
❒ If the printer driver is not installed in the print server, a message appears.

If a driver has been installed on the client, click [OK], and then follow the
instructions on the screen.

❒ There is a Windows 2000 printer driver on the CD-ROM labeled “Printer
Drivers and Utilities”.

HHHH Select whether to use this printer as the default printer, and then click [Next >].

IIII After the installation is complete, click [Finish].

The icon of the newly installed printer appears in the [Printers] window.
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3. Windows XP Configuration

Configuring Windows XP

Printing without a Print Server

The following procedure describes how to configure Windows XP to use the ma-
chine on a network without a Windows XP, Windows NT Server, Windows NT
Workstation or NetWare based print server.

AAAA Specify the protocol to use

Consult your network administrator about which of the three protocols is ap-
propriate.
• TCP/IP
• IPP

BBBB Configure the protocol.

• See p.27 “Configuring TCP/IP and IPP for Printing”.

CCCC Install the software and set the printer driver port

• Install SmartNetMonitor for Client from the CD-ROM labeled "Printer
Drivers and Utilities". For more information about how to install the soft-
ware and how to specify the printer driver port, see the Setup Guide.

Printing with a Standard TCP/IP Port

Standard TCP/IP port is a standard port of Windows XP to enable Peer-to-Peer
printing in a network environment.
For more information about Standard TCP/IP port settings, see Windows XP
Help.

Note
❒ If a device model selection dialog box appears during the procedure to add

the standard TCP/IP port, select "RICOH Network Printer C Model".
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Printing with a LPR Port

See p.34 “Configuring LPR Port Printing” for configuring a LPR port in Win-
dows XP.

Printing with a Windows 2000, Windows XP or Windows NT Print 
Server

See p.35 “Setting Up a Client Computer” for configuring Windows XP with a
Windows 2000, Windows XP or Windows NT print server.
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Configuring the Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows XP to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
• Make sure that the TCP/IP protocol is set to active. (The default is active.)
• Assign an IP address and make other settings required for using the TCP/IP

protocol.

Reference
For more information about how to make the above settings, see the Setup
Guide.
If DHCP is used to assign IP addresses, see p.121 “Using DHCP”.
To use the IP over 1394, see the Setup Guide.

Note
❒ After setting the IP address, use the ping command to make sure that it has

been set correctly.
A Click [Start], point to [All Programs], point to [Accessories], and then click

[Command Prompt].
B Type the following: (Example IP address is 192.168.15.16)

C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.
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Configuring a Windows XP computer

Follow these steps to configure a Windows XP computer to use the TCP/IP pro-
tocol.

AAAA Click [Start] on the taskbar, point to [Control Panel], and then click [Network
and Internet Connections].

BBBB Click [Local Area Connection]. On the [General] tab, click [Properties].

Note
❒ With the IP over 1394, click [1394 Connection].

CCCC Make sure that the“Internet Protocol (TCP/IP)” is selected in the [This con-
nection uses the following items:] box on the [General] tab.

Note
❒ Select the TCP/IP protocol box if it is not already selected.
❒ If the TCP/IP protocol is not installed, click [Install...] on the [General] tab to

install it. For more information about installing the TCP/IP protocol, see
Windows XP Help.

DDDD Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.
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Using SmartNetMonitor for Client 

SmartNetMonitor for Client is a utility that helps you to use network printers ef-
fectively. It is useful in environments where two or more network printers are
used. It is recommended that you install SmartNetMonitor for Client to use Par-
allel Printing and Recovery Printing. For more information about SmartNet-
Monitor for Client, see SmartNetMonitor for Client Help.

❖❖❖❖  SmartNetMonitor for Client features
• Sends a print job directly to the network printers without using a print

server.
• Notifies when a printing error occurs.
• Prints documents using other printers in the printer group when the spec-

ified printer is busy (Recovery Printing).
• Equally divides the number of copies to be printed among the selected

printers in the printer group (Parallel Printing).

Important
❒ The following must be the same for the specified printer and the print-

ers selected for Recovery Printing or Parallel Printing.
• Printer models (for Parallel Printing only)
• Installed options (e.g. Paper tray unit)
• Size and orientation of paper in each paper tray unit
• Total memory
• Installed fonts (including the downloaded fonts)

Note
❒ Failure to meet any of the conditions above may result in unexpected

print results.

Reference
For more information about how to use  SmartNetMonitor for Client,
see the "readmeXP.txt" file included on the CD-ROM labeled "Operat-
ing Instructions" (If the CD-ROM drive is D, the folder will be "D:\Net-
work\Netmon\Client\Disk1").
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Installing SmartNetMonitor for Client 

Install SmartNetMonitor for Client from the CD-ROM labeled “Printer Drivers
and Utilities”. For more information about how to install, see the Setup Guide.
After the installation is complete, configure the printer port with SmartNetMon-
itor for Client. See p.31 “Setting Up the Printer Driver”.

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it. For more information about SmartNetMonitor for Cli-
ent, see SmartNetMonitor for Client Help.

AAAA From the [Printers] window, click the icon of the printer which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

BBBB Click the [Ports] tab, and then make sure that the SmartNetMonitor for Cli-
ent port is shown in the [Print to the following port(s)] box.

Remember the port name because this port should be deleted later.

CCCC Select the [FILE] check box in the [Port] column.

DDDD Click [OK] to close the Printer Properties.

The port which is currently in use is changed.

EEEE Open the Printer Properties of the same printer.

FFFF Select the [Ports] tab.

GGGG At the [Port] column in the [Print to the following port(s)] dialog box, click to se-
lect the SmartNetMonitor for Client port name as in step BBBB. 

HHHH Click [Delete Port].

IIII When the confirmation message appears, click [Yes].
The port is deleted.

JJJJ Click [Close] to close the Printer Properties.

Download from Www.Somanuals.com. All Manuals Search And Download.



Using SmartNetMonitor for Client

31

3

Uninstalling SmartNetMonitor for Client 

Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:
• The port settings dialog box is closed.
• No printer is using the SmartNetMonitor for Client port as a printer port.
• You have performed login with the same user authority as that used to in-

stall SmartNetMonitor for Client.

AAAA Open [Control Panel], and then double-click the [Add/Remove Programs] icon.

BBBB Click the [Add or Remove Programs]category, click [SmartNetMonitor for Client],
and then click [Change/Remove].

CCCC After the confirmation message appears, click [Yes].

UninstallShield removes all of the components of SmartNetMonitor for Client.

DDDD After the confirmation message appears, click [Yes].

EEEE Acknowledge the [Remove Shared File?] dialog box.

FFFF When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

Preparation
The target printer must be turned on before starting the installation process.

AAAA Install the printer driver for the printer you want to use.

BBBB From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

CCCC Click the [Ports] tab and click [Add Port].

DDDD Click [SmartNetMonitor for Client] in the [Available port types:] box, and then
click [New Port].

The [Select Printer] dialog box appears and printers on the network are browsed. 
The displayed items are as follows: 
Model Name: The model name of the printer.
Name: The name of Network Interface Board.
Comment: Additional information about Network Interface Board.
Address: The IP address of the printer.
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EEEE Select the printer.

TCP/IP

A Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an IP broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address] and
then type the IP address or host name.

IPP

A Click [IPP].
The IPP setting dialog box appears.

B To specify the IP address of the printer, type "http://printer's-ip-ad-
dress/printer" or "ipp://printer's-ip-address/printer" in the [Printer URL]
field.
(Example IP address is 192.168.15.16)
http://192.168.15.16/printer

ipp://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name different from those of any existing port names.
If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.

D If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

Note
❒ For more information about these setting, see SmartNetMonitor for Cli-

ent Help.

FFFF Click [OK].

GGGG Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port(s)] box, and then click [Close].
This completes the settings.
To print, select the specified printer. SmartNetMonitor for Client will now di-
rect print data to the printer automatically.
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Changing Port Settings

Follow the steps to change SmartNetMonitor for Client settings, such as Parallel
Printing, Recovery Printing, TCP/IP, the proxy server and IPP URL.

Note
❒ There are no settings for the NetBEUI protocol.

AAAA Access the [Printers and Faxes] window from [Start] on the taskbar.

BBBB Click the [Ports] tab, and then click [Configure Port].

The [Port Settings] dialog box appears
• For TCP/IP protocol, you can configure Parallel Printing, Recovery Print-

ing and Timeout Settings.
• For IPP, you can configure User Settings, Proxy Settings and Timeout Set-

tings.

Note
❒ For more information about these settings, see SmartNetMonitor for Client

Help.
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Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
XP.

Note
❒ The TCP/IP protocols must be installed and configured correctly. For more

information about configuring the protocols, see p.27 “Configuring TCP/IP
and IPP for Printing”.

AAAA Access the [Printers and Faxes] window from [Start] on the taskbar.

BBBB Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

CCCC Click the [Ports] tab and click [Add Port].

DDDD In the [Available port types:] box, click “LPR Port”, and then click [New Port].

Note
❒ If “LPR Port” does not appear, “Print Services for Unix” has not been in-

stalled. For more information about how to install "Print Services for Un-
ix", see Windows XP Help.

EEEE Type the IP address of the Network Interface Board into the [Name or address
of server providing lpd:] box.

FFFF Type “lp” into the [Name of printer or print queue on that server box:], and then
click [OK].

GGGG Click [Close].

HHHH Make sure that the port name is displayed in the [Print to the following port(s)]
box and that the check box is selected, and then click [OK].
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Setting Up a Client Computer

This section describes the procedures for setting up a client in a network that
uses Windows 2000, Windows XP, Windows NT Server or Windows NT Work-
station as a print server.
When using a Windows 2000, Windows XP or Windows NT print server, select
a shared printer on Windows 2000, Windows XP or Windows NT.

Limitation
❒ When using a print server connected to the printer with SmartNetMonitor for

Client, you cannot use Recovery Printing and Parallel Printing.

Note
❒ This section assumes that the client has already been configured to communi-

cate with a Windows 2000, Windows XP or Windows NT print server. Do not
begin the following procedure until the client has been set up and configured
correctly.

Use the [Printers] window to set up the printer.

AAAA Access the [Printers and Faxes] window from [Start] on the taskbar.

BBBB Click [Add Printer] in the Printer Tasks category.
This launches the Add Printer Wizard.

CCCC Click [Next >].

DDDD Click [[A network printer, or a printer attached to another computer.], and then click
[Next >].

EEEE Click [Next >].

Windows XP

Windows 2000, Windows XP or 
Windows NT Print Server
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FFFF In the [Shared printers:] box, double-click the name of the computer used as
a print server.

The printers attached to the network are displayed.

GGGG Click the printer you want to use, and then click [Next >].

Note
❒ If the printer driver is not installed in the print server, a message appears.

If a driver has been installed on the client, click [OK], and then follow the
instructions on the screen.

❒ There is a Windows XP printer driver on the CD-ROM labeled “Printer
Drivers and Utilities”.

HHHH Select whether to use this printer as the default printer, and then click [Next >].

IIII After the installation is complete, click [Finish].
The icon of the newly installed printer appears in the [Printers] window.
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4. Windows NT 4.0
Configuration

Configuring Windows NT 4.0

Printing without a Print Server

The following procedure describes how to configure Windows NT 4.0 to use the
machine on a network without a Windows 2000, Windows NT Server, Windows
NT Workstation or NetWare based print server.

AAAA Specify the protocol to use

Consult your network administrator about which of the three protocols is ap-
propriate.
• TCP/IP
• IPP
• NetBEUI

BBBB Configure the chosen protocol.
• See p.38 “Configuring TCP/IP and IPP for Printing”.
• See p.39 “Configuring NetBEUI for Printing”.

CCCC Install the software and set the printer driver port
• Install SmartNetMonitor for Client from the CD-ROM labeled "Printer

Drivers and Utilities". For more information about how to install the soft-
ware and how to specify the printer driver port, see the Setup Guide.

Printing with a LPR Port

See p.46 “Configuring LPR Port Printing” for how to configure a LPR port in
Windows NT 4.0.

Printing with a Windows 2000 or Windows NT Print Server

See p.47 “Setting Up a Client Computer” for configuring Windows NT 4.0 with
a Windows 2000 or Windows NT print server.
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Configuring the Protocols

Configuring TCP/IP and IPP for Printing

These instructions are for configuring the Network Interface Board and Win-
dows NT to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
• Make sure that the TCP/IP protocol is set to active. (The default is active.)
• Assign an IP address and make other settings required for using the TCP/IP

protocol.

Reference
For more information about how to make the above settings, see the Setup
Guide.
If DHCP is used to assign IP addresses, see p.121 “Using DHCP”.

Note
❒ After setting the IP address, use the ping command to make sure that it has

been correctly set.
A Click [Start], point to [Programs], and then click [Command Prompt].
B Type the following: (Example IP address is 192.168.15.16)

C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.

Configuring a Windows NT computer

These steps are for configuring a Windows NT computer to use the TCP/IP pro-
tocol.

AAAA Open [Control Panel], and then double-click the [Network] icon. Make sure
that “TCP/IP Protocol” is listed in the [Network protocols] box on the [Proto-
cols] tab.

Note
❒ If the TCP/IP protocol is not installed, click [Add] on the [Protocols] tab to

install it. For more information about installing the TCP/IP protocol, see
Windows NT Help.
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BBBB Configure the TCP/IP protocols with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.

CCCC Click the [Services] tab, and then make sure that “Microsoft TCP/IP Print-
ing” is installed.

If “Microsoft TCP/IP Printing” is not installed, click [Add] on the [Services ]
tab, to install it. For more information about installing and configuring net-
work services, see Windows NT Help.

Configuring NetBEUI for Printing

These instructions are for configuring the Network Interface Board and Win-
dows NT to use the NetBEUI protocol.

Preparation
To use NetBEUI, use the SmartNetMonitor for Client port.

Configuring the machine

Configure the machine to use the NetBEUI protocol.
• Make sure that the NetBEUI protocol is set to active. (The default is active.)

Reference
For more information about how to make the above settings, see the Setup
Guide.

Configuring a Windows NT computer

Install the NetBEUI protocol on the Windows NT computer, and then change the
LAN adapter number (Lana Number).

AAAA Open [Control Panel], and then double-click the [Network] icon. Make sure
that “NetBEUI Protocol” is listed in the [Network Protocols] box on the [Proto-
cols] tab.

Note
❒ If the NetBEUI protocol is not installed, click [Add] on the [Protocols] tab to

install it. For more information about installing the NetBEUI protocol, see
Windows NT Help.

BBBB Change the Lana Number. Click the [Services] tab, click “NetBIOS Inter-
face” in the [Services] tab, and then click [Properties].

CCCC Click the Lana Number corresponding the Nbf protocol of the [Network
Route] headline, and then click [Edit].
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DDDD Type “0” as the Lana Number.

Note
❒ If the other protocol's Lana Number is configured with “0”, you must

change the Lana Number a number other than “0”.

EEEE Click [OK].

FFFF Click [Close], and then close the [Network] dialog box.

GGGG After checking the message to restart, click [Yes].

Note
❒ After you change the Lana Number, you must restart the computer.

Download from Www.Somanuals.com. All Manuals Search And Download.



Using SmartNetMonitor for Client

41

4

Using SmartNetMonitor for Client 

SmartNetMonitor for Client is a utility that helps you to use network printers ef-
fectively. It is useful in environments where two or more network printers are
used. It is recommended that you install SmartNetMonitor for Client to use Par-
allel Printing and Recovery Printing. For more information about SmartNet-
Monitor for Client, see SmartNetMonitor for Client Help.

❖❖❖❖  SmartNetMonitor for Client features
• Sends a print job directly to the network printers without using a print

server.
• Notifies when a printing error occurs.
• Prints documents using other printers in the printer group when the spec-

ified printer is busy (Recovery Printing).
• Equally divides the number of copies to be printed among the selected

printers in the printer group (Parallel Printing).

Important
❒ The following must be the same for the specified printer and the print-

ers selected for Recovery Printing or Parallel Printing.
• Printer models (for Parallel Printing only)
• Installed options (e.g. Paper tray unit)
• Size and orientation of paper in each paper tray unit
• Total memory
• Installed fonts (including the downloaded fonts)

Note
❒ Failure to meet any of the conditions above may result in unexpected

print results.

Limitation
❒ On a computer that is used as a print server, do not use the features such as

Parallel Printing, Recovery Printing and Notify. For more information about
turning off these features, see SmartNetMonitor for Client Help.
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Installing SmartNetMonitor for Client 

Install SmartNetMonitor for Client from the CD-ROM labeled “Printer Drivers
and Utilities”. For more information about how to install, see the Setup Guide.
After the installation is complete, configure the printer port with SmartNetMon-
itor for Client. See p.43 “Setting Up the Printer Driver”.

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it. For more information about SmartNetMonitor for Cli-
ent, see SmartNetMonitor for Client Help.

AAAA From the [Printers] window, click the icon of the printer which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

BBBB Click the [Ports] tab, and then make sure that the SmartNetMonitor for Cli-
ent port is shown in the [Print to the following port] box.

Remember the port name because this port should be deleted later.

CCCC From the [Print to the following port] box, select [FILE].

DDDD Click [Apply].

The port which is currently in use is changed.

EEEE Click [Delete Port].

FFFF After the confirmation message appears, click [Yes].

The port is deleted.

GGGG Click [OK] to close the printer properties.

Uninstalling SmartNetMonitor for Client 

Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:
• The port settings dialog box is closed.
• No printer is using the SmartNetMonitor for Client port as a printer port.
• You have performed login with the same user authority as that used to in-

stall SmartNetMonitor for Client.

AAAA Open [Control Panel], and then double-click the [Add/Remove Programs] icon.

BBBB On the [Install/Uninstall] tab, click [SmartNetMonitor for Client] and click [Add/Re-
move].
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CCCC After the confirmation message appears, click [Yes].

UninstallShield removes all of the components of SmartNetMonitor for Cli-
ent.

DDDD After a confirmation message appears, click [Yes].

EEEE Acknowledge the [Remove Shared File?] dialog box.

FFFF When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

Preparation
The target printer must be turned on before starting the installation process.

AAAA Install the printer driver of the printer you want to use.

BBBB From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

CCCC Click the [Ports] tab and click [Add Port].

DDDD Click [SmartNetMonitor] from the list, and then click [New Port...].
The [Select Printer] dialog box appears .
The displayed items are as follows:
Model Name: The model name of the printer. 
Name: The name of the Network Interface Board.
Comment: Additional information about the Network Interface Board.
Address: The IP address of the printer.

EEEE Select the printer.

TCP/IP

A Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an IP broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.
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NetBEUI

A Click [NetBEUI].
A list of printers that can be printed by the NetBEUI protocol appears.

B Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to a broadcast from the computer will be displayed.

To print to a printer not listed here, click [Specify Address] and then type
the NetBEUI address. Make sure that the NetBEUI address is on the con-
figuration page. For information about the printing of the configuration
page, see "Printing a Configuration Page" in the Setup Guide. The Net-
BEUI address appears as "\\RNPxxxx\xxx" on the configuration page.
Type the printer's network path name in the form of "%%Computer
name\Share name". Do not type "\\" as head characters but "%%".

❒ You cannot print to printers beyond routers.

IPP

A Click [IPP].
The IPP setting dialog box appears.

B To specify the IP address of the printer, type "http://printer's-ip-ad-
dress/printer" or "ipp://printer's-ip-address/printer" in the [Printer URL]
field.
(Example IP address is 192.168.15.16)
http://192.168.15.16/printer

ipp://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name different from those of any existing port names.
If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.

D If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

Note
❒ For more information about these setting, see SmartNetMonitor for Cli-

ent Help.

FFFF Click [OK].

GGGG Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port] box, and then click [OK].
This completes the settings.
To print, select the printer specified here. SmartNetMonitor for Client will
now direct print data to the printer automatically.
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Changing Port Settings

Follow the steps to change SmartNetMonitor for Client settings, such as Parallel
Printing, Recovery Printing, TCP/IP, the proxy server settings and IPP URL.

Note
❒ There are no settings for the NetBEUI protocol.

AAAA From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

BBBB Click the [Ports] tab, and then click [Port Configuration].
The [Port Settings] dialog box appears
• For TCP/IP protocol, you can configure Recovery Printing, Parallel Print-

ing and Timeout Settings.
• For IPP, you can configure User Settings, Proxy Settings and Timeout Set-

tings.

Note
❒ For more information about these settings, see SmartNetMonitor for Client

Help.
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Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
NT.

Note
❒ The following procedure assumes that the printer drivers have already been

installed. This is the procedure to change the printer port to LPR.
❒ The TCP/IP protocols must be installed and configured correctly. For more

information about configuring the protocol, see p.38 “Configuring TCP/IP
and IPP for Printing”.

AAAA Click [Start], point to [Settings], and then click [Printers].

BBBB Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

CCCC Click the [Ports] tab, and then click [Add Port].

DDDD In the [Available Printer Ports] box, click “LPR Port”, and then click [New Port].

Note
❒ If “LPR Port” does not appear, “Microsoft TCP/IP Printing” has not been

installed.

EEEE Type the IP address of the Network Interface Board into the [Name or address
of server providing lpd] box.

FFFF Type “lp” into the [Name of printer or print queue on that server] box, and then
click [OK].

GGGG Click [Close].

HHHH Make sure that the port name is displayed in the [Print to the following port(s)]
box and the check box is selected, and then click [OK].
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Setting Up a Client Computer

This section describes the procedures for setting up a client in a network that
uses Windows 2000, Windows XP, Windows NT Server or Windows NT Work-
station as a print server.
When using a Windows 2000, Windows XP or Windows NT print server, select
a shared printer on Windows 2000, Windows XP or Windows NT.

Limitation
❒ When using a print server connected to the printer with SmartNetMonitor for

Client, you cannot use Recovery Printing and Parallel Printing.

Note
❒ This section assumes that the client has already been configured to communi-

cate with a Windows 2000, Windows XP or Windows NT print server. Do not
begin the following procedure until the client has been set up and configured
correctly.

Use the [Printers] window to set up the printer.

AAAA Click [Start], point to [Settings], and then click [Printers].

BBBB Double-click the [Add Printer] icon.
This launches the Add Printer Wizard.

CCCC Click [Network printer server] and click [Next >].

DDDD In the [Shared Printers] box, double-click the name of the computer used as a
print server.

The printers attached to the network are displayed.

Windows NT 4.0

Windows 2000, Windows XP or 
Windows NT Print Server

Download from Www.Somanuals.com. All Manuals Search And Download.



Windows NT 4.0 Configuration

48

4

EEEE Click the printer you want to use and click [OK].

Note
❒ If the printer driver is not installed in the print server, a message appears.

If a driver has been installed on the client, click [OK] and follow the instruc-
tions on the screen.

❒ There is a Windows NT printer driver on the CD-ROM labeled “Printer
Drivers and Utilities”.

FFFF Select if you want to use this printer as the default printer, and then click
[Next >].

GGGG After the installation is complete, click [Finish].

The icon of the newly installed printer appears in the [Printers] window.
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5. NetWare Configuration

This chapter describes how to configure the machine to use as a print server or
a remote printer in a NetWare environment.

Note
❒ NetWare must be set to active using the machine's control panel. For more in-

formation about how to set it, see the Setup Guide.

Installing the NIB Setup Tool 

A utility called the NIB Setup Tool is provided to configure the machine to work
in a network environment. This section describes how to install the SmartNet-
Monitor for Admin, and how to run the NIB Setup Tool.

Limitation
❒ The NIB Setup Tool is supported to work with the following operating sys-

tems.
• Microsoft Windows 95/98/Me
• Microsoft Windows 2000
• Microsoft Windows NT 4.0

❖❖❖❖ SmartNetMonitor for Admin
Using a printer in a NetWare environment, configure the NetWare printing
environment by using SmartNetMonitor for Admin.

Note
❒ If you configure the NetWare printing environment by using SmartNet-

Monitor for Admin under the following environments, NetWare Client
provided by Novell is required.
• NDS mode in Windows 95/98
• NDS or Bindary mode in Windows 2000/Windows NT 4.0

❖❖❖❖ Printers listed by SmartNetMonitor for Admin
SmartNetMonitor for Admin displays a list of printers, which are connected
to the network.
If you cannot find out the printer from the displayed list, refer to the config-
uration page printed from the printer. For more information about printing a
configuration page, see the Setup Guide.
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Installing SmartNetMonitor for Admin 

Install SmartNetMonitor for Admin on your computer. For the installation pro-
cedure, see the Setup Guide.
After installing SmartNetMonitor for Admin, see one of the following sections:
• To configure the Network Interface Board as a NetWare print server for the

first time, see p.51 “Quick Setup Using the NIB Setup Tool Wizard”.
• To use this computer with NetWare 3.x as a print server, see p.54 “NetWare

3.x - Advanced Settings”.
• To use this computer with NetWare 3.x as a remote printer, see p.54 “Net-

Ware 3.x - Advanced Settings”.
• To use this computer with NetWare 4.x, 5 or 5.1 as a print server, see p.60

“NetWare 4.x, 5/5.1 - Advanced Settings”.
• To use this computer with NetWare 4.x, 5 or 5.1 as a print server, see p.60

“NetWare 4.x, 5/5.1 - Advanced Settings”.

Running the NIB Setup Tool 

AAAA Click [Start], point to [Programs], and then click [NIB Setup Tool] in the [Smart-
NetMonitor for Admin] program folder.
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Quick Setup Using the NIB Setup Tool Wizard

With the NIB Setup Tool, you can easily set up a NetWare printing environment. 

Reference
For more information about installing the NIB Setup Tool, see p.49 “Installing
the NIB Setup Tool”.

You can select [Wizard] or [Property Sheet] as an installation method.
When you configure the Network Interface Board for the first time, use the Wiz-
ard method.
If you want to use the Property Sheet method, see p.54 “NetWare 3.x - Advanced
Settings” or p.60 “NetWare 4.x, 5/5.1 - Advanced Settings”.

Note
❒ This section assumes that NetWare is functional and that the necessary envi-

ronment for NetWare Print Services is available.
❒ If you configure the Network Interface Board in a NetWare environment us-

ing the NIB Setup Tool, you should install the client software released from
Novell in the following cases.
• Windows 95/98/Me in NDS mode configuration
• Windows NT 4.0 in NDS mode configuration
• Windows NT 4.0 in Bindery mode configuration
• Windows 2000 in NDS mode configuration
• Windows 2000 in Bindery mode configuration

AAAA Log on to the Netware file server or the NDS tree as an Admin or Admin
equivalent.

BBBB Run the NIB Setup Tool.

Reference
 See p.50 “Running the NIB Setup Tool” .

CCCC Click [Wizard] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

DDDD Click [IPX protocol].

EEEE Click to select the IPX address of the Network Interface Board you are con-
figuring, and then click [Next >].

Note
❒ If you do not know which Network Interface Board you are configuring,

print a network configuration page to check the MAC address (Network
address).
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FFFF Make sure that the MAC address and IPX address are correct, and then click
[Finish].

GGGG Type the print server name into the [Device Name] box, and then click [Next >].

The default setting is “RDP_” followed by the 6 digit serial number. We rec-
ommend that you change it to something that is easier to remember or some-
thing based on the structure of the network.

HHHH In a dialog box for selecting a network environment, click to select the [Net-
Ware] check box and click to clear the [TCP/IP] check box.

IIII Click [Next >].

A dialog box for configuring the NetWare environment appears.

JJJJ Select [Bindery] when printing under Bindery mode, or select [NDS] when
printing under NDS mode.
When you are using NetWare version 4.x, you should select [NDS].

KKKK If you selected [Bindery], type into the [File Server Name:] box the name of the
file server in which a print server is to be created.

After clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

LLLL If you selected [NDS], type into the [Tree:] box the name of the NDS tree in
which the print server is created, and then type the context into the [Con-
text:] box.
Clicking [Browse], you can select an NDS tree and an NDS context among
those listed in the [Browse] dialog boxes.
As a context, object names are typed from a lower object and divided by a pe-
riod. For example, if you want to create a print server into NET under DS,
type “NET.DS”.

MMMM Click [Next >].

NNNN Type the name of the printer into the [Printer Name] box, and the name of the
print queue into the [Print Queue Name] box.
The default setting for Printer Name is “Print Server Name” followed by “_1”
and for Print Queue Name is “Print Server Name” followed by “_Q” (quota-
tion marks are not included). You can change them if necessary.
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OOOO If you have selected the NDS mode, type the volume of the print queue into
the [Queue Volume] box. 

Clicking [Browse], you can select one of those shown in the [Browse] dialog
box.

PPPP Click [Next >].

A dialog box to acknowledge the printing environment appears.

QQQQ After checking the environment, click [Next >].

If you want to change the settings, click [< Back], and then make the settings
again.
Clicking [Next >], the NIB Setup Tool automatically creates the Print Server,
the Printer, and the Print Queue in the NetWare network.

RRRR After the confirmation dialog box appears, select [Quit] and click [Finish] to
exit the NIB Setup Tool.
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NetWare 3.x - Advanced Settings

The actual procedures for configuring the machine vary depending on whether
the Network Interface Board is configured as a print server or as a remote print-
er. This section describes how to configure the machine in the NetWare 3.x en-
vironment.

Preparation
The following procedures use the Property Sheet method in configuring the
Network Interface Board. If you configure the Network Interface Board as a
NetWare print server for the first time, we recommend you use the Wizard
method. See p.51 “Quick Setup Using the NIB Setup Tool Wizard” .

Note
❒ This section assumes NetWare is functional and that the necessary environ-

ment for the NetWare Print Service is available.

Install the NIB Setup Tool

Print Server Remote Printer

Basic Procedure

Configure the Network Interface Board

Configure the NetWare

Start the print server
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Setting Up as a Print Server

AAAA Log on to the file server as a Supervisor or a Supervisor equivalent.

BBBB Run the NIB Setup Tool.

Reference
 See p.50 “Running the NIB Setup Tool” .

CCCC Click [Property Sheet] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

DDDD Click [IPX protocol].

EEEE Click the IPX address of the Network Interface Board which is to be config-
ured, and then click [Next >].

Note
❒ If you do not know which Network Interface Board you are configuring,

see the network configuration page to check the MAC address (Network
Address).

FFFF Make sure that the MAC address and IPX address are correct, and then click
[Finish].

The [NIB Setup Tool] window appears.

GGGG Click [Configure].
The property sheet appears.

HHHH Click the [General] tab, and then type the name of the print server into the
[Device Name] box.

IIII Click the [NetWare] tab, and then make the following settings.

A Select [Bindery].
B In the [File Server Name:] box, type the name of the file server in which a

print server is to be created.
Click [Browse] to select a file server among those listed in the [Browse] dia-
log box.

C Click [OK] to close the property sheet.

D After the confirmation dialog box appears, click [OK].

JJJJ On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

KKKK Type “PCONSOLE” from the command prompt.

F:> PCONSOLE
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LLLL Create a print queue as follows:

Note
❒ If you use a currently defined print queue, go to step M.
A From the [Available Options] menu, select [Print Queue Information], and then

press the {{{{ENTER}}}} key.

B Press the {{{{INSERT}}}} key, and then type a print queue name.
C Press the {{{{ESC}}}} key to return to the [Available Options] menu.

MMMM Create a printer as follows:

A From the [Available Options] menu, select [Print Server Information] , and then
press the {{{{ENTER}}}} key.

B To create a new print server, press the {{{{INSERT}}}} key, and then type a
print server name.

If you use a currently defined print server, select one of the print servers
shown in the [Print Server] list.

Important
❒ Use the same name as that specified in the NIB Setup Tool. (Step H).

C From the [Print Server Information] menu, select [Print Server Configuration].

D From the [Print Server Configuration] menu, select [Printer Configuration].
E Select the printer which is indicated as “Not Installed”.

F If you want to change the name of the printer, type a new name.

A name “Printer x” is assigned to the printer. “x” stands for the number of
the selected printer.

G For type, select [Remote Other/Unknown].
The IRQ, Buffer size, Starting form, and Queue service mode are automat-
ically configured.

H Press the {{{{ESC}}}} key, and then click [Yes] in the confirmation dialog box.

I Press the {{{{ESC}}}} key to return to the [Print Server Configuration] menu.

NNNN Assign print queues to the created printer as follows:
A From the [Print Server Configuration] menu, select [Queues Serviced By Printer].

B Select the printer created in step MMMM.

C Press the {{{{INSERT}}}} key to select a queue serviced by the printer. 

Note
❒ You can select more than one queue at a time.

D Follow the instructions on the screen to make other necessary settings.

When you have finished the previous steps, make sure that the queues are
assigned.
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OOOO Press the {{{{ESC}}}} key until “Exit?” appears, and then select [Yes] to exit
PCONSOLE.

Note
❒ To make sure that the printer is correctly configured, type the following

from the command prompt.
F:> USERLIST

❒ If the printer works as configured, the name of the print server appears as
an attached user.

Setting Up as a Remote Printer

AAAA Log on to the file server as a Supervisor or a Supervisor equivalent.

BBBB Run the NIB Setup Tool.

Reference
 See p.50 “Running the NIB Setup Tool” .

CCCC Click [Property Sheet] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

DDDD Click [IPX protocol].

EEEE Click the IPX address of the Network Interface Board which is to be config-
ured, and then click [Next >].

Note
❒ If you do not know which Network Interface Board you are configuring,

see a network configuration page to check the MAC address (Network Ad-
dress).

FFFF Make sure that the MAC address and IPX address are correct, and then click
[Finish].

The [NIB Setup Tool] window appears.

GGGG Click [Configure].
The property sheet appears.

HHHH Click the [General] tab, and then type the name of the print server into the
[Device Name] box.

IIII Click the [NetWare] tab, and then make the following settings.

A In the [Print Server Name] box, type the name of the print server.
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B In the [File Server Name] box, type the name of the file server in which a
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

C In the [Print Server Operation Mode] group, click [As Remote Printer].

D In the [Remote Printer No.] box, type the printer number.

Important
❒ Use the same printer number as that to be created in the printer server.

E Click [OK] to close the property sheet.

F After the confirmation dialog box appears, click [OK].

JJJJ On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

KKKK Type “PCONSOLE” from the command prompt.

F:> PCONSOLE

LLLL Create a print queue as follows:

Note
❒ If you use a currently defined print queue, go to step M.
A From the [Available Options] menu, select [Print Queue Information], and then

press the {{{{ENTER}}}} key.

B Press the {{{{INSERT}}}} key, and then type a print queue name.
C Press the {{{{ESC}}}} key to return to the [Available Options] menu.

MMMM Create a printer as follows.

A From the [Available Options] menu, select [Print Server Information] , and then
press the {{{{ENTER}}}} key.

B To create a new print server, press the {{{{INSERT}}}} key, and then type a
print server name.

If you use a currently defined print server, select one of the print servers
shown in the [Print Server] list.

Important
❒ Use the same name as that specified in the NIB Setup Tool. (Step H).

C From the [Print Server Information] menu, select [Print Server Configuration].
D From the [Print Server Configuration] menu, select [Printer Configuration].

E Select the printer which is indicated as “Not Installed”.

Important
❒ Use the same number as that specified as Remote Printer No. using the

NIB Setup Tool. (Step I-D).
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F Type a new name, if you change the name of the printer.

A name “Printer x” is assigned to the printer. x stands for the number of
the selected printer.

G Select [Remote Parallel, LPT1] for type.
The IRQ, Buffer size, Starting form, and Queue service mode are automat-
ically configured.

H Press the {{{{ESC}}}} key, and then click [Yes] in the confirmation dialog box.

I Press the {{{{ESC}}}} key to return to [Print Server Configuration Menu].

NNNN Assign print queues to the created printer as follows:
A From [Print Server Configuration Menu], select [Queues Serviced By Printer].

B Select the printer created in step MMMM.

C Press the {{{{INSERT}}}} key to select a queue serviced by the printer. 

Note
❒ You can select more than one queue at a time.

D Follow the instructions on the screen to make other necessary settings.

When you have finished the above steps, make sure that the queues are as-
signed.

OOOO Press the {{{{ESC}}}} key until “Exit?” appears, and then select [Yes] to exit
PCONSOLE.

PPPP Start the print server by typing the following from the console of the Net-
Ware Server.
 If it is running, restart it after exiting it.

❖❖❖❖ To exit
CAREE: unload pserver

❖❖❖❖ To start
CAREE: load pserver print_server_name

Note
❒ If the printer works as configured, “Waiting for job” appears.
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NetWare 4.x, 5/5.1 - Advanced Settings

The actual procedures for configuring the machine vary depending on whether
the Network Interface Board is configured as a print server or as a remote print-
er. This section describes how to configure it in the NetWare 4.x, 5/5.1 environ-
ment.

❖❖❖❖ To use NetWare 5/5.1
• If you use Pure IP, configure the machine to use the TCP/IP protocol. For

more information about how to make the settings, see the Setup Guide.

Preparation
The following procedures use the Property Sheet method in configuring the
Network Interface Board. If you configure the Network Interface Board as a
NetWare print server for the first time, we recommend you use the Wizard
method. See p.51 “Quick Setup Using the NIB Setup Tool Wizard”. 

Note
❒ This section assumes NetWare is functional and that the necessary environ-

ment for the NetWare Print Service is available.
❒ You should install the client software released from Novell in Windows be-

fore running the NIB Setup Tool for configuring in NDS mode or using Win-
dows NT 4.0.

Install the NIB Setup Tool

Print Server Remote Printer

Basic Procedure

Configure the Network Interface Board

Configure the NetWare

Start the print server

Download from Www.Somanuals.com. All Manuals Search And Download.



NetWare 4.x, 5/5.1 - Advanced Settings

61

5

Setting Up as a Print Server

Important
❒ You can set up the print server using the NDS or Bindery mode in NetWare

4.x, 5/5.1. The following procedure is for setting up the print server using the
NDS mode in NetWare 4.1. When you set up the print server using the Bind-
ery mode, use the NIB Setup Tool Wizard. See p.51 “Quick Setup Using the
NIB Setup Tool Wizard”.

Note
❒ If you use Pure IP in NetWare 5/5.1, follow the procedure on p.63 “Using

Pure IP in the NetWare 5/5.1 environment”.

AAAA Log on to the file server as an Admin or an Admin equivalent.

BBBB Run the NIB Setup Tool.

Reference
 See p.50 “Running the NIB Setup Tool” .

CCCC Click [Property Sheet] and click [OK].

DDDD Click [IPX protocol].

EEEE Click the IPX address of the Network Interface Board which is to be config-
ured, and then click [Next >].

Note
❒ If you do not know which Network Interface Board you are configuring,

see the network configuration page to check the MAC address (Network
Address).

FFFF Make sure that the MAC address and IPX address are correct, and then click
[Finish].

The [NIB Setup Tool] window appears.

GGGG Click [Configure].

The property sheet appears.

HHHH Click the [General] tab, and then type the name of the print server into the
[Device Name] box.

IIII Click the [NetWare] tab, and then make the following settings.
A In the [Print Sever Name:] box, type the name of the print sever.

B In the [File Sever Name:] box, type the name of the file sever in which a
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.
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C In the [NDS Context:] box, type the context in which the print server is to
be created.

Clicking [Browse], you can select a context among those listed in the
[Browse] dialog box.
As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type “NET.DS”.

D Click [OK] to close the property sheet.

E After the confirmation dialog box appears, click [OK].

JJJJ On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

KKKK From Windows, run NWAdmin.

Reference
For more information about NWAdmin, see the documentation that comes
with the NetWare.

LLLL Create a print queue as follows:

A Select the container object the print queue is located in among those in
the directory tree, and then click [Create] on the [Object] menu.

B In the [Class of new object] box, click “Print Queue”, and then click [OK].

C In the [Print Queue name] box, type the name of the print queue.
D In the [Print Queue volume] box, click the [Browse] button.

E In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

F After checking the settings, click [Create].

MMMM Create a printer as follows:
A Select the container object the printer is located in, and then click [Create]

on the [Object] menu.
B In the [Class of new object] box, click “Printer”, and then click [OK]. When

you are using NetWare 5/5.1, click “Printer (Non NDPS)”.
C In the [Printer name] box, type the name of the printer.

D Select the [Define additional properties] check box, and then click [Create].
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NNNN Assign print queues to the created printer as follows:

A Click [Assignments], and then click [Add] in the [Assignments] group.
B In the [Available objects] box, click the queue created in step LLLL, and then

click [OK].
C Click [Configuration], and in the [Printer type] box, select [Parallel] using the

drop-down menu, and then click [Communication]. 
D Click [Manual load] in the [Communication type] group, and then click [OK].

E After checking the settings, click [OK].

OOOO Create a print server as follows:
A Select the context specified using the NIB Setup Tool (step IIII-AAAA), and

on the [Object] menu, click [Create].
B In the [Class of new object] box, click “Print Server”, and then click [OK].

When you are using NetWare 5/5.1, click “Print Server (Non NDPS)”.
C In the [Print Server name] box, type the name of the print server.

Important
❒ Use the same name as that specified using the NIB Setup Tool. (Step H)

D Select the [Define additional properties] check box, and then click [Create].

PPPP Assign the printer to the created print server as follows.
A Click [Assignments], and then click [Add] in the [Assignments] group.

B In the [Available objects] box, click the printer created in step MMMM, and then
click [OK].

C After checking the settings, click [OK].

Note
❒ If the printer works as configured, the name of the print server appears

as an attached user.

Using Pure IP in the NetWare 5/5.1 environment

AAAA Log on to the file server as an Admin or an Admin equivalent.

BBBB Run the NIB Setup Tool.

Reference
 See p.50 “Running the NIB Setup Tool” .

CCCC Click [Property Sheet] and click [OK].

The [Network board list] dialog box appears.

DDDD Click [TCP/IP protocol].
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EEEE Click the IP address of the Network Interface Board which is to be config-
ured, and then click [Next >].

Note
❒ If you do not know which Network Interface Board you are configuring,

see the network configuration page to check the MAC address (Network
Address).

FFFF Make sure that the MAC address and IP address are correct, and then click
[Finish].

The [NIB Setup Tool] window appears.

GGGG Click [Configure].

The property sheet appears.

HHHH Click the [General] tab, and then type the name of the print server into the
[Device Name:] box.

IIII Click the [NetWare] tab, and then make the following settings.
A In the [Print Server Name:] box, type the name of the print server.

B In the [File Server Name:] box, type the name of the file server in which a
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse File Server] dialog box.

C In the [NDS Context:] box, type the context of the print server.

Clicking [Browse], you can select an NDS tree and an NDS context among
those listed in the [Browse Context] dialog box.
As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type “NET.DS”.

D In the [Print Server Operation Mode] group, click [As Print Server].

E Click [OK] to close the property sheet.
F After the confirmation dialog box appears, click [OK].

JJJJ On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

After this step, go to step K on p.61 “Setting Up as a Print Server”.
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Setting Up as a Remote Printer

AAAA Log on to the file server as an Admin or an Admin equivalent.

BBBB Run the NIB Setup Tool.

Reference
 See p.50 “Running the NIB Setup Tool” .

CCCC Click [Property Sheet] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

DDDD Click [IPX protocol].

EEEE Click the IPX address of the Network Interface Board which is to be config-
ured, and then click [Next >].

Note
❒ If you do not know which Network Interface Board you are configuring,

see the network configuration page to check the MAC address (Network
Address).

FFFF Make sure that the MAC address and IPX address are correct, and then click
[Finish].

The [NIB Setup Tool] window appears.

GGGG Click [Configure].
The property sheet appears.

HHHH Click the [General] tab, and then type the name of the print server into the
[Device Name] box.

IIII Click the [NetWare] tab, and then make the following settings.

A In the [Print Server Name:] box, type the name of the print server.
B In the [File Server Name:] box, type the name of the file server in which a

print server is to be created.
Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.
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C In the [NDS Context:] box, type the context in which the print server is to
be created.

Clicking [Browse], you can select a context among those listed in the
[Browse] dialog box.
As a context, object names are typed from a lower level object and divided
by a period. For example, if you want to create a print server into NET un-
der DS, type “NET.DS”.

D In the [Print Server Operation Mode] group, click [As Remote Printer].

E In the [Remote Printer No.] box, type the number of the printer.

Important
❒ Use the same number as that of the printer to be created in the print

server.
F Click [OK] to close the property sheet.

G After the confirmation dialog box appears, click [OK].

JJJJ On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

KKKK From Windows, run NWAdmin.

Reference
For more information about NWAdmin, see the documentation that comes
with the NetWare.

LLLL Create a print queue as follows:

A Select the container object the print queue is located in among those in
the directory tree, and then click [Create] on the [Object] menu.

B In the [Class of new object] box, click “Print Queue”, and then click [OK].
C In the [Print Queue name] box, type the name of the print queue.

D In the [Print Queue Volume] box, click [Browse] button.

E In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

F After checking the settings, click [Create].

MMMM Create a printer as follows:

A Select the container object the printer is located in, and then click [Create]
in the [Object] menu.

B In the [Class of new object] box, click “Printer”, and then click [OK]. When
you are using NetWare 5/5.1, click “Printer (Non NDPS)”.
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C In the [Printer name] box, type the name of the printer.

D Select the [Define additional properties] check box, and then click [Create].

NNNN Assign print queues to the created printer as follows:

A Click [Assignments], and then click [Add] in the [Assignments] group.

B In the [Available objects] box, click the queue created in step LLLL, and then
click [OK].

C Click [Configuration], and in the [Printer type] box, select [Parallel] using the
drop-down menu, and then click [Communication]. 

D Click [Manual load] in the [Communication type] group, and then click [OK].
E After checking the settings, click [OK].

OOOO Create a print server as follows:

A Select the context specified using the NIB Setup Tool (Step IIII-AAAA), and
on the [Object] menu, click [Create].

B In the [Class of new object] box, click “Print Server”, and then click [OK].
When you are using NetWare 5/5.1, click “Print Server (Non NDPS)”.

C In the [Print Server name] box, type the name of the print server.

Important
❒ Use the same name as that specified using the NIB Setup Tool. (Step H).

D Select the [Define additional properties] check box, and then click [Create].

PPPP Assign the printer to the created print server as follows.

A Click [Assignments], and then click [Add] in the [Assignments] group.

B In the [Available objects] box, click the queue created in the step MMMM, and
then click [OK].

C In the [Printers] group, click the printer assigned in step BBBB , and then
click [Printer Number].

D Type the printer number and click [OK].

Important
❒ Use the same number as that specified as Remote Printer No. using the

NIB Setup Tool. (Step I-E).
E After checking the settings, click [OK].

QQQQ Start the print server by typing the following from the console of the Net-
Ware Server.
If it is running, restart it after exiting it.

❖❖❖❖ To exit
CAREE: unload pserver

❖❖❖❖ To start
CAREE: load pserver print_server_name
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Setting Up a Client Computer

This section describes how to set up a client computer when using a NetWare
print server.

Note
❒ Use the version of Novell Client provided with your operating system or the

latest version.
❒ This section assumes that the client has NetWare client applications installed

and is correctly configured to communicate with a NetWare print server. If
not, install the necessary applications before starting the setting up proce-
dure.

Windows 95/98/Me

Follow the procedure to set up a Windows 95/98/Me client. 

Preparation
Log on to the NetWare file server before starting the following procedure.

AAAA Install the printer driver you want to use as “Local printer”.

Reference
For more information about installing the printer driver, see the Setup
Guide.

Note
❒ Any port can be selected during the installation, however, LPT1 is recom-

mended.

BBBB Click [Start], point to [Settings], and then click [Printers].

CCCC In the [Printers] window, click the icon of the printer you want to use. 

DDDD On the [File] menu, click [Properties].

EEEE Click the [Details] tab, and then click [Add Port].

FFFF Click [Network] and click [Browse].

GGGG On the network tree, double-click the name of the file server.

The queues are displayed.

HHHH Click the queue you want to print, and then click [OK].

IIII Click [OK].

In the [Print to the following port] box, a network path to the printer appears.
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JJJJ Click [OK] to close the Printer Properties, and again, open it.

KKKK Click the [Printer Settings] tab.

LLLL Select to clear the [Form feed] and [Enable banner] check boxes.

Note
❒ You should not select these boxes because they should be specified using

the printer driver. If they are selected, the printer might not print correctly.

When using the PostScript printer driver

Follow these steps to set up for the PostScript printer driver.
A Click the [PostScript] tab. 

B Click [Advanced].
C Click to clear the [Send CTRL+D before job] and [Send CTRL+D after job] check

boxes.

MMMM Click [OK] to close the Printer Properties.

Windows 2000

Follow the procedure to set up a Windows 2000 client.

Preparation
Log on to the NetWare file server before starting the following procedure.

AAAA Double-click the [My Network Places] icon on the desktop and navigate to the
queue you want to use, and then double-click it.

The printers dialog box appears.

BBBB Click [No].

CCCC Close all the applications that are currently running.

DDDD Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

If the setup menu starts automatically, you can go to the next step. If not, see
the Setup Guide.

EEEE The [Printer Installation] dialog box appears.

FFFF From the [Port] list, select the queue you selected in step AAAA, and then click
[Next >].

GGGG Follow the instructions on the screen to complete the installation of the
printer driver.
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Windows NT 4.0

Follow the procedure to set up a Windows NT 4.0 client.

Preparation
Log on to the NetWare file server before starting the following procedure.

AAAA Double-click the [Network Neighborhood] icon on the desktop and navigate to
the queue you want to use, and then double-click it.
The [Printers] dialog box appears.

BBBB Click [No].

CCCC Close all the applications that are currently running.

DDDD Insert the CD-ROM labeled “Printer Drivers and Utilities”into the CD-
ROM drive.
If the setup menu starts automatically, you can go to the next step. If not, see
the Setup Guide.

EEEE The [Printer Installation] dialog box appears.

FFFF From the [Port] list, select the queue you selected in step AAAA, and then click
[Next >].

GGGG Follow the instructions on the screen to complete the installation of the
printer driver.
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Configuring Macintosh

This section describes how to configure a Macintosh computer to use EtherTalk.
The actual procedures to configure a Macintosh may vary depending on the ver-
sion of the Mac OS. The following procedure describes how to configure Mac OS
9.1. If you are not using Mac OS 9.1, see the manual that comes with your version
of Mac OS for more information.

Limitation
❒ The required version of Mac OS is 8.6 or later. (Mac OS X Classic environment

is supported.)

Changing to EtherTalk

The following procedure is for configuring a Macintosh computer to use
EtherTalk.

Reference
For more information about installing the software required for EtherTalk,
see the Macintosh manuals.

AAAA Open [Control Panel], and then double-click the [AppleTalk] icon.

BBBB From the [Connect via:] pop-up menu, select “Ethernet”.

CCCC If you change zones, select a name from the [Current zone:] pop-up menu.

DDDD Close the [AppleTalk] control panels.

EEEE Restart the Macintosh.

Change to EtherTalk

Basic Procedure

Configure the printer

Change the printer name

Change the zone
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Configuring the Printer

Use the control panel to activate the EtherTalk protocol. (The default is active.)

Reference
For more information about configuration, see the Setup Guide.

Changing the Printer Name

If the network has several similar model printers, the names will be the same.
Printers that have the same name will have their names slightly changed in the
Chooser. For example, three printers named “printer” will appear in the chooser
as “printer0”, “printer1” and “printer2”. 
To change the printer name in the Macintosh EtherTalk environment, use the
Printer Utility for Mac included on the CD-ROM labeled “Printer Drivers and
Utilities”.

Changing the Zone

To change the zone configuration in the Macintosh EtherTalk environment, use
the Printer Utility for Mac included on the CD-ROM labeled “Printer Drivers
and Utilities”.

Reference
For more information about using Printer Utilities for Mac, see PostScript 3
Supplement provided as a PDF file on the CD-ROM labeled “Operating In-
structions”.
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7. Appendix

Using SmartNetMonitor for Admin

Using SmartNetMonitor for Admin, you can not only monitor the status of net-
work printers, but also allows you to change the configurations of the Network
Interface Board using the TCP/IP protocol or IPX/SPX protocol.
SmartNetMonitor for Admin is equipped with the following functions.
• Limits the settings to be done from the control panel, and disables changes to

be made to some of the items.
• Enables the selection of paper type loaded in the printer.
• Switches to the Energy Saver mode, and wakes up from the Energy Saver

mode.
• Checks the information on printing, paper exhaustion, and such, on the com-

puter.
• Monitors multiple printers at the same time. When there are many printers,

you can create groups and classify the printers to facilitate management.
• Checks the printer's network settings and detailed information of devices.
• Enables you to change the printer's network settings.
• Checks the number of pages printed for each computer, using the user codes.

Note
❒ Select the appropriate protocol stack for your operating system.

OS Protocol Stack

Microsoft Windows 95/98/Me TCP/IP provided with Windows 95/98/Me

IPX/SPX provided with Windows 95/98/Me

NetWare network client provided with Windows 
95/98

Novell Client for Windows 95/98

Microsoft Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetWare Client provided with Windows 2000

Novell Client for Windows NT/2000

Microsoft Windows XP TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

Microsoft Windows NT 4.0 TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT

Client Service for NetWare provided with Windows 
NT

Novell Client for Windows NT/2000
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Changing the Network Interface Board Configuration

AAAA Run SmartNetMonitor for Admin.

BBBB Click the [Group] menu, point to [Open LAN], and then select [TCP/IP] or
[IPX/SPX]. A list of printers appears.

Note
❒ Select the protocol of the printer you want to change its configuration.

CCCC On the list, Select a printer you want to change its configuration.

DDDD From the [Tools] menu, select [NIB Setup Tool].

The NIB Setup Tool starts up.

EEEE Select [Wizard] or [Property Sheet], and then click [Next].

• When configuring the Network Interface Board for the first time, select
[Wizard].

• When changing the configuration of the Network Interface Board or con-
figuring it in detail, select [Property Sheet].

Selecting [Wizard]

A Fill in the necessary items, and then click [Next].

Selecting [Property Sheet]

A A configuration list appears on the dialog box.

For more information about each item on the dialog box, see Help.
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Managing the User Information

AAAA Run SmartNetMonitor for Admin.

BBBB Click the [Group] menu, point to [Open LAN], and then select [TCP/IP] or
[IPX/SPX].
A list of printer appears.

Note
❒ Select the protocol of the printer you want to change its configuration.

CCCC On the list, Select a printer whose statistics information you want to man-
age.

DDDD From the [Tools] menu, select [User Management Tool].

The screen that prompts you to type a password appears.

EEEE Type the password, and then click [OK].

Note
❒ The factory default password is "password".
The User Code Maintenance Tool starts up.
For more information about using the User Management Tool, see SmartNet-
Monitor for Admin Help.

Configuring the Energy Save Mode

AAAA Run SmartNetMonitor for Admin.

BBBB Click the [Group] menu, point to [Open LAN], and then select [TCP/IP] or
[IPX/SPX].

A list of printer appears.

Note
❒ Select the protocol of the printer you want to change its configuration.

CCCC Click [Group], point to [Energy Save Mode], and select any energy saver mode
from the menu that appears.

For more information about settings, see SmartNetMonitor for Admin Help.

Download from Www.Somanuals.com. All Manuals Search And Download.



Appendix

76

7

Configuring the Network Interface Board 
with a Web Browser

The Network Interface Board functions as a Web server in addition to allowing
a printer to function as a network printer. You can use a Web Browser to view
the printer status and configure the Network Interface Board.

❖❖❖❖ Configuring the machine
This requires the TCP/IP protocol to be installed. After the machine has been
configured to use the TCP/IP protocol, it will be possible to adjust the settings
using a Web Browser.

Reference
For more information about configuring the machine to use the TCP/IP
protocol, see the Setup Guide.

❖❖❖❖ Operating system browser requirements

Limitation
❒ Sometimes after clicking [Back] , the previous page may not appear. In this

case, click [Refresh] or [Reload] .
❒ The text on the screen may disappear or be aligned incorrectly if the font

size settings of the browser are too large. It is recommended that you use
a font size equal to or smaller than “10 point” with Netscape Navigator,
and “Medium” or smaller with Internet Explorer.

❒ This machine information cannot reload automatically. Click [Reload] or
[Refresh] on the Web browser when you want to reload this machine infor-
mation.

OS Browser

Windows 95/98/Me

Microsoft Internet Explorer 4.01 or later

Netscape Navigator 4.06 or later

Windows NT 4.0

Windows 2000

Mac OS 8.6 ∼ 9.1

Solaris 2.5/2.6/2.7/7/8
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Going to the Top Page

After launching the Web Browser, type the IP address of the machine. See the
example below. This example is for the English version.
http://192.168.15.16/

(In this example, the IP address of the Network Interface Board is 192.168.15.16.)

Note
❒ If a DNS server is used on the network, you can type the host name as a URL.

For example, http://webmonitor.netprinter.com/. In order to do this, you
must the register the IP address and the host name of the Network Interface
Board with the DNS server. Consult the network administrator for informa-
tion about how to do this.

❒ When you use the proxy server, you must set up the proxy server address for
the Web browser you are using. Consult the network administrator for infor-
mation about how to set the proxy server.

1. Header Buttons
You can register favorite URLs with
[URL]. To view the Help section, click
[Help].

Important
❒ When connecting via a dial-up

connection, please be aware that
there will be a communication
charge as you are logging onto the
Internet.

Note
❒ The Help files are stored on the CD-

ROM labeled “Operating Instruc-
tions” in HTML format.

2. Menu Buttons
These Buttons are to configure the Net-
work Interface Board and for checking
the status of the machine.

Note
❒ When you click [Configuration], a dia-

log box appears requesting the user
name and password. Type only the
password in this dialog box. The de-
fault password is “password”.

❒ The password is the same as that used
for remote maintenance and that used
in the NIB Setup Tool. If you change a
password with the Web Browser, the
other passwords are also changed.

3. Status
Displays the name and comments of the
Network Interface Board, and the printer
status.

3

1
2
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Configuring the Network Interface Board Settings

AAAA Start the Web browser.

BBBB Point your browser at the URL or IP address of the printer (e.g. ht-
tp://XXX.XXX.XXX.XXX where the Xs are the number of the IP address).
The status of the printer you chose appears on the Web browser.

CCCC Click [Configuration].

The dialog box for entering the password and user name is displayed.

DDDD Enter your user name and password, and then click [OK].

To use the factory default account, enter no user name and type "password"
for the password.

EEEE Click the item you want to configure, and then make all the settings.

The following items can be configured:

❖❖❖❖ [General]
Configure the general settings for the machine here.

❖❖❖❖ [TCP/IP]
Configure the TCP/IP-related settings for the Network Interface Board,
802.11b Interface Unit, and 1394 Interface Unit.

❖❖❖❖ [SNMP]
Configure the appropriate community settings here. Up to 10 types of
community names can be registered.

❖❖❖❖ [NetWare]
Configure the settings for printing in a NetWare environment here.

❖❖❖❖ [AppleTalk]
Configure the Network Interface Board or 802.11b Interface Unit settings
related to the AppleTalk protocol.

❖❖❖❖ [NetBEUI]
Configure the Network Interface Board or 802.11b Interface Unit settings
related to the NetBEUI protocol here.

❖❖❖❖ [IEEE 1394]
Configure the 1394 Interface Unit settings related to IP over 1394 and SCSI
print (SBP-2).

Limitation
❒ This page is displayed when the 1394 Interface Unit is installed.
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❖❖❖❖ IPP Authentication
If using the IPP protocol, configure the authentication settings for printing
here.

❖❖❖❖ Paper Type
Select the paper type loaded in the machine from the drop-down menu.

❖❖❖❖ Password
Follow the procedure below to change the password.
Enter the password to change the network and machine settings or delete
spooled print jobs.

❖❖❖❖ IEEE 802.11b (Wireless LAN)
Configure the 802.11b Interface Unit settings related to communication.

Limitation
❒ This page is displayed when the 802.11b Interface Unit is installed.

Verifying the Network Interface Board Settings

AAAA Start the Web browser.

BBBB Point your browser at the URL or IP address of the printer (e.g. ht-
tp://XXX.XXX.XXX.XXX where the Xs are the number of the IP address).

The status of the printer you chose appears on the Web browser.

CCCC Click [Config. Reference].
The dialog box for entering the password and user name is displayed.

DDDD Click the item you want to check.

The following items can be checked:

❖❖❖❖ [General]
Shows general settings for the machine.

❖❖❖❖ [TCP/IP]
Shows the TCP/IP-related settings for the Network Interface Board,
802.11b Interface Unit, and 1394 Interface Unit.

❖❖❖❖ [NetWare]
Shows the settings for printing in a NetWare environment.

❖❖❖❖ [AppleTalk]
Shows the Network Interface Board or 802.11b Interface Unit settings re-
lated to the AppleTalk protocol.
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❖❖❖❖ [NetBEUI]
Shows the Network Interface Board or 802.11b Interface Unit settings re-
lated to the NetBEUI protocol.

❖❖❖❖ [IEEE 1394]
Shows the 1394 Interface Unit settings related to IP over 1394 and SCSI
print (SBP-2).

❖❖❖❖ [IEEE 802.11b (Wireless LAN)]
Shows the 802.11b Interface Unit settings related to communication.

----Linking the address (URL) to the [Help] button
You can link the address (URL) of the [Help] button to the Help files on the com-
puter or on a Web server.
A Copy the Help files on the CD-ROM to the desired location. The Help files are

located in folders labeled with abbreviated language names; for example,
English Help files are in the [EN] folder. Make sure to copy the entire [EN] fold-
er to the new location.

B Using a Web Browser, navigate to the Top Page and click [Network config].
C Type your password, (it is not necessary to type a user name) and click [OK].
D Type the path to the Help files in the [Help URL] box.

If you copied the Help files to “C:\HELP\EN”, type “file ://C:/HELP/”. For
example if you copied the files to a Web server and the index URL is “ht-
tp://a.b.c.d/HELP/EN/index.html”, type “http://a.b.c.d/HELP/”.

E Click [Apply].
When a warning message appears, select to continue configuration.
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Monitoring and Configuring the Printer

Changing Names and Comments

You can change printer names and make a comment on printers to easily iden-
tify the printers listed on SmartNetMonitor for Client.
The following utilities are used to change printer names and comments.

❖❖❖❖ SmartNetMonitor for Admin
Allows you to change names and comments when the TCP/IP protocol or
IPX/SPX protocol is available. You can install SmartNetMonitor for Admin
from the CD-ROM that comes with the printer. For more information about
installing SmartNetMonitor for Admin, see the Setup Guide.

❖❖❖❖ Web Browser
Allows you to change names and comments when the TCP/IP protocol is
available.

Note
❒ Each of the names, in a TCP/IP protocol form (printer name) and in a Net-

BEUI protocol form, is changed individually. Comments are, however,
common to both of them.

❒ The factory default name consists of "RNP" and the last 3 bytes of the MAC
address on the Network Interface Board. For example, when the MAC ad-
dress is 00:00:74:62:7D:D5, the factory default name is "RNP627DD5".
Comments are not configured.

SmartNetMonitor for Admin

AAAA Run SmartNetMonitor for Admin.

BBBB Click the [Group] menu, point to [Open LAN], and select [TCP/IP] or [IPX/SPX].
A list of printers appears.

Note
❒ Select the protocol of the printer you want to change its configuration.

CCCC On the list, Select a printer whose Network Interface Board you want to
change its configuration.

DDDD From the [Tools] menu, select [NIB Setup Tool].

The NIB Setup Tool starts up.
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EEEE Select [Property Sheet], and then click [OK].

TCP/IP

A Click the [General] tab, and then type the device name into the [Device
Name] box and comment into the [Comment] box.
• In the [Device Name] box, type the name of the printer in under 13 char-

acters. The factory default name consists of "RNP" and the last 3 bytes
of the MAC address on the Network Interface Board. For example,
when the MAC address is 00:00:74:62:7D:D5, the factory default name is
"RNP627DD5". No name of 9 characters is permitted if the prefix is
"RNP". Also, when DHCP is selected as an IP address setting, the
number of characters is limited to 13 characters.

• In the [Comment] box, type any comment on printers in under 31 charac-
ters.

NetBEUI

A Click the [General] tab, and then type the comment into the [Comment]
box.

In the [Comment] box, type any comment on printers in under 31 characters.
B Click the [NetBEUI] tab.
C Type the computer name into the [Computer Name] box.

• In the [Computer Name] box, type the name that helps you to identify
printers using the NetBEUI protocol. The factory default name consists
of "RNP" and the last 3 bytes of the MAC address on the Network Inter-
face Board. For example, when the MAC address is 00:00:74:62:7D:D5,
the factory default name is "RNP627DD5". A maximum of 13 characters
consisting of uppercase English letters, numeric, or symbols (except
"*+,/:;<=>?[\]|. and space) can be used. No name is permitted if the
prefix is "RNP". You must avoid the duplication of the same name on a
network.

• In the [Comment] box, type any comment on printers in under 31 charac-
ters.

FFFF Click [OK].

The NIB Setup Tool exits, and the setting is transmitted to the printer.

GGGG Exit SmartNetMonitor for Admin.
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Web Browser

AAAA Run the Web browser.

BBBB Type the address "http:// (IP address of the printer you want to change the
settings)".
The status of the selected printer is displayed on the Web browser.

CCCC Click [Configuration].

A dialog box that prompts you to type the user name and a password ap-
pears.

DDDD Type the user name and the password, and then click [OK].
Type only the password in this dialog box. The factory default password is
"password".

EEEE Change names and comments.

TCP/IP

A Click [General], and then type the name into the [Device Name:] box and
comment into the [Comment] box.

• In the [Device Name:] box, enter the name of the printer in under 13 char-
acters. The factory default name consists of "RNP" and the last 3 bytes
of the MAC address on the Network Interface Board. For example,
when the MAC address is 00:00:74:62:7D:D5, the factory default name is
"RNP627DD5". No name of 9 characters is permitted if the prefix is
"RNP". Also, when DHCP is selected as an IP address setting, the
number of characters is limited to in under 13 characters.

• In the [Comment] box, type any comment on printers in under 31 charac-
ters.

B Click the [IEEE 1394], and then type the name into the [Device Name:] box
when you change the device name for IEEE 1394 (IP over 1394) interface.

• In the [Device Name:] box, enter the name of the printer in under13 char-
acters. The factory default name consists of "RNP" and the last 5 bytes
of the EUI-64 on the IEEE 1394 (IP over 1394) Interface. For example,
when the EUI-64 is 00:00:74:00:02:01:0A:66, the factory default name is
"RNP0002010A66". No name of 13 characters is permitted if the prefix is
"RNP".
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NetBEUI

A Click [NetBEUI].
B Type the name into the [Computer Name] box and comment into the [Com-

ment] box.
• In the [Computer Name] box, type the name that helps you to identify

printers using the NetBEUI protocol. The factory default name consists
of "RNP" and the last 3 bytes of the MAC address on the Network Inter-
face Board. For example, when the MAC address is 00:00:74:62:7D:D5,
the factory default name is "RNP627DD5". A maximum of 13 characters
consisting of uppercase English letters, numeric, or symbols (except
"*+,/:;<=>?[\]|. and space) can be used. No name is permitted if the
prefix is "RNP". You must avoid the duplication of the same name on a
network.

• In the [Comment] box, type any comment on printers in under 31 charac-
ters.

FFFF Click [Apply].

The setting is transmitted to the printer.

GGGG Exit the Web browser.

Displaying the Status of Printer

You can view the status of printers using SmartNetMonitor for Admin, Smart-
NetMonitor for Client, or Web browser.

SmartNetMonitor for Admin

AAAA Run SmartNetMonitor for Admin.

BBBB Click the [Group] menu, point to [Open LAN], and then select [TCP/IP] or
[IPX/SPX].

The status of printers is indicated with an icon in the list.

Note
❒ For more information about the status icons, see SmartNetMonitor for Ad-

min Help.

CCCC Getting further information, click the desired printer to select from the list,
and then click [Open] on the [Device] menu.

The status of the printer is displayed on the dialog box.

Note
❒ For more information about each item on the dialog box, see Help.
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SmartNetMonitor for Client

Viewing the status of printers using SmartNetMonitor for Client, you must, in
advance, configure SmartNetMonitor for Client so it monitors the printer whose
status you want to view.

Monitoring Printers

AAAA Run SmartNetMonitor for Client.

The SmartNetMonitor for Client icon appears at the right end of the taskbar.

BBBB Right-click the SmartNetMonitor for Client icon, and check if the desired
printer is configured on the pop-up menu that appears.
If it is configured, see SmartNetMonitor for Client Help.

CCCC If the desired printer is not configured, click [Options] on the pop-up menu.

The [SmartNetMonitor for Client - Options] dialog box appears.

DDDD Click the printer to be monitored, and select the [To Be Monitored] check box
from the [Monitoring Information Settings] group.

Note
❒ Selecting the [Displayed on Task Bar] check box will bring up the status of a

printer with an icon on the SmartNetMonitor for Client icon on the task
tray.

EEEE Click [OK].

The dialog box closes and the configured printer is monitored.

Displaying the Status of Printers

AAAA Run SmartNetMonitor for Client.

BBBB The status of printers is displayed on the SmartNetMonitor for Client icon
on the task tray.

Note
❒ For more information about the status icons, see SmartNetMonitor for Cli-

ent Help.

CCCC Getting further information on the status, right-click the SmartNetMonitor
for Client icon, and then click the desired printer.

The status of the printer is displayed on the dialog box.

Note
❒ For more information about each item on the dialog box, see Help.
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Web Browser

AAAA Run the Web browser.

BBBB Type the address "http:// (IP address of the printer whose status you want
to view)".
The status of the selected printer is displayed on the Web browser.

CCCC Click [Status] and you can check the status of the printer.

Note
❒ For more information about each item, see Help.
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Using the IEEE 802.11b (Wireless LAN)

Preparation
Use the WiFi authorized card for an access point and the IEEE 802.11b card in
the computer.

Setting IEEE 802.11b (Wireless LAN)

Connect the printer and the computer in Ad hoc Mode. Then set up IEEE 802.11b
(Wireless LAN) according to your network environment using the following
procedure.

Limitation
❒ To connect in Infrastructure Mode, after connecting the printer and the com-

puter in Ad hoc Mode, make settings using a Web browser and telnet by fol-
lowing procedures C to E in "Using in Infrastructure Mode".

Using in Ad hoc Mode See p.88 “Using in Ad hoc Mode”.

Using in Infrastructure Mode A See p.88 “Using in Ad hoc Mode”.

B See p.89 “Using in Infrastructure Mode”.

C See p.90 “Setting SSID”.

D See p.90 “Applying the Settings”.

E See p.91 “Confirming the Connection”.

Using WEP When using WEP, the following procedures 
are required after C, “Setting SSID”.

C-A See p.90 “Setting the WEP Key”.

C-B See p.90 “Using WEP”.
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Using in Ad hoc Mode

AAAA Press {{{{Menu}}}}.
"Menu" appears on the panel dis-
play.

BBBB Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "Host
Interface", and then click {{{{OK}}}}.

CCCC Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "Net-
work Setup, and then click {{{{OK}}}}.

The following is displayed when
installing the 802.11b Interface
Unit in the printer with Ethernet as
standard equipment. 
If the 802.11b Interface Unit has
been installed in the printer with
Ethernet as standard equipment,
go to step F.

DDDD Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "LAN
Type", and then click {{{{OK}}}}.

EEEE Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "IEEE
802.11b ", and then click {{{{OK}}}}.

FFFF Make the network settings. The
following items must be set:

• IP Address
• Subnet Mask
• Gateway Address
• Network Boot
• Frame Type (NW)
• Active Protocol
For more information about how
to make the settings, see the Setup
Guide.

GGGG Make setting for the computer.

Set the transmission mode of the
IEEE 802.11b card installed in the
computer to ad hoc mode and the
channel to 11. Make the computer
network settings. The following
items must be set:
• IP Address
• Subnet Mask

Reference
For more information about
how to make setting for the
IEEE 802.11b card installed in
the computer and the computer
in use, see the appropriate oper-
ating instructions or consult
your network administrator.

Note
❒ Depending on the client soft-

ware of the IEEE 802.11b card
installed in the computer, the
channels might not be able to be
set. In this case, set the printer
channel to the channel specified
by the computer.

  Menu:

   Host Interface

  Host Interface:

   Network Setup

  Network Setup:

   LAN Type

  LAN Type:

   IEEE 802.11b
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❒ Depending on the client soft-
ware of the IEEE 802.11b card
installed in the computer, set-
ting IBSS (Independent Base
Service Set or Network Name)
may be required. If you have to
make settings, set the value as
"ASSID".

❒ In an IEEE 802.11b environment
using the access point set as
"ASSID" in SSID, you may not
be able to connect the computer
and the printer in ad hoc mode.

HHHH Press {{{{On Line}}}}.

IIII Make sure the computer and the
printer are connected.

Reference
See p.91 “Confirming the Con-
nection”.

Using in Infrastructure Mode

Make setting for infrastructure mode
from the control panel of the printer,
telnet, or a Web browser.
For more information about how to
make settings from the control panel
of the printer, see the Setup Guide.
For more information about how to
use telnet and a Web browser, see
p.76 “Configuring the Network Inter-
face Board with a Web Browser” or
p.92 “Remote Maintenance by tel-
net”.
The following procedure uses a Web
browser.

Preparation
When using the printer in infra-
structure mode, you need the ac-
cess point in use or information
(SSID and WEP key) about the ac-
cess point that will be used. Make
SSID and WEP key settings at the
same time.
For access point information, see
the appropriate operating instruc-
tions, or consult your network ad-
ministrator.

Changing to Infrastructure Mode

AAAA Start the Web browser of a wire-
less LAN client connected in ad
hoc mode.

BBBB Point your browser at the URL or
IP address of the printer (e.g. ht-
tp://XXX.XXX.XXX.XXX where the
Xs are the number of the IP ad-
dress).

The status of the printer you chose
appears on the Web browser.

CCCC Click [Configuration].

The dialog box for entering the
password and user name is dis-
played.

DDDD Enter your user name and pass-
word, and then click [OK].

EEEE Click [IEEE 802.11b].

FFFF Change [Communication Mode] to
[Infrastructure mode].

If using SSID, seep.90 “Setting
SSID”.
If not using SSID, seep.90 “Apply-
ing the Settings”.
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Setting SSID

AAAA Click [IEEE 802.11b].

BBBB Enter a value in [SSID].

Important
❒ If you cannot connect after mak-

ing SSID and WEP key settings,
select "WL.LAN Defaults" from
the control panel, and then set
IEEE 802.11b (wireless LAN)
from the beginning. For more
information about how to use
the control panel, see the Setup
Guide.

Note
❒ The character strings to be set

are in the range ASCII 0x20-
0x7e and the SSID is case-sensi-
tive to 32 bytes.

If using the WEP key, see p.90 “Set-
ting the WEP Key”.
If not using the WEP key, seep.90
“Applying the Settings”.

Setting the WEP Key

AAAA Click [IEEE 802.11b].

BBBB Enter a value in [WEPKey].

Note
❒ You can set only 10 hexadecimal

character strings.

CCCC Change to enable use of WEP.

See p.90 “Using WEP”.

Using WEP

Important
❒ To enable the WEP key, be sure to

first enter a value for the WEP key.
Seep.90 “Setting the WEP Key”.

❒ With some products, depending
on the access point or IEEE 802.11b
card in use, it is possible to set
more than one WEP key. In this
case, make the first key the same as
the WEP key set in the printer.

AAAA Click [IEEE 802.11b].

BBBB Change [Encryption] to [Enable].

CCCC Apply all the settings.

See p.90 “Applying the Settings”.

Important
❒ If you cannot connect after mak-

ing SSID and WEP key settings,
select "WL.LAN Defaults", and
then make setting for IEEE
802.11b (wireless LAN) from
the beginning. For more infor-
mation about how to use the
control panel, see the Setup
Guide.

Applying the Settings

AAAA Click [Refresh] or [Reload].

The settings are transmitted.

Note
❒ To verify the settings, click [Con-

fig Reference], and then click
[IEEE 802.11b].

BBBB Exit the Web browser.
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Confirming the Connection

AAAA Make sure the LED of the IEEE
802.11b card is lit.

1. If the IEEE 802.11b card is on, it
lights in orange. If the IEEE 802.11b
(wireless LAN) is not selected, it
does not light, even if the printer
power is on.

2. If it is connected properly to a net-
work, the LED lights in green with
infrastructure mode, it is not con-
nected to a network. Check the net-
work environment.

BBBB Use a Web browser to check that
the printer is connected properly.
See p.76 “Configuring the Net-
work Interface Board with a Web
Browser”.

CCCC Print the configuration page to
verify the settings.

For information about how to print
the configuration page, see the Set-
up Guide.

ZGDH600J

1
2
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Remote Maintenance by telnet

You can view the printer status and configure the Network Interface Board us-
ing telnet.

Note
❒ You should specify a password so that only the network administrator, or a

person having network administrator privileges, can use remote maintenance. 

Using telnet

The following is a sample procedure using telnet.

Limitation
❒ Only one person at a time can be logged on to do remote maintenance.

AAAA Using the IP address or host name of the machine, start telnet.

% telnet IP_address

Note
❒ In order to use the host name instead of the IP address, you must write it

to the hosts file.

BBBB Type the password.

Note
❒ The default is “password”.

CCCC Type a command.

Reference
 For more information about telnet commands, see p.93 “Commands List”.

DDDD Exit telnet.

msh> logout

When the configuration is changed, a message requests whether or not the
changes should be saved.

EEEE Type “yes” to save the changes, and then press the {{{{ENTER}}}} key.

If you do not want to save the changes, type “no”, and then press the {{{{ENTER}}}}
key. If you want to make additional changes, type “return” at the command
line, and then press the {{{{ENTER}}}} key.

Note
❒ If the “Cannot write NVRAM information” message appears, the changes

are not saved. Repeat the steps above.
❒ The Network Interface Board is reset automatically when the settings are

changed.
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❒ When the Network Interface Board is reset, the active print job which has
already been sent to the machine will finish printing. However, jobs that
have not been sent yet will be canceled.

Commands List

Use this command to display remote maintenance use.

Note
❒ Type “help” to see a list of commands that can be used.

msh> help

❒ Type “help command_name” to display information about the syntax of that
command.
msh> help command_name

TCP/IP address

Use the ifconfig command to configure TCP/IP (IP address, subnet mask, broad-
cast address, default gateway address) for the machine.

❖❖❖❖ Reference
msh> ifconfig

❖❖❖❖ Configuration
msh> ifconfig interface_name parameter address

*1 If you did not enter the interface name, it will be automatically set to the Ethernet
interface.

*2 Available when the 1394 Interface Unit Type 4510 is installed. 
*3 You can specify an interface when installing the optional 802.11b Interface Unit

Type A.

Interface name Interface to be configured

ether

naf0
Ethernet Interface *1 

ip1394 *2 

fwip0 *2 

IEEE 1394 Interface

wlan *3 

wi0 *3 

IEEE 802.11b Interface

Parameter Meaning

(no parameter) IP address

netmask subnet mask

broadcast broadcast address
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❖❖❖❖ Changing the Interface
You can specify either the LAN interface or IEEE 802.11b interface when us-
ing the optional 802.11b Interface Unit. 
msh> ifconfig interface up

Note
❒ You cannot specify the optional IEEE 1394 Interface Unit.

The following is an example for configuring an IP address of 192.168.15.16 on
Ethernet interface.
msh> ifconfig ether 192.168.15.16

The following is an example for configuring a subnet mask of 255.255.255.0 on
Ethernet interface.
msh> ifconfig ether netmask 255.255.255.0

Note
❒ This affects the configuration of the Network Interface Board of the IP ad-

dress that is used.
❒ The TCP/IP setting is the same as that for the LAN interface and IEEE 802.11b

interface.
❒ To type an address using hexadecimal, prefix it by “0x”.

----Address

❖❖❖❖ Subnet Mask
A number used to mathematically “mask” or hide the IP address on the net-
work by eliminating those parts of the address that are alike for all the ma-
chines on the network.

Note
❒ To get the above addresses, contact your network administrator.
❒ The subnet mask is the same as that for the LAN interface and IEEE 802.11b

interface.
❒ When installing the optional 1394 Interface Unit, set the subnet so that it does

not overlap with the LAN interface or the 1394 interface.
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Access Control

Use the access command to view and configure access control. You can also
specify two or more access ranges.

❖❖❖❖ Reference
msh> access

❖❖❖❖ Configuration
msh> access ✩ range start-address end-address

• ✩ represents a target number between 1 and 5. (Up to five access ranges
can be registered and selected.)

Example: To specify accessible IP addresses between 192.168.0.10 and
192.168.0.20:
msh> access 1 range 192.168.0.10 192.168.0.20

Note
❒ The access range restricts the workstations from which printing is possible

by means of an address. If you do not need to restrict printing, make the
setting “0.0.0.0”.

❒ The entry is invalid if the start address is greater than the end address.
❒ Up to five access ranges can be specified. The entry is invalid if the target

number is omitted.
❒ When using a Web browser, telnet or SmartNetMonitor for Client/Admin,

you can use an IP address that has not been restricted by access control.

❖❖❖❖ Access Control Initialization 
msh> access flush

Note
❒ This restores the factory-default settings so that all access ranges become

"0.0.0.0".

Network Boot

Use the set command to configure the boot method.
msh> set parameter {on | off}

 “on” means active and “off” means inactive.

Note
❒ When you use DHCP, the server also needs to be configured.
❒ DHCP takes precedence over all other settings.

Parameter Meaning

dhcp DHCP (Dynamic Host Configuration 
Protocol)
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Protocol

Use the set command to allow/prevent remote access for each protocol.
msh> set protocol {up | down}

*1 Available when the 1394 Interface Unit Type 4510 is installed.

Note
❒ If you prohibit remote access using TCP/IP and then log out, you cannot use

remote access. If this was a mistake, you can use the control panel to allow ac-
cess by TCP/IP.

❒ When you prevent access via TCP/IP, you are also prevented from using
ip1394, lpr, ftp, rsh, diprint, web, snmp and ipp.

Printer status

The following commands can be used to get information about the current status
of the printer.
msh> command

Note
❒ More information about any print job is displayed when the ID number is

added after the prnlog command.

Protocol

appletalk 

tcpip

netware

netbeui

scsiprint *1 

ip1394 *1 

lpr

ftp

rsh

diprint

 web

 snmp

 ipp

“up” means active and “down” means 
inactive.

Command Information that is displayed

 status Status of printer.

Information about the print jobs.

 info Information about the paper tray, output tray, 
printer language of printer.

 prnlog [ID] Lists the last 16 print jobs.
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Reference
For more information about the meaning of the data returned with these com-
mands, see p.110 “Configuring the Network Interface Board”.

Network Interface Board configuration settings information

Use the show command to display the Network Interface Board configuration
settings.
msh> show [-p]

Note
❒ Add “-p” to the show command to have the information displayed one screen

at a time.

Reference
For more information about the meaning of the data returned with this com-
mand, see p.110 “Configuring the Network Interface Board”.

System log information

Use the syslog command to display information stored in the machine's system
log. 
msh> syslog

Reference
For more information about the displayed information, see p.113 “System
Log Information”.

SNMP

Use the snmp command to display and edit SNMP configuration settings such
as the community name.

Note
❒ The 1394 Interface Unit Type 4510 supports TCP/IP only.
❒ You can configure from ten SNMP access settings numbered 1–10.
❒ Default access settings 1 and 2 are as follows.

Number 1 2

Community name public admin

IP address 0.0.0.0 0.0.0.0

Access type read-only 

trap off

read-write 

trap off
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❖❖❖❖ Display
Shows the SNMP information and available protocols.
msh> snmp ?
msh> snmp [-p] [registered_number]

Note
❒ If the -p option is added, you can view the settings one by one.
❒ Omitting the number displays all access settings.

❖❖❖❖ Community name configuration
You can set the community name of the registered number.
msh> snmp number name community_name

Note
❒ The community name must consist of 15 characters or less.

❖❖❖❖ Access type configuration
You can select the access type from those listed below.
msh> snmp number type access_type

❖❖❖❖ Protocol configuration
You should use the following command to set the protocols to active or inac-
tive. If you set a protocol to inactive, all access settings set to use that protocol
will be disabled.
msh> snmp {ip | ipx} {on | off}

•  “on” means active and “off” means inactive
To change the protocol of an access settings, use the following command.
However, if you disabled a protocol with the above command, making it ac-
tive here will have no effect.
msh> snmp number active {ip | ipx} {on | off}

❖❖❖❖ Access configuration
You can configure the address of a host depending on the protocols used. 
The Network Interface Board accepts requests only from hosts having ad-
dresses with access types of “read-only” or “read-write”. Type “0” to have the
Network Interface Board accept requests from any host without requiring a
specific type of access.
Command syntax:
msh> snmp number {ip | ipx} address

Access type Type of access which is permitted

read Read only

write Read and write

trap User is notified of trap messages.

no All access is denied.
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Note
❒ To specify the TCP/IP protocol, type ip followed by a space, and then the

IP address.
❒ To specify the IPX/SPX protocol, type ipx followed by a space, and then

the IPX address followed by a decimal, and then the MAC address of the
Network Interface Board.

The following is an example of how to configure registration number 3 with
the IP address 192.168.15.16.
msh> snmp 3 ip 192.168.15.16
The following is an example of how to configure registration number 3 with
the IPX address 7390A448, and the MAC address 00:00:74:62:5C:65.
msh> snmp 3 ipx 7390A448:000074625C65

IPP

Use the ipp command to configure the IPP settings.

❖❖❖❖ Viewing setting
The following command displays the current IPP settings.
msh> ipp
Example output:
timeout=900(sec)
auth basic

• The “timeout” setting specifies how many seconds the computer keeps try-
ing to access the network printer to send print jobs when no connection can
be made.

• The “auth” setting indicates the user authorization mode.

❖❖❖❖ IPP timeout configuration 
Specify how many seconds to wait before canceling a print job if it has been
interrupted for some reason. The range of time can be changed between 30 to
65535 seconds.
msh> ipp timeout {30 - 65535}

❖❖❖❖ IPP user authorization configuration
Use the IPP user authorization to restrict users that can print with IPP. The de-
fault is “off” .
ipp auth {basic|digest|off}

• “basic” and “digest” are user authorization setting.
• “off” removes the user's authorization.

Note
❒ If you select “basic” or “digest”, see next section “Entry the IPP User Au-

thorization” for how to configure the user name. Up to ten user names are
available.
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❖❖❖❖ Configuring the IPP user authorization
Use the following command:
ipp user
The following message appears.
Input user number (1 to 10):
Type the number, user name and password.
IPP user name:user1
IPP password:*******
After configuring the settings, the following message appears.
User configuration changed.

Direct Printing Port

The direct printing port allows printing directly from a computer, connected to
the network, to the printer.
Use the diprint command to change the direct printing port settings.

❖❖❖❖ View settings
The following command displays the current direct printing port settings.
msh> diprint
Example output:
port 9100
timeout=300(sec)
bidirect off

• The “Port” specifies the port number of the direct printing port.
• The “bidirect” setting indicates whether the direct printing port is bidirec-

tional.

❖❖❖❖ Setting timeout
You can specify the timeout interval to use when receiving data from the net-
work.
msh> diprint [0~65535]

Note
❒ The factory default is 300 seconds.
❒ If 0 is set, timeout is disabled.

❖❖❖❖ Bidirectional configuration for the direct printing port
Use this setting to configure whether the direct printing port is bidirectional.
The factory default is “off”.
msh> diprint bidirect {on|off}

Note
❒ If you select “on”, SmartNetMonitor for Client or Standard TCP/IP on

Windows 2000 might not work correctly.
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SMB

Use the smb command to configure or delete the computer name or workgroup
name for NetBEUI.
msh> smb parameter

ROUTE

Use the route command to control the routing table.
This command allows you to configure and display routing information. You
can change the network configuration from remote PCs using this command.

Note
❒ The maximum number of routing tables are 16.

*1 IP address

Parameter Settings

comp Your computer name consisting of up to 13 characters

group Workgroup name consisting of up to 15 characters

comment Comment consisting of up to 31 characters

clear comp Clears the computer name

clear group Clears the Workgroup name

clear comment Clears comment

Commands Topics of setting

route add {host | net} desti-
nation *1  gateway *1 

Adds a host/network route to “destination”, and a gateway ad-
dress to “gateway” in the table. Host becomes the default setting.

route delete {host | net} 
destination *1 

Deletes a host/network route from the table. Host becomes the 
default setting.

route get {destination *1 } Displays only route information corresponding to a specified 
destination. When the destination is unspecified, all routing in-
formation is displayed.

route active {host | net} des-
tination *1  on/off

You can turn the specified destination on or off. Host becomes 
the default setting.

route add default gateway 
*1 

You can set the default gateway address.

route flush Deletes all routing information.
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SLP

Use this command to configure SLP settings.
You can search the NetWare server using SLP in the PureIP environment of
NetWare5/5.1. To use the slp command, you can configure the value of TTL
which can be used by the SLP multi-cast-packet.

Note
❒ The default value of TTL is “1”. A search is executed only within a local seg-

ment. If the router does not support multi-cast, the settings are not available
even if the TTL value is increased.

❒ The acceptable TTL value is 1 - 255.
msh> slp ttl {1 - 255}

Setting IEEE 802.11b

To make setting for IEEE 802.11b, use the wiconfig command.

Limitation
❒ You can make settings when installing the optional 802.11b Interface Unit.

❖❖❖❖ View settings
The IEEE 802.11b settings are displayed.
msh> wiconfig
The IEEE 802.11b card information is displayed.
msh> wiconfig cardinfo

Note
❒ If the IEEE 802.11b interface is not working correctly, the IEEE 802.11b card

information is not displayed.

❖❖❖❖ Configuration

Parameter Value to be configured

mode [ap|adhoc] You can set infrastructure mode (ap) or ad 
hoc mode (adhoc).

The default is ad hoc mode.

ssid ID value You can set for SSID in infrastructure mode.

The characters that can be used are ASCII 
0x20-0x7e (32 bytes).

A SSID value is set automatically to the near-
est access point if the setting has not been 
made.

If the setting has not been made for ad hoc 
mode, the same value as for infrastructure 
mode or an "ASSID" value is set automatical-
ly if the setting has not been made.
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Job Spool

Use this command to configure Job Spool settings.

Limitation
❒ You can only specify the LPR and IPP protocol.

Note
❒ This machine information cannot reload automatically when you confirm the

Job spool settings on the Web browser. Click [Reload] or [Refresh] on the Web
browser when you want to reload this machine information.

❖❖❖❖ Reference
The job spool setting appears.
msh> spoolsw

channel frequency channel no. You can set the channel.

You can specify from following channel.

• Metric Version :1-13

• Inch Version :1-11

Set the same channel for all the machines you 
are using.

enc [on|off] You can enable or disable the WEP function. 
To enable the WEP function, specify [on]; to 
disable it, specify [off].

To start the WEP function, enter the correct 
WEP key.

key [key value] Only 10 hexadecimal characters can be used.

To use this function, set the same WEP key 
for all the ports that transmit to each other.

auth [open|shared] You can set the authorized mode when using 
WEP. The specified value and the authorized 
mode are as follows:

open: Open system authorized (default)

shared: Shared key authorized

rate [auto|11m|5.5m|2m|1m] You can set the IEEE 802.11b transmitting 
speed.

The transmitting speed you specify here is 
the speed at which data is sent. You can re-
ceive data at any speed.

auto: automatically set (default)

11m: 11 Mbps fixed

5.5m: 5.5 Mbps fixed

2m: 2 Mbps fixed

1m: 1 Mbps fixed

Parameter Value to be configured
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❖❖❖❖ Job Spool Setting
msh> spoolsw spool {on | off}

Note
❒ Specify "on" to enable the job spool function or "off" to disable it.

❖❖❖❖ Clearing Spool Job
If the printer is turned off accidentally during a spool job, you can specify
whether the job will be reprinted when the printer is turned back on.
msh> spoolsw clearjob {on |off}

❖❖❖❖ Protocol Configuration
To change the protocol settings, use the following command. You can specify
the setting for [lpr] or [ipp].
• lpr

msh> spoolsw lpr {on |off}

• ipp
msh> spoolsw ipp {on |off}

Changing the Host Name

Use the hostname command to change the printer name.
msh> hostname [interface_name ] printer_name

*1 If you did not enter the interface name, it will be automatically set to the Ethernet in-
terface.

*2 If you install the 802.11b Interface Unit Type A, you can set the command.
*3 If you install the 1394 Interface Unit Type 4510, you can set the command.

Note
❒ Enter the printer name using up to 13 characters.
❒ You cannot use a printer name starting with RNP or rnp.
❒ The Ethernet interface and IEEE 802.11b interface will have the same printer

name.

interface name Interface to be configured

ether Ethernet interface *1 

wlan  *2 IEEE 802.11b interface

ip1394 *3 IEEE 1394 interface

Download from Www.Somanuals.com. All Manuals Search And Download.



Remote Maintenance by telnet

105

7

WINS

Use the wins command to configure the WINS server settings
For more information about WINS server settings, see p.122 “Configuring a
WINS Server”.

❖❖❖❖ Viewing setting
The following command displays the WINS server IP address.
msh> wins
Example out put:
wins: primary server 0.0.0.0 secondary server 0.0.0.0
DHCP current config:
 primary server 192.168.10.1 secondary server
192.168.10.2
 hostname RNP620B47 ScopeID

Note
❒ If DHCP is used to start from the network, the current WINS server ad-

dress is displayed. This address, however, is not displayed if DHCP is not
used.

❒ If the IP address obtained from DHCP differs from the WINS IP address,
the DHCP address is the valid address.

❖❖❖❖ Configuration
Use the set command to make WINS active or inactive.
msh> set wins {on|off}

• "on means active and "off" means inactive.

❖❖❖❖ Address configuration
Use this command to configure a WINS server IP address.
msh> wins {primary|secondary} IP_address

Note
❒ Use the "primary" to configure a primary WINS server IP address.
❒ Use the "secondary " to configure a secondary WINS server IP address.

AutoNet

Use the set command to configure AutoNet.

Note
❒ For more information about AutoNet, see p.121 “Using AutoNet”.
msh> set autonet {on|off}

"on" means active and "off" means inactive.
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SNTP

The printer clock can be synchronized with a NTP server clock using the Simple
Network Time Protocol (SNTP). To change the SNTP settings, use the sntp com-
mand. Confirm with the network administrator that the NTP server settings are
correct.

Limitation
❒ SNTP supports the NTP servers running xnptd V3 and V4.

❖❖❖❖ Reference
msh> sntp

❖❖❖❖ NTP Server Address Configuration
You can specify the IP address of the NTP server.
msh> sntp server IP_address

❖❖❖❖ Interval Configuration
You can specify the interval at which the printer synchronizes with the oper-
ator-specified NTP server.
msh> sntp interval polling_time

Note
❒ The factory default setting is 3600 seconds.
❒ You can set the interval from 16 to 16384 seconds.
❒ If you set 0, the printer synchronizes with the NTP server only when you

turn the printer on. After that, the printer does not synchronize with the
NTP server.

❖❖❖❖ Time-zone Configuration
You can specify the time difference between the printer clock and the NTP
server clock.
msh> sntp timezone +/-hour_time
Example: To set the time-zone difference to +8 hours:
msh> sntp timezone +08:00

Note
❒ The time is in 24-hour notation.
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Changing the password

Use the passwd command to change the remote maintenance password.

Important
❒ Be sure not to forget or lose the password.

Note
❒ The default password is “password”.

AAAA Type “passwd”.
msh> passwd

BBBB Type the current password.

Old password:

CCCC Type the new password.

New password:

Note
❒ The password must consist of 3 to 8 alphanumeric characters and symbols.

Upper and lower case characters are considered unique. For example, R is
different from r.

❒ The password is the same as that used in the configuration of the Network
Interface Board using a Web Browser and that used in the NIB Setup Tool.
If you change a password from telnet, the other passwords are also
changed.

DDDD Type the new password once again.

Retype new password:
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SNMP

The Network Interface Board functions as an SNMP (Simple Network Manage-
ment Protocol) agent using the UDP and IPX protocols. Using the SNMP man-
ager you can get information about the printer.
The default community names are “public” and “admin”. You can get MIB in-
formation using these community names.

Reference
You can configure SNMP from the command line using telnet. See p.97
“SNMP”.
You can configure SNMP from SmartNetMonitor for Admin using the NIB
Setup Tool. See Help for SmartNetMonitor for Admin.
You can configure SNMP from your Web browser. See Help on the CD-ROM.

Limitation
❒ The kinds of supported MIBs vary depending on the printer.

❖❖❖❖ Supported MIBs
• MIB-II 
• PrinterMIB 
• HostResourceMIB 
• RicohPrivateMIB 
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Understanding the Displayed Information 

This section describes how to read the status information returned by the Net-
work Interface Board.

Print Job Information

The status of the print job can be viewed using the following commands.
• telnet : Use the status command. See p.96 “Printer status” .

Print Log Information

This is a record of the most recent 16 jobs that have been printed.
This log can be displayed with the following commands.
• telnet : Use the prnlog command. See p.96 “Printer status” .

*1 Appears the UserID and JobName information when entering the info command
with the ID.

Item name Meaning

Rank Print job status.

• Active
Printing or preparing for printing.

• Waiting
Waiting to be transferred to the printer.

Owner Print request user name.

Job Print request number.

Files The name of the document.

Total Size The size of the data (spooled).

The default is “0 bytes”.

Name Meaning

ID Print request ID.

User Print request user name.

Page The number of pages that is printed.

Result The result of the print request.

Time The time when the print request was received

UserID *1 User ID that is to be configured in the printer driver.

JobName *1 The name of the document for printing.
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Configuring the Network Interface Board

The Network Interface Board settings can be displayed by using the commands
below.
• telnet : Use the show command. See p.97 “Network Interface Board configu-

ration settings information” .

Item name Meaning

 Common 

 Mode 

 Protocol Up/Down 

 AppleTalk 

 TCP/IP 

 NetWare 

 NetBEUI 

IP over 1394 *1 

SCSI print *1 

Ethernet interface

Syslog priority

NVRAM version 

 Device name 

 Comment 

 Location 

 Contact 

 Soft switch 

 

 

Up means active, Down means inactive.

 

 

 

 

 

 

 

Internal version number.

 AppleTalk 

 Mode 

 Net 

 Object 

 Type 

 Zone 

 

AppleTalk protocol in selection.

Network number.

Macintosh printer name.

The type of printer.

Name of the zone that the printer belongs to.
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 TCP/IP 

 Mode 

 ftp 

 lpr 

 rsh 

 diprint 

 web 

 telnet 

 snmp

 ipp

 EncapType 

 Network boot 

 Address 

 Netmask 

 Broadcast 

 Gateway 

Access Range[✩] *2 

Primary WINS

Secondary WINS

Time server

Time Zone

Time server polling time

 Home page URL 

 Home page link name 

 Help page URL 

 SNMP protocol 

 

Up means active, Down means inactive. 

 

 

 

 

 

 

 

 

Frame type.

Network boot.

IP address.

Subnet mask.

Broadcast address.

Default gateway address.

Access Control Range.

Primary WINS server address.

Secondary WINS server address.

NTP server address

NTP server time difference

Synchronizes interval

URL of homepage.

URL name of homepage.

URL of help page.

Protocol used with SNMP.

 NetWare 

 EncapType 

 RPRINTER number 

 Print server name 

 File server name

 Context name 

 Switch 

 Mode 

 NDS/Bindery 

 Packet negotiation 

 Print job timeout 

 

Frame type.

Remote printer number.

Print server name.

Name of the connect file server.

Context of print server.

 

Active mode.

(this value is fixed)

 

Time of the job timeout.

Item name Meaning
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*1 The 1394 Interface Unit Type 4510 supports TCP/IP only.
*2 ✩ represents a target number between 1 and 5.
*3 You can display the item names when installing the optional 802.11b Interface Unit

Type A.
*4 You can display the item names when installing the optional 1394 Interface Unit

Type 4510.

 NetBEUI 

 Switch 

 Mode 

 diprint 

 Notification 

 Workgroup name 

 Computer name 

 Comment 

 Share name[1] 

 

 

(this value is fixed)

(this value is fixed)

Notification of print job completion.

Name of the workgroup.

Name of the computer.

Comment.

Share name (name of the printer type).

IEEE 802.11b *3 

SSID

Channel range

Channel

Communication mode

Rate

WEP encryption

Auth

Encryption key

SSID being used.

Channels available for use.

Channel being used.

IEEE 802.11b interface transmitting mode.

IEEE 802.11b interface speed.

Whether WEP is enabled or disabled.

Validity or invalidity of the authorized mode setting 
when using WEP.

WEP key.

IP over 1394 *4 

Device name

Address

Netmask

Broadcast

IP address.

Subnet mask.

Broadcast address.

SCSI print *4 

Bidi. Bidirectional setting (on/off).

 Shell mode Mode of the remote maintenance tool.

Item name Meaning
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Message List

This is a list of messages written to the machine's system log. The system log can
be viewed using the syslog command.

System Log Information

You can use the following methods to view the system log.
• telnet : Use the syslog command. See p.97 “System log information” .

Message Description and Solutions

Access to NetWare server <file server name> 
denied. Either there is no account for this print 
server on the NetWare server or the password 
was incorrect. 

(In print server mode) Cannot log in to the file 
server. Make sure that the print server is regis-
tered on the file server. If a password is speci-
fied for the print server, delete it.

add_sess: community<community name> al-
ready defined.

The same community name already exists. 
Use another community name.

add_sess: session<community name> not de-
fined.

A requested community name is not defined.

add_sess: bad trap addr:<IpAddress>, com-
munity:<community name>

The IP address (0.0.0.0.) is unavailable when 
the community access type is TRAP. Specify 
the host IP address for the TRAP destination.

add_sess_ipx: bad trap addr: <IPX address>, 
community:<community name>

The IPX address (00:00:00:00:00:00) is unavail-
able when the community access type is 
TRAP. Specify the host IPX address for the 
TRAP destination.

add_sess_ipx: community <community 
name> already defined.

The same community name already exists. 
Use another community name.

add_sess_ipx: session_ipx<community name> 
not defined.

A requested community name is not defined.

ANONYMOUS FTP LOGIN FROM <IP ad-
dress>, <password>

An anonymous login has been made with a 
password <password> from the host <IP ad-
dress>.

anpd start. (AppleTalk) An anpd (AppleTalk Network Package Dae-
mon) has started.

Attach FileServer =<file server name> Attached to the file server as a nearest server.

Attach to print queue <print queue name> (In print server mode) Attached to the print 
queue name.

Cannot create service connection (In remote printer mode) Cannot establish a 
connection with the file server. The number of 
file server users may exceed the maximum 
number that the file server can handle.
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Cannot find rprinter (<print server 
name>/<printer number>)

The printer having the number displayed on 
the print server does not exist. Make sure that 
the number of the printer is registered in the 
print server.

Change IP address from DHCP Server. The IP address changes when DHCP LEASE is 
renewed. To always assign the same IP ad-
dress, set a static IP address to the DHCP serv-
er.

child process exec error! (process name) Failed to start the network service. Turn the 
printer off and then on. If this does not work, 
contact your service or sales representatives.

Connected DHCP Server(<DHCP server ad-
dress>).

The IP address was successfully received from 
the DHCP server.

connection from <IP address> Logged on from the host <IP address>.

Could not attach to FileServer<error number> (In remote printer mode) Cannot attach to the 
file server. For some reason, the file server 
refuses the connection. Check the file server 
configuration.

Could not attach to PServer<print server> (In remote printer mode) Cannot attach to the 
print server. For some reason, the print server 
refuses the connection. Check the print server 
configuration.

Current Interface Speed:xxxMbps The speed of the network (10 Mbps or 100 Mb-
ps).

Current IP address <current IP address> The IP address <current IP address> was re-
ceived from the DHCP server.

Current IPX address<IPX address> The current IPX address.

DHCP lease time expired. DHCP lease time has expired. The printer tries 
to discover the DHCP server again. The IP ad-
dress used up to now becomes invalid.

DHCP server not found. The DHCP server cannot be found. Make sure 
the DHCP server is running on the network.

dhcpcd start. A dhcpcd (DHCP client service) has started.

Duplicate IP=<IP address>(from <MAC ad-
dress>).

The same IP address is used. An IP address 
must be unique. Check the address of the de-
vice indicated in <MAC address>.

Established SPX Connection with PServer,

(RPSocket=<socket number>, connID=

<connection ID>)

(In remote printer mode) A connection with 
the print server has been established.

exiting lpd service has ended and the system is exiting 
the process.

Message Description and Solutions
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Exit pserver (In print server mode) Exits the print server 
because the necessary print server settings 
have not been made.

Frametype =<frame type name> The <frame type name> is configured to be 
used on NetWare.

httpd start. An httpd has started.

IEEE 802.11b current channel <Channel> The current channel is displayed.

The value chosen by the user is displayed in ad 
hoc mode.

The channel used in the access point is dis-
played in infrastructure mode.

(Example: Current channel is 11.)

IEEE 802.11b current channel 11

IEEE 802.11b MAC Address = <MAC Ad-
dress>

The IEEE 802.11b I/F MAC address is dis-
played.

(Example: Current MAC address is 
00:00:74:XX:XX:XX.)

IEEE 802.11b MAC Address = 

00:00:74:XX:XX:XX

IEEE 802.11b SSID <ssid> (AP MAC Address 
< MAC Address>)

The SSID of the access point used in infrastruc-
ture mode and the MAC address of the access 
point are displayed.

(Example: Current MAC address is 
xx:xx:xx:xx:xx:xx and SSID value is "test-ssid".)

IEEE 802.11b SSID test-ssid (AP MAC Address 
xx:xx:xx:xx:xx:xx)

IEEE 802.11b Tx Rate <Transfer Speed> The IEEE 802.11b transmitting speed (set 
speed) is displayed.

(Example: Current Tx Rate is 11Mbps.)

IEEE 802.11b Tx Rate 11Mbps

inetd start. An inetd has started.

<interface> started with IP: <IP address> <IP address> has been set for <Interface> and 
<Interface> started.

<Interface>: Subnet overlap. Subnet from Netmask and the IP address you 
tried to set for <Interface> overlap the subnet 
for another interface.

Set Subnet so that it does not overlap with an-
other interface.

IPP cancel-job: permission denied. The printer could not authenticate the name of 
the user attempting to cancel a job.

ipp disable. Printing with ipp is disabled.

ipp enable. Printing with ipp is enabled.

Message Description and Solutions
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IPP job canceled. jobid=%d. The spooled job has been canceled due to an 
error or by user request.

job canceled. jobid=%d. The spooled job has been canceled due to an 
error or by user request.

LeaseTime=<lease time>(sec), Renew-
Time=<renew time>(sec).

The resource lease time that was received from 
the DHCP server is <lease time> in seconds. 
The renewal time is also <renew time> in sec-
onds.

Login to fileserver <file server name> 
(<IPX|IP>,<NDS|BINDERY>) 

(In print server mode) Logged in to the file 
server with NDS or BINDERY mode.

multid start. Data transmission service for multiprotocols 
has started.

nbstart start. (NetBEUI) The service for NetBEUI protocol stack setting 
has started.

NBT Registration Broadcast(<NetBIOS 
name>)

Use a local broadcast to map <NetBIOS name> 
with the IP address.

nbtd start. A nbtd (NetBIOS over TCP/IP Daemon) has 
started. (Available only in DHCP mode)

NetBEUI Computer Name =<computer 
name>

The NetBEUI Computer Name is defined as 
<computer name>.

nmsd start. (NetBEUI) A nmsd (Name Server Daemon) has started.

npriter start. (NetWare) (In remote printer mode) NetWare service has 
started.

nwstart start. (NetWare) The service for NetWare protocol stack setting 
has started.

Open log file <file name> (In print server mode) The specified log file 
has been opened.

papd start. (AppleTalk) AppleTalk print service has started.

permission denied. Job cancellation was determined to be unau-
thorized after checking the user name and host 
address (except for ROOT authorization).

phy release file open failed. Replacing the Network Interface Board is re-
quired. Contact your sales or service repre-
sentatives.

Print queue <print queue name> cannot be 
serviced by printer 0, <print server name>

(In print server mode) The print queue name 
cannot be serviced. Make sure that print queue 
volume exists on the specified file server.

Print server <print server name> has no print-
er.

(In print server mode) The printer object is not 
assigned to the print server <print server 
name>. Using NWAdmin, assign the printer 
object, and then restart the printer device. 

Print session full Cannot accept the print session.

Message Description and Solutions
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Printer <printer name> has no queue (In print server mode) The print queue is not 
assigned to the printer. Using NWAdmin, as-
sign the print queue to the printer, and then re-
start it.

pserver start. (NetWare) (In print server mode) NetWare service has 
started.

Required computer name (<Computer 
name>) is duplicated name 

The same computer name is detected on the 
network. The start job determines the compu-
ter name by adding the computer name to the 
suffix (0,1....). Configure a new computer 
name that is unique.

Required file server (<file server name>) not 
found 

Cannot find the required file server.

restarted. LPD has started.

sap enable, saptype=<SAP type>, sap-
name=<SAP name>

The SAP function has started. The SAP (SAP 
type and SAP name) packet is issued to adver-
tise the service on the SAP table on the Net-
Ware server.

Set context to <NDS context name> A <NDS context name> has been set. 

shutdown signal received. network service re-
booting...

Rebooting the network service.

smbd start. (NetBEUI) An smbd (SMB (Server Message Block) serv-
ice) has started.

Snmp over ip is ready. Communication over TCP/IP with SNMP is 
available.

Snmp over IP over 1394 is ready. Communication over IP over 1394 with SNMP 
is available.

Snmp over ipx is ready. Communication over IPX with SNMP is avail-
able.

snmpd start. SNMP service has started.

started. Direct print service has started.

The print server received error <error 
number> during attempt to log in to the net-
work.Access to the network was denied.Verify 
that the print server name and password are 
correct. 

Cannot log in to the file server. The print serv-
er is not registered or the password is speci-
fied. Register the print server without 
specifying a password.

win2kspd protocol-DOWN (APPEXIT). NVRAM setting ioctl (SPIO CAPPEXIT) of de-
vice SBP2TSP was set by protocol-DOWN.

SCSI print is not receiving data.

win2kspd protocol-UP (APPENTRY). NVRAM setting ioctl (SPIO CAPPENTRY) of 
device SBP2TSP was set by protocol-UP.

SCSI print is not receiving data.

Message Description and Solutions
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win2kspd started. SCSI print (SBP-2) service has started.

WINS name refresh :Server No Response There has been no response to the update re-
quest from the server. Confirm that the WINS 
server address is correct and the WINS server 
is working properly.

WINS name registration:Server No Response There has been no response to the registration 
request from the server. Confirm that the 
WINS server address is correct and the WINS 
server is working properly.

WINS server address0.0.0.0 The WINS server address has not been speci-
fied. Specify the WINS server address to 
match the printer name with WINS.

WINS Server=< WINS server address > NetBI-
OS Name=<NetBIOS name>

The printer name has been successfully regis-
tered in <WINS server address>.

WINS wrong scopeID The scope ID is wrong.

Specify the correct scope ID.

write error occurred. (diskfull) The hard disk became full while the spool file 
was being written.

Wait until enough HDD space becomes avail-
able as printing proceeds.

write error occurred. (fatal) A fatal error occurred while the spool file was 
being written.

Turn the printer off and then on. If this does 
not work, contact your service or sales repre-
sentative.

Message Description and Solutions
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Precautions

Please pay attention to the following when using the Network Interface Board.
When configuration is necessary, follow the appropriate procedures below.

Connecting a Dial-Up Router to a Network

When the NetWare file server and the printer are on the opposite side of a router,
packets are continuously sent back and forth, possibly causing communications
charges to increase. Because the packet transmission is a specification of Net-
Ware, you need to change the configuration of the router. If the network you are
using does not allow you to configure the router, configure the machine.

Configuring the router

Filter the packets so that they do not pass over the dial-up router.

Note
❒ The MAC address of the printer doing the filtering is printed on the printer

configuration page. For more information about printing a configuration
page, see the Setup Guide.

❒ For more information about configuring the printer if the router cannot be
configured, see the instructions below.

Configuring the printer with NetWare

AAAA Following the setup method in this manual, configure the file server.

BBBB Set the frame type for a NetWare environment.

Reference
For more information about selecting a frame type, see the Setup Guide.

Configuring the printer without NetWare

AAAA While not printing, the Network Interface Board sends packets on the net-
work. Set the NetWare to inactive.

Reference
For more information about selecting a protocol, see the Setup Guide.
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PostScript Printing from Windows

When printing PostScript from Windows, see the PostScript 3 Operating Instruc-
tions Supplement provided as a PDF file on the CD-ROM labeled “Operating In-
structions”.

NetWare Printing

Form Feed

You should not configure the form feed on NetWare. The form feed is controlled
by the printer driver on Windows. If the NetWare form feed is configured, the
printer might not work properly. If you want to change the form feed setting, al-
ways configure it on Windows.
• With Windows 95/98/Me, clear the [Form feed] check box on the [Printer Set-

tings] tab in the printer properties dialog box.
• With Windows 2000, clear the [Form feed] check box on the [NetWare Settings]

tab in the printer properties dialog box.
• With Windows NT 4.0, clear the [Form feed] check box on the [NetWare Settings]

tab in the printer properties dialog box.

Banner Page

You should not configure a banner page on NetWare. If you want to change the
banner page setting, always configure it on Windows. 
• With Windows 95/98/Me, clear the [Enable banner] check box on the [Printer

Settings] tab in the printer properties dialog box.
• With Windows 2000, clear the [Enable banner] check box on the [NetWare Set-

tings] tab in the printer properties dialog box.
• With Windows NT 4.0, clear the [Enable banner] check box on the [NetWare Set-

tings] tab in the printer properties dialog box.

Printing after resetting the machine

After resetting the remote printer, the connection from the print server will be
cut off for about 30-40 seconds before re-connecting. Due to the NetWare speci-
fication, print jobs may be accepted, but they will not be printed during this in-
terval.
When using the machine as a remote printer, wait about 2 minutes after resetting
the printer before attempting to print. 
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Using DHCP

You can use the printer under a DHCP environment. You can also register the
printer NetBIOS name on a WINS server when it is running.

Limitation
❒ DHCP cannot be used with IEEE 1394 (IP over 1394). Set a fixed IP address

with the control panel, telnet or a Web browser.
• See the Setup Guide.
• See p.93 “TCP/IP address”.
• See p.78 “Configuring the Network Interface Board Settings”.

Note
❒ Printers that register the printer NetBIOS name on a WINS server must be

configured for the WINS server. See p.105 “WINS”.
❒ Supported DHCP server is Windows NT 4.0 Server Service Pack 4 or later,

Windows 2000 Server and NetWare 5.
❒ If you do not use the WINS server, reserve the printer's IP address in the

DHCP server so that the same IP address is assigned every time.
❒ DHCP relay-agent is not supported. If you use DHCP relay-agent on a net-

work via an ISDN line, it will result in expensive line charges. This is because
your computer connects to the ISDN line whenever a packet is transferred
from the printer.

Using AutoNet

If the printer IP address is not assigned by a DHCP server automatically, a tem-
porary IP address starting with 169.254 which is not used on the network can be
selected automatically by the printer.

Note
❒ The IP address assigned by the DHCP server is given priority to that selected

by AutoNet.
❒ You can confirm the current IP address on the configuration page. For more

information about the configuration page, see the Printer Reference.
❒ When AutoNet is running, the NetBIOS name is not registered on the WINS

server.
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Configuring a WINS Server

The printer can be configured to register its NetBIOS name with a WINS server
when power is turned on. This enables the NetBIOS name of the printer to be
specified from SmartNetMonitor for Admin even under a DHCP environment.
This section describes how to configure the WINS server.

Note
❒ The WINS Server is supported with Windows NT 4.0 Server Service Pack 4 or

later, and Windows 2000 Servers WINS Manager.
❒ For more information about the WINS Server settings, see Windows Help.
❒ If there is no reply from the WINS Server, the NetBIOS name will be regis-

tered by broadcast.
❒ The NetBIOS name consists of up to 13 alphanumeric characters.

Using a WWW browser

AAAA Start the Web browser.

BBBB Point your browser at the URL or IP address of the printer (e.g. ht-
tp://XXX.XXX.XXX.XXX where the Xs are the number of the IP address).

The status of the printer you chose appears on the Web browser.

CCCC Click Network Config.

The dialog box for entering the password and user name is displayed.

DDDD Enter your user name and password, and then click OK.
To use the factory default account, enter no user name and type "password"
for the password.

EEEE Click TCP/IP.

FFFF Set WINS to active and enter the IP address of the WINS server in Primary
WINS Server and Secondary WINS Server.

GGGG Click Refresh.

HHHH Exit the Web browser.
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Using telnet

AAAA Connect to the remote printer using telnet.

BBBB Use the "set" command to make WINS active.

msh> set wins on

CCCC Specify the IP addresses (primary and secondary) using the following com-
mands.

msh> wins primary Ipaddress msh> wins secondary Ipaddress

Note
❒ To confirm the current configuration, use the "show" command.

DDDD Log out from telnet.

When Using the NIB Setup Tool 

If the Network Interface Board cannot browse using the TCP/IP protocol, make
sure that the TCP/IP environment is correctly configured in your computer.

When Using IPP with SmartNetMonitor for Client 

When using IPP with SmartNetMonitor for Client, note the following:
• The network printer can only receive one print job from SmartNetMonitor for

Client at a time. While the network printer is printing a job, another user can-
not access the network printer until it completes the job. In this case, Smart-
NetMonitor for Client tries to access the network printer until the retry
interval expires.

• If SmartNetMonitor for Client cannot access the network printer and times
out, SmartNetMonitor for Client stops sending the print job. In this case, you
should cancel the paused status from the print queue window. SmartNet-
Monitor for Client will resume access to the network printer. You can delete
the print job from the print queue window, but canceling a print job that has
been printed by the network printer might cause the next print job sent from
another user to be incorrectly printed.

• If a print job that is sent from SmartNetMonitor for Client is interrupted and
the network printer cancels the job because something went wrong, launch
the print job again.

• Print jobs sent from another computer do not appear in the print queue win-
dow regardless of the protocol.

• If various users send print jobs using SmartNetMonitor for Client to network
printers, the printing order might not be in the order in which the jobs were sent.

• An IP address cannot be used for the IPP port name because the IP address is
used for the SmartNetMonitor for Client port name.
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Specifications

*1 The 1394 Interface Unit 4510 supports TCP/IP and IPP.
*2 To use NetBEUI, use the SmartNetMonitor for Client port.

Interface 100BASE-TX, 10BASE-T, IEEE 1394 (IP over 1394) *1 , IEEE 802.11b

Frame type EthernetII, IEEE 802.2, IEEE 802.3, SNAP

Protocol • TCP/IP
Windows 95
Windows 98
Windows Me
Windows 2000
Windows XP
Windows NT 4.0

• IPX/SPX
NetWare 3.12, 3.2, 4.1, 4.11, 4.2, 5, 5.1 IntranetWare

• NetBEUI *2 

Windows 95
Windows 98
Windows Me
Windows 2000
Windows NT 4.0

• IPP
Windows 95
Windows 98
Windows Me
Windows 2000
Windows XP
Windows NT 4.0

• AppleTalk
Mac OS 8.6 or later (Mac OS X Classic environment is support-
ed.)

SNMP MIB-II, PrinterMIB, HostResourceMIB, RicohPrivateMIB
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Operating Instructions

Supplement
For safety, please read this manual carefully before you use this product and keep it
handy for future reference.
 Www.Somanuals.com. All Manuals Search And Download.



Introduction

To get maximum versatility from this machine all operators should carefully read and follow the instruc-
tions in this manual. Please keep this manual in a handy place near the printer.

Please read the Safety Information before using this printer. It contains important information related
to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe® and PostScript® are registered trademarks of Adobe Systems Incorporated.

Appletalk, Apple, Macintosh is a registered trademark of Apple Computer, Incorporated.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

Notes:

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.
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1. Using PostScript 3
1

Setting up Options

This documentation describes the specific printer functions and menus that are add-
ed by installing the PPD file. For more information about the functions and menus
of the Windows 95/98/Me PostScript printer driver, see the printer driver's Help.

Job Type

Use this to select the type of print job.
The following table shows the tabs or menus where you can select this function.

You can select the following items.

❖❖❖❖ Normal
Select this for normal printing. The print job starts immediately after the print
command is given.

Note
❒ If you want to use an User ID, click the [Detail] button.

❖❖❖❖ Sample Print
Use this function to print only one set of a multiple print jobs.
The other sets are saved in the machine. The saved job can be printed from the
machine's control panel. You can also delete the saved job.

Limitation
❒ To use this function, the optional Hard Disk Drive must be installed on the

printer.

Note
❒ The "User ID" can consist of up to eight alphanumeric (a- z, A- Z, 0- 9) char-

acters.
❒ Entering the "User ID" helps you to distinguish the print job from others.

Reference
For more information about how to use Sample Print, see p.2 “How to Use
Sample Print”.

Windows 95/98/Me [Job Type] on the [Setup] tab.

Windows 2000/Windows XP [Job Type] on the [Job/ Log] tab in the Printing Preferences 
Properties.

Windows NT 4. 0 [Job Type] on the [Job/ Log] tab in the Document Defaults 
dialog box.

Macintosh [Job Type] on [Job Log] in the print dialog box.
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❖❖❖❖ Locked Print
Use this function to save documents in the machine memory with a pass-
word, and then edit and print them as you want.

Limitation
❒ To use this function, the optional Hard Disk Drive must be installed on the

printer.

Note
❒ The "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) char-

acters. The "Password" must be four digits.

Reference
For more information about how to use Locked Print, see p.4 “How to Use
Locked Print”.

How to Use Sample Print 

Follow the procedures to print a document using the "Sample Print" function.

Note
❒ If the application has a collate option, make sure that it is not selected before

sending a print job. By default, sample print jobs are automatically collated
by the printer driver. If the collate option is selected in the application print
dialog box, more prints than intended may be printed.

Windows 95/98/Me

AAAA From an application, select the menu command to print.

The print dialog box appears.

BBBB Open the Printer Properties to set the Sample Print.

CCCC Click to select the [Setup] tab.

DDDD Select [Sample Print] in [Job Type].

EEEE Click [Details...].

FFFF Enter the "User ID" in [User ID]. This can consist of up to eight alphanumeric
(a- z, A- Z, 0- 9) characters.

Note
❒ Select this to identify the user associated with the job.

GGGG Click [OK].
Download from Www.Somanuals.com. All Manuals Search And Download.



Setting up Options

1

Windows 2000/Windows XP, Windows NT 4.0

AAAA From an application, select the menu command to print.
The print dialog box appears.

BBBB Open the Printer Properties to set the Sample Print.

CCCC Click to select the [Job/ Log] tab.

DDDD Select [Sample Print] in [Print Job].

EEEE Enter the "User ID" in [User ID]. This can consist of up to eight alphanumeric
(a- z, A- Z, 0- 9) characters.

Note
❒ Select this to identify the user associated with the job.

FFFF Click [OK] to close the Printer Properties.

GGGG Start printing from the application's print dialog box.

The Sample Print job is sent to the machine and one set is printed.

HHHH Check the sample print to confirm that the settings are correct.

If the settings are correct, see "Printing a Sample Print File" in the Printer Ref-
erence.
If not, you can delete the saved job. See "Deleting a Sample Print File" in the
Printer Reference.

Macintosh

AAAA From an application, select the menu command to print.
The print dialog box appears.

BBBB Click to select [Job Log] from the pop up menu.

CCCC Select [Sample Print] in [Job Type], and then select the appropriate setting.

DDDD Enter the “User ID” in [User ID]. This can consist of up to eight alphanumer-
ic (a-z, A-Z, 0-9) characters. 

Note
❒ This is used to identify the user associated with a job.
❒ The "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) char-

acters.

EEEE After making all of the settings you want, click [Print].

The Sample Print job is sent to the machine and one set is printed.
3
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FFFF Check the sample print to confirm that the settings are correct.

If the settings are correct, see "Printing a Sample Print File" in the Printer Ref-
erence.
If not, you can delete the saved job. See "Deleting a Sample Print File" in the
Printer Reference.

How to Use Locked Print

Follow the procedures to print a document using the "Locked Print" function.

Note
❒ If the application has a collate option, make sure that it is not selected before

sending a print job. By default, locked print jobs are automatically collated by
the printer driver. If the collate option is selected in the application print dia-
log box, more prints than intended may be printed.

Windows 95/98/Me

AAAA From an application, select the menu command to print.

The print dialog box appears.

BBBB Open the Printer Properties to set the locked print.

CCCC Click to select the [Setup] tab.

DDDD Select [Locked Print] in [Job Type].

EEEE Click [Details...].

FFFF Enter the "User ID" in [User ID]. This can consist of up to eight alphanumeric
(a-z, A-Z, 0-9) characters. Then enter a password in [Password], up to four
digits.

Note
❒ Select this to identify the user associated with the job.

GGGG Click [OK].

Windows 2000/Windows XP, Windows NT 4.0

AAAA From an application, select the menu command to print.
The print dialog box appears.

BBBB Open the Printer Properties to set the locked print.

CCCC Click to select the [Job/ Log] tab.
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DDDD Select [Locked Print] in [Print Job].

EEEE Enter the "User ID" in [User ID]. This can consist of up to eight alphanumeric
(a-z, A-Z, 0-9) characters. Then enter a password in [Password], up to four
digits.

Note
❒ Use this to identify the user associated with the job.

FFFF Click [OK] to close the Printer Properties.

GGGG Start printing from the application's print dialog box.
The Locked Print job is sent to the machine.

Macintosh

AAAA From an application, select the menu command to print.

The print dialog box appears.

BBBB Click to select [Job Log] from the pop up menu.

CCCC Select [Locked Print] in [Job Type], and then select the appropriate setting.

DDDD Enter the “User ID” in [User ID]. This can consist of up to eight alphanumer-
ic (a-z, A-Z, 0-9) characters. Then enter a password in [Password], up to four
digits.

Note
❒ This is used to identify the user associated with a job.

EEEE After making all of the settings you want, click [Print].
5
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Collate

Use this function to enable collation. With this feature, the printer can efficiently
print collated sets of multiple-page documents.

Limitation
❒ To use this function, the optional Memory Unit of 96MB in total or Hard Disk

Drive must be installed on the printer.
❒ If you select Upper Tray as an output tray, it is shift collated automatically.
The following table shows the tabs or menus where you can select this function.

Duplex Printing

Use this function to select duplex printing.

Limitation
❒ To use this function, the optional Duplex Unit must be installed on the print-

er.
The following table shows the tabs or menus where you can select this function.

You can select the following items. The following items may vary depending on
the operating system you are using.

Windows 95/98/Me

❖❖❖❖ Off
Disables Duplex Printing.

❖❖❖❖ Open to Left
Prints output so that you can open it to the left when bound along the left
edge.

Windows 95/98/Me [Collate] on the [Setup] tab.

Windows 2000/Windows XP [Printer Features] on [Advanced...] on the [Paper/Quality] tab 
in the Printing Preferences Properties.

Windows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] 
tab.

Macintosh [Collate:] on [Printer Specific Options] in the print dialog 
box.

Windows 95/98/Me [Duplex] on the [Setup] tab.

Windows 2000/Windows XP [Print on Both Sides (Duplex)] on the [Layout] tab in the 
Printing Preferences Properties.

Windows NT 4.0 [Print on Both Sides (Duplex Printing)] on the [Page Setup] tab 
in the Document Defaults dialog box.

Macintosh [Print on Both Sides] on [Layout] in the print dialog box.
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❖❖❖❖ Open to Top
Prints output so that you can open it to the top when bound along the top edge.

Windows 2000/Windows XP, Macintosh

Note
❒ When you use the Macintosh, click to select the button that means [Flip on Long

Edge] or [Flip on Short Edge].

❖❖❖❖ None
Disables Duplex Printing.

❖❖❖❖ Flip on Short Edge
Prints output so that you can open it to the short edge when bound along the
short edge.

❖❖❖❖ Flip on Long Edge
Prints output so that you can open it to the long edge when bound along the
long edge.

Windows NT 4.0

Note
❒ When you use the Macintosh, click to select the button that means [Flip on Long

Edge] or [Flip on Short Edge].

❖❖❖❖ Short Side
Prints output so that you can open it to the short edge when bound along the
short edge.

❖❖❖❖ Long Side
Prints output so that you can open it to the long edge when bound along the
long edge.

Paper Selection

Paper Sources and Output Tray Tabs

Use this to select the media type, input tray, and output tray on the following
tabs.

Limitation
❒ This function is for Windows 95/98/Me only.

Reference
For more information about the [Paper Sources and Output Tray] tabs. See the
Help file for the printer driver.
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Paper Size

Use this to select the size of paper you want to use.
The following table shows the tabs or menus where you can select this function.

Reference
For more information about the paper sizes supported by this printer, see "Pa-
per and Other Media Supported by This Printer" in the Printer Reference.

Media Type

Use this to select the paper type.
The following table shows the tabs or menus where you can select this function.

Reference
For more information about the media type supported by this printer, see "Pa-
per and Other Media Supported by This Printer" in the Printer Reference.

Paper source

Use this to select the paper sources.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Size:] on the [Paper] tab.

Windows 2000/Windows XP [Paper/Output] on [Advanced...] on the [Paper/Quality] tab in 
the Printing Preference Properties.

Windows NT 4.0 [Paper Size:] on the [Page Setup] tab in the Document De-
faults.

Macintosh [Paper:] on the [Page Attributes] tab in the Page Setup dia-
log box.

Windows 95/98/Me [Type:] on [All Pages] on the [Paper] tab.

Windows 2000/Windows XP [Media:] on the [Paper/Quality] tab in the Printing Prefer-
ence Properties.

Windows NT 4.0 [Paper/Output] on the [Advanced] tab in the Document De-
faults.

Macintosh [Paper Type:] on [Printer Specific Options] in the print dialog 
box.

Windows 95/98/Me [All Pages] on the [Paper] tab.

Windows 2000/Windows XP The [Paper/Quality] tab in the Printing Preferences Proper-
ties.

Windows NT 4.0 The [Page Setup] tab.

Macintosh [Paper Source:] on [General] in the print dialog box.
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Destination Tray

Use this to select the output tray.
The following table shows the tabs or menus where you can select this function.

Resolution

Use this to set the resolution to [600dpi] or [1200dpi].
The following table shows the tabs or menus where you can select this function.

Toner Saver

Use this function to reduce the amount of toner used when printing.
The following table shows the tabs or menus where you can select this function.

Note
❒ When you use Windows 2000/Windows XP/NT 4.0, this function is called

"Toner Saving".

Windows 95/98/Me [Destination] on the [Paper] tab.

Windows 2000/Windows XP [Printer Features] on [Advanced...] on the [Paper/Quality] tab 
in the Printing Preferences Properties.

Windows NT 4.0 [Printer features] on [Document Options] on the [Advanced] 
tab.

Macintosh [Destination:] on [Printer Specific Options] in the print dia-
log box.

Windows 95/98/Me [Advanced] on the [Print Quality] tab

Windows 2000/Windows XP [Printer Features] on [Advanced...] on the [Paper/Quality] tab 
in the Printing Preferences Properties

Windows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] 
tab

Macintosh [Printer Specific Options] in the print dialog box

Windows 95/98/Me [Toner Saver] on the [Print Quality] tab.

Windows 2000/Windows XP [Printer Features] on [Advanced...] on the [Paper/Quality] tab 
in the Printing Preferences Properties.

Windows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] 
tab.

Macintosh [Toner Saver:] on [Printer Specific Options] in the print dia-
log box.
9
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User Code

Use this to set a user code for print logging.
Enter a user code using up to eight digits. A user code identifies a group of users
and allows you to check the number of sheets printed under each code with
SmartNetMonitor for Admin.
The following table shows the tabs or menus where you can select this function.

Reference
For more information about using SmartNetMonitor for Admin, see the Help
file.

Options

See “Setting Up Options” in the Setup Guide for the installation method appro-
priate to your printing environment.
The following table shows the tabs or menus where you can select this function.

❖❖❖❖ Tray 2
• You can select the tray with the following menu for Paper Feed Unit Type

2600:
Paper Source⇒ p.8

❖❖❖❖ Tray 3
• You can select the other tray with the following menu for an additional Pa-

per Feed Unit Type 2600:
Paper Source⇒ p.8

❖❖❖❖ Duplex Unit
• You can use the following function with AD410:

“Duplex Printing” ⇒ p.6

Windows 95/98/Me [User Code] on the [Statistics] tab.

Windows 2000/Windows XP [User Code] on the [Job/ Log] tab in the Printing Preferenc-
es Properties.

Windows NT 4.0 [User Code] on the [Job/ Log] tab in the Document De-
faults dialog box.

Macintosh [User Code] on [Job Log] in the print dialog box.

Windows 95/98/Me [Option] on the [Accessories] tab.

Windows 2000/Windows XP [Installable Options] on the [Device Setting] tab.

Windows NT 4.0 [Option] on the [Device Setting] tab.

Macintosh [Chooser] on the Apple Menu.
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❖❖❖❖ Hard Disk
• You can use the following function with Hard Disk Drive Type 2600:

Collate⇒ p.6
Job Type⇒ p.1

❖❖❖❖ Mailbox

Note
❒ The optional Mailbox and Upper Tray can not be installed at the same

time.
• You can select the following menu for CS380:

Destination⇒ p.9

❖❖❖❖ Upper Tray

Note
❒ The optional Mailbox and Upper Tray can not be installed at the same

time.
• You can select the following menu for 1-bin Shift Sort Tray Type 2600:

Destination⇒ p.9

❖❖❖❖ Total Memory
• You can use the following function with Memory Unit TypeB 64MB:

Collate⇒ p.6
11
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2. Printer Utility for Mac
By using Printer Utility for Mac, you can download fonts, change the name of
the printer and so on.

Limitation
❒ If a Macintosh and printer are connected by USB, you cannot use Printer Util-

ity for Mac.

Note
❒ Printer Utility for Mac is included on the CD-ROM labeled “Drivers and Util-

ities”.
❒ Printer Utility for Mac requires Mac OS 8.1 or later. (Mac OS X Classic envi-

ronment is supported.)

Installing Printer Utility for Mac

Follow these steps to install Printer Utility for Mac on the machine.

AAAA Start the Macintosh.

BBBB Insert the CD-ROM into the CD-ROM drive.

The CD-ROM icon appears.

CCCC Double-click the icon of hard disk to open it.

DDDD Double-click the CD-ROM icon.

The contents of the CD-ROM appear.

EEEE Double-click the [PS Utility] folder on the CD-ROM, and then drag the [Print-
er Utility for Mac] file, and then drop it into the Macintosh hard disk.

FFFF Drag the CD-ROM icon and drop it into [Trash] to eject the CD-ROM.
Printer Utility for Mac is installed.
13
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Starting Printer Utility for Mac

The following instructions describe how to start Printer Utility for Mac.

Important
❒ Before starting Printer Utility for Mac, confirm that the printer is selected with

[Chooser] on the Apple menu.

AAAA Double-click the icon of Printer Utility for Mac.

The Printer Utility for Mac dialog box appears.

BBBB Click [OK].
Printer Utility for Mac will take a few seconds to start.

Reference
For more information, see “Printer Utility for Mac Functions”. 
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Printer Utility for Mac Functions

Printer Utility for Mac functions are described below.

❖❖❖❖ File menu
• [Download PS Fonts...]

Download fonts (PostScript Type 1) to the printer. See p.16 “Downloading
PS Fonts”.

• [Display Printer's Fonts...]
Display and delete the fonts in printer memory and the printer's hard disk
drive. See p.17 “Displaying Printer's Fonts”.

• [Initialize Printer's Disk...]
Initialize the printer's hard disk drive. See p.18 “Initializing the Printer
Disk”.

• [Page Setup...]
Set up the paper size to print “Printer Font Catalog” and “Printer Font
Sample”. See p.18 “Page Setup”.

• [Print Font Catalog...]
Print the names of available fonts. See p.18 “Printing Font Catalog”.

• [Print Font Sample...]
Print a sample of fonts. See p.19 “Printing Font Sample”.

• [Rename Printer...]
Change the printer's name when viewed via Appletalk. See p.19 “Renam-
ing the Printer”.

• [Restart Printer]
Restart the printer. See p.20 “Restarting the Printer”.

❖❖❖❖ Utility menu
• [Download PostScript File...]

Download a PostScript File. See p.20 “Downloading PostScript Files”.
• [Select Zone...]

Change the zone the printer belongs to via Appletalk. See p.20 “Selecting
the Zone”.

• [Display Printer Status...]
Display the status of the printer. See p.21 “Displaying the Printer Status”.

• [Launch Dialogue Console...]
Create and edit a PostScript file, and download it to the printer. See p.21
“Launching the Dialogue Console”.
15
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Downloading PS Fonts

You can download the PS fonts to the printer's memory or hard disk drive.

Important
❒ The following procedures to download the fonts assume that you are a sys-

tem administrator. If you are not, be sure to consult your system administra-
tor.

❒ If the printer restarts, all the printer settings return to their defaults.
❒ Confirm that Macintosh and the printer are connected with Appletalk.

Note
❒ Some fonts cannot be downloaded.
❒ Before downloading, read the documentation about the fonts you want to

use.

AAAA Select [Download PS Fonts...] on the [File] menu.

BBBB Click [Add to list].

The dialog box to select fonts appears.

CCCC Click to select the desired font files, and then click [Open].

The list of selectable font names appears.

DDDD After adding all the fonts you want to download, click [OK].
The dialog box of selected fonts to download appears.

EEEE Click [Download].

The fonts begin to download, and the download status is shown.

Important
❒ During the download, do not turn off the power switch, operate the panel

or open or close the cover.

FFFF When the completion message appears, click [OK].

GGGG Click [Cancel].
Download from Www.Somanuals.com. All Manuals Search And Download.



Printer Utility for Mac Functions

2

Displaying Printer's Fonts

You can display the available fonts currently downloaded to the printer. Fonts
in the printer's memory and hard disk drive can be displayed.

Note
❒ The fonts displayed in italics are the default fonts.

AAAA Select [Display Printer's Fonts...] on the [File] menu.
A dialog box appears.

BBBB Select [Printer's memory] or [Printer's disk].

CCCC Click [OK].

Deleting Fonts

You can delete fonts from the printer's memory or hard disk drive.

AAAA Select [Display Printer's fonts] on the [File] menu.

A dialog box appears.

BBBB Select [Printer's memory] or [Printer's disk].

CCCC Select the fonts you want to delete.

Limitation
❒ You cannot delete the fonts displayed in italic.

DDDD Click [Delete].

A confirmation message appears.

EEEE Confirm the fonts you want to delete and the printer name from which you
want to delete the fonts.

FFFF Click [Continue], and then click [OK].

GGGG Click [OK].
17
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Initializing the Printer Disk

When initializing the printer's hard disk, all the fonts downloaded to the print-
er's hard disk drive are deleted. Before initializing, be sure to check the fonts on
the hard disk drive.

Important
❒ When initializing the printer's hard disk drive from the operation panel, all of

the data on the printer's hard disk drive is deleted. Before initializing, be sure
to check the data on the hard disk drive.

AAAA Select [Initialize Printer's Disk...] on the [File] menu.
The confirmation message appears.

Note
❒ To cancel initialization, click [Cancel].

BBBB Click [Execute].

Initializing starts.

Important
❒ Do not turn off the power switch until initializing is completed, otherwise

the hard disk drive might be damaged.

CCCC When the completion message appears, click [OK].

Page Setup

You can set the paper size on which to print “Print Fonts Catalogue” and “Prints
Fonts Sample”.

AAAA Select [Page Setup...] on the [File] menu.

BBBB Choose the paper size.

Printing Font Catalog

Print the names of fonts available on the printer.

Note
❒ The paper selected under [Page Setup] is used.

AAAA Select [Print Fonts Catalogue] on the [File] menu.

BBBB Click [Print].
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Printing Font Sample

You can print samples of fonts downloaded to the hard disk drive or memory.

Note
❒ Print by using the paper selected on [Page Setup].

AAAA Select [Print Fonts Sample...] on the [File] menu.

BBBB Click [Print].

Renaming the Printer

You can change the printer's name displayed under Appletalk. If you connect
several printers on the network, assign different names so you can identify them.
If several printers have the same name, a digit appears next to the printer name
in [Chooser].

AAAA Select [Rename Printer...] on the [File] menu.

BBBB Type a new name in the [New Name:] field. 

Limitation
❒ You can enter up to 31 digits and letters.
❒ Do not use symbols, for example “*”, “:”, “=”,”@”, “~”.

CCCC Click [Rename].

The printer name is changed.

DDDD Press [OK].

EEEE Select [Chooser] on the Apple menu.

FFFF Click the [AdobePS] icon.

GGGG Click to select the printer name renamed in step BBBB, and then close [Chooser].

Note
❒ If there are several Appletalk zones, select the zone the printer belongs to.
19
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Restarting the Printer

You can restart the printer.

AAAA Select [Restart Printer] on the [File] menu.

BBBB Confirm the message that appears on the screen, and then click [Restart].

The printer restarts.

Note
❒ The fonts that you downloaded in the printer's memory will be deleted.
❒ If the printer restarts, all the printer settings return to their defaults.

Downloading PostScript Files

You can download a Postscript file to the printer.

AAAA Select [Download PostScript File...] on the [Utility] menu.

BBBB Select the file name to download and click the file name, and then click
[Open].

CCCC Type the log file name, and then click [Save].

The selected file is downloaded.

Note
❒ Errors are recorded in the log file.

Selecting the Zone

You can change the zone to which the printer belongs under Appletalk.

Important
❒ Confirm that the printer and a Macintosh are connected in an Appletalk en-

vironment.

AAAA Select [Select Zone...] on the [Utility] menu.
The zone to which the printer belongs and the available zone list appear.

BBBB Select the zone to which you want to switch the printer, and then click
[Change].

A confirmation message appears.

CCCC Click [Continue].
A confirmation message appears.
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DDDD Press [OK].

EEEE Select [Chooser] on the Apple menu.

FFFF Click the [AdobePS] icon.

GGGG Select the zone selected in step BBBB on the [Appletalk zone:] list.

HHHH Click to select the printer you want to use on the [Select a PostScript Printer:]
list.

IIII Close [Chooser].

Displaying the Printer Status

You can display and confirm the current status of the printer.

AAAA Select [Display Printer Status...] on the [Utility] menu.
The current status of the printer appears.

BBBB Confirm the current status of the printer.

You can confirm the memory capacity, the VM (Virtual Memory) space, the
hard disk drive status and available space on the hard disk drive. You can
also confirm the zone to which the printer belongs.

CCCC Click [OK].

Launching the Dialogue Console

You can create and edit a PostScript file for printing, and download it to the
printer.

Important
❒ “Launch Dialogue Console” is recommended for users with an understand-

ing of PostScript.
❒ Do not download any file other than PostScript files to the printer.
❒ “Launch Dialogue Console” must be used at your own responsibility.

AAAA Select [Launch Dialogue Console...] on the [Utility] menu.

Open the editing screen. The Dialogue Console menu bar appears.

BBBB Type the PostScript command in the editor screen.

Note
❒ To edit a PostScript file, select [Open] on the [File] menu to open it.
❒ You can search or replace a character string by using the [Search] menu.
21
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CCCC After editing the PostScript file, select [Download Top Window] on [Console]
menu to start printing.

The PostScript file is sent to the printer.

Note
❒ The [Reply from Printer] box opens, depending on the PostScript file you

sent.

DDDD Select [Return To Main Menu] on the [Console] menu to close the PostScript file.
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Read this manual carefully before you use this product and keep it handy for future
reference.
For safety, please follow the instructions in this manual.
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Introduction

To get maximum versatility from this machine all operators should carefully read and follow the instruc-
tions in this manual. Please keep this manual in a handy place near the machine.

Please read the Safety Information in the “Printer Reference” before using this machine. It contains im-
portant information related to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Parts of this manual are subject to change without prior notice. In no event will the company be liable
for direct, indirect, special, incidental, or consequential damages as a result of handling or operating
the machine.

Further Information

Please consult your authorized reseller concerning additional UNIX support.

Trademarks

PostScript is a registered trademark of Adobe Systems, Incorporated.

PCL is a registered trademark of Hewlett-Packard Company.

Sun, SunOS, Solaris are trademarks or registered trademarks of Sun Microsystems, Inc. in the United
States and other countries.

HP-UX is a registered trademark of Hewlett-Packard Company.

LINUX is a trademark of Linus Torvalds.

RED HAT is a registered trademark of Red Hat, Inc.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.
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Manuals for This Printer

The following manuals describe the operational procedures and maintenance of
this machine.
To enhance safe and efficient operation of this printer, all users should read and
follow the instructions carefully.

❖❖❖❖ Quick Installation Guide
Describes how to install the printer.

❖❖❖❖ Setup Guide 
Provides information about setting up the printer and its options. This man-
ual is provided as a printed manual, and also as a PDF file on the CD-ROM
labeled "Operating Instructions".

❖❖❖❖ Printer Reference
Provides information about using the printer and its options. This manual
provided as a PDF file on the CD-ROM labeled “Operating Instructions”.

❖❖❖❖ Network Interface Board Operating Instructions
Provides information about setting up and using the printer in a network en-
vironment. This manual provided as a PDF file on the CD-ROM labeled “Op-
erating Instructions”.

❖❖❖❖ PostScript 3 Operating Instructions Supplement
Describes the menus and features for the PostScript 3 printer driver. This
manual provided as a PDF file on the CD-ROM labeled “Operating Instruc-
tions”.

❖❖❖❖ UNIX Supplement (this manual)
Provides information about setting up and using the printer in a UNIX envi-
ronment. This manual provided as a PDF file on the CD-ROM labeled “Oper-
ating Instructions”.

Note
❒ There are two CD-ROMs that come with this printer. One is labeled "Operat-

ing Instructions" and the other is "Drivers and Utilities".
i
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How to Read This Manual

Symbols

In this manual, the following symbols are used:

R WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

R CAUTION:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.
* The statements above are notes for your safety.

Important
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates the prior knowledge or preparations required before op-
erating.

Note
This symbol indicates precautions for operation, or actions to take after misop-
eration.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

[ ]
Keys that appear on the machine's panel display.
Keys and buttons that appear on the computer's display.

{ }
Keys built into the machine's operation panel.
Keys on the computer's keyboard.
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1. UNIX Configuration
This section explains how to set up a network printer and check the print status
using UNIX.

Limitation
❒ To print from a UNIX workstation, use the file that the printer supports.

Using the Installation Shell Script

The installation shell script helps with the setup process. The installation shell
script automates some of the tasks in configuring /etc/hosts, /etc/printcap, and
in creating the spool directory for BSD UNIX, and in running lpadmin command
for System V UNIX.

Preparation
The installation shell script can be used on the following three kinds of the
workstations. Do not use this installation shell script with other types of
workstations.
• Solaris 2.5.1, 2.6, 7, 8
• HP-UX 8.x, 9.x, 10.x, 11.0
• Red Hat Linux 6.2
When you use NIS (Network Information Service) or DNS, you should con-
figure the server before running this installation shell script.
For more information about the configuration utility of your OS, see the man-
ual that came with the utility.

Assigning the IP Address

Preparation
Configure the printer to use the TCP/IP protocol. 
• Confirm that the TCP/IP protocol on the printer is set to be active. (The fac-

tory default is active.) 
• Assign an IP address to the printer and configure the other settings re-

quired for using the TCP/IP protocol.

Reference
For more information about how to make above settings, see the Setup Guide
that comes with the printer.
1
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Confirming the IP address

Follow the procedure below to confirm that the IP address has been configured
correctly.
• Following procedure uses sample IP address: 192.168.15.16.

A Enter the following:

# ping 192.168.15.16

If the address has been configured correctly, the following message appears.
192.168.15.16 is alive

If the address has been configured incorrectly, the following message ap-
pears.
no answer from 192.168.15.16

Note
❒ When you use NIS, the IP address and host name are written to /etc/hosts

on the master server. When you use DNS, the information is written to a
data file on the name server. After writing the host name and IP address to
the file, confirm the configuration by pinging the host name.
# ping host_name

❒ If the host name is registered with an IP address, the server can access the
printer using its host name instead of its IP address.

Executing the Installation Shell Script

After having configured the printer IP address, follow the procedure below to
execute the installation shell script and set up the workstation printing environ-
ment.

Preparation
Before executing the installation shell script, the IP address, the host name
and the printer name must be required.
Following procedures use sample IP address: 192.168.15.16, sample host
name: nphost and sample printer name: np.

Note
❒ Use ftp to get the installation shell script from the printer.

A Log on to the workstation as root.

Note
❒ If you do not log on as root, the installation shell script will not run.
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B Get the installation shell script from the printer.
AMove to the directory you want to copy the installation shell script to.

B Use ftp to connect to the printer with the IP address that you just config-
ured.

# ftp 192.168.15.16
Connected to 192.168.15.16
220 printer FTP server ready.
name (192.168.15.16:root:)

CWhen a user name is requested, ignore and press the {{{{RETURN}}}} key.
331 Password required for root.
Password:

DWhen a password is requested, ignore and press the {{{{RETURN}}}} key.

230 User root logged in.
ftp>

E Type the following to get the installation shell script.

ftp> get install

F Close the ftp session.

ftp> bye
221 Goodbye.
#

C Run the installation shell script.

# sh ./install

Note
❒ Insert a period and slash before the current directory.

D Enter a number to select the workstation OS that you are using.
Network printer install shell
 Copyright RICOH CO.,LTD. 1994-2000
 Select your workstation OS type.
  1. SunOS 4.x.x
  2. Solaris 2.x, Solaris 7-8 (SunOS5.x)
  3. HP-UX 8.x,9.x,10.x,11.x
  4. UnixWare
  5. Linux
  6. other
Enter <1-6>:
2

Note
❒ SunOS and UnixWare appear on the screen, but they are not supported.

Use Solaris, HP-UX or Linux.
❒ If you select “6”, the installation shell script exits.
3
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E Enter the IP address of the printer.
Enter Printer host IP address <xxx.xxx.xxx.xxx> [return=skip]:
192.168.15.16

Note
❒ The IP address will be added to the /etc/hosts file.
❒ If the host name of the printer has already been configured, ignore and

press the {RETURN} key. Nothing is added to the /etc/hosts file.

F Enter the host name of the printer.

Enter Printer host name : nphost

Note
❒ The host name will be added to the /etc/hosts file.
❒ If no IP address was entered in step E, nothing is added to the /etc/hosts

file.

G Configure the printer name.
Enter logical printer name [default nphost_prn]

If you want to use the default name, press the {RETURN} key. If you want to
change this name, enter a new name.

Note
❒ The host name entered in step F followed by “_prn” appears in “default”.

H Set the print option.

Enter remote printer name [default lp]:

• Press the {RETURN} key, print with PCL or PostScript is enabled.
• If you enter “text”, text printing is enabled.

If you enter “text”, printing with PCL and PostScript is unavailable.
Enter remote printer name [default lp]:text

Limitation
❒ You can enter up to 14 characters for HP-UX 11.0, 256 for Solaris 8, and 51

for Red Hat Linux 6.2.
Setup with the installation shell script is finished. If you enter the IP address
in step E, the following message appears.
hosts file is modified

IMake a test print to confirm that the settings are correct.
# lpr -Pnp file_name

# lp -d np file_name

For more information about lpr and lp, see P.10 “Printing Method”.
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Deleting the printer

To print using the lp or lpr command, the option specified when the Installation
Shell Script is executed is used. Change the option in accordance with the work-
station you are using.

❖❖❖❖ BSD UNIX workstation, Linux
Delete the printer entry from /etc/printcap, then execute the installation
shell script again. Select options during the setup process.
Or, search the printer entry from /etc/printcap, change its rp capability to op-
tion setting.

❖❖❖❖ Solaris, HP-UX
Delete the printer entry, and then execute the installation shell script again.
Select options during the setup process. To delete the printer entry, follow the
procedure below.
A Stop the scheduler.

# /usr/sbin/lpshut

B Delete the printer.
# /usr/sbin/lpadmin -x printer_name

C Restart the scheduler.
# /usr/lib/lpsched

Setup

The printing environment is set up automatically when the installation shell
script is executed.
This section describes the set up contents when the installation shell script is ex-
ecuted under Red Hat Linux, Solaris and HP-UX.

Linux

❖❖❖❖ Adding the IP address and host name to the /etc/hosts file
The following line is added to the /etc/hosts file.
192.168.15.16  nphost  # Network Printer

• 192.168.15.16 is the IP address, nphost is the host name, from # to the end
of the line is a comment.

Note
❒ The /etc/hosts file contains a list of the IP addresses and their host names

of all of the hosts communicating on the network. Each entry is delimited
with a space or a tab, and each line is separated with a return.

❒ If you do not use NIS or DNS, you must manually enter the IP address and
host name of each workstation using the network printer in the /etc/hosts
file.
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❖❖❖❖ Adding an entry to the /etc/printcap file
The following entry is added to the /etc/printcap file.
This is the configuration for printing with the lpr command. In order to use
the lpr command to print, you need to edit the /etc/hosts file, add an entry
for the network printer to the /etc/printcap file and create a spool directory.
##PRINTTOOL3## REMOTE
np|Network Printer:\
      :rm=nphost:\
      :rp=lp:\
      :sd=/var/spool/lpd/npd:\
      :lf=/var/log/npd-errs:\
      :sh:\
      :mx#0:

Note
❒ The /etc/printcap file is used to register the name and attributes of a print-

er. You must make an entry for the network printer in the /etc/printcap
file of all workstations using the network printer.

❒ Each entry is separated with colons into several fields. The syntax is to be-
gin each entry with a colon, the entry, and then end the entry with a colon,
a back slash, and then a return.

❒ The first line of the field is the name of the printer. You use this name when
logging on to a network printer from a workstation. You can define several
different names by separating each name with the “|” character.

❒ The second, and the following lines, contain the printer's attributes. At-
tributes of the printer are represented by two character names referred to as
capabilities. For more information about capabilities, see the following table.

Capability Explanation Value Required for the Network 
Printer.

lp Device name of the printer Nothing.

rm Host name of the printer The host name that was registered 
with the /etc/hosts file.

rp Optional specification Select options for printing.

For printing with PCL or Post-
Script, select “lp”.

For text printing, select “text”.

sd Path name of the spool directory. Path name of the spool directory 
that is to be created.

lf Path name of the log file. Path name of log file.

For example /var/log/lpd-errs.

mx Maximum file size which the di-
rectory can copy. When set to 0, the 
size is unlimited. If nothing is en-
tered, the size is set to 1024 k. 

Nothing or something suitable.
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❖❖❖❖ Making the spool directory
Create a spool directory under /var/spool/lpd. The name of spool directory
should be the name of the printer followed by a “d”.

Note
❒ The spool directory is used to control the data used for a print job. For ex-

ample, when a print job is created, a temporary copy of the file data used
for printing is created in the spool directory. All workstations accessing the
network printer need to have a spool directory for the network printer.

❒ A spool directory should be made for every network printer entry listed in
the /etc/printcap file.

❒ The spool directory should normally be made under /var/spool/lpd and
the name should match that listed under the sd capability in /etc/print-
cap. Change the owner and group of the directory to root and lp. The fol-
lowing examples show how to make a /var/spool/lpd/npd spool
directory.
# cd /var/spool/lpd
# mkdir npd
# chown root np
# chgrp lp np

❖❖❖❖ Making the log file
Error messages are logged to a file created in the /var/log directory. The log
file name is the printer name followed by “d-errs”.

Solaris

❖❖❖❖ Adding the IP address and host name to the /etc/hosts file
The following line is added to the /etc/hosts file.
192.168.15.16  nphost  # Network Printer

• 192.168.15.16 is the IP address, nphost is the host name, from # to the end
of the line is a comment.

Note
❒ The /etc/hosts file contains a list of the IP addresses and their host names

of all of the hosts communicating on the network. Each entry is delimited
with a space or a tab, and each line is separated with a return.

❒ If you do not use NIS or DNS, you must manually enter the IP address and
host name of each workstation using the network printer in the /etc/hosts
file.
7
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❖❖❖❖ Registering the printer
The installation shell script registers the printer as a remote printer.
A If your workstation is Solaris 2.5.1, register the print server and print client

to the print service.
# lpsystem -t bsd -R 0 -y ″″″″Network Printer″″″″ nphost

B Register the printer as a remote printer.
# lpadmin -p np -s nphost!option -T dump -I any

• np is the printer name, nphost is the host name. options is “lp” or
“text”. For printing with PCL or PostScript, enter “lp”. For text printing,
enter “text”.

C If your workstation is Solaris 2.5.1, set the print job enable to be accepted
by print queue.
/usr/lib/accept np

D If your workstation is Solaris 2.5.1, set the print job enable to print.
/usr/lib/enable np

HP-UX

❖❖❖❖ Adding the IP address and host name to the /etc/hosts file
The following line is added to the /etc/hosts file.
192.168.15.16  np  # Network Printer

• 192.168.15.16 is the IP address, np is the host name, from # to the end of the
line is a comment.

Note
❒ The /etc/hosts file contains a list of the IP addresses and their host names

of all of the hosts communicating on the network. Each entry is delimited
with a space or a tab, and each line is separated with a return.

❒ If you do not use NIS or DNS, you must manually enter the IP address and host
name of each workstation using the network printer in the /etc/hosts file.

❖❖❖❖ Registering the printer
The installation shell script registers the printer as a remote printer following
the procedure below.
A Stop the scheduler.

/usr/lib/lpshut

B Register the printer.
/usr/lib/lpadmin -Pnp -v/dev/null -mrmodel

 -ormnphost -orpoption -ob3

• np is the printer name, nphost is the host name. options is “lp” or
“text”. For printing with PCL or PostScript, enter “lp”. For text printing,
enter “text”.
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C Set the printer so that the print job is listed in the print queue.
/usr/lib/accept np

D Set the printer to perform the print job.
/usr/lib/enable np

E Restart the scheduler.
/usr/lib/lpsched
9
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Printing Method

Printing with lpr, lp

Depending on the type of the workstation being used, execute one of the follow-
ing commands:

❖❖❖❖ BSD UNIX workstation
% lpr -Pprinter_name file_name [file_name...]
For example:
printer name is np, file names are file1 and file2
% lpr -Pnp file1 file2

❖❖❖❖ Solaris, HP-UX
% lp -d printer_name file_name [file_name...]
For example:
printer name is np, file names are file1 and file2
% lp -d np file1 file2

Note
❒ ”printer_name” is the name that was entered when executing the installation

shell script.
❒ You can use wild cards ( * or ? ) for the file name.
❒ The message “print session full” appears when the maximum number of

print requests has been reached *1 . You should try to print again when the
number of requests becomes less than five. You can confirm the number of
print requests using telnet. For more information about using telnet, see the
Network Interface Board Operating Instructions provided as a PDF file on the
CD-ROM labeled “Operating Instructions”.

*1 The maximum number of print session differ depending on printer's total memory
size. When the printer has standard memory (32MB), one print session is available.
When the printer has optional memory (total 96MB), the maximum number of print
session is five.
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Printing with rsh, rcp, ftp 

You can also print using the rsh, rcp and ftp commands.

Note
❒ Print using the format that the printer can support.
❒ The message “print session full” appears when the maximum number of

print requests has been reached *1 . You should try to print again when the
number of requests becomes less than five. You can confirm the number of
print requests using telnet. For more information about using telnet, see Net-
work Interface Board Operating Instructions provided as a PDF file on the
CD-ROM labeled “Operating Instructions”.

*1 The maximum number of print session differs depending on printer's total memory
size. When the printer has standard memory (32MB), one print session is available.
When the printer has optional memory (total 96MB), the maximum number of print
sessions available is five.

rsh

% rsh host_name print < file_name [file_name...]

For example:
host name is nphost, file names are file1 and file2
% rsh nphost print < file1 file2

Note
❒ ”host_name” is the name entered when executing the installation shell script.
❒ If you use a HP-UX, use the remsh command instead of rsh.

rcp

❖❖❖❖ To specify the file and print it
% rcp file_name [file_name...] host_name:
For example:
host name is nphost, file names are file1 and file2
% rcp file1 file2 nphost

❖❖❖❖ To print all of the files in a directory
% rcp -r directory_name host_name:
For example:
host name is nphost, directory name is directory1
% rcp -r directory1 nphost

Note
❒ ”host_name” is the name entered when executing the installation shell script.
❒ You can use wild cards ( * or ? ) for the file name.
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ftp

Depending on the number of files to be printed, use the put or mput commands.

Limitation
❒ File names cannot contain “=” or “,”.

❖❖❖❖ To print one file
ftp> put file_name

❖❖❖❖ To print several files
ftp> mput file_name [file_name...]

Note
❒ You can use wild cards ( * or ? ) for the file name with the mput command.

The following procedure shows an example of how to print a file using ftp. 

A Start ftp using the IP address or host name of the printer.

% ftp IP_address

Note
❒ ”host_name” is the name entered when executing the installation shell

script.

B Enter the user name. Ignore the password, and then press the {{{{RETURN}}}}
key.

Name:
Password:

C Set the file transfer mode to binary.
ftp> bin

Note
❒ If the file transfer mode is not set to binary, the image might not be printed

correctly.

D Print the file.

Note
❒ For example, to print one file named file1:

ftp> put file1 

❒ For example, to print two files named file1 and file2:
ftp> mput file1 file2

E Exit ftp.

ftp> bye
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Printer Status

You can use the following commands to have information and the printer status
displayed or copied to a file.
Use the lpq or lp command to display the status of the printer or information
about print jobs.
Use the rsh, rcp or ftp commands to get more detailed information from the
printer.

Viewing the Printer Status with lpq and lpstat

❖❖❖❖ BSD UNIX workstation, Linux
% lpq -Pprinter_name 
For example: Printer name is np
% lpq -Pnp 

❖❖❖❖ System V UNIX, Soralis, HP-UX
% lpstat -o printer_name 
For example: Printer name is np
% lpstat -o np 

Viewing the Printer Status with rsh and ftp

Use the rsh or ftp command to display the status of printer or information about
print jobs using specified parameters.
You can use these commands for BSD and System V UNIX.

Note
❒ If your workstation is HP-UX, use the remsh command instead of the rsh.
% rsh host_name parameter

 
% ftp host_name
User user_name
password:
ftp> get parameter -
13
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Note
❒ For the user name and password input nothing, and then press the {RETURN}

key.
Parameters that can be used with rsh, rcp and ftp:

Copying Information to a File

Use the rcp or ftp command to copy information about the specified parameters
to a file.
You can use these commands for BSD and System V UNIX.

Note
❒ The same parameters are used as those above.
% rcp host_name:parameter file_name

 
% ftp host_name
User: user_name
password:
ftp> get parameter file_name

Note
❒ For the user name and password input nothing, and then press the {RETURN}

key.

Parameter Information returned Reference

status
Status of the printer.

Information about print jobs.

Network Interface Board 
Operating Instructions 
provided as a PDF file on 
the CD-ROM labeled “Op-
erating Instructions”

info
Information about the paper tray, output tray 
and printer language of the printer.

Printer Reference provid-
ed as a PDF file on the CD-
ROM labeled “Operating 
Instructions”.

prnlog Record of the last 16 jobs printed. Network Interface Board 
Operating Instructions 
provided as a PDF file on 
the CD-ROM labeled “Op-
erating Instructions”.

syslog
Record of messages about the Network Interface 
Board.
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Please read the Safety Information in the Setup Guide or Printer Reference before using this machine.
It contains important information related to USER SAFETY and PREVENTING MACHINE PROBLEMS.

QUICK INSTALLATION GUIDE
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INSTALLING  THE  TONER
CARTRIDGE

 Warning
• Do not incinerate spilled toner or used toner. Toner

dust might ignite when exposed to an open flame.
• Disposal can take place at our authorized dealer

or at appropriate collection sites.
• If you dispose of the used toner cartridge your-

self, dispose of them according to your local regu-
lations.

 Caution
• Do not eat or swallow toner.
• Keep toner (used or unused)  and the toner car-

tridge out of reach of children.
• Our products are engineered to meet the highest

standards of quality and functionality. When pur-
chasing expendable supplies, we recommend
using only those provided by an authorized dealer.

Important
❒ Do not expose the toner cartridge to a light for a

long time. If you do, the toner cartridge will be
damaged and the print quality might be reduced.

Open the front cover by pushing the front cover
release button.

ZGDH126E

Remove the fixing material inserted between
toner cartridge and the printer.

ZGDT146E

While lifting the front side of the toner cartridge,
pull it out of the printer.

ZGDT115E

Note
❒ Do not hold the toner cartridge upside down or

stand it vertically.
❒ Do not put the toner cartridge on an unstable

or tilted surface.
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Place the toner cartridge on a flat surface. Pull
out the tape inside the unit horizontally while
holding the cartridge with one hand as shown
in the illustration.

Important
❒ Be sure to remove the tape completely before installing

the toner cartridge. Otherwise, the printer might be
damaged.

❒ If you pull out the strips when the toner cartridge
is slant or standing on its side, the cartridge might
cause trouble with the printer.

❒ Be sure to pull the tape horizontally. Pulling it
upward or downward may cause the toner to scatter.

❒ Be careful not to make your cloths dirty with toner.

❒ After pulling the tape out of the cartridge, toner scatters
easily. Do not shake the cartridge.

Holding the grips of the toner cartridge, insert
it into the printer until it stops.

ZGDT121E

Insert the toner cartridge in its appropriate
position by gently pushing down.

ZGDT145E

Close the front cover.

ZGDH135E

Important
❒ Do not close the front cover with force. If you

cannot close the cover easily, pull out the toner
cartridge from the printer and insert it again.
After that, close the front cover again.

Power Connection
Connect the power cord to a power source with the follow-
ing specifications:

❒ 120V, 60Hz, 8.4A or more

Space Required for Installing the Printer
Leave enough space around the printer. This space is neces-
sary to operate the printer. The recommended (or minimum)
space requirement is as follows:

ZDDH010E

A: more than 10 cm (4.0")

B: more than 10 cm (4.0")

C: more than 100 cm (40.0")

D: more than 10 cm (4.0")

<G074-8627>

INSTALLING THE PAPER TRAY
The default paper settings size are as follows:

Metric version: A4 L (long-edge feed)
Inch version: 81/2" x 11" L (long-edge feed)

For settings other than the default paper size, see
“Loading Paper and Other Media” in the Printer
Reference provided as a PDF file on the CD-ROM
labeled "Operating Instructions".
For more information about the paper sizes that
can be set in the paper tray, see “Paper and Other
Media Supported by this Printer” in the Printer
Reference provided as a PDF file on the CD-ROM
labeled "Operating Instructions".

Lift the paper tray slightly then pull it out until
it stops.

Note

❒ Do not touch the three white pins on the left
front side of the printer.

While lifting the front side of the tray, pull it out of
the printer.

Load paper into the paper tray with the print
side up.

Important
❒ Confirm that the top of the stack is not higher

than the limit mark inside the tray.

❒ Confirm that the paper fits under the rear guide.

WHERE TO PUT THE PRINTER
The printer’s location should be carefully chosen
because environmental conditions greatly affect its
performance.

 Warning
• Confirm that the wall outlet is near the machine

and freely accessible, so that in event of an
emergency, it can be unplugged easily.

• Only connect the machine to the power source
described on this sheet.

• Avoid multi-wiring.
• Do not damage, break or make any modifica-

tions to the power cord. Do not place heavy ob-
jects on it, pull it hard or bend it more than nec-
essary. These actions could cause an electric
shock or fire.

 Caution
• Keep the machine away from humidity and dust.

A fire or an electric shock might occur.
• Place the machine on a strong and level sur-

face. Otherwise, the machine might fall and
cause personal injury.

• If you use the machine in a confined space, con-
firm that there is a continuous flow of air.

Optimum Environmental Conditions
Recommended temperature and humidity

32°C
54%

27°C 80%10°C 80%

32°C 15%10°C 15%

%RH

80

60

40

20

10 20 30 °C

15°C
70%
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30%

25°C
30%

25°C
70%

50°F 80% 80.6°F 80%

77°F
70%

77°F
30%

89.6°F
54%

89.6°F 15%50°F 15%

59°F
30%

59°F
70%

80

60

40

20

50 80 9060 70

%RH

°F

 Possible operation range  Recommended range

The machine must be level within 5 mm, 0.2" both front to rear
and left to right.

Environments to Avoid

Important
❒ Locations exposed to direct sunlight or strong light

❒ Dusty areas

❒ Areas with corrosive gases

❒ Areas excessively cold, hot, or humid

❒ Locations near an air conditioner or humidifier

❒ Locations near other electronic equipment

❒ Locations where the printer might be subjected to
frequent strong vibration

UNPACKING THE PRINTER AND
CHECKING THE CONTENTS OF
THE BOX

Check the contents of the box according to
the following list. If one or some items are miss-
ing, please contact your sales or service rep-
resentative.

Important
❒ The interface cable is not included in the box. Make

sure that the interface cable you use is appropriate
for your computer.

Quick Installation Guide (this sheet)

Setup Guide
CD-ROM (3)
Printer (including a starter toner cartridge)
Additional Documentation

Remove the plastic bag. Lift the printer and move
it to the place where you want to install it.
When lifting the machine, use the inset grips on both sides. Otherwise
the machine could break or cause injury if dropped.

ZGDT052N

Remove the orange adhesive tape (7 pieces).
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PRINTING A CONFIGURATION
PAGE
You can check if the printer works properly by
printing a configuration page.
However, you cannot check the connection
between the printer and the computer by printing
the configuration page.

Check that the power switch is turned on.

Press the {Menu} key.
"Menu" appears on the panel display.

Press the {▲} or {▼} key until the following
message appears on the panel display.

Menu:

 List/Test Print

Press the {Enter  } key.
The following message appears on the panel display.

List/Test Print:

 Config. Page

Press the {Enter  } key.
The test printing will start.

Important
❒ If you cannot complete the test printing correctly,

check if an error message appears on the panel
display. For more information about error
messages, see “Troubleshooting” in the Printer
Reference provided as a PDF file on the CD-ROM
labeled "Operating Instructions".
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❖ Parallel connection

Important
❒ The parallel interface cable is not provided with

the printer. Make sure that the interface cable
you use is appropriate for your computer.

❒ The printer’s parallel connection is a standard
bi-directional interface. It requires a standard
36-pin parallel cable compliant with IEEE 1284
and an available parallel port on your computer.

❒ To avoid electrical interference, use a shielded
cable.

Note

❒ Do not use a parallel cable more than 2.5 meters
(8.2 feet) long.

Turn off the power switch.

Turn the computer off.

Attach the interface cable to the interface con-
nector of the printer. Secure the cable with the
metal fittings as shown in the illustration.

ZGDX115E

Attach the other end of the interface cable to
the interface connector of the computer. Se-
cure the cable.

Important
❒ Rating voltage of the parallel interface connector

for the computer ; Max. DC5V.

CONNECTING THE PRINTER TO A COMPUTER
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Carefully slide the paper tray into the
printer until it stops.

Important
❒ Confirm that the setting of the paper size

dial matches the size and feed direction of
the paper in the tray. Otherwise, the printer
might be damaged or a printing problem
might occur.

❒ Do not slide the paper tray in and out with
force. If you do, the front and side paper
guides will move out of the place.

CONNECTING THE POWER
CORD

 Caution
• When you pull the plug out of the socket,

grip the plug to avoid damaging the cord
and causing a fire or an electric shock.

• It is dangerous to handle the plug with
wet hands. An electric shock might occur.

Check that the power switch is turned off.

ZGDH205E

Securely insert the power cord plug into the
wall socket.

SELECTING THE PANEL
DISPLAY LANGUAGE
Select a language following the procedures
described.
The message for the selected language will
appear on the panel display.

Note
❒ The default setting is English.

❒ If you want to use the English panel display, the
following procedures are unnecessary.

Check that the power switch is turned on.

Press the {Menu} key.

EnterForm Feed

Job Reset

On Line

Escape

Menu

Power Error Data In

"Menu" appears on the panel display.

Press the {▲} or {▼}  key until the following
message appears on the panel display.

Menu:

 Language

Press the {Enter } key.

Press the {▲} or {▼} key until the language
you want to select appears on the panel display.

Press the {Enter } key.

Press the {On Line } key.
The settings are applied and the ready message appears on the panel
display.

❖ Network connection
If your printer is installed with the Network Interface
Board, follow the procedures below.

Turn off the power switch.

Loop the network interface cable and attach
the ferrite core.

 Note
❒ The network interface cable loop should be about

15 cm(6")(a) from the end of the cable (on the
end closet to the printer). The ferrite core at the
end of the cable should be a ring type ferrite core.

Attach the network interface cable to the
jack on the board.

ZGDT290E

Connect the other end of the network interface
cable to the network.

Turn on the power switch.
Check the LEDs on the ethernet port.

ZGDH260J

1
2

1 is lit when the printer is securely connected to the network.

2 is lit when 100BASE-TX is in use and not lit when 10BASE-T is in
use.

❖ USB connection

Important

❒ The USB interface cable is not provided with the
printer. Make sure that the USB interface cable
you use is appropriate for your computer.

Attach the USB interface cable to the USB
interface connector of the printer. Secure the
cable.

ZGDT300E

Attach the other end of the interface cable to
the USB interface connector of the computer
or the USB Hub. Secure the cable.

SETTING UP FOR PRINTING
Printing requires installation of a printer driver
for the operating system.

Reference
❒ See “Printer Drivers for This Printer” in the

Setup Guide.

❒ If you want to install options, see “Installing
Options” in the Setup Guide.
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